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      	In this photo of Point Bonita and the Golden Gate near San Francisco, California moonlight supplied ambient background light, with the Point Bonita lighthouse as an important focus of the composition.

    


    
      52mm, 2 minutes at f/5.6 and ISO 200, tripod mounted
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          	Title page: With this composition of fog and sunlight I intentionally underexposed to bring out the graphic patterns revealed by the composition.

        


        75mm, 1/640 of a second at f/8 and ISO 100, tripod mounted
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        	I used the bright sunlight and grill reflections to make this semi-abstraction of a 1930s Cadillac.

      


      200mm macro, 1/15 of a second at f/32 and ISO 100, tripod mounted
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        	Page 6: This night time view of traffic lights on the Golden Gate Bridge uses the absence of color to suggest the colors that are presumably present in the scene.

      


      380mm macro, 10 seconds at f/11 and ISO 100, tripod mounted
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        Introduction


      

    


    
      
        As photographers, we are confronted each and every day with a wide array of choices. Most of us have the experience of being paralyzed with indecision when confronted with all the choices about what can be photographed.


        Besides your choice of subject, you can worry about how your photograph is going to be lit (if you are using artificial light), or what time of day the lighting is best (if you are relying on natural light). Then there’s the choice of lens, focal length, f-stop, shutter speed, ISO, and so on—not to mention the choices about how you will process and present your photo after it has been shot.


        Bewilderment in the face of so many artistic choices can lead to creative blocks, and is sometimes called horror vacui—or fear of “empty spaces” on the canvas of life that presents itself to every photographer. One response is to intentionally limit one’s artistic palette so there are not so many choices. A natural self-limitation in photography is to leave out the color and present the world in black and white.


        Limiting photography to black and white is an obvious strategy because of the history of photography. For a substantial part of the history of photography, the only choice was monochrome—and people thought of photography as being black and white. Color was only introduced to photography in the mid-twentieth century, and people have had a hard time accepting color work as part of the accepted canon of photographic art.


        As I’ll show you in Creative Black & White: Digital Photography Tips & Techniques, many things are different with the rise of digital technology. Presenting a photo in black and white is not a consequence of the materials used; rather, it is an intentional aesthetic choice. Furthermore, from a technical perspective it almost always makes sense to shoot and initially process a digital photo in color—even if you plan from the very beginning to present it in black and white.


        Black and white photography is redolent with echoes from the history of photography, and it is wise to keep this in mind as you make your own black and white images. The absence of color in a black and white print or online image can strongly imply the color that isn’t present—but only imagined. Black and white photography must play strongly to the imagination of the viewer. This often means taking advantage of the power of the graphic design that can occur when an image is composed only in monochrome.


        My goal in Creative Black & White is to be your companion and guide as you create your own black and white imagery. Together we’ll experience what it means to think in black and white. I’ll show you many of the visual ideas that can work well with black and white, and share my expertise about the technical approaches that can be used to create high quality digital black and white photos.


        I have a great passion for black and white photography, and I look forward to sharing my joy in the art and craft of digital monochromatic image creation with you!
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          	The idea for this photo was to isolate the typewriter key used to type French accents, because it looks like a little funny face. To achieve this goal I kept the circumflex (^) key sharp, while letting everything else in the image go out of focus.


          	
            I wanted to present the photo with an antique look, so once I’d processed the black and white version I added a sepia tone layer with reduced opacity (see page 166 for more information about this technique).

          

        


        200mm macro, 1.3 seconds at f/4.5 and ISO 100, tripod mounted

      

    

  


  
    


    
      The Monochromatic Vision
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        	Just before an early winter sunset I stood on a bluff above a beach to the south of San Francisco, California and photographed the incoming long rollers. My idea was to exploit the contrast between the extremely bright highlights created by the setting sun and the darkness in the valleys between the waves. Knowing I was going to transfer the color scene in front of me into a black and white vision, I intentionally shot the image to be dark (by underexposing) at a very fast shutter speed (1/8000 of a second), which also served to stop the motion of the waves.

      


      190mm, 1/8000 of a second at f/7.1 and ISO 400, tripod mounted

    


    
      Past, Present, and Future

    


    
      In large part, when we think of great photography prior to the digital era, we think of black and white imagery.


      Gritty stills of the Second World War. Magnificent Ansel Adams landscapes of the American West. Classical compositions of nudes, peppers and shells by Edward Weston. All these and more are part of the shared black and white collective consciousness.


      Sure, once color film came along we started filling up those yellow boxes with slides. But until fairly recently color photos have not been recognized as art.


      Back in the days of film, you could shoot in color or in black and white. A vast gulf separated the two. Amateurs, and some advertising photographers, shot color. Art photographers worked in monochrome.


      An oversimplification, of course. But the fact remains that if you had a 35mm camera, you had to decide what kind of film cassette to load, and whether it should be color or not.


      With the domination of digital technology in photography, the choice of color versus black and white no longer belongs to the physical domain. The best bet is to shoot full color whether you intend to present your final image in color—or to make an outstanding black and white image. I’ll tell you more about the best practices in creating Black and White in the Digital Era, starting on page 66.


      The implication is that the choice to create black and white imagery is virtual. In other words, it is an aesthetic choice, similar in nature to presenting work that is only blue in tint, that uses a specific focal length or lens, or is limited to a certain kind of subject matter. The choice of black and white does not have to be made until “after the fact”—because the photo has already been taken—although the best black and white imagery is intentionally created with monochrome in mind.


      In other words, your photos of a given scene can be presented in both color and black and white. Or you can decide to present your work in monochrome after you see how your shoot has turned out. There’s nothing wrong with these approaches. But since black and white is now an affirmative choice—amounting to the intentional abnegation of color—it works best to make this choice with intentionality.


      Whichever way you choose to work, learning to think in black and white is part of the job.
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          	When photographing the wonderful spirals of a Chambered Nautilus shell, it’s hard not to think of the classical black and white imagery of Edward Weston. With this fairly straightforward macro photograph of the shell, I was able to use the color information I captured to create a really rich monochromatic image with great tonal range.

        


        50mm macro, 8 seconds at f/32 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Thinking in Black and White

    


    
      The absence of color does not mean the obliteration of color. Black and white is a choice—and surprisingly, this choice can call attention to implied color in the image even more than if the image were actually presented in color.


      If you want to think in black and white you must learn to view the world as seen through your camera in terms of implied color, and through gradations of gray.


      A black and white image potentially shows a range from pure white to absolute black (leaving aside issues of tinting and toning, explained starting on page 166).


      These extremes are not often seen to any great extent in a color photo because pure white represents highlight blowout, and absolute black is approximated in impenetrable shadow. Except in unusual circumstances, color photos don’t usually feature as wide a range of grayscale tonal values as monochromatic imagery.


      Contrast


      Thinking in black and white means thinking in contrasts. The building blocks of composition are shape, design, and form. In the case of black and white, this formalism is consistent, and unleavened or softened by color. As I’ve noted, taking this to its limits, the contrast is between white and black.


      Black and white photographers know that one of the primary tools of their compositional trade is the edge—the line between white and black. A hard edge between light and dark becomes a black shape on a white background—or a white shape on a black background.


      In either case, the interrelationship between black and white allows for complexity in the handling of positive and negative spaces in the composition. Experienced black and white photographers know that creating, or emphasizing, the edge adds an element to a photo that is often not present in a color image.


      Life doesn’t usually present us with obvious hard edges between black and white to photograph. Finding these edges requires developing a special kind of vision. Look for:


      
        	Strong, interesting shadows: the shadows themselves may create a hard line between darkness and light.


        	Compositions that are monotonic: if color is already mostly absent, then it is likely you can add light, expose, or add post-processing effects to create high contrast imagery.


        	Extremes between areas of brightness and shadow in a subject: if there are extremes between light and dark, then a composition may lend itself to a high contrast black and white treatment.
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          	The sun was streaming through a great arch carved by the Pacific Ocean, creating highlights on the surf coming through the gap. Everything else in the scene was in deep shadow. I pre-visualized a black and white image exposed for the bright surf framed by the surrounding cliffs, shown in silhouette as a black negative-space shape.

        


        95mm, 1/320 of a second at f/9 and ISO 200, tripod mounted

      


      Even when you recognize a high-contrast photographic subject, there may be additional work to do. You’ll want to consider:


      
        	Positioning the camera to emphasize the edge, or the delineation between dark and white areas.


        	Use lighting to maximize the contrast.


        	Underexpose dark areas to make them blacker in the final image or overexpose bright areas to make them whiter in the image. To compensate, you’ll need to adjust processing in areas that you don’t want to go fully black (or white).


        	Consider various post-processing effects to increase tonal range, or to emphasize light or dark areas important to the composition.
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            	In color, this lettuce-like leaf looked like some green and luminous sea creature, complete with curling tentacles. Converting the image to black and white added elegance. Oddly enough, the black and white version presents a more natural representation of the actual leaf than its color counterpart—because the actual color appears unnatural. Converting to black and white, we can substitute natural colors of our own imagining to come up with something like a Platonic ideal of a mustard leaf.

          


          85mm macro, 5 seconds at f/51 and ISO 100, tripod mounted

        

      


      Color Implied


      Our expectation is that scenes and objects in our world are colored. For example, lettuce is green, a tomato is red, and an orange is, well, orange.


      The fact that one is viewing an object in black and white doesn’t negate the fact that we know the object has color. We tend to visually impute color to the subjects of photos unless these subjects seem so ancient or far away as to be beyond the reach of realism.


      The imputation of color means that a photographer who is presenting work in black and white can assume that the subject will be seen as colored, at least to some degree.


      Therefore, the photographer can take advantage of what monochrome does best, namely present the underlying forms and contrasts. In the universe of black and white, color can take care of itself, but it doesn’t mean it isn’t present. Color is the elephant in the room—not talked about but with a vast presence.


      Black and white photographers who want to take advantage of the imputation of color should:


      
        	Look for subjects whose color is readily known

        (think apples, oranges,

        and lettuce).


        	Consider photographs where the natural colors don’t work well for some reason, but where imputed colors would be an improvement.


        	Try to create a composition where formal aspects of design outweigh the allocation of color to the objects within the photo.

      


      The Tonal Landscape


      From the earliest origins of photography, black and white has been specially associated with landscape photography. The best landscape photographs have a purity of expression that meshes well with the sparseness of black and white. In addition, the simplicity and tonal range of black and white allows details to be brought out that would otherwise be camouflaged by the complexities of color.


      To create interesting black and white landscape compositions, you should:


      
        	Look for landscapes with varied textures and forms in the earth and sky.


        	Avoid landscapes where the interest is primarily in saturated colors.


        	Try to create compositions that take advantage of the bold shapes possible in black and white.


        	Seek drama in the interplay between light and dark areas

        in your photo.
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          	Unusual snowfall in the coastal range mountains of California made this scene dramatic. However, overcast skies kept compelling colors out of the landscape. I realized that to make an interesting landscape image I would need to process the image file to bring out the extensive contrast and color range that I saw in the scene in front of me (see Black and White in the Digital Era starting on page 66 for more information about post-processing black and white).

        


        200mm, 1/620 of a second at f/13 and ISO 200, hand held

      


      Visual Implication


      A black and white photograph shows the full spectrum world of color monotonically. By stripping the color from a scene, the photograph adds mystery. When black and white is done correctly, we don’t always know what we are looking at. There’s a sense of ambiguity and—hopefully—profound mystery.


      Ambiguity causes a double-take, engages the viewer, and makes the viewer spend time with the image. This is a good initial goal for any work of art because when time is spent deciphering the image, the viewer may progress to a deeper relationship with the work.


      When the image is studied carefully and pursued to its logical extreme, certain visual implications can be drawn.


      Ideally, visual ambiguity should be set up so that looking at the photo long enough does make the real subject matter—as opposed to the superficial first apparent subject—apparent.


      Black and white photography that uses visual implication works on a kind of pun. The viewer gets a frisson of delight and a sense of collaboration with the photographer, when the real subject is uncovered.


      To create images that take advantage of ambiguity and visual implication, you should:


      
        	Look for subject matter that can be interpreted visually in more than one way.


        	Use positioning, framing, focus, and exposure to exploit the visual ambiguity by highlighting secondary visual meanings.


        	Be aware that camera angle and choice of lens can be particularly important in creating visually ambiguous imagery.


        	Post-process images to keep the sense

        of mystery alive.


        	Work to create photos whose visual meaning can only be decoded a bit

        at a time.
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        	My idea when I photographed this close-up of a toilet was to abstract the shapes so the subject matter of the image wasn’t clear at first glance. When this kind of image works, the viewer does a double-take. At first look, this might be a human nude—of course, it is not. The implied domain of the image (a nude abstraction) is not the actual subject matter of the photo (plumbing).

      


      85mm macro, 1/15 of a second at f/64 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      Seeing in Black and White

    


    
      From thought (learning the characteristics that are important to a black and white photo) to action (the act of making a monochromatic image) can be a long journey. Fortunately, there’s an intermediate step: learning to see in black and white. Pre-visualization techniques, explained on pages 26–29 and 68–73, can help you see your photos as they will appear in monotone before you take them, but it is also important to think about the more general issues of seeing.


      I consider far more photos in my mind’s eye than I ever end up actually taking. The whole approach to photography should be an inverted pyramid looking something like what is shown below, starting with thought and conception and ending with presenting the work. At each stage in the photographic journey, there are less and less images.


      Here’s the explanation for the reduction in quantity of photos. At the top stages of the pyramid, the world is one’s oyster. Everything is grist for the visual mill, and the possibilities have not been limited.


      A few of the possibilities out there actually become digital photos, either as planned photos or because something in the world captures the attention of a diligent photographer.


      [image: ]



      Of these few, an even smaller number will actually be fully processed in Lightroom, Photoshop or some other software. And fewer still of those processed will actually see the “light of day”—get shown to others.


      Online communities of photographers such as Flickr or Photo.net have changed this equation somewhat—because it is easy to post images where they may be widely seen. But I’d keep in mind the wisdom a famous art director shared with me when I was beginning my career as a photographer. He told me that if I needed to show more than six images then I didn’t really understand what was important about

      my work.


      Black and white photography limits the choice of subject matter further than it would otherwise be limited—to those images that actually work, or are improved, without color. Therefore, the universe of possibilities is far smaller at each stage of the inverted pyramid than for digital imagery overall.


      There’s nothing wrong with limiting one’s photography to specific techniques. In fact, it can be a valuable approach for enhancing creativity. But the fact remains that not all photos should be shown in black and white.


      In my drawing you’ll note that I’ve shown Thinking and Seeing connected with a double-headed arrow. This is because, like chickens and eggs, it is a little hard to know which comes first. The two activities are interrelated. I prefer to conceptualize first, and then “see” my photos without feeling too bound by ideas about what “should”

      be in the photo.


      My ideas about creative black and white photography are to look for:


      
        	Positive and negative spaces, because sometimes these will create the composition.


        	Level of contrast within the image, because high contrast often works well for black and white. (There are some exceptions, such as high-key imagery, explained on pages 40–43).


        	Formalism in composition, since design becomes extremely important to the success or failure of a monochromatic image.

      


      Finally, I use the pre-visualization techniques and exercises explained on pages 26–29 to try very hard to see the world without color. Seeing without color is not the same thing as seeing black and white; but it is a first step. From a world that has no color, one can start to abstract and pre-visualize what a piece of the world captured in a photo might look like as a black and white work of art.
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          	Lying back in a dense forest, I looked up at the sky. Suddenly I saw the sky as a circular shape in the center of my field of view, apparently held up by the tangled and gnarled trees. I knew that in black and white I could isolate the white, round shape of the sky from the dark background of the forest and trees—transforming the image into one “round globe” (actually the sky) held up in “space” by the trees.


          	
            If you look at the composition carefully, you’ll see perfectly well that it is an image of the sky seen through branches of trees. But at a quick glance, the circular shape makes it appear to be something else (the globe in the sky). Visual ambiguity of this sort greatly appeals to me in my black and white imagery.

          

        


        10.5mm digital fisheye, 1/60 of a second at f/8 and ISO 100, hand held
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        	I placed this egg slicer on a white seamless background, and lit it to emphasize the shadow. There was an absence of color in the composition, and I saw that the contrast between the strong shadow and the rather mundane kitchen utensil could create a striking black and white composition.

      


      85mm macro, 6 seconds at f/64 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      Pre-Visualization Techniques

    


    
      Pre-visualization refers to the ability to see in the “mind’s eye” how a final image will come out based simply on the scene in front of one. Ansel Adams maintained that pre-visualization was a crucial skill in his work and for all photographers; in the era before digital he was often able to accurately “know” what his final print would look like, taking into account the vagaries of exposure and development, as well as the craft of fine print making.


      Without pre-visualization, photography can be largely random, and lacks conceptual clarity. You’ll also waste a great deal of time by making captures that don’t come out the way you’d expect or like.


      Some people think that digital technology has made pre-visualization greatly easier. With a digital capture, you can “see” what you’ve got right after the exposure—or using Live View even before you make the exposure. For more information about using these aspects of digital technology to help you pre-visualize black and white imagery, see pages 70–73.


      Reviewing a photo on your LCD screen can be a great way to check the accuracy of your exposure and the basics of your composition, but there are a couple of reasons why pre-visualization in the

      digital era is still as great a challenge

      as it ever was.


      Assuming you’ve set your camera to create RAW captures, the image you see on your LCD is a JPEG rendition of the RAW file—and as such gives you only one data point regarding the potentialities available within the complete capture. See pages 74–75 for a comparison of JPEG and RAW captures in the context of black and white digital photography. It’s as if Ansel Adams were pre-visualizing his negatives developed only one way instead of considering how his negatives might come out depending on the complex chemical mixtures he used determined by shooting and exposure conditions.


      There’s also close to an infinite universe of possible approaches to digital post-processing. You can take the file representing a photo and process it in numerous different ways—with tremendous variations in the final black and white image. From this viewpoint, the ability to pre-visualize digital black and white takes knowledge of the vast array of post-processing techniques as well as the ability to see with subtlety and clarity how the color world translates to monochrome. (This is the subject of Black and White in the Digital Era starting on page 66 and Creative Black and White Opportunities starting on page 142.)


      Here are some techniques I use to help develop my pre-visualization skills, and to try and see how particular photos will “come out” in their final black and white versions:


      
        	I consider a generally monochromatic subject—this could be anything ranging from a bush to a door—and pay special attention to how it is lit. I think about whether I can make a black and white photo from the contrast between highlights and shadows. If not, I consider how I need to change the lighting to create an interesting photo.


        	I sometimes bring a small sketchbook and a pencil with me on my shoots. Before making any exposures, I try to draw the key shapes I see in the image. I’m not in the least worried about the quality of my drawing. Often, this work helps me clarify the important aspects of the composition I am trying to make.


        	Looking at a potential photo in my viewfinder, I try to see the image in black and white. In my mind’s eye I try to take both black and white areas to the limit. What happens when the darker areas go completely black? What happens when the lighter areas go completely white? What are the results if both “moves”

        are attempted at the same time?

      


      By the way, pre-visualization is not a be-all and end-all by itself. It’s a tool and technique to help you create more powerful images with greater control. But don’t get caught in the trap of excluding alternative possibilities when you come to process your imagery. Often, the most interesting photos come from surprise detours along the way rather than following the straight and narrow path of your original roadmap.
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        	I photographed this small, white Hellebore flower in a room with the curtains drawn so that there was only a single shaft of sunlight on the blossom.


        	
          Looking at the essentially monochromatic flower, I saw that if I made darks darker and whites whiter I might have an interesting black and white image with deep shadows in the “valleys” between the petals and highlights creating interesting shapes around the petal rims. But what I saw in my viewfinder didn’t correspond to my pre-visualization.


          I adjusted the light focused on the flower, and moved its position, to create deeper shadows with highlights playing on the petal edges. Post-processing yielded the black and white image I had pre-visualized.

        

      


      200mm macro, 24mm extension tube, 1/6 of a second at f/35 and ISO 100, tripod mounted
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        	Wandering at an outdoor classic car show, I kept my eye out for interesting compositions. When I saw the sunlight reflecting on the grill of this 1930s Cadillac, I was able to pre-visualize an interesting monochromatic image. One reason that I was able to see this composition in advance is that the car itself wasn’t highly colored. Perhaps taking a leaf from Henry Ford—his customers could have any color they wanted so long as it was black—this classic car was black with chrome detailing.


        	
          The contrast between the chrome, brightly lit by the sun, and the deep black car body, helped to create the kind of pattern that can be very interesting in black and white imagery.

        

      


      200mm macro, 1/15 of a second at f/32 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      Black and White Composition

    


    
      In the classic film Casablanca, Captain Renault describes the intriguing nightclub owner Rick in these words: “Oh, he’s just like any other man, only more so.”


      You could also say that black and white composition is like composition in color—only more so. Since color is not present to entertain, beguile, and misdirect the eye, formal composition becomes more important.


      The elements of formal composition that are most important to black and white photos include:


      
        	Framing and the relationship of an image to its “frame”


        	Patterns and symmetry


        	Use of lines and shapes

      


      To learn more about issues discussed in this section, you might want to check out my book Creative Composition: Digital Photography Tips & Techniques.


      Framing


      By definition, a photograph appears within a frame—which is to say that the image is bounded and has a boundary. It’s important to design your framing to present an interesting view of the world.


      The way your image is framed should complement—rather than compete with—the rest of your composition. Essentially, your framing puts the world within a rectangle. You should consider why the particular rectangle you’ve chosen is interesting, whether your choice of rectangle is as compelling as possible and how the framing rectangle relates to the elements within your composition.


      When you are thinking about the black and white composition of a photo, you cannot ignore the frame and create a successful image. I’m not talking about picture frames here, but rather the edges of the photo.


      Black and white composition requires a particularly forceful approach to framing—because there are fewer compositional elements to play with than in a color composition. In addition to featuring an interesting view of the world, strong framing often divides the frame, or presents a frame within a frame. The two effects can be combined for more compositional power.


      Here’s how it works: frame division focuses compositional elements into different discrete areas—for example, shadow and light. Dark areas that are in shadow contrast with bright areas that are well lit and combine to create the formal composition.


      Often the elements used to divide frames are exclusively horizontal, or vertical—although diagonals can also be involved.


      A frame within a frame uses elements within a photo to construct a virtual frame within a composition. The virtual frame can be literally created by causing the viewer to “look” through a window of some sort. Alternatively, the inner frame can seem to be a natural consequence of the shapes of the composition.


      When frame dividers also serve as an inner frame then you get the power of frame division and of having a frame within a frame. For example, in the photo on page 63, the window inside the image acts as a frame within the frame.


      When you are pre-visualizing your black and white compositions, you should also think about the role framing will play. It pays to make the most use of framing possible, and to see if you can maximize the power that good framing brings to any composition.
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          	On snowshoes in a storm, I climbed to Vernal Falls in Yosemite Valley. As I approached the waterfall, the storm lifted. Everywhere I looked, the scene was magnificent. While the scene was one to savor, I knew that to create a striking photo I needed to frame an interesting “slice” of the view in front of me. I decided to use the relatively dark pine trees dusted with snow as a “frame” to show the white waterfall behind the trees as a contrasting compositional element. This both divides the frame of the photo vertically and creates the effect of a frame within the frame.

        


        200mm, 1/800 of a second at f/5.6 and ISO 200, hand held

      


      Patterns


      In photographic composition, a visual pattern is a repetition of similar, or essentially similar, shapes that combine to create a pleasing whole. Patterns are an important part of how we perceive the world and can add to the power of black and white compositions.


      Patterns are made up of lines and shapes, and can occur at many different scales. In black and white, the most important aspect of a pattern is the repetition of a specific variation in contrast.


      It’s interesting to consider the end of a pattern. A pattern that goes on forever is not all that interesting. On the other hand, many patterns don’t continue infinitely. Therefore, there must be an end to the pattern, either present in the photograph or visually implied. Some of the most interesting black and white compositions that rely on patterns use the pattern boundaries to combine the impact of the pattern and the way the pattern interrelates with the frame.


      [image: missing image file]


      
        
          	This white Dahlia was essentially without color, so it was natural that a monochromatic image should occur to me. In considering the composition, I realized that the flower was symmetric, creating a strong natural pattern with whiter inner petals contrasting with the grayer petals nearer the perimeter of the flower.


          	
            In addition, the shape of the flower resembled a kind of starburst. This shape could be effectively contrasted with a square, black photo frame.

          

        


        85mm macro, 20 seconds at f/64 and ISO 100, tripod mounted


        Lines


        Black and white photographs are made up almost exclusively of lines and shapes. Lines connect points and enclose areas to create shapes. The edge of a shape is a line. So lines and shapes are related, but for a moment consider the simplicity and occasional complexity of a line itself.


        A line moves across a composition in one of several ways: it is horizontal, vertical or diagonal. Lines themselves can be curved or straight. Curvilinear lines are different from straight lines. Lines have width. They have brightness: you can have a dark line on a white background, or a light line on a black background. A simple line can be a most expressive thing!


        Lines are particularly compelling in monochromatic compositions. When you are shooting for black and white, look to see how the lines in your compositions interrelate; and look to see what you can do to strengthen the way those lines express emotion.

      


      [image: missing image file]


      
        
          	Sunsets are usually seen, pre-visualized, and presented photographically in color. With this image, I decided to take up the challenge of creating a visually interesting sunset image in black and white, using only the simplest visual elements: the sunset’s reflection on the ocean and the shadows framing that reflection.


          	
            The delicate lines of the horizontal waves play against the predominant dark diagonal lines of the shadows in this composition. The demarcation between shadow and light works as an effective frame divider.

          

        


        50mm, 1/640 of a second at f/11 and ISO 100, hand held

      


      [image: missing image file]


      
        	The rough quality of the broad lines formed by the shadows of the seeds contrasts with the delicate lines of the seeds themselves, making for an interesting black and white composition.

      


      85mm macro, 1 second at f/51 and ISO 100, tripod mounted

    

  


  
    


    
      Shape and Form

    


    
      How do you know when the shapes and forms in your black and white composition will be effective?


      The best way to pre-visualize the impact of shapes on your photos is to practice separating form and function. In other words, try to forget about the subject matter of your photo as you abstract a composition from the shapes in front of you.


      True, in an ideal world, form should follow function, and the two should be inextricably partnered in a dance that will last as long as we have material things. But as a practical matter, if you keep what something is too much in mind, then that very “is-ness”—the function of the object—will intrude into your vision and overlay issues of pure form.


      In fact, some of the most startling black and white compositions occur when the form portrayed in the image appears very different from the function of the object in the photo—or at least unusual, in the sense that the form isn’t usually associated with the object.


      When I’m pre-visualizing an image, one part of my work is to ignore the meaning and function of the actual object or scene in front of me. I look for formal components such as framing, lines, and shapes.


      Sometimes I have a hard time looking at things in such an abstract way. When this happens, I find that I can amuse myself by inventing alternative scenarios. I picture the image in front of me as belonging to an alien, possibly absurd universe. I try to invent humorous stories about the objects.


      If I can succeed in inventing plausible alternatives, then it is very likely that I can sit back and “cancel out” both this everyday world and my invented alternative. With no points of reference to connect the objects or scene in my photo to “thingness”—the physical reality and function of the actual world—I am able to create visual constructs that use shapes as compositional building blocks and create forms that are fluid and graceful.

    


    [image: missing image file]


    
      
        	Split chambered Nautilus shells have been the subject of classical black and white photography for many years (see page 13 for another example of Nautilus shell photography). Up close, as this macro image of a Nautilus resolved in my viewfinder, I no longer saw a shell; but rather the curved deco lines of an elegant sapling tree.

      


      200mm macro, 6 seconds at f/36 and ISO 100, tripod mounted

    


    
      [image: missing image file]


      
        	Artichokes are good to eat, and they are also an occasional subject of classical black and white photography by Edward Weston and others. In my studio, artichokes proved to be a surprisingly difficult subject because they turn brown quickly after they are cut open. But I was enchanted by the interplay of lines and forms when the center of the artichoke was examined closely. I had to persevere through a number of “models” to get this image.

      


      85mm macro, 30 seconds at f/45 and ISO 100, tripod mounted


      [image: missing image file]

    


    
      
        	Near where I live there’s a special recycling yard where many interesting things are brought for possible reuse. The bulk of the stuff you’ll find there comes from home renovations. When I saw these toilets in a row, I made my mind blank. Without preconceptions, I didn’t see plumbing fixtures and toilets, but rather a chorus line kicking up their heels! I blinked my eyes and visions of shapely legs vanished. But having seen an alternative reality I was better able to concentrate on combining the shapes that were in front of me in a pleasing way.

      


      85mm macro, 0.1 seconds at f/64 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      High Key

    


    
      I’ve already noted that black and white photography from a formal perspective is largely about the contrast between lights and darks (see pages 30–39). Powerful black and white compositions often require very dark blacks and very light whites—both in the same image.


      It’s interesting that the opposite approach can also work well.


      High-key photos are predominantly white, bright, and can be characterized as overexposed. Low-key photos are largely black, or dark—and can easily be considered underexposed (see pages 44–47). In these images, the single key predominates. Particularly with high-key imagery, there is seldom very much contrast at all.


      To create a high-key image, look for a subject that is well lit and quite bright in tonal values. You may think this goes without saying, but if you look around, you may be surprised at how few compositions actually meet this requirement.


      A high-key composition as a whole may work best if it operates by intrigue, mystery, and indirection. In some ways it may not matter that much what your actual subject is since high-key compositions can be built around many different kinds of subject matter. You should look for simple, evocative, subtle lines and shapes that evoke a sense of wonder in the viewer.


      High-key effects can be created in post-processing, although these after-the-fact techniques will not be appropriate for all photos (see pages 142–147).


      It’s best to shoot with high-key in mind. This means overexposing. It’s okay to bracket by shooting many frames at different exposures. That way you can pick the exposure that works best. I bet you’ll be surprised by how far to the overexposure side a high-key image needs to be. So don’t be timid about your overexposures when you are going for a high-key effect.


      With a properly lit high-key image that is already creatively overexposed, exotic and attractive, you can proceed to use the post-processing techniques explained later in this book to amplify the impact of the effect.
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        	The actual subject of this photo is the shapes underneath a somewhat dirty toilet bowl in a salvage yard. A high-key exposure reduces this subject to a single, curvilinear line that meets soot on the upper right. I overexposed to eliminate the extraneous detail in the white areas of the photo.


        	
          The photo becomes about its composition, and the associations that a simple line can evoke—with the subject matter forgotten and irrelevant.

        

      


      85mm macro, 0.1 seconds at f/64 and ISO 100, tripod mounted
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        	I set this vase and flower up on a white seamless background and lit the flower using a single light source to create an interesting shadow. Then I intentionally overexposed it to create a high-key, evocative, and dreamy effect.

      


      55mm, 1/2 second at f/32 and ISO 200, tripod mounted

    

  


  
    


    
      Low Key

    


    
      While a high-key photo is predominantly presented in white and light tones, low-key images are mostly very dark or black. When this kind of image works, it is because the darkness that encompasses most of the photo focuses attention on the areas that are not dark, providing a sense of mystery.


      Low-key imagery tends to work because it is human nature to replace the mystery of darkness with imaginary scenes or objects.


      To make this kind of image, you should look for an overall dark scene. In addition to a pervading sense of darkness, the scene needs to be lit with intermittent light. In an effective low-key image, one area of interest can specifically be lit; for example, the eyes in a portrait on a black velvet background, or a shaft of moonlight.


      Alternatively, there can be lighting more spread out across a generally dark scene. In this case, it’s often effective to look for chiaroscuro—moody lighting that shows contrasts between shadows and brightness.


      Post-processing techniques can help you create a low-key image after the fact (see pages 148–153). However, it is very desirable to start with a photographic subject that is appropriate for low-key treatment.


      You should look for subjects that are largely dark with intermittent illumination of significant features, or specific areas lit either by direct light or using chiaroscuro.


      As with high-key imagery, it’s desirable to bracket exposures, because a good creative low-key exposure may register in your camera’s light meter as surprisingly underexposed. Essentially, you want to expose for the lit part of your composition—and let the rest of the image go completely black.


      Be careful to avoid an average light meter reading as the way to judge the brightness of a low-key scene. Since you really don’t care how dark the black background gets in these images, it’s best to take a spot meter reading of the lit areas of your subject.
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        	A shaft of light illuminates this boy’s face in an otherwise dark background, creating an interesting portrait.

      


      200mm, 1/200 of a second at f/5.6 and ISO 100, hand held
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        	I shot this hand-held night shot at a high ISO (3,200), and planned a low-key exposure based on the brightness of the moon. This exposure would capture the moon and moonlight reflected on the water crisply while letting the surrounding ocean and sky go black.

      


      65mm, 1/30 of a second at f/5.0 and ISO 3200, hand held

    


    
      [image: missing image file]


      
        
          	I intentionally underexposed this near-night scene of waves pounding at the surf to create a low-key, mysterious image.

        


        48mm, 30 seconds at f/22 and ISO 100, tripod mounted


        [image: missing image file]


        
          	The intermittent lighting and significant underexposure relative to an average light meter reading contributes to the moodiness of this low-key tidal scene.

        


        18mm, 1 second at f/5.6 and ISO 100, tripod mounted

      

    

  


  
    


    
      Shades of Gray

    


    
      By definition, every black and white image consists of a range of grays. I’ve noted that the majority of black and white photos work by contrasting dark against light (pages 30–39). These darks and lights are shades of gray, of course.


      High-key images, consisting of a subtler shade of gray, work with the tones towards the lighter end of the scale (pages 40–43). Low-key images primarily use the dark tones on the grayscale (pages 44–47).


      Yet another effective black and white strategy is to employ midtones as the predominant compositional element. These compositions use midtone gray values to work together in an endless compositional dance. The nearness of tonal values means that there are relatively few sharp breaks in a predominantly midtone gray composition—you won’t find many hard black forms or white areas that are highlights.


      When a midtone gray composition works, it is because the eye looks to the subtlety of the relationship between the tonal gradations. So when you are considering this kind of composition, be careful to present tonal values that work well together.


      You should look for subjects that present intricate patterns of grays working off one another. Do not expect the drama of a dark shape against a light background, the Zen simplicity of lines in a high-key setup, or the unrelenting angst of a low-key photo. The virtue of the grayscale is a virtue of subtlety.


      As opposed to high-key and low-key imagery, midtone photos should be captured so they are neither underexposed nor overexposed. To achieve this kind of “just right” Goldilocks exposure, consider using your light meter set to average the scene.


      If what you see in front of you tends to be a little dark, you may have to lighten things a bit with your exposure. Conversely, if things seem too bright you may have to underexpose slightly to damp things down.
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        	My goal in creating this image was to emphasize the interplay between the feathery lines of surf and the hard edge of the shore. While the left side of this image is quite dark, the real visual interest in the photo is how the surf works in midtone grayscale with grays overlapping and competing against each other.

      


      170mm, circular polarizer, 1.6 seconds at f/32 and ISO 100, tripod mounted
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        	In this photo, a lonely islet in San Francisco Bay appears to be much darker than the surrounding water and sky. But this is to some extent an illusion. In fact, none of the grays in the image are very dark—and the entire photo has a low tonal range, almost biased towards the high-key except for the great tonal range of grays.


        	
          A viewer who spends some time with this photo will be intrigued to pick out details such as the reflection of the tree on the island and the lit boat in the background—which at first glance appears to be a fairly featureless gray.

        

      


      18mm, 2 seconds at f/8 and ISO 100, tripod mounted

    

  


  
    


    
      Finding Monochromatic Subjects

    


    
      There are as many different things to photograph as there are photographers. A good photograph uses the world around us and the human way of visual perception, and filters these elements through the consciousness of the photographer and camera and lens to create a new way of presenting the subject matter photographed.


      People, places, and things are all grist for the photographer’s mill—whether presented in an overall environment or isolated in a different context.


      Either way, the range of black and white photographic subjects isn’t that different from what you might take photos of in color. But there are two additional factors you need to consider:


      
        	The tonal contrast on the grayscale


        	The artifice of presenting the world without color

      


      There are many different degrees of tonal contrast. Some monochromatic images rely on extremes of tonal contrast (pages 30–39): high-key black and white photos make their point solely using the tones on the lighter end of the grayscale (pages 40–43); low-key photos are at the darker end of the grayscale (pages 44–47).


      However, some images primarily rely on the interplay between midtone grays for their appeal. You should consider your strategy in relation to these options to create successful monochromatic photos, since the grayscale is so important to black and white imagery.


      Make a choice, then expose and process your image to back it up. If one of these choices is not feasible, then it is possible that your image is not the best choice for black and white.


      Photography was once entirely monochrome, but of course this has not been true for a long time (see pages 12–13). One consequence is that digital black and white images can look artificial. If you’re not careful, instead of enjoying your image the viewer will be asking the question, “Why is this photo being presenting in black and white?”


      The image should itself present a compelling visual reason why it is monochrome. Here are some possibilities:


      
        	The graphic content of the image is clearer without the distraction of color.


        	A great contrast is being presented between darks and lights.


        	Shadows play a big role in the image.


        	The subject matter of the image is in some way old-fashioned or anachronistic.

      


      Perhaps you can come up with other reasons why presenting your photos in black and white is a good idea (but please understand, “I just love black and white!” may not count).


      If you have a general idea of the kind of subjects that work well with black and white, you will be able to find monochromatic images in many places.
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        	In Revolutionary Square in Havana, Cuba many photographers concentrate on the big picture—in this case the huge wire sculptures showing the heads of Fidel Castro, Che Guevara, and other revolutionary leaders. But looking at the wire sculpture of Che, I was struck by the way the strong tropical light created a pattern of shadows and lines formed by three elements: the wire sculpture itself, built several feet out from a building façade; its shadow; and the supports holding the wire sculpture in place.


        	
          I used a telephoto lens to photograph a detail of the Che wire sculpture. A polarizer helped to adjust the contrasting light in the image so the difference between the various elements was stronger.

        

      


      130mm, circular polarizer, 1/320 of a second at f/9 and ISO 100, handheld
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          	I made this photo during a freak snowstorm in the California coastal range hills. This tree was lit with subdued sunlight in a nook with towering dark fir trees behind. I intentionally underexposed to let the background go dark, and to bring out the contrast between the white branches and the dark background.

        


        62mm, 1/250 of a second at f/14 and ISO 200, hand held
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          	The point of this photo is the relationship between the flower gone to seed and its shadow. I used a direct, harsh light behind the flower to create the strong shadow, and positioned my camera below and to the left, taking care to avoid pointing it directly at the light.

        


        85mm macro, 8 seconds at f/51 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Black and White at Night

    


    
      It’s often not recognized that photography at night can produce wonderful results in black and white. As is generally true with black and white, if color is important to an image, it will work no better at night than in the day. In other words, spectacularly colored star trails do not work in the absence of color. At night, black and white requires strong composition with considerable contrast between light and dark areas.


      When I consider photographing at night in black and white, I’m looking for scenes that have a strong compositional appeal. In addition, the absence of color should add to the viewer’s appreciation of the scene. Someone looking at a black and white photo should think they know or feel something unusual about the scene presented. Perhaps there’s a sense that colors are more vivid than they would actually be if the photo were seen in color. Or maybe there’s an edge to the image that makes the viewer wonder about what they are seeing.


      Wandering in the night, we are without the sense of clear sight that we usually rely upon. This causes many people to feel that they are adrift in a strange environment.


      Small noises can cause anxiety. Wind whistling through trees can sound like a howling gale. Phosphorescent eyes staring from a forest’s edge can be creepy. Black and white photos can pick up on this perceived anxiety, and produce images that are thought provoking and keep viewers on their toes.
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        	I came to photograph the view facing the ocean, but it was totally obscured by the fog. Turning in the other direction, I saw intense, orange street lighting coming through the trees on the other side of the parking lot.


        	
          I knew this image would not work in color, because the quality of the street lights was very orange and made the scene look muddy. However, the shadows created by these lights towards the bottom of the row of trees were extremely visually intriguing. Here was a perfect situation for black and white at night!

        

      


      56mm, 52 seconds at f/4.8 and ISO 100, tripod mounted
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        	In color, the clouds and ocean at low tide were quite attractive in this early night scene. But the whole scene looked much too friendly. Converting to black and white brought out the sinister aspects of this composition, and also amplified the difference between the light coming from the windows in the beach shack and the textured shadows cast by this light on the beach.

      


      18mm, 30 seconds at f/4 and ISO 200, tripod mounted

    

  


  
    
      

    


    
      Portraits in Black and White

    


    
      “Character is destiny,” wrote Greek philosopher Heraclitus back in the fifth century BC. And what better way to see character than to observe the lines of someone’s face?


      As I’ve previously noted, in the absence of color you have shapes—and lines. Therefore, black and white emphasizes lines and portraits created using black and white can show character at a deeper level than those in which the structural issues are masked by color.


      For these reasons, black and white portraits can stick in our memory and stay with us as powerful statements of character. Color photographs of celebrities and movie stars are often glamorous. Black and white can be glamorous too—think of movie star portraits of the 1930s—but more often black and white seems to tell the truth,

      and to present the underlying character

      of its subject.


      When I take a portrait, my goal is to attempt to reveal the character of the subject. Just as with a landscape, I am doing my job right when I marry the

      craft and technique of photography

      with the subject.


      Like landscapes and other subject matter, black and white portraits can predominantly involve contrast, or make their compositional point by being high-key, low-key, or by featuring the interplay of gray midtones—all formal concerns.


      No matter what the subject, your choice of black and white treatment impacts the emotional response to the subject matter. In the case of portraiture, a decision about rendering will “color” the viewers response to the person shown.


      High-key portraits usually show happy people in fun situations. Dark, low-key and high contrast portraits show characters who have led interesting or dramatic lives, or who may be involved in emotionally charged situations.


      By the way, as adults we grow into the faces we deserve. But even kids with unlined cheeks, untouched as yet by life, have characters. All right, maybe they are characters, too! Black and white photography can help to reveal the inner being of a child just as surely as with those who are more mature.


      One can go too far in imputing emotional affect to portraits via the compositional and technical choices made. A child shown in high-key lighting is not necessarily an angel! However, your visual choices regarding monochromatic treatment play a big role in how your portrait subjects will be perceived—and as a photographer it is important not to lose sight of this impact.
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        	This essentially high-key portrait shows the affectionate nature of the portrait subject.

      


      200mm, 1/160 of a second at f/6.3 and ISO 400, hand held


      [image: missing image file]


      
        	The low-key interpretation of this portrait of mother and child works well with the chiaroscuro lighting and evokes classical paintings with similar subject matter.

      


      32mm, 1/80 of a second at f/5.6, hand held
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        	You can practically see the neurons firing in this portrait of a contemplative child. I made sure that the midtone grays in the child’s face were harmonious with each other so as not to distract from the point of the portrait—the intense look of his gaze.

      


      200mm, 1/320 of a second at f/4.5 and ISO 200, hand held
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        	The contrast between the boy and the play structure he’s in helps to make this an interesting portrait. The window opening acts as a frame within the frame of the photo.

      


      18mm, 1/160 of a second at f/6.3 and ISO 100, hand held
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        	I photographed this man on the streets of a Cuban provincial capital. To me, he looks like he’s seen a great deal of life, not all of it pleasant—but he retains warmth and a happy outlook on life. The contrast between the relatively dark tones of his eyes and the lighter area of the rest of the portrait help make this image subtly dramatic.

      


      200mm, 1/160 of a second at f/6.3 and ISO 200, hand held
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        	This woman helped to run a coffee shop for tourists in a Cuban ecology reserve. I felt that the lines on her face showed a life that had seen much sorrow, so I photographed her using high contrast, low-key lighting to emphasize this feeling.

      


      170mm, 1/40 of a second at f/5.6 and ISO 200, hand held

    

  


  
    
      

    


    
      Black and White in the Digital Era
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      Digital Black and White Roadmap

    


    
      Creating a digital black and white photograph is an odd act of resistance, anachronism, and artistic passion considering that digital captures are inherently in color. One way or the other, starting with digital and ending up with black and white means discarding the color information in favor of gradations of gray.


      It’s important to understand that the color information itself can profitably be used as the basis for this transformation to black and white.


      There are many paths towards achieving black and white imagery starting with a digital capture. As you might expect, approaches that take more effort in conversion tend to yield better results—this reminds me of the slogan “no pain, no gain.” For very simple black and white images, converting JPEGs in programs like iPhoto and Picassa may work fine. But if you want a more artistic approach, you’ll have to work harder and get your digital hands dirty.


      [image: ]



      It’s also the case that the vast array of possible techniques for converting a digital capture to black and white can lead to confusion and paralysis. The chart shown below should help you clarify your options so you can get started creating spectacular black and white photos.
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        	During the years since the revolution, an elegant palace in a provincial capital in Cuba had gone to ruin. I stood at the bottom of a stair in the old palace, and used the contrast between lights and darks to frame an image that I knew I would process to eventually become a black and white image.


        	
          In converting the image to black and white, I cropped it to square to emphasize both the darkness of the shadow areas and the comparative brightness of the stair.

        

      


      10.5mm digital fisheye, 1/10 of a second at f/22 and ISO 100, tripod mounted

    


    
      It was a blustery, bright winter day along the outer Marin Headlands, California with big waves rolling in.


      I used a fast shutter speed to “freeze” the motion of the waves in place, and a polarizer to boost the contrast between the surf, clouds, and cliffs. I made the capture using my camera’s native RAW format, converted the image to color using Adobe Camera RAW (ACR) and Photoshop, and proceeded to use multiple Black & White adjustment layers in Photoshop (see pages 122–127) to create the final version shown on the facing page.


      All versions: 32mm, circular polarizer, 1/400 of a second at f/8 and ISO 200, hand held
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        	Here’s the RAW capture I made, shown using default

        “As Shot” settings.
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        	Converting to grayscale in ACR sometimes leads to middle-of-the-road black and white that is fairly flat and does not have great tonal variations.
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        	For comparison purposes, the in-camera black and white JPEG is shown. It’s not bad, but there are not tonal gradations. Depending on your purpose, it may be good enough.
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        	The version I processed into color is bright and shows quite a bit of contrast between light and dark areas.
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      My idea in photographing this exploding wave was to capture the action of the fast-moving surf using a high shutter speed to reveal what it looked like beyond the ability of the human eye to stop the motion of the water. I purposely underexposed so that the details of the water in the sunlight would be crisp, creating contrast between the wave and the shore.
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          	In-camera, I duplicated my capture in black and white to get an idea of

          what it might look like, but it was too dark.
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          	I also tried the sepia (left) and cyanotype (right) in-camera options as well, but they were also too dark.
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          	None of the in-camera options were satisfactory. Processing the RAW image multiple times through Adobe Camera RAW (pages 108–113) and converting to black and white in Photoshop using a stack of Black & White adjustment layers (pages 122–127) yielded the more interesting black and white work shown below.

        


        130mm, 1/1250 of a second at f/10 and ISO 200, hand held

      

    

  


  
    


    
      The RAW Advantage

    


    
      A RAW file is a complete record of the data captured by a digital sensor. The detailed implementation of RAW files varies from camera manufacturer to camera manufacturer, but it is important to understand that a RAW file represents a large number of potential images rather than a specific rendering of the digital bits captured.


      Most reasonably sophisticated digital cameras can save their captures as RAW files, although you may have to change the default settings to make this happen. Cameras can also capture images as JPEG files. A JPEG file is a single version of a RAW capture, as interpreted by the camera that can be used without any further work. You can usually set your camera to save both JPEG and RAW versions of a capture at the same time.


      The advantages of the JPEG format are that JPEG files are compact and don’t take up much space, and that you don’t have to do any further work on these files before they are usable on most computers.


      However, if you are interested in creative photography, RAW files give you many advantages. You can use your own ideas of how the image data should be interpreted—for example, how the image should be exposed. Furthermore, if you’ve chosen to make RAW captures you can process different portions of your photo differently. The exposure and color values do not have to be the same across an entire image. Last, but not least, you are not throwing away much of the data collected by the sensor, as a JPEG capture inherently does.


      Fundamentally, the creative advantage to a RAW capture as opposed to a JPEG capture is that you get to implement your creative idea of what your photo should look like—and not be forced to rely on the camera’s “brain” to make your final image.
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        	The in-camera JPEG version of this essentially monochromatic shot is nothing special, with the detail on the lower right completely lost.

      

    


    [image: missing image file]


    
      
        	Starting with the RAW file, I multi-RAW processed the image using its color information (pages 108–113), then used a layer stack to convert the photo to black and white (pages 114–133). The result is a black and white image of the mist in the mountains above Yosemite Valley that shows a great tonal range and is far more interesting than the in-camera JPEG version. (See pages 156–163 for more information about extending tonal range.)

      


      Both: 200mm, 1/750 of a second at f/14 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      Black and White in Adobe Camera RAW

    


    
      One of the easiest ways to gain much of the power of RAW without having to go to a great deal of trouble is to use the Adobe Camera RAW (ACR) grayscale conversion feature. This works best on images that don’t have a huge range of color, and are a fairly easy target for black and white conversion.


      By way of comparison, I sometimes set my camera to shoot both JPEG and RAW, then drop the color information from the JPEG file (see the examples on this page). This shows me what I don’t want my final black and white image to look like. You can get far better results from ACR with a few simple manipulations.


      The point here is that there are many ways to formulate black and shades of gray. Using the sliders in ACR, you can determine how the colors in your photo are combined to create these blacks and grays.


      In many situations, this will give you the control you need to create interesting black and white images—particularly if you are not looking for an extended tonal range. In situations where you do need a dramatic range of tones in your photo, it does take a little more work. You’ll need to use the tools available in Lightroom and Photoshop to extend the dynamic range in color before you begin the black and white conversion process.
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        	The in-camera JPEG version of this photo isn’t bad, but it doesn’t have as much brightness and tonal range as it might. Depending upon what you are going to do with the image, the in-camera JPEG might be satisfactory. It certainly takes no effort at all. However, using a JPEG generated by your camera means that you have no control over the aesthetic choices involved.

      

    


    [image: missing image file]


    
      
        	For comparison purposes, this shows the in-camera JPEG version with the color information simply dropped. Yes, it is a black and white image, but it certainly doesn’t have a great tonal range nor is it very exciting.

      

    


    [image: missing image file]


    
      
        	Step 1: To convert a capture to black and white in ACR, start by double-clicking on your RAW file to open it in the Photoshop Adobe Camera RAW (ACR) plug-in.


        	Step 2: On the Basic tab in the ACR window, use the Temperature, Tint, Exposure, Contrast, and Saturation sliders to enhance the color and contrast in the image. If you compare the first in-camera JPEG version of the image shown on page 77 with the color version shown here in ACR, you’ll already see improvement.
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        	Step 3: Open the HSL/Grayscale tab by clicking the fourth tab from the left in the ACR window.


        	
          Put a check in the Convert to Grayscale check box. The default settings on the tab shown here simply drop the color information when the image is converted to grayscale.
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        	Step 4: Instead of dropping all the color information, you can tweak how the color data in the RAW file is applied during the grayscale conversion. Here I increased the tonal range in the image primarily by pushing the Yellow slider to the left. This decreased the impact of the yellow during the image conversion.


        	
          When you are pleased with your settings, click Done. The converted grayscale image will open in Photoshop. You can then further enhance your black and white photo, although you may have to convert from Grayscale to RGB by choosing Image ► Mode ► RGB to access all the functionality of Photoshop.
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        	Crunching on my snow shoes across fresh snow in Yosemite Valley, California I came across a pond with still winter reflections. I used a polarizer to maximize the reflections, and a tripod to compose this image, which is essentially monochromatic except for the tree trunks.


        	
          I used ACR to brighten the image and increase the contrast, then worked with the ACR grayscale conversion feature to improve the rendition of the image in monochrome. After I converted the image to grayscale using ACR, I worked on the image in Photoshop to increase its drama and tonal range, with the results shown here.

        

      


      All: 70mm, circular polarizer, 1/250 of a second at f/10 and ISO 200, tripod mounted

    

  


  
    


    
      Black and White in Lightroom

    


    
      Many photographers enjoy using Adobe Lightroom for post-processing their photos because Lightroom provides a simplified workflow and environment specifically designed for digital photography—the program can also produce great black and white images from RAW originals with relatively minimal effort.


      Lightroom combines the power the ACR RAW converter, additional developing tools and a great image cataloging system into

      a very friendly user interface.


      The trade-off is that Lightroom doesn’t provide the complete pixel-level control of Photoshop. However, there’s plenty of ability to process RAW captures into black and white. If necessary, you can edit the results in Photoshop for further work.


      For the most part, unless I am processing a great many photos at one time, I use Photoshop to keep complete control of my black and white creative process. However, there are times where the convenient workflow features (Lightroom makes it very easy to keep track of different versions of an image) and the simplicity of obtaining good black and white results makes me sigh with relief when I use Lightroom.


      If Lightroom is already part of your digital workflow, as it is for many photographers, then by all means you should incorporate it into your process of black and white conversion. If you are new to black and white image rendition from RAW originals, then Lightroom may be a great place for you to start with your creative monochromatic digital photography.


      Grayscale Conversion Using Presets


      The easiest way to convert an image to black and white using Lightroom is to simply use the Lightroom grayscale conversion features. This can be done using the Develop module (see HSL Conversion starting on page 86) or when in the process of importing a RAW image, as shown on page 83.


      By way of comparison, the RAW image processed at default “As Shot” values is shown to the left.
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        	When I inspected this image before importing it, I felt it would be a good candidate for preset conversion because of the overall acceptable exposure without great ranges.
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        	Step 1: When you import a RAW file into Lightroom you can apply a preset using the Develop Settings drop-down list.


        	
          I converted the image to black and white using the Creative–BW High Contrast Lightroom preset.

        

      

    


    
      
        	Step 2: You can also apply more than one preset to an image. Select Sharpen–Portraits from the Develop Settings drop-down list following the Creative–BW High Contrast conversion.


        	
          Lightroom ships with a number of effective presets; in addition, you can create your own custom presets or download them from the web.


          However, you don’t have to use the import process to apply presets. Once an image has been imported into Lightroom, you can apply presets and further tweak the image in the Develop module shown on pages 84–91.

        

      

    


    
      


      
        Silver Efex Pro and Lightroom


        Silver Efex Pro, from Nik Software, can be configured to work in conjunction with Lightroom. This elegant black and white filter set is explained in the context of Photoshop on pages 128–135, and works pretty much the same way with Lightroom. You don’t need to buy two versions of Silver Efex Pro; the same software works with both Lightroom and Photoshop.


        Please refer to the Silver Efex documentation for information about configuring Silver Efex Pro to work with Lightroom, and working with Silver Efex from within Lightroom.
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      You can use the Develop module shown above to fine tune an image that has been imported in black and white.


      There are many other approaches to creating black and white images besides the simple two-or-three click approach I’ve shown you here; some other ways to go about monochromatic interpretation are shown in the next few pages.
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        	In an impoverished village in the Cuban countryside, beside the ruins of an old sugar mill, I photographed this farmer. Back at my computer, using Lightroom, it took only a few mouse clicks to convert this image to black and white using the Lightroom Creative–BW High Contrast and Sharpen–Portrait presets.

      


      200mm, 1/160 of a second at f/6.3 and ISO 100, hand held

    


    
      HSL Conversion


      You can get a bit more control over your black and white interpretation if you import your RAW file into Lightroom without applying a preset.


      Once you’ve imported your image, in the Develop module you’ll find controls on the Basic panel that can be used to set White Balance, Tint, Exposure, and so on. If this reminds you of the comparable controls in ACR, it should come as no shock—they are the same.


      As with the HSL/Grayscale tab in the ACR window, you can use the HSL/Color/Grayscale panel in the Develop module to determine the way in which the colors in your image are used to blend to grayscale.


      Some images require different kinds of work in different areas. Provided this is not the case, you can get very satisfactory black and white results quite quickly by importing your RAW photo into Lightroom, then tweaking the settings on the Basic panel and the HSL/Color/Grayscale panel.
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        	You can use the controls in the Develop module to adjust your image.
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        	The HSL/Color/Grayscale panel lets you set how the different colors in your photo are used to create a grayscale image.
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        	In Havana, Cuba, the Presidential Palace with its dome decorated by Tiffany became the Revolutionary Museum when Castro took over. I used a fisheye lens to take in the whole scene, with the thought that the patterns of lights and darks shown in the central space under the dome would make an interesting monochromatic image.

      


      105mm digital fisheye, 1/8 of a second at f/11 and ISO 200, tripod mounted

    


    
      Exposure Gradients and Adjustments


      Photographers are often confronted with exposure challenges in which part of a scene is considerably brighter than the other part. In the days before digital photography, such situations could be met by using a graduated neutral density filter—for example, darker on the upper part for the bright sky and lighter beneath for the dark earth.


      If portions of the photo were still too dark or too light, they could be “burned” or “dodged” in the darkroom. Burning made a print darker by exposing selected areas longer; dodging made the print lighter in selected places by withholding exposure

      of the enlarger from specific areas.


      RAW photos in Lightroom can be adjusted for the kinds of exposure problems that were treated with graduated neutral density filters or burning and dodging

      quite easily.


      For example, I opened the image shown below in the Lightroom Develop module using the Creative–BW High Contrast preset. You can see that the upper part

      of the photo is too light, and that detail has been lost in the dark shadow areas

      at the bottom.
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        	If you look at this image, the upper part appears much too bright, while a great deal of the detail has been lost in the shadow areas at the bottom.
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        	Step 1: To adjust the exposure of the top part of the image using a gradient, choose the Graduated Filter tool, found fourth from the left, right under the Histogram. The Graduated Filter allows you to apply changes in exposure using a gradient.

      


      
        	Step 2: Choose the exposure adjustment you want. For example, to make the top part of the photo darker, choose a negative value for the Exposure slider.
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        	Step 3: Click and drag the mouse down from the top of the image to draw the gradient. Notice that as you drag the mouse, lines appear representing the gradient. A circle on the center line shows where the middle of the gradient is. The gradient controls how the exposure is applied—from most at the top to the least where you release the mouse. Note that you can view the impact of your changes in the main photo window of the Develop module, and adjust as necessary.

      


      
        	Step 4: When your exposure adjustment is just right, click Close.
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        	Step 5: To darken or lighten specific areas in your photo as if you were burning or dodging, choose the Adjustment Brush tool (fifth from the left, right under the Histogram).


        	
          The Adjustment Brush tool lets you “paint” in areas with different exposure values so that they become lighter or darker.

        

      


      
        	Step 6: In the Effect area use the Exposure slider to set how light or dark the painting will be. Moving the Exposure slider to the left towards the negative side will result in darker areas just like burning. Moving the Exposure slider to the right towards positive values will make the areas painted lighter, like dodging.

      


      
        	Step 7: Use the Size slider in the Brush area to choose a brush size that lets you paint in the areas you want to adjust.

      


      
        	Step 8: Paint in the adjustments. You can adjust

        the brush size as you paint, if you need more or

        less coverage on a particular area.

      


      
        	Step 9: Click Close when you are finished.


        	
          With very little effort, the finished photo shown on page 91 is a great deal more satisfactory than where it started. The overly bright areas are toned down and the details cloaked by dark shadow are revealed.
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        	The entrance foyer to the Capitolio Nacional in Havana, Cuba is dominated by a giant statue of the Greek Goddess of wisdom, Athena. Unfortunately, the building has only rarely been used for the purpose it was intended.


        	
          Standing beneath the statue with my camera on a tripod using a fisheye lens, I visualized this photo as showing an extreme tonal range—in other words, an example of black and white HDR photography (see pages 156–165 for more about extending dynamic range in black and white). Lightroom allowed me to easily adjust the dynamic range in the photo using a Graduated Filter and the Adjustment Brush.

        

      


      10.5mm digital fisheye, 0.8 seconds at f/13 and ISO 100, tripod mounted

    


    
      Exporting Virtual Copies into Photoshop as Layers


      Lightroom Graduated Filters and the Adjustment Brush function a great deal like Photoshop layers—more precisely, like Photoshop adjustment layers. But if you really want to take advantage of the full power and precision of Photoshop layers and masking, you’ll need to bring your photo into Photoshop itself.


      Fortunately, it’s easy to integrate Lightroom with Photoshop. You can use the streamlined workflow interface provided by Lightroom and then pull your work into Photoshop for the finishing touches.


      For example, I imported a photograph of the The Wave rock formation into Lightroom using the Creative–BW High Contrast preset. Looking at the image as an abstraction, I decided I needed to increase the contrast, and make the left side a bit brighter and the right side a bit darker.


      Using the Lightroom tools shown in Exposure Gradients and Adjustments (pages 88–91), it would be perfectly possible to accomplish these tasks. But I decided the easiest way to get exactly the creative effect I wanted was to export three versions into Photoshop. The first version would be the default black and white conversion using the preset which would work as my background; the second version would be lighter; and the third version would be darker.


      Lightroom makes it easy to create these different versions using the Photo ► Create Virtual Copy command. Once the virtual copies have been edited, all three versions can be easily exported as Photoshop layers.
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        	The photo of The Wave converted with the Creative–BW High Contrast preset.

      

    


    
      [image: missing image file]


      [image: missing image file]

    


    
      
        	Step 1: From the Lightroom Photo menu, choose Create Virtual Copy to create a copy of the image. This copy appears selected next to the original image in the Filmstrip at the bottom of the window.
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        	Step 2: On the Basic panel, move the Exposure slider to the right to create a lighter version.
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        	Step 3: Make sure the lighter version you just created is selected in the Filmstrip. From the Lightroom Photo menu, choose Create Virtual Copy to create a copy of the lighter version. This copy appears selected in the Filmstrip at the bottom of the Lightroom window.

      


      
        	Step 4: On the Basic panel, move the Black slider to the right. Then, move the Exposure slider to the left to create the darker version.
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        	Step 5: Hold down the Shift key and click each version in the Filmstrip to select the three versions.
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        	Step 6: From the Lightroom Photo menu, choose Edit In ► Open as Layers in Photoshop …


        	
          The three Lightroom versions appear in the Photoshop Layers palette.

        

      

    


    [image: missing image file]


    
      
        	Step 7: The layers automatically appear in the Photoshop Layers palette as Background, Layer 0, and Layer 1. Rename Layer 0 as “Lighter” and Layer 1 as “Darker.”


        	
          This is now the functional equivalent of multi-RAW processing using ACR and Photoshop as explained on pages 108–113.
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        	Step 8: Using layers and masking in Photoshop (as explained on pages 98–107), blend the three layers to make the left side lighter and the right side darker.
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        	The Wave is a spectacular geologic formation on the Utah-Arizona border. As a photographer, one of the things I like best is the way this landscape becomes an abstraction. It’s very hard to know the scale of an image such as this one, which is part of its appeal for me. It could be a detail of tree bark, or pulled taffy—but in fact it is a rather vast valley of stone, frozen like a wave in time.


        	
          Speaking of time, it’s good news for photographers that using the Lightroom-Photoshop combination black and white conversions such as this one can be created in just a few minutes.

        

      


      52mm, 1/20 of a second at f/29 and ISO 100, tripod mounted

    

  


  
    


    
      Multiple Layers and Masking in Photoshop

    


    
      There’s no such thing as a monochrome-only sensor on the marketplace, and I probably wouldn’t want it if there were. In-camera JPEG black and white photos are inherently inferior to images processed from RAW files (see pages 74–75).


      Therefore, since I start with a color RAW capture, my digital workflow for high quality black and white imagery involves the following steps:


      
        	Looking at the world around me with an eye towards subjects that will work well in black and white (see pages 10–65).


        	Coming up with a plan for exposure and conversion.


        	Capturing my images in RAW format.


        	Processing the image for color in Adobe Camera RAW (ACR).


        	Repeating the RAW conversion more than once at differing exposure values. This is called multi-RAW processing.


        	Combining the different RAW conversions in Photoshop into a color version using layers and masking (pages 98–107).


        	Converting the images to black and white in Photoshop using multiple conversion techniques depending on the image (or portion of the image), layers, and masking.

      


      Note that steps 3 and 4 are functionally equivalent to the Lightroom technique shown on pages 92–97 of creating virtual copies of an image, applying different exposures, and bringing the virtual copies into Photoshop as a layer stack.


      Since layers and masking are vitally important to two parts of this process—the initial color conversion and the subsequent conversion to black and white in Photoshop—it’s worth taking a look at the basics of using layers.

    


    
      


      
        
          
            	How Layers Work

            

            If you understand how to use layers, then you know how to unleash the power of Photoshop. Almost everything in Photoshop is better with layers, and you can even control elements of your image with precision down to the pixel level. Fortunately, effective use of layers and layer masks is not very hard to understand and to learn to use.

            

            Layers are placed on top of other layers to form a layer stack. You can control the opacity of each layer, as well as the formula for how pixels in the layers are combined, called the blending mode.

            

            A layer mask is used to hide or reveal portions of the associated layer. Black conceals the associated layer, white reveals it, and gray shades in-between pure black and full white—partially revealing or partially concealing the associated layer (depending how you look on things). It’s important to remember that we are talking about concealing or revealing the layer that the mask is on, not the layers below it in the stack.

            

            You can start with a layer mask that is completely black (by choosing a Hide All layer mask) or completely white (by choosing Reveal All) and then modify the layer mask. The most common tools for layer mask modification are the Brush Tool and the Gradient Tool.
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        	Step 1: From Adobe Bridge, double-click a RAW file to process a version for the background of the photo in ACR. Bear in mind that when planning to convert to black and white, you generally want more dramatic contrast than you would have normally in color photos. When you are pleased with the settings, hold down the Alt key and click Open Copy to open the image in Photoshop.
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        	Step 2: Go back to Bridge and double-click the same file again to open it a second time in ACR. Process this version of the image so that it is brighter, to lighten the deep shadow areas. When you are pleased with the settings, hold down the Alt key and click Open Copy to open the image in Photoshop.
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        	Step 3: Third time pays for all! Go back to Bridge and double-click the same file again to open it a third time in ACR. Process this version of the image so it is darker. This version will be used to tone down highlights that are too bright. When you are pleased with the settings, hold down the

        Alt key and click Open

        Copy to open the image

        in Photoshop.


        	
          You now have three versions of the image open in Photoshop. You’ll use the background and lighter versions right away. You’ll use the darker version a bit later so just move it to one side of your monitor to get it out of the way for now.
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        	Step 4: The next thing you want to do is align the lighter RAW conversion exactly on top of the background version in the same Photoshop window.


        	
          To do this, hold down the Shift key and use the Move tool to drag and drop the lighter version onto the original version (see pages 96–99). (Make sure you release the mouse button before you release the Shift key or the versions may not be perfectly aligned.) The lighter version will appear in the Layers palette. Rename this layer “Lighter – Upper Left Side.”

        

      

    


    
      [image: missing image file]


      [image: missing image file]

    

  


  
    
      
        
          	Step 5: With the “Lighter–Upper Left Side” layer selected in the Layers palette, choose Layer ► Layer Mask ► Hide All to add a layer mask to that layer.


          	
            The Hide All layer mask hides the layer it is associated with (in this case the “Lighter–Upper Left Side” layer). It appears as a black thumbnail in the Layers palette associated with the layer.
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            	Step 6: Make sure the layer mask on the “Lighter–Upper Left Side” layer is selected in the Layers palette. Choose the Gradient Tool from the Toolbox and drag a white-to-black gradient diagonally from the upper left corner of the image window to the brighter area in the middle of the image window.


            	
              This lightens the upper left side in a natural way.
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          	Step 7: The lower area of the image could use some lightening as well. To do this, make sure the “Lighter–Upper Left Side” layer is selected in the Layers palette, and then choose Layer ► Duplicate Layer to duplicate the layer. Name the new layer “Lighter–Bottom.”


          	
            Notice that when you duplicated the layer, the layer mask was duplicated as well. In the next step, you’ll remove this duplicate layer mask and then add a new, unused one.
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          	Step 8: Remove the duplicate layer mask

          by selecting Layer ► Layer Mask ► Delete.


          	
            Next, add a new, unused layer mask by choosing Layer ► Layer Mask ► Hide All

            like you did in Step 5 on page 101.


            There are now three layers: “Background,” “Lighter–Upper Left Side,” and “Lighter–Bottom.”
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          	Step 9: Make sure the layer mask on the “Lighter–Bottom” layer is selected in the Layers palette. Choose the Gradient Tool from the Toolbox and drag a black-to-white gradient from where the lower shadowed area of the image starts down to the bottom of the image window.
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          [image: missing image file]


          [image: missing image file]

        

      


      
        
          	Step 10: Go back to the darker RAW conversion that you parked on one side of your monitor back in Step 3. Hold down the Shift key and drag this darker RAW conversion on top of the “Lighter–Bottom” layer. Rename it “Darker.”


          	
            There are now four layers: “Background,” “Lighter–Upper Left Side,” “Lighter–Bottom,” and “Darker.”

          

        

      


      
        
          	Step 11: With the Darker layer selected, add a black layer mask to the layer by choosing Layer ► Layer Mask ► Hide All like you did in Step 5 on page 101.
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        	Step 12: In the Toolbox, set white as the Foreground color. Make sure the layer mask on the “Darker” layer is selected in the Layers palette. Use the Brush tool to paint in the areas where you want to selectively darken the overly-bright areas of the image. To start, set your brush to 50% Opacity and 50% Flow. Adjust the Brush settings as you paint.
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          	Step 13: To convert the image to black and white, start by merging the four layers down into one layer by selecting Layer ► Flatten Image. The four layers will collapse into one “Background” layer.

        

      


      
        
          	Step 14: Duplicate the Background layer by selecting Layer ► Duplicate Layer. Name the duplicate layer “B&W–Darker.”
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              	Step 15: Make sure the “B&W–Darker” layer is selected in the Layers palette. On the Adjustments palette, click the Create Black & White adjustment layer button to apply a default black and white adjustment. (You could also access Black & White adjustment layers by selecting Layer ► New Adjustment Layer ► Black & White.)

            

          


          
            Click to add a Black & White adjustment layer. Fore more about Black & White adjustment layers see pages 122–127.

          

        

      


      
        
          
            	Why I merge down adjustment layers

            

            I often decide to merge down adjustment layers, even though there are some disadvantages to this step: a normal layer takes up more space on disk than an adjustment layer, and once an adjustment layer has been merged down you can’t tweak its settings.

            

            The reason I merge down adjustment layers despite these disadvantages is that I find it easier to see what I’m doing in a complex, multi-layered document. I also want to be able to reduce the opacity of the layer that an adjustment layer is connected to—not just the opacity of the adjustment layer.

            

            But let’s face it, the choice is yours. If you prefer adjustment layers to merged-down layers, that’s fine!
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          	Step 16: Use the drop-down list on the Adjustments palette to make the Black & White adjustment layer to Darker. This layer is now the base for the black and white version of this image.


          	
            The color “Background” layer has no impact on the final image because the “B&W–Darker” layer is set at 100% opacity.

          

        

      


      
        
          	Step 17: With the adjustment layer selected in the Layers palette, merge the Black & White adjustment layer down onto the “B&W–Darker” layer by choosing Layer ► Merge Down.

        

      


      
        
          	Step 18: Duplicate the color “Background” layer by selecting Layer ► Duplicate Layer. Name the duplicate layer “B&W Infrared.”

        

      


      
        
          	Step 19: With the “B&W Infrared” layer selected in the Layers palette, use the Adjustments palette to apply a Black & White adjustment layer set to Infrared (this is one of the selections on the drop-down list shown in Step 16).
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          	Step 20: With the adjustment layer selected in the Layers palette, merge the Black & White adjustment layer down onto the “B&W Infrared” layer by choosing Layer ► Merge Down.

        

      


      
        
          	Step 21: With the “B&W Infrared” layer selected in the Layers palette, choose Layer ► Layer Mask ► Hide All to add a layer mask to that layer.

        

      


      [image: missing image file]


      
        
          	Step 22: Selectively tone down areas of the image by painting with the Brush Tool in white on the black layer mask.

        

      


      
        
          	Step 23: Repeat steps 18–22 adding more black and white layers using different Black & White adjustment layer settings. As you can see in the Layers palette shown here, I ended up with five black and white layers that I used to subtly tone the image. The final image is shown on pages 106–107.
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        	As the sun sank towards the west, light began filtering through the canyons and rock formations, creating deep shadows along with occasional brightly lit areas. I saw this high contrast between the dark and light areas as a natural for a semi-abstract black and white composition. I captured the image as a RAW file, and back at my computer processed the image using multiple layers twice: once to fully capture the color information, and once to customize my translation to black and white.

      


      44mm, 1/10 of a second at f/22 and ISO 100, tripod mounted

    

  


  
    
      
        Multi-RAW Processing In Photoshop

      


      
        Suppose you have a perfect subject for extending the dynamic range through multi-RAW processing (see pages 98–103 for an example). It’s important to come up with a plan as to how you are going to post-process your RAW captures more than once to come up with an image that can

        be effectively converted to black and white.


        The three strategies I most commonly

        use are:


        
          	Dark to light: This means processing the darkest, most underexposed version first, and then blending-in successively lighter versions on top.


          	Starting in the middle: If your capture is pretty close to where you want it, you could start by processing it fairly neutrally. Next, you could add lighter and darker versions on top as necessary.


          	Light to dark: This means processing the lightest, most overexposed version first, and then blending-in successively darker versions on top.

        


        Whichever strategy you choose, the mechanics of creating a layer stack with aligned layers from different versions of the RAW capture, and then combining

        the layers is the same.

      


      [image: missing image file]


      
        
          	With this image of waves crashing on the shore, I knew I would need to process a lighter version to get detail in the shoreline at the right of the image. I would also need a darker version to tone down the comparatively brighter waves on the upper left.
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          	Step 1: Open the RAW capture in ACR. Use the Exposure slider to darken the capture so the waves on the left side of the image are exposed correctly.


          	
            Hold down the Alt key and click Open Copy to open this darker version in Photoshop. It will appear in the Layers palette as a Background layer. (See Steps 1–3 on pages 99–100 to find out more about opening multiple versions of the same image in Photoshop using ACR.)
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          	Step 2: Choose Layer ► New ► Layer from Background and rename the layer “Darker.”
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          	Step 3: Open the RAW capture again in ACR. Use the Exposure slider to lighten the capture so the shoreline on the right side of the image is exposed correctly.


          	
            Hold down the Alt key and click Open Copy to open this darker version in Photoshop. It will appear in the Layers palette as a Background layer.

          

        

      


      
        
          	Step 4: Choose Layer ► New ► Layer from Background and rename the layer “Lighter.”


          	
            You now have two versions—a lighter version and a darker version—of the same image open in Photoshop.
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          	Step 5: Hold Down the Shift key and use the Move Tool to drag the lighter version from its window onto the darker version’s window. Release the mouse before you release the Shift key. This will perfectly

          align the layers on top of each other.


          	
            There are now two layers in the Layers palette: “Lighter” and “Darker.”
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          	Step 6: With the “Lighter” layer selected in the Layers palette, choose Layer ► Layer Mask ► Hide All to add a layer mask to that layer.


          	
            The Hide All layer mask hides the layer it is associated with (in this case the “Lighter” layer). So all you will see in the image window right now is the “Darker” layer. The layer mask appears as a black thumbnail in the Layers palette.
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          	Step 7: In the Layers palette, make sure the layer mask on the “Lighter” layer is selected.


          	
            Use the Gradient Tool from the Toolbox to drag a white-to-black gradient from the right hand side of the window to the left hand side of the window. This will leave the left side of the image brighter while lightening the darker right side.


            You can see the gradient on the layer mask thumbnail in the Layers palette.
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          	Surf was dramatically crashing on the rocky shore by the light of the setting sun. In my mind’s eye, I saw a black and white photo contrasting the bright waves with the dark shore. To achieve the photo I pre-visualized, I knew I would need to use a fast shutter speed, and underexpose so that I could stop the motion of the waves and not lose their detail because of blown-out highlights. My plan was to “rescue” the overly dark areas of the photo using multi-RAW processing.


          	
            After blending multiple RAW versions of the image in Photoshop, I converted this already essentially colorless image to black and white using Black & White adjustment layers (see pages 104–105 and 122–127).

          

        


        32mm, 1/1250 of a second at f/11 and ISO 200, hand held

      

    

  


  
    


    
      Black and White in Photoshop

    


    
      One of the wonderful things about Photoshop is that there are always many ways to accomplish any task. This is good news—and bad news. The good news is that Photoshop is immensely powerful and flexible. The bad news is that one is never done learning Photoshop, and there are so many ways to accomplish anything that it’s sometimes hard to know which one to use.


      Black and white conversion in Photoshop is no exception. There are many ways to go about this task, ranging from very simple—which does not create very nuanced black and white imagery—to quite elaborate, powerful and flexible.


      The simplest way to translate a color photo in Photoshop into black and white is to simply drop the color information. This can work reasonably well with images that are not high contrast, and where there isn’t much color information available in

      any case.


      To convert to black and white by dropping the color information, you can do one of the following (which all have more or less the same results):


      
        	With an RGB image select Image ► Mode ► Grayscale (see the example of a conversion accomplished this way on the facing page).


        	With an RGB image select Image ► Adjustments ► Desaturate.


        	Convert your image to LAB color, and drop the A and B channels (for more about using LAB color to create black and white images, see pages 182–187).

      


      Another pretty straightforward approach is to use the Color blending mode to combine the photo with a black layer (see pages 116–117). This can work well with photos that have strong blacks and whites in the color version.


      More sophisticated black and white conversion methods in Photoshop include:


      
        	Using the Channel Mixer, either as an adjustment layer or on a duplicate layer (pages 118–121).


        	Using a Black & White adjustment layer (pages 122–127).


        	Using a third-party black and white conversion filter, such as Silver Efex Pro (pages 128–135).

      


      I often find that it takes more than one black and white conversion technique—either applied to different parts of an image, or applied sequentially—to fully process photos to my satisfaction. For information about combining conversions in Photoshop, see pages 136–141.
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        	I shot this image of a large succulent plant outdoors with a camera that had been retrofitted to make captures on the infrared spectrum (see pages 224–231). Since the infrared capture was a low contrast image that contained very little color information, a simple grayscale conversion in Photoshop (Image ► Mode ► Grayscale) worked fine.

      


      40mm, 1/100 of a second at f/11 and ISO 200, hand held

    

  


  
    


    
      
        Blending with Black
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          	In the color version of the tulip image shown above, the white tulips and highlights were very white, and the blacks were very dark.


          	
            When I decided to convert the image to black and white, it seemed to me that blending the photo with a black layer using the Color blending mode would work well. This is a quick and easy way to convert a high contrast color photo to black and white.
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          	Step 1: In the Layers palette, click the Create a new layer button at the bottom of the palette to add a transparent (empty) layer on top of the color image. Name the layer “Black.”

        


        
          	Step 2: Select the Paint Bucket Tool in the Toolbox. Press D to make sure the Foreground Color is set to Black.

        


        
          	Step 3: Make sure the “Black” layer is selected in the Layers palette. Click the Paint Bucket Tool in the image window to fill the layer with black. All you will see in the image window is solid black. Don’t worry, that will change with the next step!
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            	Step 4: In the Layers palette, use the Blending Mode drop-down list to change the blending mode from Normal to Color.


            	
              The Color blending mode mixes the luminance (grayscale values) of the underlying color image with the hue and saturation values of the “Black” layer on top, creating a black and white image.
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            	I used a Lensbaby to selectively focus on the white tulips in a cut crystal vase, with the idea of converting the image to black and white so that the colored background wouldn’t compete with the white flowers.


            	
              Since I was only interested in the white whites and the black blacks, I didn’t really need to use the color information in the photo for an effective black and white conversion. Using the Color blending mode to combine the photo with a black layer was quick and worked well.

            

          


          Lensbaby Composer, 1/640 of a second using f/4 aperture ring at ISO 200, hand held

        

      

    

  


  
    


    
      Using the Channel Mixer

    


    
      The Channel Mixer provides a great mechanism for using color information to control the look and feel of your black and white photos when you convert them using Photoshop.


      Before the introduction of Black & White adjustment layers with the CS3 version of Photoshop, the Channel Mixer was probably the premier way to control your black and white conversions. It remains an important tool—particularly in situations in which the precise mixture of information from each color channel that is used to form the black and white tones is an important aspect of the black and

      white conversion.


      For example, hugely decreasing the contribution of the Blue channel while simultaneously boosting Red and Green channel contributions is known as the “Ansel Adams effect”—the look can be

      one of sumptuous, very black blacks in contrast to extreme whites. Using the Channel Mixer remains the best way to achieve this special effect.


      The dramatic interplay between sky and mountains with Yosemite Valley as a backdrop made me think that this photo below was a good candidate for the Ansel Adams effect, applied using a Photoshop Channel Mixer adjustment layer.
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          	Step 1: Choose Layer ► Layer via Copy to duplicate the color Background layer. Name this duplicate layer “Channel Mixer –

          Ansel Adams.”

        

      


      
        
          	Step 2: With the “Channel Mixer – Ansel Adams” layer selected in the Layers palette, click the Create new fill or adjustment layer button at the bottom of the palette. Next, choose Channel Mixer from the drop-down list.


          	
            (Alternatively, you can add a Channel Mixer adjustment layer using the Adjustments palette or by choosing Layer ► New Adjustment Layer ► Channel Mixer.)


            The Channel Mixer adjustment layer appears above the “Channel Mixer – Ansel Adams” layer in the Layers palette and default Channel Mixer settings appear in the Adjustments palette.

          

        

      


      
        
          	Step 3: In the Adjustments panel, make sure Monochrome is checked.
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          	Step 4: Use the sliders to set up the Ansel Adams effect: set Red to +150; set Green to +140; and set Blue to –190.


          	
            Notice that if you add these values up they equal 100%. When using the Channel Mixer sliders, the values for the three channels should total 100%.
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          	Photographing during a clearing winter storm in Yosemite, I worked hard to find a slightly different angle to frame the marvelous vista that opened before me. It was hard to see this view without thinking of the sumptuous Ansel Adams photography of Yosemite and the Sierra Nevada mountains, so naturally I wanted to create a photo that could be successfully converted to black and white.


          	
            To achieve this goal, I knew that I would need to have a sense of crispness across the entire image. This meant that I would need maximum depth-of-field. So I stopped my camera all the way down to f/22 and used a wide angle setting to achieve as much depth-of-field as possible.

          

        


        20mm, 1/40 of a second at f/22 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Black & White Adjustment Layers
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          	I shot this photo of an ancient Bristlecone Pine, one of the oldest living things, with black and white in mind.

        

      


      
        Black & White adjustment layers are probably the most effective and powerful way to create great creative monochromatic imagery in Photoshop. They’re easy, flexible, and powerful—although in many cases a single Black & White adjustment layer isn’t optimal for all areas in a photo. To resolve this problem, multiple adjustment layers can be used with different settings, each setting applied on a different layer, with the layers masked and blended to create the final results. (For more about layer masks and blending layers see pages 98–107.)


        Even just one Black & White adjustment layer can be a powerful conversion tool. Part of what makes Black & White adjustment layers easy to use are the Presets—conversions to black and white using settings chosen from a list. These Presets mostly use the metaphor of applying filters in an old-fashioned darkroom, and are named after these filters. (Presets and how to use them are discussed on pages 123–125.)


        Don’t get too caught up in the metaphor to film that the presets provide. As with everything digital, the analogy to old-fashioned process doesn’t always hold up. The best way to see what one of the black and white adjustment presets does is try it, and find out. If you don’t like it, you can always go back and try again.


        Note that I tend to merge down adjustment layers to form “just plain old regular” layers that can be masked normally. This process is explained further on pages 136–141.
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          	Step 1: In the Layers palette, select the layer to which you want to add the adjustment layer.

        

      


      
        
          	Step 2: In the Adjustments palette, click the Create Black & White adjustment layer button to apply a default black and white adjustment.


          	
            You can also add a Black & White adjustment layer by selecting Layer ► New Adjustment Layer ► Black & White.
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          Default Black & White adjustment layer applied to the image shown below
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          	After adding the Black & White adjustment layer, the Default preset becomes active in the Adjustments palette as shown, converting the layer to a neutral monochromatic image.


          	
            If you move the sliders, changing the color values represented by the sliders, you will immediately see the impact on the photo in the image window. The Default preset has neutral tonal values, so this is often a good starting place for conversions that require additional work.
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          	Step 3: Use the Black & White drop-down list to choose a preset. These presets are only a starting place—there’s nothing to stop you from making further tweaks using the sliders.
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          	The slider settings created by the Green Filter preset are basically fairly neutral for this photo.

        

      


      
        


        
          Using Auto with Black

          & White Adjustments


          If you look carefully at the Black & White Adjustments palette you’ll notice an Auto button. Click this button for Photoshop’s best guess at what your monochromatic conversion should look like.


          Often the Auto settings aren’t bad—or at least provide a pretty good background layer you can use as a starting place for

          a creative conversion.

        

      


      
        [image: missing image file]


        [image: missing image file]

      


      
        
          	The High Contrast Blue Filter preset darkens the image dramatically—particularly on the upper left. It’s a striking effect, and one that I planned to partially incorporate in my finished image.
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        	The High Contrast Red Filter preset produces an image that is generally toned to the light side across the entire image.

      

    


    [image: missing image file]  [image: missing image file]


    [image: missing image file]


    
      
        
          	To create a simple sepia tone for your black and white image, you can start with the Default preset, check the Tint box, and select a sepia color. When I want a tinted monochromatic effect, I almost always take the Sepia Tint layer down to about 20% opacity.
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            	The final conversion uses four Black & White adjustment layers in a layer stack. On top of the conversion achieved using the Default preset the following layers were used:


            	A layer using the High Contrast Blue preset with a gradient on a layer mask to make the left side of the photo darker.


            	A second layer using the High Contrast Blue preset with painting on a layer mask, making the image darker in specific areas.


            	A layer using the Infrared preset with painting on a layer mask that adds a nice, light quality.
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            	This textural image of an ancient and weathered Bristlecone Pine high in the White Mountains on the California–Nevada border struck me as perfect for monochrome, but I wanted to make sure that monochrome didn’t mean monotonous. The photo that I pre-visualized required considerable tonal gradations from dark to light. So I made sure to process the image using multiple Black & White adjustment layers.

          


          200mm, 1/100 of a second at f/8 and ISO 100, tripod mounted

        

      

    

  


  
    


    
      
        Silver Efex Pro

      


      
        Silver Efex Pro works with both Lightroom and Photoshop. It is probably the best known third-party plug-in for these programs that provides extensive black and white conversion capabilities via the use of filters (see page 234 for some other options).


        I’m not generally enthusiastic about recommending expensive third-party tools. After all, you’ve probably already laid out good money for Adobe’s Lightroom or Photoshop. But Silver Efex Pro has some serious advantages, and I often find I use it as part of my black and white conversion workflow—either by itself or in conjunction with other Photoshop conversion tools such as the Channel Mixer and Black & White adjustment layers.


        If you decide to live without Silver Efex Pro, I think you can still do awesome digital black and white work—it just might take a little longer. You can always find a way in Photoshop itself to create the effects that are easily available in Silver Efex Pro, but how to do so isn’t necessarily obvious. In my opinion, why recreate the wheel? I prefer to spend my time in more creative pursuits.


        Like Black & White adjustment layers themselves, the different black and white effects that Silver Efex Pro provides are largely named as if they were filters on the enlarger in a film darkroom. In addition, some of the options are named after antique film technologies—for example,

        Tin Type.


        Obviously in both cases, what you are getting is a digital simulation of the effect that is referenced by its anachronistic name.


        Once you’ve selected a particular filter, you can adjust its strength by changing the exposure and adding special effects such as toning and vignetting. Please refer to the product documentation for a detailed explanation of how these controls work.


        As always, I strongly recommend working with Silver Efex Pro on a duplicate layer rather than on the background itself. This gives me added flexibility, particularly as most of my conversions seem to involve more than one filter.


        Once Silver Efex Pro has been installed, it will appear towards the bottom of the Photoshop Filters menu as an item.


        To open Silver Efex Pro:


        
          	Open the photo you want to convert to black and white in Photoshop.


          	Duplicate the layer you want to convert.


          	With the duplicate layer selected, choose Silver Efex from the Photoshop Filters menu. The Silver Efex Pro window will open with a Neutral conversion selected. I often use this neutral conversion as the starting place for my black and white work with Silver Efex Pro.
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            	Silver Efex Pro is shown here in split-screen mode, with the original color capture of an onion on top, and the Silver Efex Pro default conversion, called Neutral, on the bottom.
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            	The Silver Efex Antique Plate filter gives black and white photos an old-fashioned look.
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          	The Silver Efex Pro High Structure filter increases contrast throughout an image.
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          	The final conversion uses six different Silver Efex Pro filters, shown here in the Layers palette. Most of the time I use more than one Silver Efex Pro conversion, with each different filter on its own layer. Note that I’ve retained the original color image as the bottom, Background layer.
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            	With this capture of an onion I tried to create an abstraction, so that the layers of the onion appear something like the tracks in a race course.

          


          200mm macro, three exposures combined in Photoshop at shutter speeds between 30 seconds and 90 seconds; each exposure at f/32 and ISO 100, tripod mounted
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        	In creating this black and white conversion from a color photo of a red pepper, I wanted to achieve an intentionally old-fashioned effect. So I started with a Color Efex Antique Plate layer as the primary basis for my conversion. On top of the Antique Plate layer I added a Silver Efex Pro High Structure layer (to add definition) and an Overexposure layer (to brighten), with both layers selectively applied using layer masks and painting-in the areas I wanted.

      


      85mm macro, five exposures combined in Photoshop at shutter speeds between 30 seconds and 3 minutes; each exposure at f/51 and ISO 100, tripod mounted
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          	I used an LED light positioned behind some marbles to create this still-life composition that makes strong use of shadows.
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          	Among the many Silver Efex Pro filters, there are quite a few that use the black and white conversion process to simulate the appearance of an image as if it had been shot with a specific film camera or film stock. In this black and white conversion, I used the Holga Silver Efex Pro simulation for a slightly antique effect with increased contrasting grain.

        


        Both: 200mm macro, 8 seconds at f/36 and ISO 100, tripod mounted

      

    

  


  
    


    
      
        Combining Conversions in Photoshop

      


      
        It’s certainly true that no one black and white conversion technique works well for all photos. In addition, I usually find that a single black and white conversion technique doesn’t work for all parts of a photo. My expectation is that my black and white conversions will require a number of different filters and effects—with each one on its own layer and with different effects applied to different parts of the image.


        As I’ve mentioned, before I even get to the black and white conversion I like to process the color photo so it will convert into a dramatic black and white shot. This often means increasing the contrast and saturation, as well as using multiple RAW processing techniques to properly bring out the exposure for the different areas of the photo (see pages 108–113).


        Here’s an example of how I might go about using multiple conversion techniques in a single black and white conversion.


        I started with a color version of a photo taken in the ancient Bristlecone Pine forest high in the desert mountains along the California-Nevada border. To live up to the drama inherent in the color version, I knew I would have to process the foreground portions of the image differently from

        the clouds and sky.
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          	I processed the RAW file to increase saturation and contrast in the color image.
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          	A Black & White adjustment layer using the Red Filter preset worked well for the trees. (See pages 122–127 for more about adjustment layers.)
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          	A Black & White adjustment layer using the Green Filter preset increased the contrast in the sky somewhat. I used a layer mask with a gradient so the Green Filter preset had no impact on the foreground. (See pages 98–107 for more about layer masks and gradients.)
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          	I used the Silver Efex Pro High Structure filter to add some apparent depth to the old tree, “painting” in just the areas I wanted to enhance using the Brush Tool on a layer mask. (For more about Silver Efex Pro, turn to pages 128–135.)
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          	The Silver Efex High Contrast Green filter, combined with the layer beneath it in the stack using the Multiply blending mode, adds a little more drama to the sky. (See page 189–191 for more about blending modes.)
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          	On a day of turbulent, dramatic clouds and weather I wandered in the high, desolate groves of Bristlecone Pines. These oldest of living things are a photographer’s dream—whether you work in color or black and white. I knew that to present the nuances and contrast in this subject I would need to use several conversion tools when I converted my capture to monochrome.

        


        10.5mm digital fisheye, 1/60 of a second at f/22 and ISO 200, tripod mounted

      

    

  


  
    
      

    


    
      Creative Black and White Opportunities
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      	This photo presents an abstraction based on a composition made up of several toilets. The shapes reminded me of bodies, rather than plumbing. My idea was to make the photo look as old-fashioned as possible, so I extended the dynamic range of the image for blacker blacks and whiter whites, and “toned” the photo with an overall sepia tint.

    


    85mm macro, 1/4 of a second at f/64 and ISO 100, tripod mounted

  


  
    Lighting and Monochromatic Photos

  


  
    If there’s one thing almost all photographers agree on, it’s that photographs are about capturing light. How your subject is lit—whether you arrange the lighting, or it is natural because the light was “just there”—is crucial to the success of any photo. The most important aspect of the art and craft of working with light is perceptual. It’s necessary to learn to be able to pre-visualize the impact of lighting—and relatively small changes in lighting—on a final image.


    The way light works in your photographic compositions is different depending on whether your photo is a monochromatic or color image. With color, there are more variables. Light with a given quality can interact and appear differently depending on what is being photographed. Two objects, right next to each other in the same photo, can reflect different color temperatures, even though they are lit the same way. The infinite gradations of light intensity, color temperature, and tone correspond to the normal way we see the world, and provide a rich and subtle palette for nuanced imagery.


    The strengths of black and white tend to lie elsewhere. Light still plays a crucial role in monochromatic compositions. But its role is usually anything other than subtle. Monochrome favors bold boundaries and abrupt transitions from light to dark. When I see a subject that shows this kind of strong, abstract demarcation—particularly if color doesn’t play a vital role in the composition—I start thinking, “black and white.”


    Since a digital monochromatic image is essentially a simulation that involves re-purposing a full color capture, working with light in black and white should take place in four stages:


    
      	Recognizing, or setting up, a black and white composition (see Part I, The Monochromatic Vision, starting on page 10).


      	Making an exposure (or more than one to extend dynamic range, see pages 156–165). Many of the photos I’ve used in this book, taken together with their captions that include camera settings information, are intended to help give you a starting place for your own creative black and white exposures.


      	Processing an image captured in color—usually as a RAW file—into monochrome (see Part II, Black and White in the Digital Era, starting on page 66).


      	Applying creative special effects to the way the lighting appears in your processed photos using the digital darkroom.

    


    Part III, Creative Black and White Opportunities, shows you many of the special effects you can use as part of processing your monochromatic photo from the RAW file after it has been initially processed.


    You can use these ideas as a reference, as possibilities to bear in mind when you conceptualize a black and white image or as recipes for enhancing your existing work.
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      	Watching the morning sun rise on the Yosemite Valley floor, I couldn’t see much in the way of color. But the interaction of the rays of sunshine with the morning haze held the promise of an interesting monochromatic image. I intentionally underexposed my capture, then processed the photo by selectively lightening the bright areas using multi-RAW processing, layers, and masking.

    


    32mm, 1/400 of a second at f/5 and ISO 100, hand held
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        	From the vantage point of a sailboat under the Golden Gate Bridge, I noticed that sunlight passing through the bridge tower created a shadow of the tower projected on the fog. The unusual lighting conditions made a striking monochromatic composition possible. I overexposed the capture, then worked in post-processing to darken the tower and its shadow.

      


      135mm, 1/1000 of a second at f/8 and ISO 200, hand held
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        	By using some carefully positioned lights in my studio I was able to create an interesting composition out of an egg, its refractions through the glass, and the shadows created by both the egg and glass.

      


      85mm macro, 1/4 of a second at f/17 and ISO 100, tripod mounted

    

  


  
    


    
      Creating High-Key Effects

    


    
      When I explained high-key photography from the viewpoint of shooting the image on pages 40–43, I noted that not all subjects work well for high-key photos, and that when you find a good high-key subject you should plan to overexpose.


      As I described more generally (pages 144–147), when you are looking at light in the context of a black and white composition you should consider appropriateness, exposure, RAW processing, and black and white conversion. It’s best if you can learn to pre-visualize these steps as much as possible at the early stages of your creations.


      With shooting with high-key in mind, look for bright, white, well-lit subjects which can be rendered in subtle shades of gray and do not require strong contrasts.


      Overexpose by as much as a couple of f-stops. As you likely know, each successively smaller f-stop lets in 1/2 of the light of the previous f-stop—so a two f-stop overexposure means increasing the shutter speed by a factor of 4 if you keep the f-stop constant. For example, at f/32 if the exposure according to your camera’s light meter is 1 second, then 4 seconds might be the right shutter speed for a successful high-key effect. If you bracket, you’ll maximize the chances of getting the right exposure.


      Process the RAW conversion in multiple layers to emphasize transparency (see pages 108–113 for more about RAW processing). This means using lighter layers for areas of the high-key image that you want to look transparent, with darker layers possibly providing information for the image’s edges.


      Convert to black and white using a method that tends to lighten your image; for example the Maximum White preset available as a Black & White adjustment layer, or the Overexposure filter that is

      part of Silver Efex Pro. You can always

      add a darker conversion for areas—such

      as edges—that you want to emphasize.


      One technique that adds apparent transparency to a high-key image is to paint with white over areas you want to lighten. For the most accuracy, use a layer and layer mask as follows:


      
        	In the Layers palette, click the Create a new layer button at the bottom of the palette to add a transparent (empty) layer on top of the layer stack. (See pages 98–107 for more about layers).


        	Press D and then X to make sure the Foreground color is set to White.


        	Using the Paint Bucket Tool, fill the new layer with white. Your image will disappear, but don’t be alarmed! It will be right back in the next step.


        	Choose Layer ► Layer Mask ► Hide All to add a black Hide All layer mask. This hides the all-white layer.


        	With the layer mask selected in the Layers palette, use the Brush Tool (set to roughly 10% opacity) to paint on the layer mask. This will make the areas you paint on more “transparent”—by adding white to them. (For more about painting on a layer mask, turn to page 103.)
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        	I carefully placed these poppies from my garden on a white light box, and gently sprayed them with water to increase their transparency. I made a series of captures at different shutter speeds with the camera on a tripod, intentionally overexposing most of these captures.


        	
          Three of the captures were combined in Photoshop. I used the lightest captures for the flower petals, and darker captures for the edges of the flowers.


          To convert to black and white, I used Black & White adjustment layers, with the Maximum White preset for the interior of the petals, and the Maximum Black preset for the edges.


          As a final step, I used a layer and a layer mask to selectively paint in white in areas that I wanted to look more transparent

          (see page 148).

        

      


      50mm macro, 3 exposures combined in Photoshop at shutter speeds from 1 second to 10 seconds, each exposure at f/32 and ISO 100, tripod mounted


      [image: missing image file]


      
        	Looking up during a storm in Yosemite Valley, I saw the cliff briefly become visible through a break in the weather. My thought was to create a mysterious, high-key image that used the clouds to frame the cliff. So I exposed for the details of tree, rock, and snow letting the clouds overexpose.


        	
          I used a Black & White adjustment layer with the High Contrast Red filter for the background of the image, with the Silver Efex Pro High Structure filter to bring out the details on the cliff. Finally, to give the image an old-fashioned look, I tinted it with a 20% sepia layer (see pages 162–167).

        

      


      200mm, 1/400 of a second at f/10 and ISO 200, hand held

    

  


  
    


    
      Creating Low-Key Effects

    


    
      On pages 44–47 I explained that low-key images are predominantly very dark. The point of these compositions is to contrast the important areas that are lit with the blackness that surrounds them. It’s human nature to vest the dark negative spaces with an aura of power and mystery—so low-key compositions can be very powerful. Another feature of low-key compositions is they are effective at isolating the key elements of a composition and removing extraneous details. You can hide many sins, not to mention a great deal of clutter, behind a curtain of dense black!


      With shooting with low-key in mind, look for the exact opposite of what you’d try to find with high-key. In other words, good low-key subjects are dark and black. The best low-key subjects are intermittently lit. Lighting often shows a chiaroscuro effect, meaning that there is mottled lighting with an extreme contrast between light and dark areas.


      Effective use of low-key lighting involves underexposing the overall scene. That way, the highlight areas, which is what you are really interested in, will be properly exposed. There’s no substitute for trial and error, and for checking your captures using your camera’s LCD. Since you are only interested in selective areas of your composition, with a willingness to let the rest go very dark, be sure to zoom in on the parts of the photo that matter rather than relying on an overall impression.


      Process the RAW conversion using multiple layers to emphasize the darkness that you’d like to have surrounding the lit areas of your composition (see pages 108–113 for more about RAW processing). This often means creating a dark layer to use for background areas. You can layer in lighter areas using a mask and the Brush Tool.


      Converting to black and white using a method that tends to darken your image—for example, using the Maximum Black preset available as a Black & White adjustment layer, or the Underexposure filter that is part of Silver Efex Pro—is a possible way to create a low-key image. Sometimes a High Contrast Red preset

      or filter works well with low-key images.

      You can always add a darker conversion

      for areas that need to be almost or

      entirely black.


      One technique that adds darkness to a low-key image is painting with black over areas you want to darken. For the most accuracy, use a layer and layer mask as follows:


      
        	Choose Layer ► New ► Layer to add a transparent (empty) layer at the top of your layer stack (see pages 98–107 for more about layers). Click OK in the New Layer window to add the new empty layer.


        	Press D to set the Foreground color to black.


        	Select the Paint Bucket Tool from the Toolbox. Click on the transparent layer with the Paint Bucket Tool. The layer will fill with black and your image will disappear. Don’t be alarmed, the image will be back in the next step.


        	Choose Layer ► Layer Mask ► Hide All to add a black Hide All layer mask to the all-black layer. This hides the all-black layer and makes the image layer visible again.


        	Select the Brush Tool from the Toolbox. Set the Brush Tool’s opacity to 50%. Make sure the Foreground color is set to white and then paint on the layer mask in the areas you want to make darker. You can vary the opacity setting of the Brush Tool as you work.


        	When you finish adding black, archive your layered document, and merge it down so the file can be used for reproduction or on the web.
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        	I photographed my sleeping daughter by the light of a single low-wattage bulb. To recreate the chiaroscuro lighting of the scene once I converted the photo to monochrome, I added an all black layer and “painted in” the areas that I wanted using varying degrees of opacity.

      


      105mm, 1/25 of a second at f/5.6, hand held
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        	I photographed this Parks department volunteer working on restoring the wheel of an antique cannon using his work light for illumination. During the black and white conversion process I seized the opportunity to remove extraneous and distracting details from the composition by blending the photo with a black layer, and selectively painting out distractions.

      


      135mm, 1/100 of a second at f/9 and ISO 500, tripod mounted
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        	I aimed for emotional mystery in this infrared capture of a model in the studio (see pages 222–231 for more about black and white infrared capture). In post-processing, I used the Silver Efex Pro Underexposure filter to keep the low-key effect that I had visualized.

      


      Infrared capture, 1/50 of a second at f/4.5 and ISO 1600, hand held

    

  


  
    


    
      HDR in Black and White

    


    
      HDR—High Dynamic Range—photography means creating photos with a greater variation in tone from lightest to darker than is normally possible in a single digital capture (or a frame of film, for that matter).


      The human eye is capable of perceiving a much greater tonal range than is normally captured in photography. To see this is true, try staring at the shadows in a dark room that is illuminated in one area by a shaft of strong sunlight. As your eyes adjust, you’ll be able to see details in both the dark areas and in the bright sunshine. No conventional photo can do as much.


      Digital photos with an extended tonal range can render an even greater gamut from light to dark of tonal values than even the human eye. This can sometimes cause these photos to look unnatural and almost unreal—which, depending on the context and the intention of the photographer is either good, or bad.


      When it comes to digital black and white photography, there are a number of possible strategies for extending dynamic range:


      
        	Multi-Raw processing (pages 108–113)


        	Combining black and white conversions (pages 136–141)


        	High Dynamic Range (HDR) photography

      


      You’ll find examples of photos that use these different strategies throughout this book; this is generally explained in the caption information for each image.


      To create an HDR image, start by shooting multiple captures at different exposure settings. The multiple captures are combined in post-processing to create a single image.


      Hand HDR involves putting the captures together in Photoshop using layers and masking (pages 98–107). Automated HDR uses automatic software to do this compositing. Photoshop provides an automated HDR feature, but the best software for the job is Photomatix, explained in this section.


      Color images created with Photomatix HDR can look garish. In black and white, no colors no problem. I think you’ll find that using an automated HDR program such as Photomatix can open a whole world of new possibilities in your creative black and white work.
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          	I was impressed with the patterns of light and shadow on the brick work at the historic Fort Point beneath the Golden Gate Bridge in San Francisco, California. However, I realized that a single exposure could not possibly capture the dynamic range involved. So I made a series of bracketed exposures, and used HDR techniques to blend the captures to extend the dynamic range of the final image.

        


        14mm, 6 exposures combined in Photomatix at exposure times from 0.6 of a second to 8 seconds, each exposure at f/22 and ISO 100, tripod mounted

      


      Shooting for HDR


      Whether you use Photoshop, Photomatix, or some other tool, here’s what I’ve found to work best when shooting for HDR:


      
        	The camera shouldn’t move between captures; therefore, I almost always use a tripod.


        	I keep my ISO fairly low, probably less than 400. Otherwise, my HDR composite is likely to get very noisy.


        	It’s better to vary the shutter speed than the aperture. If you change apertures between captures, you may change the depth-of-field between images—which could make the final HDR composite look off-balance and simply weird—because the in-focus areas wouldn’t

        be the same from image to image.


        	Assuming you are bracketing the shutter speed, you should have no fewer than three captures. You may get better results with more captures; 5–10 is a good range.

      


      I tend to bracket at about 100% shutter speed increments, calculating my exposures manually rather than using an in-camera bracket program. For example, I shot the three images of the ornate and unused Capitolio Nacional (below) using a digital fisheye at 0.4 of a second, 0.6 of a second, and 1.3 seconds.


      Using Photomatix


      There are two parts to Photomatix: the initial HDR blend, and an adjustment step that is called “applying a tone curve.”


      Using the first part of Photomatix couldn’t be simpler. You fire up the application, and the small window shown in Step 1 opens. Choose Generate HDR image, choose the images to blend in the window shown on the right, and click OK.
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          	These three images of the ornate and unused Capitolio Nacional were shot using a digital fisheye at 0.4 of a second, 0.6 of a second, and 1.3 seconds. Here the three RAW captures are shown in Adobe Bridge. I’m going to process them in Photomatix to show you how HDR blending works.
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          	Step 1: Launch Photomatix and click the Generate HDR image button in the Workflow Shortcuts window. Then, use the Generate HDR window to choose the images you want to blend and click OK.


          	
            The HDR blending process may take a while, even on powerful hardware.
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          	Step 2: When the blending is complete, a window like the one shown below will open. Don’t pay too much attention to the way the image looks at this point.


          	
            Click the Tone Mapping button in the Workflow Shortcuts window, and then fiddle with the sliders until you get something you like.


            You don’t really begin to see what you get with Photomatix HDR until you perform this Tone Mapping step. It’s well worth playing with the various sliders until you like the results.


            Try to bear in mind that the final image will be in black and white. This means you can ignore unfortunate colors and concentrate on the tonal range as if the colors were not there.

          

        

      


      [image: missing image file]  [image: missing image file]


      
        
          	Step 3: When you are satisfied with the tonal range in the image, click Process.
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        	Step 4: Here’s a Photomatix trick: After you’ve processed your tone curve, you can press CMD+T (Mac) or Ctrl+T (Windows) and re-process the image a second time. Depending on the image, you are likely to get an even greater HDR effect with this second processing.


        	
          Following a second tone mapping there’s an even greater tonal range in the image to the right, although the image admittedly looks pretty garish in color. Fortunately, we don’t care about the color.

        

      

    


    
      
        	Step 5: When you’ve finished tone mapping your image, use the Photomatix File menu to save it as a TIFF file. Then open the file in Photoshop and convert it to black and white as you would any other color photo. (See pages 114–141 for Photoshop black and white conversion methods.)
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        	I bracketed exposures inside the Capitolio Nacional in Havana, Cuba—not so much with the plan of creating an auto-generated HDR image but in order to be sure to get the right exposure values. Back at my computer, the three captures I had made did seem in fact like a good candidate for processing with Photomatix. After running the sequence through Photomatix twice (see Step 4 above), I converted to black and white using the Nik Silver Efex Pro High Structure filter—which further enhanced the HDR effect.

      


      10.5mm digital fisheye, 3 exposures combined in Photomatix at exposure times from 0.4 of a second to 1.3 seconds, each exposure at f/13 and ISO 100, tripod mounted

    


    [image: missing image file]


    
      	I stood at the bottom of a stairwell in Cienfuegos, Cuba and looked up. I knew a single capture could never render the extreme dynamic range from the dark parts of the stair to the bright sunlight, so I exposed a series of bracketed exposures, with the plan of combining the exposures to extend the dynamic range in post-processing. Processing this image for HDR in Photomatix added considerable noise—some of which I converted to simulated film grain (see pages 218–219). But I didn’t mind, as the apparent messiness of the image fits well with the tumble-down state of the stairs.

    


    13mm, 6 exposures combined in Photomatix at exposure times from 1/2 of a second to 20 seconds, each exposure at f/22 and ISO 100, tripod mounted
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        	My idea with this black and white HDR image was to subvert the usual assumptions about framing an architectural photo. When you realize that the camera was positioned at the bottom of a courtyard, it’s easy to see you are looking up at the sky. However, at a glance the nearly square patch of sky and cloud could be a framed work of art on the wall. Using HDR allowed me to lift the bottom of the courtyard out of shadow and expose the decorative details within the windows making this visual double take possible.

      


      12mm, 6 exposures combined in Photomatix at exposure times from 1/250 of a second to 1/25 of a second, each exposure at f/14 and ISO 100, tripod mounted

    

  


  
    
      

    


    
      
        Toning and Tinting

      


      
        Black and white is black and white, right? Not so fast, pardner. From the very beginnings of photography, black and white has actually meant the light brown of sepia toning, the gray caused by the chemical selenium, the blue of the cyanotype process, and so on—the single, monochrome color on a scale with white. In other words, black and white means monochrome, but it doesn’t literally imply that the image is actually and literally in the key of black.


        Historically, toning was the result—or by-product—of the chemical process used to make a print, although aesthetic choice may also have been involved when a toned effect was actively sought after. Toning sometimes added archival qualities and extended the tonal range of a print; whereas, tinting simply added color.


        With digital photography, all “toning” and “tinting” choices are virtual—applied digitally—and intended to add to the visual appeal of a black and white photo.


        The decision to tone a digital photo means to add a color tint to some or all of a photo for aesthetic reasons. Thus, in the digital world, there is no difference between toning and tinting (in the chemical darkroom the two may have been achieved differently). However, if you want those who look at your monochromatic photos to associate the added color with the kind of tones they’ve seen in vintage photos, you should keep your color choices to those that might plausibly have been seen in toned, old prints.


        Obviously, there are many ways to add a color overlay to a monochromatic image. These methods work with images that are in RGB or CMYK (if you’ve converted your images to Grayscale, you should convert it back to a color mode).


        It’s worth noting that most monochromatic digital images are archived as RGB color files, and only converted to grayscale if there is a specific reason for doing so.


        Here are some of the simpler ways to add a tone or tint to your image:


        
          	In Adobe Camera RAW (pages 76–81) choose the Split Toning tab. Enter the same values for highlights and shadows.


          	In Adobe Lightroom (pages 82–97) use the Split Toning tab with the same values set for highlights and shadows.


          	In Photoshop, place a layer filled with your color above a photo on the background layer, and then adjust opacity and blending mode until you achieve

          the desired effect.


          	In Photoshop, add a Hue/Saturation adjustment layer to your photo, with

          the Colorize box checked.


          	In Photoshop, add a tint to a Black & White adjustment layer (see “Tinting with a B&W Adjustment Layer” on

          page 167).

        


        Note: You can also use programs like iPhoto and Picassa to add tints to your photos. In addition, many cameras will add tones to copies of your photos before you even download the images to your computer.

      


      
        Tinting with a Black & White Adjustment Layer
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          	Step 1: Add a Black & White adjustment layer as shown in Steps 1 and 2 on page 123.


          	
            After adding the Black & White adjustment layer, the Default preset becomes active in the Adjustments palette, converting the layer to a neutral monochromatic image.

          

        

      


      
        
          	Step 2: In the Adjustments panel, check Tint. This adds a virtual tone to the image.
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          	Step 3: Click the swatch to the right of the Tint check box to open the Color Picker window. Use this window to select the color of the tint that will be added to the image.


          	
            After selecting the tint, click OK to close the Color Picker.


            I suggest cutting the opacity of a Black & White adjustment layer used for the purpose of adding a tint or tone down to the 20% to 25% range so that the effect doesn’t seem overwhelming.
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        	I chose to add a slight sepia tint to this photo using a neutral Black & White adjustment layer with the Tint box checked to give the image a slightly antique look, and to recreate the “feel” of the original background.

      


      85mm macro, 0.4 of a second at f/24 and ISO 100, tripod mounted
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        	I wanted to give this high-key portrait of Christianna an old fashioned look. I started with the Silver Efex Pro Tin Type filter, then used Silver Efex Pro to add sepia tone and a vignette effect (the darkened corners of the image).

      


      32mm, 1/160 of a second at f/6.3 and ISO 3200, hand held

    


    
      [image: missing image file]


      [image: missing image file]


      
        
          	I photographed the Rodin sculpture garden at Stanford University at night. My idea after converting the photos of Adam (above) and Eve (right) to monochrome was to show the dreams these figures might be having—their shadows—as warmer than Adam and Eve themselves, figures lost in the mists of time. So I used a simple layer mask and gradient to tint the sculpture side in each image a cool blue and the opposite side shadow in warmer sepia tones.

        


        Both: 82mm, 4 seconds at f/11 and ISO 200, tripod mounted

      


      
        Split Toning


        Split toning means adding two different tones to an image. Classically, this was accomplished using chemical baths that impacted highlights and dark areas differently. Split toning is therefore often considered an effect that treats dark tones and highlights differently—but there is no reason to limit the effect to this traditional use.


        You can use the Split Toning tools available in Adobe Camera RAW and Lightroom to easily add a classical split toning effect—where the highlights and shadows have different added tints.


        In Photoshop, there are a number of different approaches to achieving a split toning effect. If you want the traditional split between highlights and shadows, you can use the Color Range window to make separate selections of highlight areas and shadow areas. With each selection, create a mask. Invert the mask to apply the desired tint only to highlights, and only to shadows using any of the techniques for applying color I’ve shown you.


        Another alternative is to use layers and masking to paint in whatever tones you want for visual effect. To heck with tradition! It’s good to know some photo history so the context of modern digital image making is clearer. However, why be limited by the chemical photo techniques of the past?
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        	The difference in feeling between the foreground trees and the mountains in the background made this winter Yosemite image seem a natural for split toning. I used a light, warm sepia tone for the highlights, and a darker sepia tone for the darker areas of the photo.

      


      27mm, 1/350 of a second at f/10 and ISO 100, tripod mounted

    

  


  
    


    
      Selective Color

    


    
      In Steven Spielberg’s mostly monochromatic film Schindler’s List, there’s one small bit of color: a girl in a red coat. We later recognize the girl on a pile of corpses because of the color of the coat she’s wearing.


      This visual device using selective color works in Schindler’s List because it is somewhat restrained. In other words, it’s easy to create a selective color effect in an otherwise monochromatic image, but seldom an effective creative choice because it can often seem unnatural and over the top. When you do try it, don’t overdo it!


      If you have a color version of a monochromatic image, it’s easy to sandwich the color and monochromatic versions together. You can then add selective color by masking out the color and selectively painting small areas of it back in.


      Depending on the situation, another approach is to literally paint-in the color you’d like. I always suggest doing this on a duplicate layer, in case you want to adjust the opacity at a later point.


      Either way, it’s easy to add spots of color to a monochromatic image. The hard part is making sure that the color adds cohesion to a black and white photo in a pleasing way and doesn’t seem to be just a gimmick.
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          	Live music is a big part of everyday life in Cuba. I photographed this cigar-smoking guitar player in the central square of a provincial Cuban city.

        

      


      
        
          	I converted the photo to black and white, but thought that something was missing. I decided to apply selective color via masking to the reflections in the sunglasses.

        

      

    


    [image: missing image file]  [image: missing image file]


    
      
        
          	Step 1: Make sure the black and white version is on the layer stack above the colored version in the Layers palette.
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        	Step 2: With the black and white layer selected in the Layers palette, choose Layer ► Layer Mask ► Reveal All to add a white layer mask to the black and white layer.


        	
          The white Reveal All layer mask makes the color layer beneath invisible.

        

      

    


    
      
        	Step 3: Select the Brush Tool from the Toolbox and set it to 70% Opacity and 70% Hardness (this is just a starting place for these settings, you can vary them as you paint). Make sure the Foreground color is set to black.
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      This is how the layer mask looks after painting

    


    
      
        	Step 4: With the layer mask selected in the Layers palette, paint on the image window in the sunglass area. As you paint, color will appear on the sunglass lenses. Make sure the edges of the glasses look crisp.
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        	There was no glow present at the end of the cigar in the color photo, but I thought I might as well add some burning embers to the mostly monochromatic version of the photo. I used the Brush Tool to paint in red at low opacity on a duplicate layer, suggesting a faint glow at the end of the cigar.
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        	The finished image is entirely in shades of gray except for the reflections in the sunglasses (taken from the color version) and a faint glow at the end of the cigar (painted in).

      


      200mm, 1/125 of a second at f/5.6 and ISO 200, hand held

    

  


  
    


    
      Hand Coloring

    


    
      Ever since the earliest days of photography people have been painting by hand in color on black and white photos. Originally this was a laborious process that started with a finished black and white print and added color with the idea of adding realism to the image. When color photography came along, some photographers continued hand painting their monochromatic prints for the value of the aesthetic statement they could make by applying a paint brush to their finished prints.


      With digital monochrome, it’s easily possible to add a hand color effect without having to be particularly good at painting.


      As I’ve mentioned, a black and white digital photo is a kind of virtual monochromatic image that dispenses with colors for aesthetic purposes. Imagine: creating a hand color effect on top of a monochromatic image is doubling the simulated nature of the ensemble. First, the monochromatic image is abstracted from a color file. Next, digital tricks are used to add back in some color, but this digital color looks intentionally applied—a digital artifice added to an already artificial construct. What fun!


      That said, the best monochromatic images for hand coloring are those that will exhibit internal visual cohesion and logic when the color is applied. Hand colored black and white photos may be intentionally “retro” but they needn’t be gauche. Look for imagery that has an antique look before hand coloring is applied, be selective about the application of color, and try to extend the anachronistic appeal of your hand-colored photo.
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          	I created the hand-colored effect by dragging the color version of the image back over the monochromatic version, adding a Hide All layer mask, and painting-in the model at reduced opacity. I did this twice, once with the layer blending mode set to Overlay and the second time with the blending mode set to Screen.
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          	Adding selective color back into the “tintype” photo of Christianna shown on page 169 creates an interesting effect that works well with the idea of a tintype, since tintypes historically were often painted on.

        


        32mm, 1/160 of a second at f/6.3 and ISO 3200, hand held
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          	Along the Malecón, the boulevard that runs beside the ocean in Havana, Cuba, waves often crash across the road. Building maintenance has been deferred, and a number of structures fall down every year. During a storm, I snapped this telephoto view of the architecture of Old Havana behind the Malecón at a high ISO. I wanted to convey the decayed aspect of this architecture, so I converted the image to monochrome.
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          	The monochromatic view was interesting, but I wanted to add emphasis and a sense of how things had faded in the years since the Cuban revolution. What better metaphor than fading color? I lightened the image and applied a selective layer of color to the photo, helping to make the image look antique.

        


        Both: 200mm, 1/60 of a second at f/5.6 and ISO 400, hand held

      

    

  


  
    
      

    


    
      Using LAB Color

    


    
      I’ve mentioned using color information in a capture to create interesting effects in black and white. This may seem paradoxical—but it’s not because color information can be really valuable when it comes to making interesting black and white images.


      Color information is used as part of the more flexible black and white conversion processes—for example, the color sliders in the Channel Mixer are used to determine the composition of a monochromatic conversion. The suggestion here is a little different: radically manipulate the image in color before conversion to get spectacular black and white following conversion.


      The LAB color space is particularly useful for this kind of work because LAB separates black and white from color information. This means that you can do downright radical things to the monochromatic information in your color image, recombine the color and black and white, then convert to color—ending up with a work product that is inarguably different from your starting place, and in some cases markedly superior.


      Let me back up for a little and explain what you need to know about the LAB color space. Then I’ll show you some examples of how techniques that use LAB color can improve your black and white results.


      Understanding LAB


      A color model—sometimes called a color space—is the mechanism used to display the colors we see in the world. You are probably familiar with two of the most common color spaces, RGB and CMYK. The RGB—Red, Green, and Blue—color space is used to display photos on a monitor. The CMYK—Cyan, Magenta, Yellow, and Black—color space is primarily used for printing books, magazines, and other materials.


      You may not know as much about the LAB color space, which is structured in three channels:


      
        	The L channel contains luminance information. Luminance is another way of referring to the black and white data in a photo. In the Photoshop Channels palette, the L channel is called the Lightness channel.


        	The A channel provides information about greens and magentas.


        	The B channel provides information about yellows and blues.

      


      I’m not going to go into the details of the theory of LAB, or many of the aspects of how best to work with LAB. You could write a book on these topics (and, in fact, books have been written).


      What you need to understand is that the black and white information is completely separate from the color information. This means that you can operate on the black and white data without having any impact on the color in an image. Specifically, if you want to swap blown-out highlights for shadows—and, in some cases, you might—LAB is the way to go about it.


      

    


    
      By the way, it is worth mentioning that you can’t actually do anything with an image in LAB. Printers aren’t calibrated for LAB, and there’s no such thing as a LAB JPEG that you can display on a photo sharing site. Before you can use an image that you’ve worked in LAB, you’ll need to convert it back to RGB or CMYK.


      Converting a photo into the LAB color space only takes a second in Photoshop. There are two ways to go about it as shown below.
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        	To convert to LAB color:


        	
          Choose Image ► Mode ► Lab Color


          or


          Choose Edit ► Convert to Profile. The Convert to Profile dialog will open. Select Lab Color from the Profile drop-down list in the Destination Space area. Make sure Relative Colormetric is selected from the Intent drop-down list and that Use Black Point Compensation is checked.


          It’s probably better to use the Edit ► Convert to Profile method because that way you can be sure the right options are used.
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        	Once you’ve converted an image to LAB mode, take a look at the Channels palette. There you’ll see the three channels: Lightness, or L, containing the black and white data; and the A and B channels for the color information.
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          	Top: Since this capture of a green Echinacea bud was essentially one color, it was a good candidate for black and white conversion.


          	Below: I used Black & White adjustment layers in Photoshop for a “normal” conversion of the image to black and white. However, I wanted more from this conversion.

        


        Both images: 85mm macro, 1/2 of a second at f/16, tripod mounted

      


      
        Flower Effects


        The small, green flower bud to the left is a young Echinacea, sometimes called a Cone Flower. I knew I had to photograph it—and I realized that the image was essentially only one color: green. To me, this meant that I would end up creating a black and white photo. However, a standard conversion to black and white (below left) using Black & White adjustment layers yielded unexciting results.


        Looking at the black and white photo, I thought it was acceptable, but I longed for an image with more punch and pizzazz. So I decided to go back to the color photo in Photoshop to increase the contrast in LAB before converting to black and white. The increased contrast would make for a more interesting monochromatic image.

      


      
        Inverting the L Channel
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          	Step 1: Convert the image to the LAB color space by choosing Image ► Mode ► LAB Color from the Image menu (see Step 1 on page183).

        

      


      
        
          	Step 2: In the Channels Palette, select the Lightness (L) channel. This channel holds all

          the luminance, or black and white, information

          in a photo.
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          	Step 3: With only the L channel selected, invert the black and white information in the photo by choosing Adjustments ► Invert from the Image menu.


          	
            The color image appears with whites and blacks “inverted”—a sometimes odd look that can be quite striking.

          

        

      


      
        
          	Step 4: Convert the image back to RGB by selecting Image ► Mode ► RGB.
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          	Step 5: Convert the image to black and white using Black & White adjustment layers. (For more about converting using adjustment layers, turn to pages 122–127.)


          	
            The effect here is pretty cool and a bit like solarization (see pages 200–203 for more about solarization). But looking at the result made me somewhat dizzy. I wanted a black and white effect that was striking, but maybe not quite so opposite in luminance levels to the original photo.

          

        

      


      

    


    
      
        Equalizing LAB Channels
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          	Step 1: Starting with the original color photo, convert the image to the LAB Color space by choosing Image ► Mode ► LAB Color from the Image menu (see Step 1 on page 183).
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          	Step 2: With all the channels selected, choose Image ► Adjustment ► Equalize.


          	
            Equalization adjustments push tonal values towards the maximum so blacks become blacker and whites become whiter. The color image of the Echinacea (below right) now has more contrast.


            (As a different technique, you could select just one channel and equalize it. Try it and see what effects you get.)

          

        

      


      
        
          	Step 3: Convert the image back to RGB by selecting Image ► Mode ► RGB.
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          	Step 4: Convert the image to black and white using Black & White adjustment layers. (For more about converting using adjustment layers, turn to page 122.)


          	
            The two LAB adjustments shown on pages 185 and 186—inverting and equalizing—are very simple moves. A small amount of tweaking in LAB color can give you many options when you convert your photos to monochrome.
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          	Here is the resulting image after equalizing the LAB channels and converting the image to black and white using a straightforward Black & White default adjustment layer for the conversion. This is the best of the three black and white versions of this photo.

        


        85mm macro, 1/2 of a second at f/16, tripod mounted

      

    


    
      
        Swapping Tonalities


        Whites not white enough? Blacks not black enough? You can use LAB color moves and blending modes to adjust your way out of these problems and avoid monochromatic blandness.
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          	For example, take the shot of lace underwear on a model shown here. I intentionally overexposed the image in the hope of getting an interesting abstraction, but wasn’t very excited with the immediate results.
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          	Converting the photo to LAB color and inverting it produced something interesting, but I really wasn’t interested in an image on a black background. (To find out how to invert LAB channels, turn to page 185.)


          	
            What I wanted to do was increase the graphic quality of the initial image, not transform it beyond recognition.
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          	Next, I equalized the image in LAB color to get an expanded tonal range. (For more about equalizing LAB channels, turn to page 186.)


          	
            This is better because it exaggerates the tonal range of the image, but I still wanted more contrast and tonal range before converting to black and white.

          

        

      


      


      
        Using Blending Modes


        After working on the color image, I had three versions of the lace underwear photo:


        
          	The original, overexposed version

          (top left)


          	The LAB color inversion on a black background (middle left)


          	The LAB equalization with the expanded tonal range (bottom left)

        


        In Photoshop, a blending mode controls the way the pixels from one layer blend with the pixels on the layers beneath them. I decided to put the three versions together as layers in one image and then use blending modes to mix the tonalities of the three layers.
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          	Step 1: Convert the three versions of the image back to RGB, if necessary, by selecting Image ► Mode ► RGB.

        

      


      
        
          	Step 2: Use the inversion on the black background as the bottom layer for a layer stack. Rename the layer “Inverted.”
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          	Step 3: Hold down the Shift key and drag the equalized version from its image window on top of the “Inversion” layer. Name this layer “Equalized.” (For more about dragging images from one window to another, turn to page 101.)

        

      


      
        
          	Step 4: With the “Equalized” layer selected in the Layers palette, select Difference from the blending mode drop-down list on the Layers palette. This blends the two layers, adds more contrast to the image, and puts the lace underwear back on a white background.
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            	Step 5: Drag the original overexposed version on top of the “Equalized” layer. Name this new layer “Original.”

          

        


        [image: missing image file]


        
          
            	Step 6: With the “Original” layer selected in the Layers palette, select Multiply from the blending mode drop-down list on the Layers palette. This blends the “Original” layer with the layers underneath adding more subtle toning.

          

        


        
          
            	Step 7: Choose Layers ► Flatten to merge the three layers down into one layer.
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          	Step 8: Use a default Black & White adjustment layer to convert the image to monochrome. (For more about this, turn to page 122.) The resulting monochromatic image is shown on page 191.
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            	I started with the inverted image and combined it with the equalized image. I then blended the original capture over the adjusted versions to come up with this stylized monochromatic version.

          


          200mm, 1/160 of a second at f/6.3 and ISO 3200, hand held

        

      

    

  


  


  
    
      Duotone and Tritone Effects

    


    
      Duotone was a printing process that created rich monochromatic imagery using two colors or inks—with black being one of the colors. Each color was used to ink a separate plate. The plates were pressed in sequence in perfect register to create the printed monochromatic image on the paper.


      As you probably imagine, tritone printing involves creating monochromatic imagery with black ink and two other colors. Why stop with three? It’s perfectly possible—although expensive and anachronistic—to create monochromatic imagery with four inked plates (called a quadtone). How about that? You can use four colors, and still end up with something that is “seen” as black and white. Note that—in the case of a quadtone—these are not process colors, they are spot colors. In other words, the four colors are not used in combination to create a complete spectrum of colors. The inks are used one at a time on four different plates.


      Today, you won’t find any authentic duotone, tritone, or quadtone printing—except perhaps in one or two fine art print making ateliers. But you will find a mechanism for simulating this process from grayscale images in Photoshop.


      Converting your RGB images to grayscale and then converting the grayscale images to duotone or tritone can be a way to produce rich monochromatic prints using a modern inkjet printer. However, making fine art prints is beyond the scope of this book. But I do use the Photoshop duotone functionality for another reason: to add an effect to my monochromatic imagery where it is appropriate. Using the duotone effect this way is essentially a digital simulation of the old printing process. Probably the effect that is closest to this is split toning (see pages 170–173).
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        	Step 1: Start by converting your photo to grayscale (if it is not already in grayscale mode) by choosing Image ► Mode ► Grayscale from the Photoshop menu. A Photoshop dialog may appear, asking whether you want to discard color information. This is okay because your monochromatic image should not have any color information, so click Discard.


        	
          If your image is in 16-bit mode, you will need to convert it to 8-bit mode by choosing Image ► Mode ► 8 Bits/Channel. Otherwise, the Duotone option on the Image ► Mode menu will be grayed out and unavailable.
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        	Step 2: Choose Image ► Mode ► Duotone. The Duotone Options dialog will open.


        	
          The Duotone Options dialog appears deceptively simple, but it is actually a powerhouse that hides a wide range of creative options.


          If you check out the Preset drop-down list, you’ll find a large list of possible duotone, tritone, and quadtone combinations that you can use as a starting place for your effect. Though, my preference is to create my own color combinations. A few preset combinations are shown below.


          Note that once you come up with an “ink” combination that works for you it can be saved and retrieved as a custom preset.
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          	This is a duotone preset using black and purple inks.
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          	This is a quadtone preset using black, cyan, magenta, and yellow inks.


          	
            Don’t be confused by the CMYK inks. They are used here as spot colors, not as the process colors that make up the CMYK color space.
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          	This is a tritone preset using black, orange, and brown inks.
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        	Step 3: For this example, create a tritone by selecting Tritone from the Type drop-down list. This will let you use three color inks for the effect.


        	
          The default setting in the Duotone Options dialog is Monotone with black as the ink choice. You can change this default color, if you wish, though of course your image will also change color.

        

      

    


    
      
        
          	Step 4: Leave the first ink choice as the default black. Notice that a color swatch of the black appears to the left of the color name.
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          	Step 5: Click the color swatch for Ink 2 (which looks like a white square) to access the Color Libraries dialog.
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          	There are many color libraries to choose from. It’s fun to look through the extensive list of colors available, but I’ll confess to a weakness for the Pantone metallic coated “book”—perhaps because I rarely get the chance to specify such an expensive option in “real life.”
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        	Step 6: The colors you pick should all be pretty different from one another for the most impact. For this example, choose Pantone 871 C from the Pantone metallic coated book. The ink is a metallic gold.

      

    


    
      
        	Step 7: Click OK to close the Color Libraries dialog and return to the Duotone Options dialog.

      

    


    
      
        	Step 8: Click the color swatch for Ink 3 to access the Color Libraries dialog.
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        	Step 9: For the third ink in this example, choose Pantone 877 C from the Pantone metallic coated book. The ink is a metallic silver.


        	
          Now that the three inks have been selected, it’s time to control how the inks are applied by adjusting the curve setting for each ink.

        

      

    


    [image: missing image file]  [image: missing image file]  [image: missing image file]


    
      
        
          	Step 10: To adjust the curve for the Black ink, click the curve box to the left of the Ink 1 color swatch. The Duotone Curve dialog opens.


          	
            Drag the curve line to adjust how the ink is used in the image. Moving the curve down and to the left decreases coverage of the ink in the tonal areas indicated by the bar at the bottom of the graph. Moving the curve up and right increases coverage.


            There’s no substitute for experimenting, so play with the curve and see how it affects your image.

          

        

      


      
        Drag the curve to adjust ink coverage. You can click on the curve to add handles.

      

    


    
      
        	Step 11: Adjust the curves for Ink 2 and Ink 3 using the directions in Step 10.
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        	After you adjust the curve for each ink and close the Duotone Curve dialog, a thumbnail of the curve appears in the curve box associated with each ink.
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        	Step 12: When you are satisfied with the results, click OK to close the Duotone Options dialog. The color mode is shown in the title bar of the image.


        	
          Depending on what you plan to do with the photo, you may need to reconvert the image back to RGB or CMYK from the Duotone, Tritone, or Quadtone color mode. Once this reconversion has happened, the image can no longer be used for duotone printing with the “inks” you specified. Instead, the color model simulates the colors of the combined inks you specified for regular printing or display on the Web.
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        	This studio portrait of a model struck me as reminiscent of an old-fashioned pin-up, so I decided to increase the antique effect by adding the simulation of tritone reproduction using gold and silver Pantone metallic inks. This makes the model’s skin glow and adds a hint of silver to the highlights in the photo.

      


      31mm, 1/100 of a second at f/5.6 and ISO 100, hand held

    

  


  


  
    
      Pinhole Effect

    


    
      In “real life” pinhole photography is photography without a lens. Instead of a lens, light passes through a tiny hole; the light passing through this hole forms the image in the camera.


      The optics of the pinhole effect were understood as early as the fifteenth century Renaissance, and were described by Leonardo da Vinci and others. The optical effect was used to invent the camera obscura—a dark room that projects an image of the surroundings on the wall using a pinhole. The camera obscura is one of the key discoveries leading up to the invention of photography; if you get the chance, don’t miss the opportunity to visit one.


      Today, it is possible to purchase pinhole cameras, or to make them from a kit. Working pinhole cameras have been constructed from shoe boxes, tin cans,

      and even odder materials.


      If you are interested in retrofitting a DSLR to work like a pinhole camera, a great choice is the Pinhole/Zone Plate optic associated with the Lensbaby Composer.


      The general characteristics of a pinhole photo are great depth-of-field, overall softness, darkened edges, and brightness

      in the center of the image. To start with

      the simulation of this effect, I chose an image entirely in focus so depth-of-field wasn’t an issue.
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        	Step 1: With the “Background” layer selected, choose Layer ► Duplicate to make a copy of the layer. Name this duplicate layer “Soft Focus.”


        	
          For each step in creating the pinhole effect, work on a duplicate layer. That way, you can go back to the original image if you make an adjustment you don’t like.
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        	Step 2: With the “Soft Focus” layer selected in the Layers palette, choose Filter ► Blur ► Gaussian Blur to open the Gaussian Blur dialog. Set the Radius to 3 to add an overall soft focus effect, and then click OK to apply the blur to the layer. (For more about soft focus, turn to page 192.)

      

    


    
      
        	Step 3: With the “Soft Focus” layer selected in the Layers palette, choose Layer ► Duplicate to make a copy of the layer. Name this duplicate layer “Vignette.”
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        	Step 4: Choose Filter ► Distort ►Lens Correction to open the Lens Correction dialog. Move the Amount slider towards darken in the Vignette area. This darkens the edges of the layer to make the edges look like an old-time pinhole photo. Click OK when you are pleased with the results.

      

    


    
      
        	Step 5: With the “Vignette” layer selected in the Layers palette, choose Layer ► Duplicate to make a copy of the layer. Name this duplicate layer “Brighten Center.”

      

    


    
      
        	Step 6: With the “Brighten Center” layer selected, choose Layer ► Layer Mask ► Hide All to add a black layer mask to that layer. In the Layers palette select Screen from the blending mode drop-down list.
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        	Step 7: Use the Brush Tool to paint in the central area of the image window. (For more about layer masks and painting, turn to

        page 98.)


        	
          This will lighten the central area of the image, just like a pinhole photo.

        

      

    


    
      
        	Step 8: Convert the image to monochrome using a Black & White adjustment layer set to the Max Black preset, and then add a dark sepia tint to make the image seem antique (see page 166).
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      	The soft, dreamy look of this vista of the Cathedral Spires behind Bridalveil Falls in Yosemite Valley struck me as perfect for the pinhole effect.

    


    112mm, 1/500 of a second at f/10 and ISO 200, hand held

  


  


  
    
      Solarization

    


    
      Solarization in photography reverses blacks and whites. It is also called the Sabattier effect after French photographer and scientist Armand Sabattier, who described the effect in 1862. In the chemical darkroom, solarization was achieved by re-exposing an already exposed negative or print to light before development was finalized.


      Since solarization reverses—or partially reverses—dark and light tones, this effect will work well for images in which the contrasts between blacks and whites are an important part of the overall composition.


      In the Photoshop darkroom, there are a number of ways to achieve a simulated solarization effect. One of my favorites is to convert the image to LAB, followed by an inversion of the L channel. (See pages 182–193 for more about inverting LAB channels.) This step should be taken prior to the monochromatic conversion.
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        	Step 1: Starting with the original color image, choose Layer ► Duplicate to make a copy of the layer. Name this duplicate layer “Inversion.”

      

    


    
      
        	Step 2: Convert the image to the LAB Color space by choosing Image ► Mode ► LAB Color from the Image menu (see Step 1 on page 183).
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        	Step 3: With the “Inversion” layer selected in the Layers palette, click the Lightness channel in the Channels palette to select it.
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        	Step 4: Choose Image ► Adjustments ► Invert

        to invert the Lightness channel. This creates a fairly conventional solarization effect.

      

    


    
      
        	Step 5: Click Lab at the top of the Channels palette to select all the channels.
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        	Step 6: Choose Image ► Adjustments ► Invert to invert all the channels.


        	
          This double inversion can be used as the basis for a partially solarized monochromatic image.

        

      

    


    
      
        	Step 7: Convert the image back to RGB by selecting Image ► Mode ► RGB.
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        	Step 8: With the “Inversion” layer selected in the Layers palette, convert the layer to monochrome using a Black & White adjustment layer. Click the Auto button in the Adjustments palette to set the conversion values. (Turn to page 124 for details on how to do this.)
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        	Using studio lighting, I slightly underexposed the image to create a black background and extend the sense of abstraction surrounding the model. I created a partial solarization effect by inverting first the L channel in LAB color, and then inverting the entire image. Following the second inversion, I converted back to RGB and then converted to monochrome.

      


      95mm, 1/200 of a second at f/9 at ISO 100

    

  


  
    
      Using Curves to Solarize an Image


      There are a number of other approaches to a post-processing solarization effect that you can experiment with besides LAB inversions. I do suggest you keep your image in color mode until after you have applied your solarization effect.


      One of the easiest ways to solarize an image is to use the Photoshop Solarize filter by choosing Filter ► Stylize ► Solarize.


      While this filter gives you a perfectly decent Solarize effect it doesn’t provide any options. A more flexible approach that is fun to play with is to use a Curves adjustment layer.
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        	Step 1: Starting with the original color image, choose Layer ► Duplicate to make a copy of the layer. Name this duplicate layer “Solarize.”

      

    


    
      
        	Step 2: With the “Solarize” layer selected in the Layers palette, select Layer ► New Adjustment Layer ► Curves or click the Curves button on the Adjustments palette.
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        	Step 3: Using the curves window in the Adjustments palette, drag the handle at the upper right corner down to the baseline. This is the end of the curve that adjusts the white point in the image. Make sure the middle of the curve hits the center of the window, so that a triangle along the bottom baseline is formed.
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        	Step 4: Use a Black & White adjustment layer to convert the image to monochrome. (To find out how to use Black & White adjustment layers, turn to page 122.)


        	
          The monochrome result is shown on page 206.

        

      

    

  


  [image: missing image file]


  
    
      	The solarization effect emphasizes the contrast between the water drops on this spider’s web and the background. Note the thin white line around the central water drop—this is one of the characteristics of solarization.

    


    200mm macro, 24mm extension tube, 1/5 of a second at f/16 and ISO 200, tripod mounted
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        	To solarize the photo of the chambered Nautilus shell shown on page 13, I used the Solarization filter that is included in Nik Software’s Color Efex Pro filter pack. As you can see, the black background became white and the internal elements of the shell are rendered almost as chrome.

      


      50mm macro, 8 seconds at f/32 and ISO 100, tripod mounted
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        	The complex and sensuous curves in this image of a small Hellebore struck me as good candidates for solarization because the primary interest in the composition centered on the distinction between light and dark shapes.

      


      100mm macro, 1.6 seconds at f/22 and ISO 100, tripod mounted

    

  


  
    Soft Focus

  


  
    While some schools of photography preach that everything in a photograph from end-to-end should be razor sharp, other photographers have always intentionally created images where the focus is soft, either in whole or part.


    A great thing about the world is that it is big enough to have room for many schools of visual thought—and many different kinds of photos have aesthetic validity.


    Personally, I try not to prejudge photos based on whether or not I like—or use—a given technique in my own work. Seeing a technique that I don’t use often but that’s put to good use is always inspiring for my own work. That said, I prefer soft focus photos where the absence of hard edges is integral to the composition and makes visual sense, rather than photos that use soft focus to hide flaws in the underlying subject. The choice, however, is yours: when soft focus is in your toolbox you can use it to hide wrinkles, or to create novel compositions—or both.


    There are many ways to create soft focus effects with your camera. Some of these involve no special equipment, but can be tricky to get just right; for example, throwing your lens slightly out of focus, or moving the camera slightly.


    Another approach is to add a filter to the end of your normal lens that will soften the photo (a clear filter coated with a soapy solution, vaseline, or other “schmutz” works for this), or to use a special “soft focus” lens—essentially, as I’ve joked, turning an expensive interchangeable lens DSLR into a cheap plastic camera.


    An interesting variation is selective soft focus. This means that everything in an image is soft except a relatively small area—often the center. A crisply focused lens set to a wide open aperture (so there is low depth-of-field) can achieve this effect, as can some filters. A great tool for controlled and selective focus in-camera is the Lensbaby, a lens that can be moved to alter the point of focus and the degree to which the surrounding areas are out of focus.
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      	I used the sweet spot—the area that is in focus when creating an otherwise soft focus Lensbaby image—to highlight a single apple blossom in this selective focus image.

    


    Lensbaby Composer, standard optic, 1/8000 of a second using f/8 aperture ring at ISO 400, hand held
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      	This intentionally soft focus effect of sunlight in a forest glade was created in-camera using a plastic lens.

    


    
      Adding Soft Focus


      Didn’t think to create a soft focus capture when you took the photo? Don’t worry, no problem. It’s pretty easy to create soft focus effects after the fact in the Photoshop darkroom, including selective soft focus.


      Of course, you can do just about anything in Photoshop—and there are usually many ways to do those many things. But you need to know where you are headed. That’s why I’ve started this section with some examples of soft focus effects created in the camera—these provide an idea for what kind of effects you can create in post-processing that will have visual credibility.


      Probably the easiest way to add a soft focus effect to a photo is to use the Gaussian Blur filter. For example, I took a number of fairly standard photos of a model holding her hands above her head, and wanted to add some interest to the portrait.
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            	Step 1: Choose Layer ► Duplicate Layer to create a copy of the Background layer. Name this new layer “Blur.”


            	
              I recommend always adding blur on a duplicate layer in Photoshop. That way, you can always go back to the original Background layer if you don’t like the effect or want to start over.

            

          

        


        
          
            	Step 2: Choose Filter ► Blur ► Gaussian Blur. The Gaussian Blur dialog opens.
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          	The head shot of this model with her arms above her head needs a way to draw viewer interest into the photo and focus attention on her face.

        

      

    


    
      Lensbaby Composer, Plastic Optic, 1/800 of a second using f/4 aperture ring at ISO 400, hand held
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        	Step 3: Use the Radius slider to set the blur. The higher the Radius setting, the more blur—and blur translates to a soft focus effect. I suggest trying 24 pixels. If this proves to be too much, you can always take down the strength of the soft focus effect by reducing the opacity of the layer that is blurred using the Opacity slider in the Layers palette.


        	
          Click OK when you are satisfied with the amount of blurring.
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        	Step 4: With the “Blur” layer selected in the Layers palette, choose Layer ► Layer Mask ► Reveal All

        to add a white layer mask to the “Blur” layer.

        (For more about layer masks, turn to page 98.)
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      	Step 5: Select the Brush Tool from the Toolbox and make it soft so the edges feather as you paint. Set the Hardness to 0% and the Opacity to 50%. You can adjust these settings as you paint.

    

  


  
    
      	Step 6: Paint on the face to hide the “Blur” layer and reveal the sharp Background layer underneath.
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      	The finished image really focuses the viewer on the model’s face.

    


    200mm, 1/125 of a second at f/7.1 and ISO 100, hand held

  


  


  
    
      Adding and Reducing Noise

    


    
      Just as grain was always present in film, noise—digital static in a photo—is always part of every digital image, although there may be so little noise that depending upon the magnification you may not really be able to see it.


      Your attitude towards noise should depend upon the aesthetics of a photo and the effect you are trying to create. Reducing noise inherently reduces sharpness, and some images need the “bite” that only noise can provide—but too much noise can be inherently unpleasant looking.


      Photoshop provides noise addition and reduction tools, found by selecting Filter ► Noise. In addition, a number of third-party plugins and filters provide sophisticated noise processing options. You’ll need to refer to a book such as my Photoshop Darkroom for detailed instructions about how to use this kind of software.
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        	With this studio shot, I used selective noise reduction in post-processing to add apparent smoothness to portions of the model’s face. It is not often understood that noise reduction inherently softens and smooths. I used selective noise reduction to take advantage of this effect where it was needed without also softening hair and eyelashes.

      


      200mm, 1/200 of a second at f/6.3 and ISO 200, hand held


      [image: missing image file]


      
        	To add more of a tactile sense to this abstract composition of a shadow within the frames of the lines of a building, I chose to up the noise levels in the lower left rectangle of the image.

      


      26mm, 1/250 of a second at f/16 and ISO 200, hand held

    

  


  


  
    Film Effects

  


  
    Because digital camera sensors capture color information, creating a digital black and white photo is to some extent an act of creative anachronism—some would even say nostalgia. It’s therefore not surprising that digital monochromatic imagery is often made after study of film imagery. Also creative choices are sometimes presented in the context of the film comparison.


    For example, do vintage grainy photographs taken on the streets or in coffee houses using high speed black and white film during the 1960s appeal to you? Then why not see if you can replicate this very distinctive look using digital tools.


    Using Photoshop, the goal of reproducing the intentionally retro look of almost any old-time film stock can clearly be achieved. Some film effects are not hard to create, others take quite a bit of effort and planning. In any case, the Photoshop steps involved are beyond the scope of this book.


    Fortunately, there are a number of third-party Photoshop filters that offer an array of film effects out of the box. One of the best of these, Silver Efex Pro, lets you choose from an extensive menu of film types for your simulation after you’ve first selected a basic monochromatic conversion strategy. Film effects are grouped depending upon their sensitivity (ISO) and you can choose whichever effect you think works best with your photo.
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      	I wanted to give this “noir” image of the streets of San Francisco a gritty look. I converted the color photo to monochrome with Nik’s Silver Efex Pro using a neutral conversion filter. Next, I chose a high ISO film effect to add grain and contrast to the photo. I finished the image off with a split toning effect (see pages 170–173).

    


    60mm, 3 seconds at f/10 and ISO 100, tripod mounted

  


  


  
    Infrared Camera Conversions

  


  
    Infrared radiation (IR) is electromagnetic radiation with a wavelength that is longer and a frequency that is shorter than that which produces visible light. Capturing imagery using IR has forensic and scientific applications; however, there are currently no production IR cameras available.


    The alternatives are to use a filter, or to retrofit a digital camera (you can also simulate IR in post-processing, as explained on pages 222–223). An IR filter appears either black or very dark red, letting IR pass through it while blocking visible light. One problem with this kind of filter is that since it blocks visible light it can be very hard to see and compose through if you are using a DSLR. For superior results, I’d recommend converting an existing camera (see page 235 for information about doing this). An older model DSLR or a compact camera with a manual exposure mode that is capable of RAW captures is probably best for IR retrofitting.


    Most digital sensors, particularly older ones, have considerable inherent sensitivity to IR (as well as UV, the radiation at the opposite end of the visible spectrum). Retrofitting in part involves removing any filters that blocked IR. This may change the distance from the back of a lens to the sensor, and therefore its focusing. So it’s a good idea to have the lens you will use with your IR camera calibrated for the retrofitted camera at the same time it is modified.


    There’s nothing inherently monochromatic about an IR capture, although IR captures will typically not exhibit a great dynamic range. RAW captures often have a kind of pinkish hue at default settings.


    Personally, I prefer to present my IR captures in black and white, with the expectation that I’ll be converting not-very-colorful RAW captures to monochrome using the techniques shown in this book.


    If you don’t want to go to the trouble of converting your infrared images to monochrome each time, it is possible to get your camera equipped with a black and white IR filter at the time it is retrofitted. However, I feel that this limits rather than expands your options.


    What does an IR capture look like? This can be hard to know until you experiment in a given situation—one of the great things about digital IR capture is that you get immediate feedback on the LCD screen. Foliage appears white rather than green. The more plants are growing, the whiter they appear. Skies are dark, although clouds can be quite dramatic. Depending on the lighting you use, portraits can be very unusual with pale, milky skin and dark, dark eyes.


    Infrared and monochrome go very well together. If you’ve never tried to make a photo using a light spectrum not visible to the naked eye, this may be just the time for you to experiment with one of the most creative effects available to black and white photography.
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        	A RAW infrared image in color is shown next to the in-camera almost monochromatic JPEG version in Adobe Bridge (see page 226 for the final version of this photo following black and white conversion).
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        	Here is the infrared image shown with default “As Shot” settings in ACR. The white balance of this image is 2000 degrees Kelvin, the lowest possible temperature on the ACR scale.
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        	On the slopes of Mount Tamalpais, California, my decision to use infrared capture added drama to this end-of-the-day image of sunset and rain squall over the distant Farallon Islands.

      


      34mm, 1/6 of a second at f/4.5 and ISO 200, tripod mounted


      [image: missing image file]


      
        	Lush, growing foliage shows up as brightly white in an infrared capture, like the lichen and background forest in this shot.

      


      65mm, 1/13 of a second at f/9 and ISO 200, tripod mounted
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        	Infrared macro captures of flowers can produce surprisingly nuanced imagery, with areas that appear to be sharp and in focus contrasting to soft areas. Whatever the original color of the flower—this Camellia was vibrant red—it is likely to appear mostly white in the infrared capture.

      


      50mm macro, 6 seconds at f/32 and ISO 200, tripod mounted


      [image: missing image file]


      
        	I used a high-powered studio strobe to make this infrared portrait of a model. Compared to the actual tones of her skin, the infrared rendering when lit by direct flash made her skin look pale and almost ghost-like. The infrared rendering of the model’s skin was quite different when I didn’t use flash (see pages 228 and 229).

      


      70mm, 1/160 of a second at f/8 and ISO 200, hand held
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        	This hand held infrared capture made using available ambient light and a high ISO has a dream-like effect.


        	
          IR captures look different depending upon the light source and it is hard to know how an image will come out in advance. So with IR, as with many other kinds of photography, the best thing you can do is experiment, play, and try lots of different lighting.

        

      


      1/50 of a second at f/6.3 and ISO 1600, hand held


      [image: missing image file]


      
        	The visual impact of infrared can sometimes be quite a surprise. With this high-ISO capture the model’s face appeared far brighter than the rest of her body.

      


      1/60 of a second at f/5.6 and ISO 1600, hand held
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        	This is a photograph of the abandoned naval shipyard at Mare Island, California. During World War II, more than 40,000 workers built the battleships here that waged the war in the Pacific theater. An infrared capture helped me convey the eeriness and desolation of the scene.

      


      18mm, 1/160 of a second at f/6.3 and ISO 200, hand held

    

  


  
    
      


      
        Infrared Conversion without an IR Camera

      


      
        Want to make digital infrared photos but don’t have an extra camera lying around to convert to IR (or the extra couple of hundred bucks to pay for the conversion)?

        No problem!


        Many effects can be fairly easy to simulate in post-processing, and monochromatic IR is one of them. Of course, first you have to know what a “real” infrared capture looks like—so you know what you are aiming for. So if you want to create your own simulated IR captures without a camera converted to infrared, start taking a look at as many IR photos as you can find

        (and check out pages 220–229).


        A good starting place for converting a photo into an IR look-alike is to use a Black & White adjustment layer with the Infrared preset in the Adjustments palette. (See pages 122–129 for more about using

        Black & White adjustment layers

        for monochromatic conversions.)
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            	Consider this image of Mount Diablo and the California coastal range in the spring. Infrared conversion renders foliage as white—and the more green and growing the foliage the whiter it becomes under infrared.

          


          [image: missing image file]  [image: missing image file]

        


        
          	Here’s the image after applying a Black & White adjustment layer using the Infrared preset. Bear in mind that the Infrared preset gives you a pretty good starting place for creating a digital image that looks like it was an IR capture—but it is only a starting place. You’ll almost certainly need to tweak the image further to come up with a realistic and plausible IR rendition.
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          	To create the finished simulation of an IR image, I started with a Black & White adjustment layer using the Infrared preset shown to the left. However, this preset did not convert the foliage to white as it would have been in a “real” IR capture. So I added a LAB color inversion (see pages 185–188) to turn the dark trees white, and then painted in this effect using a layer and layer mask (see pages 98–107).


          	
            As you can see, it’s not that hard to simulate a reasonably plausible infrared capture, starting with a Photoshop Black & White adjustment layer using the Infrared preset.

          

        


        46mm, 1/250 of a second at f/8 and ISO 100, hand held
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      	The vast but surprisingly gentle undulations of this geologic formation reminded me of fabric. I waited for even light in the late afternoon when the vista was in shadow and used a small aperture setting to get maximum depth-of-field so the foreground would be in focus along with the rest of the rock formation. The drama of the image derives at least in part from the lack of contrast from white to black in the scene.

    


    28mm, 4 seconds at F/22 and ISO 200, tripod mounted

  


  
    


    
      
        Notes and Resources

      


      
        Simple B&W Conversion Programs


        A number of programs that are either free or very inexpensive let you do straightforward black and white conversions from color captures. Check out Digital Black & White Roadmap on pages 68–69 to understand where this kind of software fits in the scheme of creative digital black and white photography.


        For example, iPhoto, Picasa, and Photoshop Elements each provide black and white conversion for JPEG photographs that’s easy to use—although not as powerful, subtle, or capable of tonal gradations as the methods that are the focus of this book. This kind of software is perfectly adequate for some kinds of black and white photography, depending upon your goals and what you want to do with the photos.


        You won’t find it very hard to convert your files using this kind of tool, although the results may fall short in terms of high quality creative expressiveness. You can easily find directions online. For example, to find out more about black and white conversions using Picasa, simply search Google for Picasa black white conversion.


        Learning Photoshop


        Creative Black & White: Digital Tips & Techniques is not a book about Photoshop—it’s a book about learning to see the world in monochrome. That said, some of the book is concerned with finding the best strategy in Photoshop to convert specific images to black and white in a way that lives up to your expectations when the image was pre-visualized.


        I’ve tried to include enough Photoshop information so that you can use the techniques with your own photos.


        At the same time, I haven’t included information on basic Photoshop techniques. If you need to brush up on Photoshop concepts and techniques, I think you might find one of my other books helpful. Please check out The Photoshop Darkroom: Creative Digital Post-Processing (Focal Press).


        Sensor Size and Focal Length


        Not all sensors are the same size. The smaller the sensor, the closer a given focal length lens brings you to your subject. For example, if a sensor has half the area of another sensor, then a specific focal length lens will bring you twice as close on a camera with the smaller sensor.


        Since different cameras have different sized sensors it is not possible to have a uniform vocabulary of lens focal lengths. So people compare focal lengths to their 35mm film equivalent by adjusting for the sensor size.


        To make the comparison with 35mm film focal lengths, you need to know the ratio of your sensor to a frame of 35mm film, which is called the focal-length equivalency. The photos in this book were created using Nikon DSLRs with a 1.5 times 35mm focal-length equivalency. To find out how the focal lengths I used compare with 35mm focal lengths, multiply my focal lengths by 1.5.


        To compute the comparable focal lengths on your own camera if your sensor has a different size than mine, you need to know the focal-length equivalency factor of your sensor. Check your camera manual for this information.


        For example, I took the photo of the Wave shown on page 232–233 using a 28mm focal length. The 35mm equivalence is 42mm.


        Black & White Filters


        Silver Efex Pro is published by Nik Software, www.niksoftware.com. A free trial version is available. Nik also publishes Color Efex Pro, which includes a black and white conversion filter along with many interesting color filters.


        Other filters and plugins specifically intended for black and white conversion in Photoshop and Lightroom are available from publishers including:


        Auto FX Software: www.autofx.com


        Fred Miranda Software: www.fredmiranda.com/software


        Power Retouche: www.powerretouche.com


        Silver Oxide: www.silveroxide.com.


        Most of these publishers have free trial versions available.


        Infrared Camera Conversion


        Converting a camera to capture the infrared (IR) spectrum (see pages 220–229) is not for the faint of heart. The conversion is expensive, voids the camera manufacturer’s warranty, cannot be undone, and usually makes the camera useless for captures by normal light.


        Considering the negatives, why would one send one’s camera off for this conversion process? IR captures can be spectacular, particularly in monochrome. Simulation in Photoshop (an example is shown on pages 230–231) really isn’t the same.


        If you search for infrared conversion on the web you’ll find a number of companies that provide this service, including Life Pixel, www.lifepixel.com.


        The process involves shipping your camera for IR conversion, usually takes a few weeks and costs several hundred dollars (the precise amount depending upon your camera model and the options you choose).


        With most digital cameras, sensors are naturally very sensitive to IR radiation, and are protected with a special filter. The retrofitting replaces this filter with one that allows IR to pass through to the sensor. Focusing can be slightly different under IR, so if possible you should have a lens calibrated at the same time as the filter over the sensor is modified. This makes IR modification ideal for an older generation DSRL that was purchased with a “kit” lens.


        Usually, you can choose to have the modification produce “normal” color IR, or only do black & white captures. I recommend choosing the color IR option. If you control the monochromatic conversion yourself, you can achieve greater flexibility and better results—all the information you need about conversion techniques is found on pages 66–141 of this book.

      

    

  


  
    
      

    


    
      
        Glossary

      


      
        Ambient light: The available, or existing, light that naturally surrounds a scene.


        Aperture: The size of the opening in the iris of a lens. Apertures are designated by f-numbers. The smaller the f-number, the larger the aperture and the more light that hits the sensor.


        Bracket: To shoot more than one exposure at different exposure settings.


        Chiaroscuro: Moody lighting that shows contrasts between shadows and brightness.


        Color space: A color space—sometimes called a color model—is the mechanism used to display the colors we see in the world in print or on a monitor. CMYK, LAB, and RGB are examples of color spaces.


        Composite: Multiple images that are combined to create a new composition.


        CMYK: Cyan, Magenta, Yellow, and Black; the four-color color model used for most offset printing.


        Depth-of-field: The field in front of and behind a subject that is in focus.


        Diffraction: Bending of light rays; unwanted diffraction can cause loss of optical sharpness at small apertures.


        DSLR: Digital Single Lens Reflex, a camera in which photos are composed through the lens that will be used to take the actual image.


        Duotone: A historic printing process that created rich monochromatic imagery using two colors or inks—with black being one of the colors. Each color was used to ink a separate plate that were combined in register.


        Dynamic range: The difference between the lightest tonal values and the darkest tonal values in a photo.


        Exposure: The amount of light hitting the camera sensor. Also the camera settings used to capture this incoming light.


        Exposure histogram: A bar graph displayed on a camera or computer that shows the distribution of lights and darks in a photo.


        Extension tube: A hollow ring that fits between a lens and the DSLR, used to achieve closer focusing.


        f-number, f-stop: The size of the aperture, written f/n, where n is the f-number. The smaller the f-number, the larger the opening in the lens; the larger the f-number, the smaller the opening in the lens.


        Focal length: Roughly, the distance from the end of the lens to the sensor. (The relationship of focal length to sensor size is explained on page 234.)


        Framing: In a photographic composition, positioning the image in relationship to its edges.


        Grain: Texture found in photographic film and prints due to the residue of small grains of metallic silver left over from chemical developing.


        Grayscale: Used to render images in a single color from white to black; in Photoshop a grayscale image has only one channel.


        Hand HDR: The process of creating a HDR (High Dynamic Range) image from multiple photos at different exposures without using automatic software to combine the photos.


        High Dynamic Range (HDR) image: Extending an image’s dynamic range by combining more than one capture either using automated software or by hand.


        High key: Brightly lit photos that are predominantly white, often with an intentionally “over exposed” effect.


        Hyperfocal distance: The closest distance at which a lens at a given aperture can be focused while keeping objects at infinity in focus.


        Image stabilization: Also called vibration reduction, this is a high-tech system in a lens or camera that attempts to compensate for, and reduce, camera motion.


        Infinity: The distance from the camera that is far enough away so that any object at that distance or beyond will be in focus when the lens is set to infinity.


        Infrared (IR) photography: Captures made using infrared rather than normal, visible light.


        ISO: The linear scale used to set sensitivity of a digital sensor.


        JPEG: A compressed file format for photos that have been processed from an original RAW image.


        LAB: Color model that separates luminance from color information.


        Lensbaby: A special purpose lens with a flexible barrel that allows you to adjust the “sweet spot” (area in focus).


        Low key: Dimly lit photos that are predominantly black, often with an intentionally “under exposed” effect.


        Macro lens: A lens that is specially designed for close focusing; often a macro lens focuses close enough to enable a 1:1 magnification ratio.


        Monochrome, monochromatic: A monochrome image is presented as nominally consisting of tones from white to black; however, “black and white” images can be tinted or toned, and so may vary from straight grayscale.


        Multi-RAW processing: Combining two or more different versions of the same RAW file.


        Noise: Static in a digital image that appears as unexpected, and usually unwanted, pixels.


        Open up, open wide: To open up a lens, or to set the lens wide open, means to set the aperture to a large opening, denoted with a small f-number.


        Photo composite: See composite.


        Pre-visualization: Seeing how an image will come out after capture and processing before making an exposure.


        Process color: A technique for reproducing a broad spectrum of colors by blending a few inks or colors that represent the entire color spectrum; for example, CMYK.


        Quadtone: Process that uses four inked plates to create monochromatic imagery; see also Duotone.


        RAW: A digital RAW file is a complete record of the data captured by the sensor. The details of RAW file formats vary among camera manufacturers.


        RGB: Red, Green, and Blue; the three-color color model used for displaying photos on the web and on computer monitors.


        Sabattier effect: See Solarization.


        Sensitivity: Set using an ISO number; determines the sensitivity of the sensor to light.


        Shutter speed: The interval of time that the shutter is open.


        Solarization: Reverses, or partially reverses, blacks and whites; in film photography using re-exposure to make partially developed material lighter, and in digital photography via simulation.


        Split toning: Toning with two colors; often one toning color is applied to highlights and the other to shadows.


        Spot color: In the printing process, color applied via a single plate; not process color.


        Stop down: To stop down a lens means to set the aperture to a small opening; denoted with a large f-number.


        Sweet spot: The area that is in focus when using a Lensbaby.


        Tinting: Adding color to a monochromatic image.


        Toning: In the chemical darkroom, toner such as sepia or selenium was added for visual effect; in the digital darkroom, toning simulates the impact of chemical toning.


        Tritone: Process that uses three inked plates to create monochromatic imagery; see also Duotone.
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          	Page 240: I took this photo on the slopes of Mount Tamalpais, California on a foggy morning. I liked the composition with the path heading through the forest floor in the color version, but when I converted the image to black and white the photo had a great deal more subtlety and impact.

        


        19mm, 15 seconds at f/22 and ISO 100, tripod mounted
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      	I intentionally underexposed this photo of a poppy bud to create an abstract image that reminds me a bit of a viper’s head.

    


    200mm macro, 1/400 of a second at f/11 and ISO 100, tripod mounted
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        	Title page: As clouds floated by, making the morning sun go in and out of shadow, I waited for the right moment to press the shutter. My patience paid off and I got this shot of sunlight on a water drop.

      


      200mm macro, 1/15 of a second at f/40 and ISO 100, tripod mounted
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        	Above: I used a wide open aperture to create a watercolor-like effect with this hand-held close-up of a poppy.

      


      100mm macro, 1/800 of a second at f/2 and ISO 200, hand held
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        	Page 6: Getting out early one morning, I found this dew-covered dandelion glistening in a field; many of the individual water drops can almost be seen as fractal-like representations of the whole flower.

      


      105mm macro, 36mm extension tube, +4 close-up filter, 1/3 of a second at f/32 and ISO 100, tripod mounted

    

  


  
    
      


      
        


      

    


    
      
        Introduction

      


      
        “The unbelievably small and the unbelievably vast eventually meet, like the closing of a gigantic circle,” observes the ever-smaller hero of the 1950s movie The Incredible Shrinking Man. What I love most about close-up photography is the way size, scale and orientation gets lost as you photograph things that are smaller and closer.


        If your subject gets small enough, you might as well be photographing the cosmos. To photograph close-up with this in mind is to show a fractal part of the universe that is whole and complete by itself. Close-up photography allows you to reveal small worlds of wonder to those who look at your photos.


        Best of all, close-up worlds are right where you are. You don’t have to wander long distances through time and space to find great subjects for close-up photography. Wherever you go, there you are; and there will certainly be something to train your macro lens on.


        Speaking of macro lenses, I use the term “close-up” and “macro” more or less interchangeably, although some close-ups are not true macros. All macros are close-ups, but close-ups from two or three feet away probably cannot be considered true macros, as they show more of the context of the photo.


        This book is primarily about how to make creative close-ups. You’ll find all you need to know to create technically accomplished close-ups, along with the stories and exposure data behind the photos shown. I’ve focused on visualizing and making close-up photos, rather than on magnification charts and ratios (which are usually not helpful for actual picture-taking in the field). Taking close-up photos does not have to be complicated. I’ve tried to keep things simple.


        Two of my own close-up loves are flowers and water drops. So it won’t surprise you to find that many of the photos in this book are botanical images and photos of water drops. I hope you enjoy my photos and use the illustrated techniques to capture your favorite close-up subjects.


        The more close-up photography you do, the more you’ll realize that the circle does indeed close. Please enjoy!
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          	The colors in these backlit water drops on a spider’s web fascinated me, so I used a telephoto macro lens to get a magnified macro of this jewel-like effect.

        


        200mm macro, 66mm combined extension tubes, 2 seconds at f/32 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Worlds of wonder
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        	Using a telephoto macro lens let me snap this photo of a dragonfly without getting close enough to disturb the critter.


        	
          Usually a telephoto macro will take you out of the range that is noticed by insects. In addition, using this kind of lens allowed me to isolate the dragonfly from its background.

        

      


      200mm macro, 1/320 of a second at f/9 and ISO 640, hand held

    


    
      
        Close and Closer

      


      
        How close can you go? That is the macro question. Or maybe a better question is, how close do you want to go? Close, but not quite so close, lets you show the context of your photo. Very close means zeroing in on individual features of your subject.


        The magnification ratio describes the correspondence between an object and its actual size on the sensor. At 1:5, a capture renders an object as 1/5 of the corresponding dimensions of the object itself. At 1:1 the sensor rendering is exactly life size, and at 2:1 the digital image is twice as large as life.


        When photographers go beyond very close—to magnification ratios greater than 1:1—they enter a completely new universe of the microcosm.


        A key issue is depth-of-field, the field in front of and behind a subject that is in focus. The closer you get to a subject, the shallower the depth-of-field, even with the lens stopped down to its smallest aperture. This means that as you get to a magnification ratio of 1:2 and closer, you need to use the shallow focus to your advantage by isolating particular aspects of your subject.


        For more apparent sharpness, you should also attempt to position the camera so that it is as parallel as possible to the subject. This will maximize apparent focus, even though the field that is in focus is not deep. As you get very close to a subject, minute adjustments of camera position become very important because small changes

        in camera position have a big impact

        on focus.


        I shot this sequence of photos of a water drop on a Dahlia petal, starting from furthest away and moving closer, to show what the magnification ratio means in the real world.


        Ratio 1:5


      


      [image: missing image file]


      
        
          	At a magnification ratio of 1:5, it’s a close-up, but not that close. You can barely see the water drop at the edge of the dahlia petal.

        


        50mm macro, 10 seconds at f/32 and ISO 100, tripod mounted


        Ratio 1:2


      


      [image: missing image file]


      
        
          	At a magnification ratio of 1:2, it’s getting closer. There’s not much visible outside of the context of the flower, and the water drop can be seen easily.

        


        50mm macro, 10 seconds at f/32 and ISO 100, tripod mounted


        Ratio 1:1
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          	True macro lenses focus to a magnification ratio of 1:1. You can see the water drop … and a smaller water drop that wasn’t visible before.

        


        50mm macro, 13 seconds at f/32 and ISO 100, tripod mounted


        Ratio 2:1
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          	This 2:1 magnification shows a completely different macro world, centered on the water drop and its satellite smaller drop.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 13 seconds at f/40, tripod mounted

      

    

  


  
    


    
      
        Worlds of Close-Up Photography

      


      
        There are as many worlds of close-up photography as there are objects to get close to. Almost anything you can think of looks different at different magnifications. Getting closer is a way to investigate.


        What do you want to investigate?


        Besides my favorite subjects of water drops and flowers, some great things to explore with your camera and macro lens include insects, reflections, metallic surfaces, small marine animals in tide pools and much, much more.


        Along with your choice of subject matter, consider the impact of magnification on your composition. At 1:2 or less magnification, you can fully capture an insect such as the wasp shown below or show the context of your subject.


        In contrast, at 2:1 or greater, viewers lose the sense of a coherent whole. In compensation, the tiny details of your subject are now huge (like the pistils in the flower shown to the right). These details are seen as never before and can be the basis for startling photos.

      


      [image: missing image file]


      
        
          	The wasp shown in this photo landed near the ceiling in my living room. To photograph the insect, I propped my tripod up on some old cartons and climbed on top of a coffee table. Sometimes to get into position for a close-up shot, you just have to improvise!

        


        105mm macro, 0.6 of a second at f/32 and ISO 200, tripod mounted
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          	I used a Low Pod Mount from Kirk Enterprises to get low enough to the ground to get this head-on view of the pistils of the Fuchsia bud. I think the photo makes the flower look like a jet engine!

        


        200mm macro, 36mm extension tube, 8 seconds at f/32 and ISO 100, Low Pod mounted
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          	At a classic car show, I got out my macro lens to photograph reflections in the polished chrome.


          	
            With this kind of close-up photo, even slight movements of the camera position have a huge impact on the final composition.


            I usually try to be careful to position myself so that reflected photographer, camera, and tripod don’t appear as part of the composition. This can be surprisingly difficult! Witness my small self-portrait in the lower right of the photo.


            Macros that involve reflections begin to become visually spectacular when the reflection is iterated: The reflection is itself and so on.

          

        


        200mm macro, 1/8 of a second at f/36 and ISO 100, tripod mounted
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        	This is a close-up of an anemone taken in a California marine preserve at low tide. If you look closely, you can see me and my tripod reflected in the tentacles.


        	
          At a normal magnification, this anemone is a sea creature. Up close at roughly 1:1, as in this photo, the anemone becomes an abstraction like a work of blown glass. Several people have commented to me that this photo reminds them of the work of the great glass artist Dale Chihuly.

        

      


      105mm macro lens, 36mm extension tube, 2.5 seconds at f/40 and ISO 100, tripod mounted

    

  


  
    


    
      
        Photographing Artifacts

      


      
        ar-ti-fact (är-ti-fakt) n. 1. Something created by humans usually for a practical purpose; especially: an object remaining from a particular period.

      


      
        Close-up photographers spend most of their time taking pictures of objects, or portions of objects, in isolation. The subject that is photographed close-up needs to be mysterious, to tell the story of its context or to show something commonplace in a new way. The best close-ups do all of these. I consider these subjects in isolation artifacts: artifacts of culture, artifacts of time, and—despite the dictionary definition, which says that an artifact is something created by humans—artifacts of nature.


        For me, an artifact is an isolated object that has been left behind.


        Look for this sense of being remnant, where the thing that remains says something about the whole that it once was part of. Objects that convey this sense make great close-up subject matter.


        To make the photos of a common child’s toy shown to the right, I used colored board to reflect colors into the Slinkies. Had I wanted a more natural effect, I could have reflected neutral colors onto the metal. One thing is for sure: a reflective surface will reflect. To get good photos of something with reflections, you need to observe them carefully and sometimes construct the reflections yourself. (See “Close-Ups in the Studio” starting on page 166 for more information.)

      


      [image: missing image file]


      [image: missing image file]


      [image: missing image file]


      [image: missing image file]


      
        
          	Slinkies: I used bits of cardboard to reflect colors into this set of photos of a common children’s toy.

        


        Top: 105mm macro, 2.5 seconds at f/40 and ISO 200, tripod mounted


        Middle: 105mm macro, 4 seconds at f/40 and ISO 200, tripod mounted


        Bottom: 105mm macro, 2.5 seconds at f/40 and ISO 200, tripod mounted


        Above: 105mm macro, 2 seconds at f/32 and ISO 200, tripod mounted
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            Both: On a deserted beach, a strong prevailing wind had gradually blown seagull feathers into a wind trap. I loved the way these feathers looked as a mass, creating an overall pattern on the grassy background and conveying a sense of mystery. Closer in, the individual feathers made a great macro subject with an ethereal ambience.

          

        

      


      Top: 105mm macro, 1/6 of a second at f/36 and ISO 100, tripod mounted


      Bottom: 105mm macro, 1/5 of a second at f/36 and ISO 100, tripod mounted
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        	When taking an extreme close-up, high depth-of-field water drop image, it’s difficult to see what the photo will look like from the camera viewfinder. Even the depth-of-field preview doesn’t tell me much, because at small apertures like f/40 with a bright sun, I can’t see much. The effects of sunlight on the water drops are unpredictable and the smallest amount of motion can ruin the photo.


        	
          I can see—but not much more—from the LCD viewer after I’ve taken the photo. Part of the problem here is that in bright sunlight it is hard to see it. Another issue is that at the LCD size, the difference between almost sharp and laser sharp isn’t readily apparent if the subject has moved slightly.


          To combat these problems, I look at close-up subjects directly—not through the viewfinder—and try to time my exposures when the subject is absolutely still.

        

      


      200mm macro lens, 1/3 of a second at f/40 and ISO 200, tripod mounted
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        	As the overnight rain evaporated in the morning sunshine, I noticed these water drops on a peony leaf. The sky and clouds in the reflections in the drops reminded me of entire little worlds, or alien artifacts dropped from space.

      


      200mm macro lens, 36mm extension tube, +4 close-up filter, 1/13 of a second at f/36 and ISO 100, tripod mounted
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        	The defined pattern of water drops on this tin can lid struck me as an interesting contrast to the printed directions on the lid. To me, it represents an interesting artifact of a society that seems to regard everything as disposable. I converted this close-up image to black and white in the digital darkroom when I post-processed it.


        	
          I was particularly struck by the apparent sharpness of this image. I was drawn to the way some of the lettering, such as the upsidedown “and,” appears to be magnified

          in the water drops.

        

      


      200mm macro, 3 seconds at f/22 and ISO 100, tripod mounted

    

  


  
    In my studio, I photographed one of the first Bibles ever printed for a collector. This Textus Biblie was printed by Preuss of Strassborg in 1486, twenty years after the Gutenberg Bible. It is the first printed book with a date on the title page.


    Back in the fifteenth century, books were printed in one color (black). The decorations and illuminated paintings were added on a one-off basis. So there are some versions of this Bible that were never finished by an artist; otherwise each copy is different.


    I felt very lucky to handle and photograph such an early and special book—one that is connected to the history of printing and the religious history of Western civilization.
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      	The photo shows the first page of the Textus Biblie; the painting is probably of Saint Jerome at work on an edition of the Bible.

    


    85mm Perspective Correcting macro, 3 seconds at f/36 and ISO 100, tripod mounted
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      	The illustration shows the Garden of Eden, starting off the Book of Genesis.

    


    200mm macro, 2.5 seconds at f/16 and ISO 100, tripod mounted

  


  
    


    
      
        Finding Macro Subjects

      


      
        Following my toddler around, I watched him stop, pick up something and scrutinize it carefully. He’d repeat the process over and over again, and would happily spend hours covering very little ground. The objects of scrutiny were commonplace: leaves of grass, pebbles, sticks and cracks in the pavement.


        This childlike sense of wonder in the everyday—scrutiny of everything as though seeing it for the first time—is the best mindset for finding close-up subjects. Forget the way you normally see, look for details and try to see patterns and beauty in the apparently mundane.


        I carry a macro lens and some other close-up gear in my everyday camera bag. (See “Getting Close,” starting on page 44, for suggestions about close-up equipment.) That way, if I encounter a great macro subject when I’m in the field, I’m ready for it. But I know that many of the best close-up photos are taken at home, in familiar surroundings, and not abroad. It’s one of the great things about close-ups: you don’t have to go far to see whole new worlds!


        Take a look at the things on your desk. Many objects you look at everyday would make good close-up subjects. Pencils, paper clips and bits of paper are all grist for the macro mill.


        Wander around your house. There are tons of subjects for close-ups just sitting there, waiting for their moment in the photographic sun.


        Feel like eating? Among the most interesting subjects for close-ups are a bowl of fruit, a berry or even melting ice cream.


        Want a breath of fresh air? There are sure to be good close-up subjects in your yard and on the nearby sidewalk. I love having a nice garden, but sometimes the best close-up subject matter is in stark environments.


        So don’t think you need to find special close-up subjects in special places: good macro subjects abound everywhere!
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        	At first glance, this looks more like a head of lettuce than a close-up of mint chocolate chip ice cream in a bowl.

      


      105mm macro, 5 seconds at f/36 and ISO 200, tripod mounted
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      Both: Dandelions are considered weeds, and the subject of intense eradication efforts on the part of lawn fanciers. However, kids love dandelions in all the phases of their life cycle—from flower to blowing seeds. And the delicate, intricate patterns of the plant make a great subject for close-up photography.


      Top: 105mm macro, 1/3 of a second at f/40 and ISO 200, tripod mounted


      Bottom: 105mm macro, 1/10 of a second at f/16 and ISO 200, tripod mounted

    

  


  
    


    
      
        Macros and the Digital Darkroom

      


      
        I do not believe that a photographer’s work is done after the shutter has been released. For me, at least half the fun starts after the photo has been taken, and when the RAW file has been copied to my computer. I have no shame when it comes to the use of Photoshop, which is what I tell people when they ask if one of my images has been “Photoshopped.” I tell them that I work on all of my photos in Photoshop. This is a bit of an exaggeration, but it gets my point across.


        In my work, close-ups have been among the most fertile ground for work in the digital darkroom. Moving from a photograph to a composition that is one part digital photo and one part digital painting has enabled me to add magic to the realities of insects, household objects, textures and much more.


        So when you shoot close-ups, stop to think about what you could do with the photo after it is taken. The possibilities are amazing!
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          	I shot this pinned butterfly straight down on a lightbox for transparency.
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          	My final image was created from the macro photo using digital painting on duplicate layers in Photoshop.

        


        200mm macro, 1/60 of a second at f/6.3 and ISO 100, tripod mounted
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          	I photographed these oregano leaves, and then added color in Photoshop using LAB color, inversion and equalization adjustments, and a variety of blending modes. (To find out more about these post-processing techniques, see the suggested reading on page 234.)

        


        200mm macro, 1/4 of a second at f/32 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      
        Creating Close-Up Abstractions

      


      
        One thing I love to do is take a fairly commonplace close-up photo and use the digital darkroom to transform it into a compelling abstraction. Viewers are often unable to tell what the original subject matter was. Hopefully, they’ll be intrigued by the composition, colors and patterns of the abstraction.


        If this approach appeals to you, start looking for close-up subjects with abstractions in mind. Separating content from form and leaving the subject matter aside, what is it about the composition of the object … up close and personal … that you like? How can you visualize shifting it to become an exciting abstraction?
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          Both: I photographed this pattern in seaweed on the Edward Weston Beach in Point Lobos Preserve, California. The original photo is already pretty abstract; but if you look closely, you can see small insects crawling on the kelp.


          I felt that this photo was a good candidate for further abstraction because of the intriguing, and somewhat sinister, patterns in the composition. These patterns are an interesting contrast with the bright colors I added. By completely divorcing the image from its subject matter, the viewer is compelled to respond to the colors and composition of the abstraction.

        

      

    


    105mm macro, 0.6 of a second at f/36 and ISO 100, tripod mounted
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          Both: I photographed a shadow pattern on a Persian rug close-up, and then rotated and abstracted the image to create a magical image that reminds me of a carpet that could provide magic rides.

        

      

    


    52mm, 1/200 of a second at f/8 and ISO 200, hand held
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          All: I created the first image (page 42, top) as a common domestic image that shows kitchen reflections in a large pot. If you look carefully at the reflections, you can see me and my tripod hidden in the center of the reflections.


          The image called out to me for more work. So, I abstracted it in Photoshop using LAB colors, channel adjustments, layers and a variety of blending modes (page 42, bottom and above). To find out more about these post-processing techniques, see the suggested reading on page 234.

        

      

    


    105mm macro, 20 seconds at f/36 and ISO 100, tripod mounted

  


  
    
      

    


    
      Getting close
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      	I used a waterproof point-and-shoot camera to make this interesting close-up composition on a very wet, rainy day. I wouldn’t have wanted to take my “real” cameras out and expose them to the elements.

    


    Pentax Optio WPi fixed-lens camera, sensor with a 6X crop factor, 13.8mm (112mm in 35mm terms), macro mode, 1/25 of a second at f/3.9 and ISO 160, hand held


    
      
        Seeing Up Close and Personal

      


      
        Cameras don’t take pictures; people do. So the most important thing you can do to learn to take good close-up photos is to learn to observe carefully … up close. What is it that intrigues you about a macro subject? How close do you need to be? When you pre-visualize a close-up photo, is it in color or black and white? Where is it focused?


        You may notice that I shot most of the photos in this book with a DSLR and a macro lens, or other specialized close-up equipment. However, you don’t need fancy equipment to shoot macros. I encourage you to go out and shoot close-ups with almost any gear.


        Oddly enough, a compact fixed-lens digital camera even has some advantages for close-ups, provided it has a macro mode. This is because the smaller the sensor size, the more depth-of-field you get. In other words, you can fairly easily get close-ups with a compact digital camera, and you’ll see that you can capture the whole subject in focus because the camera uses a small sensor. This small-size sensor is a disadvantage in terms of noise, but that’s another story.


        So if you have a yen to take photos close-up, don’t feel you need fancy equipment to get started. The camera I used to take the close-ups on this page and page 47 is a basic several-generations-old point-and-shoot, and you can see it performs fine in macro mode.


        The camera doesn’t matter. Learning to see close-up, so you can pre-visualize how very small things will look when they are revealed on a large scale, does.
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          	If you don’t need to blow up a photo to a huge size or worry about critical reproduction, then almost any point-and-shoot with a macro mode will work well for close-ups. When I took this photo of rose petals and their reflections, I wasn’t worrying about camera hardware. Instead I could concentrate on the composition.

        


        Canon Powershot G3 fixed-lens camera, sensor with a 4.5X crop factor, 28.8mm (140mm in 35mm terms), macro mode, 3/10 of a second at f/8 and ISO 50, tripod mounted
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          	I photographed these paper clips in my studio with a small camera I had at hand. I used colored boards to reflect color onto the reflective surfaces.

        


        Canon Powershot G3 fixed-lens camera, sensor with a 4.5X crop factor, 28.8mm (140mm in 35mm terms), macro mode, 1/2 of a second at f/7.1 and ISO 50, tripod mounted

      

    

  


  
    
      

    


    
      
        Macro Lenses

      


      
        I collect macro lenses the way some people collect shoes. Actually, I’m no Imelda Marcos; but when it comes to macro lenses, I wish I were.


        Macro lenses are the one kind of equipment for my DSLR that I truly obsess over. If I had hundreds of macro lenses in my closet, I would be in heaven! I hope my actual macro lens closet doesn’t bore you, because I’m going to tell you what’s in it in a moment.


        My obsessions aside, you don’t need a macro lens to make close-ups. Extension tubes and close-up filters are two much less expensive alternatives (see page 52). But having a macro lens makes taking close-ups easy, gracious and fun.


        By definition, a macro lens focuses close—often so you can achieve a 1:1 magnification ratio. (See pages 12–13 for an explanation of magnification ratios.) However, most macro lenses also focus to infinity and theoretically can be used as fixed-focal length general purpose lenses. With some exceptions, zoom lenses with macro settings tend not to offer true macro magnification levels.


        There are macro lenses in a wide range of focal lengths—from the normal angle of view (roughly 50mm) toward longer telephoto macros. (True wide angle macros are rare and optically difficult to create.) The longer in focal length a lens is, the closer it brings the photographer to the subject. At the same time, telephoto lenses provide lower depth-of-field. This is great for isolating subjects when they are in focus and the background is not, but not so good for achieving an image that is in focus in its entirety.


        A special consideration in macro photography is that getting too close with your lens can block light, create shadows and disturb living subjects. Using a telephoto macro lens helps to avoid these pitfalls. (See the photo on pages 44–45 for an example of a telephoto macro used in this way.)


        A downside of a telephoto macro is that it is unlikely to achieve quite as close a magnification ratio as a shorter lens. There’s no one-size-fits-all solution when it comes to photo gear; you just have to pay your money and take your chances, which may help to explain my macro lens collection.


        As with any lens, when considering the focal length of a macro lens, you need to factor in the sensor size of the camera with which it will be used. With a few exceptions (each is duly noted in the technical captions), the photos in this book were shot with Nikon DSLRs with a 1:1.5 ratio of sensor size compared to a 35mm film frame. This means that to calculate the equivalent focal lengths in 35mm terms for the lenses I’ve used, you need to multiply the focal lengths by 1.5. This is important not because I’m suggesting that you go back to film, but because 35mm film equivalency has become the standard for comparing focal lengths of lenses across different camera brands and models with different sensor sizes.


        Here are some of the macro lenses I use, with notes about what I like and don’t like about them. Even if you are not interested in any of these specific lenses, my notes may help you understand what may be important to you when shopping for a particular type of macro lens.
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          	I used a “normal” focal-length macro lens to make this moderate close-up of a bouquet of Asiatic lilies. The normal perspective enhanced the natural look of this still life composition.

        


        50mm macro, 1/2 of a second at f/32 and ISO 100, tripod mounted

      

    


    
      
        
          	Focal Length

          	Brand

          	Notes
        


        
          	50mm f/2.8 DG macro D

          	Sigma

          	This is the shortest focal length macro lens I use; a neat feature about this lens is that the magnification ratio is clearly printed on the lens barrel so you can see it when you focus.
        


        
          	PC Micro-Nikkor 85mm f/2.8 D

          	Nikon

          	This is a macro lens that allows some tilts and swings, so you can correct lines of perspective—much as you would with an old-fashioned view camera. It’s a completely manual lens, meaning that you first compose your photo and then manually use a button to close the diaphragm when you are ready to actually shoot your photo.
        


        
          	Makro-Planar 100mm f/2 ZF

          	Carl Zeiss

          	A great piece of glass with an “old school” feeling, this lens is particularly good at rendering colors at wider-open
        


        
          	AF Micro Nikkor 105mm f/2.8

          	Nikon

          	This is the standard, all around macro lens that travels with me everywhere. I have an older version that is lighter than current models that feature image stabilization. I feel that image stabilization is not very useful for macro work since I mostly use a tripod. (See pages 64–67 for more about tripods.)
        


        
          	AF Micro Nikkor 200mm f/4 ED

          	Nikon

          	This a great lens that allows me to get very close shots of my subjects while keeping my distance. The design features a tripod collar (surprisingly useful) and a front optical element that doesn’t change position no matter how the lens is focused. A drawback of longer lenses like this one is they may not actually get as close as 1:1.
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          	I used a telephoto macro in this shot to compress the planes of this photo that shows an Iris on a mirror. This focal length helped to emphasize the strong vertical composition created by the decorative marking intended for pollinators.

        


        200mm macro, 36mm extension tube, 7.1 seconds at f/40 and ISO 100, tripod mounted
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          	Using a telephoto macro allowed me to snap this photo that isolated the eyes of this newt.

        


        200mm macro, 1/320 of a second at f/9 and ISO 640, hand held

      

    

  


  
    
      

    


    
      
        Extension Tubes and Close-Up Filters

      


      
        Extension tubes are hollow rings that fit between a lens and the DSLR. Close-up filters, sometimes called close-up lenses, screw on the front of a lens. Both are inexpensive alternatives to a macro lens, or they can be used (either individually or together) in conjunction with a macro lens to get you really close.


        Extension tubes let lenses focus closer than their normal minimum focusing distance. This has the effect of magnifying the subject. Since there are no optics in an extension tube, you can expect results on par with the lens being used.


        With an extension tube in place, you cannot usually focus to infinity. Another drawback to using an extension tube is that adding a longer tube to the lens cuts down on the light that hits the sensor.


        I use the DG extension tube set from Kenko. There are versions of this product that fit many DSLR brands, including Canon and Nikon. The set provides a 12mm, 20mm and a 36mm tube with electronic couplings which enable the light meter automation to work with the extension tubes in place. You can use these extension tubes individually, or together to get even closer. Don’t get me wrong: extension tubes are simple devices with not much to go wrong. Any brand is fine.


        A close-up filter is a piece of optical glass that screws into the front of a lens and provides magnification. Adding another piece of glass to the front of your lens potentially diminishes optical quality, and this can be a concern because the quality (and price) of close-up filters varies tremendously. Unfortunately, there’s no good way to know how well a close-up filter will work until you try it with your particular lens. The good news is that you can get some perfectly acceptable close-up filters quite cheaply from companies not associated with making cameras themselves, such as the German optical firm B&W Schneider.


        Both extension tubes and close-up filters can be low-cost and effective ways to enter the world of close-up photography.
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          	This photo shows a small portion of a starfish, less than half an inch long. I used a close-up filter on a Lensbaby to get this close, and I “pumped” the ISO so I could hand-hold the image. I think the result looks a little like the jaw of a prehistoric monster.

        


        Lensbaby Classic, +10 close-up filter, 1/320 of a second using f/5.6 aperture ring and ISO 1000, hand held
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          	I used a telephoto macro equipped with an extension tube to shoot this “self portrait” that’s reflected in a door knob.

        


        200mm macro, 36mm extension tube, 1.5 minutes at f/36 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      
        More Close-Up Gear

      


      
        There’s quite a bit of close-up gear available beyond macro lenses, extension tubes and

        close-up filters. Some common items you should know about:


        
          	Bellows: Like extension tubes, a bellows fits between your lens and camera. The bellows is flexible black cloth or leather that uses a ratcheted rail to extend or contract. At its most extended, a bellows can get you very, very close to a subject with much the same benefits and drawbacks as extension tubes. It also provides greater flexibility as to the precise magnification you can achieve. One point worth noting in the digital era: bellows tend to collect dust in the folds and this dust seems to migrate easily to your sensor.


          	Lens Reversal Ring: A lens reversal ring screws into the place where filters normally go at the end of a lens. With the lens turned around, because its front optic is screwed into the ring, the lens reversal ring mounts on your camera. A variation is to start with a macro telephoto lens, and then use a lens reversal ring to attach a reversed normal lens. The normal lens functions like a high-powered close-up filter when reversed.

        


        Either setup for lens reversal gets you extremely close with good optical quality, although only at one extreme magnification. To buy a lens reversal ring, you need to know the filter screw size of your lens, which is usually expressed in millimeters.


        
          	Focusing Rail: Like a bellows, a focusing rail is extended and contracted on a ratcheted rail. Unlike a bellows, your camera is positioned on the focusing rail using its tripod socket. You leave your camera in a fixed focusing position, and focus by moving your camera backward and forward on the rail. The point is to achieve more precise focus than you can by manually turning a lens barrel. Usually, the focusing rail is itself mounted on a tripod, although sometimes it is clamped directly to a work table.

        


        As you can see, there’s quite a bit of close-up gear out there. I’d encourage you to mix and match and experiment. Use some of this hardware in combinations that were never expected! There’s nothing like trial and error for learning how this stuff works and for making creative close-ups.
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          	I used a lens reversal ring to get extremely close to a detail in this affiliation pin. You can see how close this photo is by comparing the entire pin to a penny in upper photo.

        


        Left: 50mm macro, 48mm of combined extension tubes, 6 seconds at f/32 and ISO 100, tripod mounted


        Right: 50mm lens mounted in reverse, 1.5 minutes at f/32 and ISO 100, tripod mounted

      


      [image: missing image file]


      
        
          	I used a macro lens mounted on a bellows (extended to about 55mm) to get an extreme close-up of this small ring. The advantage of using the bellows was that I could control the exact magnification that I wanted, which allowed me to emphasize the eye pupils in the composition.

        


        50mm macro, extension bellows, 5 seconds at f/32 and ISO 200, tripod mounted

      

    


    
      
        
          	
            Extreme Macro Photography

            

            When you use the gadgets described on page 54, you’ll probably be working at magnifications greater than 1:1. In this realm of the extreme macro, some special considerations come into play:

            


            
              	Critical focusing is both more important and more difficult than in normal photography. (See page 68 for some suggestions to help with this.)


              	The photographic apparatus itself tends to cut down the light that reaches the sensor. (See page 72 for more about macro exposures.)


              	Continuous focusing is no longer possible. In other words, an object may be sharp at one distance from the camera when focused one way, and at another distance with a different focus, but not at any of the points in between.


              	Looking through the viewfinder can be disorienting. It can be tough to “find” the area you want to photograph, and to know how to move the camera to get your composition.


              	Small bits of dust and dirt on your subject have a greatly magnified effect, as you’d expect, since the whole thing is magnified anyway!
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          	I used a wide-angle zoom lens equipped with an extension tube to get closer than 1:1 magnification with this wide-angle macro of a tiny hydrangea blossom. The combination of unusual gear creates a seldom seen viewpoint—both wide and extremely close.

        


        12-24mm zoom lens at 24mm, 12mm extension tube, 13 seconds t f/22 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	I experimented with adding an extension tube and a close-up filter to my 18-200mm zoom lens (which has an image stabilization feature that’s useful for hand holding). I don’t think the designer of this lens ever thought it would be used as a macro lens, but it actually does a pretty good job. It creates a different, more soft-focus feel than a standard macro lens, as you can see in this photo of an apple blossom.


          	
            To use this combination of gear, with autofocus off, I set a fixed point of focus on the lens barrel. Next, I use the zoom control—rather than the focusing ring—to focus. It is not, as I said, what the designers of the lens had in mind, but it worked.

          

        


        18-200mm zoom lens at 95mm, 36mm extension tube, +2 diopter close-up filter, 1/250 of a second at f/8 and ISO 100, hand held
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          	This photo shows the fake “eye” of a butterfly—a pseudo eye on the wing that’s intended to give predators the idea that the butterfly is a larger creature than it really is. I used a lens reversal setup to reach extreme magnifications; the apparent grain in the image is actually the delicate texture of the wing itself.

        


        200mm macro, 50mm lens reverse mounted, 1 second at f/40 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Lensbaby Close-Ups

    


    
      The Lensbaby is an innovative lens—or system of lenses—that provides a way to move the barrel of the lens around on a flexible tube. This enables you to change the area of focus, called the sweet spot. The point of the Lensbaby is to allow you to control an area of focus within an overall composition that is attractively out of focus.


      You don’t set the aperture on a Lensbaby; instead, you use magnetic aperture rings that go inside the flexible lens barrel.


      The Lensbaby Close-Up Kit provides a +4 and a +10 close-up filter for the Lensbaby. You can use them separately or together. If you choose to get really close by combining close-up filters, be sure that you put the +10 on first, closest to the lens.


      The Lensbaby 0.42x Super Wide Angle Conversion lens screws apart to reveal a secret—a really sharp close-up auxiliary lens, which you can experiment with by itself or together with the +4 or +10 close-up filters.


      I love playing with the Lensbaby with close-ups attachments as much—or more—than I love playing with the Lensbaby by itself. Truly close-up, this gadget is my baby!
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          	I used the Lensbaby close-up kit to create a macro of a small statuette with emotional overtones. I read the expression on the face as fearful.

        


        Lensbaby 2.0, +10 close-up filters, f/4 aperture ring, 1/320 a second at ISO 200, tripod mounted
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          	This ant wandered over to where I was shooting still lives and got stuck in the museum gel I use to safely hold objects in place. I used the Lensbaby to create this character portrait of the ant.

        


        Lensbaby 2.0, +10 and +4 close-up filters, f/8 aperture ring, 1/15 of a second at ISO 200, tripod mounted
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          	I photographed this bee hand-held with the Lensbaby and macro kit +10 close-up filter with an intention to spot light the wings and “fur ruff” while letting the background go out of focus.

        


        Lensbaby Classic, +10 close-up filter, f/5.6 aperture ring, 1/250 of a second and ISO 200, hand held
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          	I used a Lensbaby and close-up filters to focus on the drops of water on this leaf while letting everything else go out of focus; the effect reminds me of a leaf critter.

        


        Lensbaby 2.0, +10 and +4 close-up filters, 1/250 of a second with no aperture ring at ISO 200, hand held
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          	This close-up shot of a succulent was shot with a Lensbaby at a high ISO. The highlight areas of the composition blew out because they were overexposed, which is usually not a good thing. In this case, the white from the overexposed areas added to the pattern that makes the photo interesting.

        


        Lensbaby 2.0, +10 close-up filter, f/4 aperture ring, 1/250 second at ISO 1000, hand held

      

    

  


  
    


    
      
        Using a Tripod

      


      
        There’s a very real place for hand-held close-ups using fast shutter speeds (see pages 72–79) or when using a strobe (see page 84). But the bulk of quality close-up photography is achieved with a tripod. This is because the closer you get to your subject, and the greater the magnification, the more impact even slight camera movement has on the sharpness of your photo.


        Even apart from the technical consideration of holding the camera steady, a tripod is often an assist in making close-up photos because shifting the camera slightly has a huge impact on composition. When the camera is on a tripod, you can make movements in a controlled way.


        It’s likely that you will have your tripod longer than your camera, so it is worth investing in a good tripod.


        The requirements for a close-up tripod in the field are different from what you need in the studio—although reasonable compromises are possible; you don’t have to buy two. A field tripod should be lightweight, preferably with legs made of carbon fiber—the material used in applications ranging from aircraft and artificial limbs to high tech windmill blades.


        Weight and portability aren’t so important in a studio tripod, but the ability to hold the weight of even the heaviest cameras and lenses is vital.


        Professional-quality tripods come in two parts: the legs and the head. When it comes to legs, two of the best manufacturers are Gitzo and Manfrotto.


        Tripod heads come in many varieties; which you choose is a matter of personal taste. That said, a ball head is probably the best choice for close-ups and macros because this style of tripod head allows the greatest flexibility of motion and an ability to put the camera in any position. Kirk Enterprises and Really Right Stuff make good ball heads along with other gadgets for supporting cameras that are useful for shooting close-ups.


        If you look at your camera, you’ll see that it has a tripod screw hole on the bottom. But the professional-quality ball heads that I’ve mentioned do not provide the screw to fit. Instead, a quick release plate (sometimes called an Arca-Swiss plate, after the first manufacturer of this item) stays permanently attached to the camera with a screw. The plate can quickly and easily, but very firmly, get attached to the tripod ball head. Both Kirk and Right Stuff make a variety of plates designed to fit many camera bodies or lenses with a tripod collar.


        It’s sometimes possible to improvise camera supports … by putting your camera on a rock, for example. Depending on the weight of your camera, you can also look into other support devices, such as the Gorillapod, a lightweight tripod alternative with flexible legs that can clamp onto poles, rocks, chairs, trees—or almost anything. Some photographers swear by using a beanbag as a lightweight and portable field support (and also for taking photos from a car window).


        Getting close to the ground is a problem with conventional tripods. For my close-to-the-ground work, I like to use two products marketed by Kirk. One is the Low Pod Mount (see example on page 14). The other is the Kirk Mighty Low-Boy, a chopped Manfrotto tripod with the center column removed. The point of the Mighty Low-Boy, which is specifically intended for macro photography, is that with the legs spread wide it can rest right on the ground.


        You’ll find websites for the manufacturers I’ve mentioned on page 234.
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          	I attached my telephoto macro lens to the tripod using the socket on the tripod collar of the lens. Since the front element of this lens doesn’t change position when I focus, I knew I wouldn’t get wax on the lens during this shot; I would be able to maintain a constant distance from the flame.

        


        200mm macro, 0.8 of a second at f/40 and ISO 100, tripod mounted
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          	I focused straight down on the eyes of this hermit crab, which was hiding under a rock, and used a moderate aperture to create shallow depth-of-field. That way, only the creature’s eyes were in focus. Perhaps I could have hand-held this photo (taken at 1/160 of a second shutter speed); but I’m convinced that by using a tripod, I was better able to create a sharp image and concentrate on focusing precisely rather than holding my camera steady.


          	
            It was reassuring to know that the carbon fiber legs of my tripod would be completely undamaged by the salt water they rested in to make this photo.

          

        


        200mm macro, 1/160 of a second at f/7.1 and ISO 100, tripod mounted
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          	To get down low and close to this marble, I mounted my camera on a Kirk Mighty Low-Boy cut-off tripod and spread its legs wide.

        


        105mm macro, 2.5 seconds at f/40 and ISO 200, tripod mounted

      

    

  


  
    
      

    


    
      
        Focusing

      


      
        Accurate focusing is a crucial issue in close-up photography, whether you are making images with a selective focus or ones that are fully in focus.


        If you are going for a selective-focus image, small variations in the point of focus have a large impact on your composition.


        Carefully observe the angle of your camera to your subject. Many focus problems can be resolved with slight adjustments to the camera angle; try making the camera more parallel to the subject.


        If you are looking to create a close-up photo that is in focus from end to end, you should:


        
          	Position your camera so that it is as parallel as possible to your subject. If the camera is at an angle to the subject, then it becomes harder to end up with the entire subject in focus.


          	Stop down your lens to a small opening for greater depth-of-field. (See page 76 for an explanation of depth-of-field and aperture.)


          	Pick your point of focus carefully, bearing in mind that there is slightly more depth-of-field behind the focal point than in front of it. For maximizing depth-of-field, assuming that you stop down your lens, the best place to focus is slightly in front of your subject.

        


        Many specialized macro lenses do not have an autofocus capability. Even if your macro lens does autofocus, you should mostly turn it off for shooting close-ups. I say this because precise focusing is crucial for this kind of photography, and autofocus gets it wrong more often than not. At best, autofocusing with a macro lens (or a normal lens at close-up distances) tends to be a slow and clunky affair.


        It’s worth taking the time to observe your point of focus and the angle of the camera to your subject very carefully, because these issues can make or break a close-up photo.
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          	I used a telephoto macro positioned parallel to this sand dollar, and a magnifying eyepiece for precision focus, to present the sea creature at the structural level. Each of the “dots” in the photo is smaller than a grain of sand and shows the animal at its cellular level.

        


        200mm macro, 36mm extension tube, 2 seconds at f/36 and ISO 100, tripod mounted

      

    


    
      
        
          	Accessories for precision focusing

          

          I confess: my eyesight isn’t what it was a number of years ago. If you are like me, you may find that a couple of simple accessories, available for many DSLRs, can help you focus your close-ups with precision.

          

          A magnifying eyepiece in place of the regular eyepiece on the viewfinder of your camera does exactly what you’d expect. This is a great thing to have as part of your camera kit. I’ve often had the experience of thinking I had focused optimally with my normal eyepiece; but after slipping on the magnifying eyepiece just to check, I’ve found that my focus was slightly off.

          

          A right-angle finder attaches to the eyepiece of your viewfinder and then swivels at a 90-degree angle. My right-angle finder also magnifies the image; but I’m not very happy with this feature, because (unlike my magnifying eyepiece) it cuts off so much of the image when magnified that I can’t really compose with it. So I use my right-angle finder for situations in which I can’t see through the viewfinder because of camera position, such as when the camera is close to the ground.
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          	To create this selective-focus image, I used a Lensbaby and close-up filter. I positioned the camera parallel to the Poppy and made sure that the center of the flower was in focus.

        


        Lensbaby Classic, +4 close-up filter, f/4 aperture ring, 1/125 of a second at ISO 200, handheld

      

    

  


  
    


    
      
        Exposing Close-Ups

      


      
        An exposure represents the amount, or act, of light hitting the camera sensor. It is also the camera settings used to capture this incoming light.


        Given a particular camera and lens, there are three settings that are used to make the exposure: shutter speed, aperture and sensitivity.


        
          	Shutter speed is the amount of time that the camera is open to receive incoming light. In other words, it is the amount of time that the sensor is exposed to light coming through the lens. With close-up photography, it is not uncommon to have shutter speeds in the seconds, because many close-up subjects don’t move.


          	Aperture is the size of the opening in the camera’s lens. The larger the aperture, the more light that hits the sensor. The size of the aperture is called an f-stop, written f/n, and n is also called the f-number. Somewhat confusingly, the larger the f-number, the smaller the hole in the lens; and the smaller the f-number, the larger the opening. Depth-of-field, the field in front of and behind a subject that is in focus, depends largely upon aperture. You’ll find more about aperture, depth-of-field and close-ups starting on page 76.


          	Sensitivity determines the degree to which a sensor is affected by light. Sensitivity is set using an ISO number; the higher the ISO, the more sensitivity to light.

        


        Changing any of the three exposure settings impacts the lightness or darkness of your photo. So, assuming you want to keep your photo constant, if you change one setting, you also need to change another to compensate. Each of these adjustments has compositional implications.


        Balancing the relationship of shutter speed, aperture and sensitivity is filled with possibilities and constraints that change the way your photos turn out. For more information about exposing photos, see the suggestions for further reading on page 234.


        Using Exposure Histograms


        A histogram is a bar graph that shows a distribution of values. An exposure histogram shows the distribution of lights and darks in an exposure. Check your camera manual for details on how to display exposure histograms.


        In light conditions where you can’t see your LCD screen (when it is very bright), a histogram is an invaluable aid to exposure. Aside from being unable to review a photo because of brightness, a histogram can help you figure out how to expose your image in many other situations.


        The exposure histogram of an underexposed photo is bunched to the left, and the exposure histogram of an overexposed photo is bunched to the right. A theoretically “correct” exposure will be represented by a histogram with a bell-shaped curve smack dab in the middle. However, it sometimes makes sense to deviate from the “correct” exposure, which may be based on an overall average. Try deviating in favor of a “creative” exposure that is intended to capture a specific part of the composition or to emphasize certain tonal values.


        [image: ]
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          	To create this nautilus shell image, I had to overexpose relative to my camera’s overall average reading of the light. Otherwise, the details of the chambers in the shell would have been too dark; “overexposing” the all-white background didn’t matter.

        


        50mm macro, 8 seconds at f/32 and ISO 100, tripod mounted

      

    


    
      
        
          	Magnification and Exposure

          

          Exposing a close-up photo is not much different from exposing any other photo, except that by adding to the length of the lens tube—for example, when you focus close with a macro lens or add an extension tube between your lens and camera—you cut down the amount of light that reaches the sensor.

          

          Depending upon the lens and close-up equipment, at a 1:1 magnification, you can lose as much as two f-stops. With a two f-stop loss, the lens would let in 1/4 of the light it would in normal focal ranges; for example, a nominal aperture of f/5.6—the aperture set on your lens or in your camera—would become an actual aperture of f/11. If you use an extension tube, you will further cut down the amount of light hitting the sensor—more than if you only use a macro lens.

          

          At other magnifications, the formula for the loss of light hitting the sensor is roughly:

          

          Effective Aperture = Lens Aperture • (1 + Magnification)

          

          Since you can usually use the light meter in your camera for your close-up work, you don’t really need to quantify the adjustment for loss of light due to magnification, because the camera does it for you.

          

          Still, you should know that you are reducing the light hitting the sensor by getting close. In addition, some equipment—such as a lens reversal ring—is simply not going to coordinate very well with an onboard exposure meter.

          

          Fortunately, with digital you get instant feedback on your exposure after you’ve taken your photo. But when you’re calculating your initial exposure in situations that baffle your camera’s meter, you’d do well to remember the exposure impact of magnification.
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          	This version of a nautilus shell was shot on a black background, so I needed to “underexpose” relative to my camera’s overall average reading of the light. If I hadn’t, the details in the shell would have been too light; “underexposing” the all-black background didn’t matter.

        


        50mm macro, 3 seconds at f/32 and ISO 100, converted to black and white in Photoshop, tripod mounted

      

    

  


  
    
      

    


    
      
        Aperture and Depth-of-Field

      


      
        The aperture is the size of the opening in a lens. The smaller the aperture opening, the larger the f-number that’s used to designate the aperture.


        An f-stop is one over the f-number. So f/36 refers to a very small opening in a lens, whereas f/3.5 refers to a much larger opening. If, say, the lens can’t be opened any wider than f/3.5, then f/3.5 is called the maximum aperture of the lens.


        As already noted, depth-of-field is the distance in front of and behind a subject that is apparently in focus. If your image has a great deal of depth-of-field, then more of it will be in focus; whereas, if a photo is low in the depth-of-field department, important portions of the image can be in focus and isolated from an out-of-focus background.


        The closer you go, the more important depth-of-field becomes because the range of distances that are in focus get shallower. At 1:1 magnification ratios (or greater), we are looking at paper-thin edges.


        All other things being equal, aperture controls depth-of-field. Some other factors that have a bearing on depth-of-field are sensor size—smaller sensors provide more depth-of-field at a cost, as I explain on page 46—and the focal length of the lens. The longer the lens, the less depth-of-field, as explained on pages 48–51.


        You also need to pay attention to where you focus and the camera’s angle in relationship to the subject. (For more about this see pages 68–71.) Camera position and angle doesn’t impact the amount depth-of-field per se, but it does have major consequences in terms of how much of your photo is in focus.


        By the way, depth-of-field should not be confused with sharpness, which also depends on variables such as optical quality, atmospheric conditions and so on.


        The smaller the lens aperture, the more depth-of-field there is. At its maximum aperture, say f/2, a lens has almost no depth-of-field; at intermediate apertures, such as f/11 and f/16, there is some depth-of-field; and at the minimum aperture, say f/36, there is a great deal of depth-of-field.


        To visualize the impact of your depth-of-field choice on your photo, you can snap the picture and view the results in your LCD. If you don’t like what you see, change the settings and try again. You can also use the depth-of-field preview. (Check your camera manual to find the location of this control.) The depth-of-field preview on a DSLR lets you look through the lens while it’s stopped down. However, it may be hard to see anything in the dim light of a lens when it is fully stopped down to a small aperture, as is the case for many close-ups.


        Some cameras let you check depth-of-field in real time in the LCD using a “live view” mechanism. (Check your camera manual to see if yours has this feature, and for details.)


        As I’ve mentioned, depth-of-field is a critical issue for many macros because at greater magnifications, focus is inherently shallow. Before you jump to the conclusion that you should therefore stop your lens all the way down to its smallest aperture to get the most depth-of-field when shooting macros, bear in mind that there is a loss of optical sharpness due to diffraction—the bending of light rays—at macro magnifications when you use a small, stopped down aperture. When I need them, I tend to use these small apertures regardless of the diffraction effect, but keep this in mind. Also note that the impact of diffraction varies, depending upon your lens.


        You may want to run tests on your lenses at one close-up magnification and different f-stops to see if you notice any difference in optical sharpness when you blow up the resulting photos.
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        	For this not-so-close close-up of an antique typewriter, I wanted the typewriter completely in focus. I used a normal angle macro lens (50mm), focused on the middle row of keys, and stopped the lens down to its smallest opening (f/32) for maximum depth-of-field.

      


      50mm macro, 0.6 of a second at f/32 and ISO 100, tripod mounted, converted to black and white with sepia tint in Photoshop
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        	The idea for this photo was to isolate the typewriter key used to type French accents, because it looks like a little funny face. This meant it was important to keep the circumflex (^) key sharp, while letting everything else in the image go out of focus.


        	
          To achieve a shallow depth-of-field, I used a telephoto macro lens opened up to its widest aperture (f/4.5), and I used a magnifying eyepiece for precise focus on the key.

        

      


      200mm macro, 1.3 seconds at f/4.5 and ISO 100, tripod mounted, converted to black and white with sepia tint in Photoshop

    

  


  
    


    
      
        Lighting Close-Up Photos

      


      
        The word photography comes from the concept of “writing with light,” so it’s not surprising that lighting plays a crucial role in photography. The topic of lighting includes both the ability to accurately analyze existing light and how to light a subject artificially. Since the subjects of close-up photos are small in size, and close-ups are often shot in controlled environments, lighting close-ups is actually easier than lighting photos on a larger scale.


        If you are capturing close-up subjects in motion and don’t want a motion blur effect, there are only two approaches to consider. One, you can boost the ISO so it is high enough for a fast shutter speed. This will increase the level of noise in your photo, but perhaps not to unacceptable levels. Also, cameras are getting better at processing noise all the time.


        The other approach for “stopping” motion is to use a flash, also called a strobe. (See pages 84–87 for information about using macro flash to light close-up photos.)


        Close-up photography can generally be divided into studio work and field photography. For the record, my studio is my home and vice versa.


        In a studio, when it comes to close-up still life work, there are a great many lighting options you can use that create great lighting effects without requiring fancy equipment. You’ll find information about lighting close-ups in the studio starting on page 168.


        In the field, lighting options are more limited. If you are not using flash, you can augment light with a portable device such as a powerful flashlight. You can also use metallic or white boards to reflect light into a macro subject.


        But the truth is that most of the time my field close-up work relies on an ability to place myself in the path of “good” light. To do this requires skills in observing light. As you might expect, learning to closely observe light is very important in the studio as well.


        There’s no cookie-cutter approach to finding out when light is going to work for field close-ups, so I use the Internet to learn as much as I can about topographic and atmospheric conditions when I’m on a field shoot. For close-ups, I often look for overcast but bright days with a touch of moisture in the air.


        Be mindful of the intensity, quality and direction of light. Intensity refers to how strong light is. Quality is basically a measure of to the color temperature of the light, referring to where the light fits on the visible frequency of light waves. No doubt, this measure is in part subjective.


        The direction of light is usually described in relation to the subject of a photo, as shown in the table. Of course, in many cases light is coming from a number of different sources at once. I make it a point to observe the direction (or directions) of light hitting my subjects no matter what the subject is—from flowers and people to mountains and bridges—and certainly in my close-up work. If you don’t understand the direction of light, then you don’t really know what you are photographing.

      


      
        
          
            	Front lighting

            	Illuminates the front of the subject and is usually coming from behind the photographer. It’s great for illuminating details in a subject but may cause blown-out highlights (see example page 82).
          


          
            	Back lighting

            	Comes from behind the subject and is, roughly speaking, pointed at the camera. This can be used effectively as a specialty lighting direction with translucent subjects or to create a halo effect (see example page 73).
          


          
            	Side lighting

            	Predominantly hits the sides of the subject; a strong light with distinctive shadows can work well, particularly when side lighting from several different directions is involved (see example page 79).
          


          
            	Bottom lighting

            	Generally not flattering and (when it comes to portraits) has been called “monster lighting.” However, some interesting close-up effects are possible with bottom lighting that isolate a bottom-lit subject from the rest of a dark composition (see example page 77).
          


          
            	Top lighting

            	Can flatten subjects in an unflattering way and is therefore not usually appreciated in general photography. However, in close-up work, a strong but diffused top light can be ideal (see example page 66).
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          	In my studio, I placed this semi-transparent pencil shaving on a fluorescent lightbox to backlight it. I intentionally overexposed the image to create a high-key lighting effect. (See pages 102–107 for more about high-key lighting.)

        


        200mm macro, 36mm extension tube, 0.4 of a second at f/13 and ISO 100, tripod mounted
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          	At an outdoor classic car show, I observed that the sun was front lighting this hood ornament. I carefully positioned myself and tried a variety of apertures to create the biggest possible “star” effect of the sun hitting the ornament.

        


        200mm macro, 1/200 of a second at f/16 and ISO 100, tripod mounted

      

    

  


  
    


    
      Using Macro Flash

    


    
      There are many good reasons to use flash to light close-up photos. Some things to consider:


      
        	Flash allows you to stop motion without having to jack up the ISO.


        	Flash units used to light close-ups are probably more portable than any other artificial lighting setup.


        	Flash has roughly the same color temperature as sunlight, so it works very well with natural light.

      


      The number one rule of quality flash photography is to get the flash unit off your camera, because an on-camera flash unit almost invariably produces harsh front-lighting. If you decide to disobey this prime directive, be sure to take off your lens shade, which will probably produce a large, unattractive shadow when used with a built-in flash.


      You can use almost any separate flash unit to effectively light close-ups. A bracket attached to your camera gets it off the camera. Or you can hold the flash or clamp it to a light stand or other support. It’s easier to position the flash well away from your camera when it is controlled wirelessly—a standard feature in many DSLRs.


      To get a better quality of light, bounce the flash off the ceiling, add diffusers and experiment with adding cardboard modifications to the front of the flash. Several flash units positioned in different locations work better than a single unit.


      For close-up subjects, use flash units specifically designed for macro work. It’s possible to buy ring flashes that fit on the end of a macro lens for this purpose, but I prefer to use two small flash units designed for macro work. These strobes are triggered wirelessly from the camera in aperture-preferred or manual mode. In this setup, the camera is the controller and the macro flash units are its slaves.


      For convenience, I can attach both units to a ring that screws into the filter holder on most macro lenses. It’s very effective to light a subject from two sides—one side per unit.


      I can also use these units in conjunction with a larger strobe that creates background lighting. In this case, the strobe becomes the controller and the small flash units—usually positioned closer to the subject than the bigger unit—are its slaves.


      If macro flash intrigues you, I suggest jumping right in. You’ll find that hardware costs are not too high, and automation built into cameras and flash units makes it pretty easy to learn the process of lighting close-ups with small flash units.

    


    [image: missing image file]

  


  
    	Using a telephoto macro lens let me get far enough away from my close-up subjects to use flash units mounted on a ring on the front of the lens. However, when photographing a reflective surface like a water drop, if you light them with strobes, the reflections in the drops will change, depending upon the position of the strobe itself. So to create this photo, I experimented with hand-holding one of my macro strobe units in a variety of positions to see what worked best for creating an interesting reflection in the water drop.

  


  200mm macro, 36mm extension tube, 1/60 of a second at f/40 and ISO 200, two wireless strobe units (one attached to the front of the lens, the other handheld), tripod mounted


  
    [image: missing image file]


    
      
        	I used two wireless macro flash units attached to a ring on the front of my lens to stop the motion of this bee in flight on a Dahlia.

      


      200mm macro, 1/60 of a second at f/16 and ISO 100, wireless strobe, tripod mounted

    

  


  
    
      

    


    
      Photographing flowers

    


    [image: missing image file]


    
      
        
          	Roses have been cultivated for centuries for their luscious perfection. I photographed this rose to emphasize the romantic spirals at the core of the flower.

        


        105mm macro, 1 second at f/36 and ISO 100, tripod mounted

      


      
        Botany of Desire

      


      
        Michael Pollan’s fascinating book The Botany of Desire explores the question of who is the boss: Do we cultivate flowers because they happen to be beautiful? Or, have flowers made themselves beautiful to people so that we will cultivate and spread them? Are people manipulating flowers, or do flowers manipulate people?


        This question of who is doing what to whom comes up in the general context of human desire, and it’s a safe bet that the truth is a bit of both. There’s usually a complex interlocking relationship when it comes to appearance and desire. Undoubtedly, people find flowers and other plants decorative. Equally unquestionable, the history of human cultivation of decorative plants has manipulated the genetic course of these botanicals to make them evolve toward our culturally idealized sense of plant perfection.


        There is a connection between the botany of desire and flower photography, but before I get there, consider that humans may not be as important to flowers as other species. Flowers need to be concerned about attractiveness to their natural pollinators.


        Many of the striking markings we see (and don’t see) on flowers are designed to attract bees, pollinating insects and hummingbirds. Some of these “decorations” show the pollinator where to go, in much the way that runway markings direct an airplane pilot to land.


        Your close-up photography of flowers will be more powerful if you take the time to become familiar with the aspects of the botany of desire.


        For instance, when I’m looking closely at a flower, I always like to consider:


        
          	The reproductive systems of the plant; I want to understand the sexual organs of a flower I photograph and how the parts of this system relate to each other.


          	Markings that flowers use to entice pollinators, such as the “flight path” on an Iris (see page 106).


          	Flowers and fashion; what is particularly attractive in a human sense about the flower in front of me?

        


        On the first of these topics, here’s a bit of Botany 101 for flower photographers.


        Each flower has both male and female reproductive organs. The stamens are the male sexual organs of each flower. The stamen consists of the anthers at the top of a delicate stalk and the stalk itself, called a “filament.” The anthers host the pollen used for fertilization. You can see anthers clearly in the photo of an Easter Lily on page 93 and the stamen clusters in the photos on page 96–97.


        While each flower has a number of stamen, the flower has only one pistil, the female sexual organ. The stalk of the pistil, which can be seen in the photos on pages 96–97, is called a “style.”


        In the pictures on page 96–97, you can’t really see the “stigma” (it would be at the top of the styles shown in these photos) or the ovary at the base of the pistil. (The poppy version of the ovary is the green center core shown in the photo on page 95.)


        We tend to think of the ovary in non-botanical and imprecise terms as the flower’s “bud”; although this is approximately right, it isn’t always precisely true. Another great photographic example of a flower ovary is shown in the transparent anemone image on page 107.


        Of course, great flower photos are not really about botany and the sexual parts of flowers, unless the photos are gracing a botany textbook.


        Great flower photos are about color, lines and grace. But no knowledge is wasted. The more you know about flowers, the more likely you are to make close-ups of these gorgeous life forms that go a step beyond the ordinary. Like some human beings, flowers present their “private parts” brazenly, coyly or matter-of-factly. Your approach to photography of these aspects of a flower should vary depending upon the presentation made by the flower.

      


      [image: missing image file]

    


    
      	Flowers that are wet with drop from an early morning rain, like these Gerbera, are always more attractive to me than flowers than have not been moistened. I often try to get out to photograph flowers first thing in the morning.

    


    200mm macro, 0.7 of a second at f/36 and ISO 100, tripod mounted


    
      [image: missing image file]


      
        
          	This orchid has an extremely unusual male reproductive organ—anther and filament. From this angle, the flower looks almost like an art deco sculpture to me.

        


        Original Lensbaby, 1/250 of a second with no aperture disk at ISO 400, hand held


        [image: missing image file]


        
          	This photo shows the sexual apparatus of an Easter Lily, a flower from a bulb originally imported from Japan. The bird’s eye view of pistils drenched in pollen attracts both pollinators and humans.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 2 seconds at f/40 and ISO 100, tripod mounted
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        	This photo of a wet poppy clearly shows the flower’s ovary, pistils and stamen as well as pollen that has mingled with the rain drops. The forthright presentation of the flower’s reproductive organs is partially what gives the image interest and power. Perhaps the contrast between these parts of the flower and the signs of its swift life cycle is what gives this photo poignancy. The pollen has, after all, mixed with the rain drops and can no longer be gathered.

      


      200mm macro, 1/25 of a second at f/36 and ISO 200, tripod mounted

    


    
      [image: missing image file]
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        	These photos show a group of stamen standing upright, anthers waving in the breeze. The stamens are grouped around a single style, which is perpendicular to the stamens. The stamen cluster is apparently holding the style in a posture that is reminiscent of dancing.

      


      
        	Top: The style is part of a pistil with stigma to the left (out of the photo), and it comes out of an ovary to the right (also not visible).

      


      50mm macro, 24mm extension tube, 1 second at f/32 and ISO 100, tripod mounted


      
        	Bottom: Compared to the photo on page 96, the camera is pulled back a bit in this view. From further back, the stamen appears to dance around and embrace the pistil.

      


      200mm macro, 36mm extension tube, 1.6 seconds at f/45 and ISO 100, tripod mounted

    

  


  
    


    
      
        Flowers and Light

      


      
        On page 90, I wrote about “the botany of desire,” and covered some of the things that make flowers a special subject matter to so many photographers. Viewed another way, as Gertrude Stein put it, “a rose is a rose is a rose”; to me meaning it’s just another object to be photographed. As with anything you photograph, when seen this way, the key issue is lighting and how it interacts with the flower.


        Flowers can be successfully photographed indoors, where you can control the lighting. Also, in a studio you don’t have to worry about movement from the wind spoiling long exposures. When I first started photographing flowers, I was hesitant to bring my flower close-up work indoors because I was afraid that the results would look unnatural. But as my technique has progressed, I’ve come to see controlled photography of flowers in the studio as complementary rather than competitive to outdoor flower photography. For example, I use the studio on days when the outdoor weather prohibits working because the light is “no good.”


        Indoors, I like to photograph flowers against a black background (see pages 108–111) or on a lightbox for a very white “high key” effect (see pages 102–107). Either way, you’ll probably need to light your subject at an angle from the front, using a somewhat diffused light source. See pages 80–83 for information about the direction of lighting and see pages 202–211 for more information about lighting close-ups.


        Outdoors, the key issues are perception and patience: perception because you need to be able to clearly see the effects of natural light on the flowers you want to photograph close-up, and patience because getting good results depends upon waiting for just the right light.


        While waiting for perfect lighting conditions in the garden takes time, the good news is that it is almost always a wonderful place to wait and meditate about the state of the universe. When I’ve spent a great deal of time waiting for the light to become “right” in the garden, I’ve noticed alternative subjects to photograph that I probably wouldn’t have seen if I were rushing through the motions of photography without pausing to observe.
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          	I cut a bunch of these poppies, Papaver rhoeas, from my garden and arranged them on a fluorescent lightbox to best show off the beautiful translucent reds of these petals. The trick to this kind of studio flower photo lies in arranging the flowers in a pleasing way You should also overexpose the image, because brighter photos appear more transparent.

        


        85mm Perspective Correcting macro, 8 seconds at f/51 and ISO 100, tripod mounted
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          	It rained overnight. In the first light of the morning sun, I photographed the translucent petals of this Rose (Rosa ‘Rio Samba’), lush and drooping from the weight of the water. A moment later the sun had moved on and was no longer hitting the water drops.

        


        200mm macro, 1/80 of a second at f/40 and ISO 200, tripod mounted
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        	To create this studio image, I placed this Gaillardia x grandiflora on a black background and lit the front of the flower using natural light and a diffuser. Then I used an LED light to shine pinpoint light from behind the flower at the center of the Gaillardia.

      


      200mm macro lens, 36mm extension tube, 4 seconds at f/36 and ISO 100, tripod mounted
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        	Calypso Orchids grow wild and close to the ground in shaded forests on the slopes of Mount Tamalpais, California, for a few weeks in the spring. I try to make a pilgrimage to photograph them every year.


        	
          This specimen held still for me for a full-second exposure as the dappled sunlight came through the forest cover.

        

      


      105mm macro, 36mm extension tube, 1 second at f/36 and ISO 200, tripod mounted
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        	The California poppy, Eschscholzia californica, native to California, was so named by the naturalist of an early Russian exploration ship to California after his good friend, the ship’s doctor. When I photographed this wildflower during its brief but intense life cycle in the California hills, I was struck by the intense backlighting and how the lighting from behind the flower projected a shadow of the flower’s petals on its front petals.

      


      105mm macro, 1/250 of a second at f/7.1 and ISO 200, hand held
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        	This opium poppy was brilliantly lit by the sun, with blown-out highlights. So I created a shallow-focus image centered on the flower core, which was shaded by the broad petals of the flower.

      


      90mm, 36mm extension tube, 1/160 of a second at f/5.6 and ISO 200, handheld

    

  


  
    


    
      
        Transparency in the Garden

      


      
        Transparency in the garden is a function of the direction and intensity of the light source (usually the sun) and the opacity of the parts of the flower, particularly its petals. Some flowers are simply opaque, and no matter what you do, light won’t shine through. Others have natural translucence, and when the sun is at the right angle, its light can be used to make photos with a great natural “stained glass” effect.


        When I’m aiming for a photograph showing transparent flower petals in the garden, I look first for perfect petals. The strong back lighting required for a transparent effect magnifies even slight imperfections.


        The best transparent effects are created, as I’ve already noted, by strong backlighting. At the same time, you don’t want the sun to be straight overhead, as this is more likely to produce a washed-out looking image than the vibrant colors you see in the most exciting transparent flower photos. So the best transparent effects in the garden occur shortly after the sun emerges from the horizon and just before it sinks below the horizon line. At these times of day, there’s enough light to create transparency, but it’s likely to be pleasing and not overly harsh.


        A little moisture on the flower petals—from overnight rain, morning dew or sprayed on with a mister by the photographer—helps to add to the transparency effect.


        The camera’s position is also a vital aspect of garden images that showcase transparency. Most of the time, the camera needs to be more or less opposite the sun, meaning low to the ground and pointed obliquely up at the flower (with the sun illuminating the opposite side). If you are using a tripod, you may need to consider a special setup for low-to-the-ground photography (see pages 64–67).
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          	I laid flat on the ground and positioned my camera on a Kirk Mighty Low-Boy cut-off tripod to capture the transparency of the petals on this poppy as lit by the morning sun.

        


        200mm macro, 0.1 of a second at f/36 and ISO 100, tripod mounted
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          	When I was looking at this alstromeria through my viewfinder, the lone water drop in shadow caught my eye. This shadow is created by the transparency of the petal as the sunshine filtered through the petal.

        


        85mm Perspective Correcting macro, 0.2 of a second at f/45 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      
        Transparency in the Studio

      


      
        One of my favorite effects to capture when I’m photographing flowers indoors is transparency. In this context, transparency means taking advantage of the inherent translucence of flower petals. This partial opacity is enhanced by either shining a light through the petals or placing the flower on a light source. Sometimes I even use both techniques at the same time.


        To pull off this technique, the first thing to look for is flower transparency. Before you start sending me e-mails to tell me how obvious this point is, bear in mind that it is not always clear what flowers, or portions of flowers, will actually be transparent until you shine a light through them. You may be surprised to find that flowers which at first glance appear fully opaque are actually semi-transparent when backlit.


        I find that a bit of moisture tends to increase apparent transparency. I use a small spray bottle dedicated to this purpose. Depending upon the final image that I’ve visualized, I’ll either leave small drops of water on the petals, or I’ll use a soft cloth to gently coat the petal with a bit of moisture.


        Even with flowers that have quite transparent petals, like the ones shown on these pages, you need to consider where opaque parts of the flower—such as pistil, stamen, style and ovary—will fit in your composition. I try to arrange these parts of the flower to reveal a pleasing but natural contrast to the softer and more transparent petals.


        Transparent flower images work best when they are somewhat overexposed, meaning the exposure histogram is biased to the right side. (See pages 72–75 for more about exposures and flowers.)


        A transparent flower image is generally lit with high-key (overexposed) lighting like that shown on these pages, particularly if the flower has been placed directly on a light source. In this case, the image of the flower benefits from the additional brightness of nuanced overexposure. Yet the overexposure makes no difference to a predominantly white background; after all, white is white.
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          	A white anemone is the simplest and most elegant of flowers. I used this composition to show off the elegance of the white-to-transparent anemone petals while contrasting the petals with the relatively opaque stem and flower core.

        


        105mm macro, 2 seconds at f/40 and ISO 100, tripod mounted
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          	I carefully applied a patina of water to enhance the natural transparency of this small flower.

        


        200mm macro, 8 seconds at f/36 and ISO 100, tripod mounted
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          	I placed this anemone on a lightbox and substantially overexposed it to create the subtle effect shown here.

        


        200mm macro, 3 seconds at f/36 and ISO 100, tripod mounted
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          	This dinner-plate-sized clematis blossom was placed on a lightbox for transparency. When I processed the blossom image, I combined six exposures. (See pages for 112–119 for more information about combining flower exposures.) All six were skewed toward high key, meaning a right-facing histogram and over-exposure bias.


          	
            I used my PC Micro Nikkor 85mm f/2.8, a wonderfully sharp and old-fashioned lens. This lens allows modified tilts and swings, which lets me get the perspective exactly right so the flower appears centered in the frame.

          

        


        85mm Perspective Correcting macro, 1 second and f/14 at ISO 200, tripod mounted

      

    


    
      
        
          	These poppies were arranged on a lightbox and I carefully uncurled the lower petals. These flowers are not as transparent as they may seem in this photo. I orchestrated the impression of transparency by making sure that the outer petals—naturally the most transparent—were the flattest. The illusion of transparency on the outer portions of these flowers draws in the eye and makes the whole image seem more transparent than it actually is.

        


        105mm macro, 0.8 of a second at f/36 and ISO 100, tripod mounted
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        Flowers on White

      


      
        Flowers can look great on a white background, even when the desired effect is not transparency. (For information about transparent flower images on white, see pages 102–105.) I’ve found that the most important issue in creating interesting photos of opaque flowers on a white background is the contrast between the flower and the background.


        Perhaps the small tendrils at the end of the flower curl to make an exotic pattern as in the Rose Cone Flower on white shown below. Or maybe the pollinator’s flight path is marked and seems to stand out in three-dimensional space as in the Iris on a white background to the right.


        The common thread of these photographs is that specific elements contrast in an interesting way with the white background. When selecting a flower for a shoot, look at the edges of the flower to see how well they contrast with the background. Also, take into consideration the markings on the flower and see if they work well with white.
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          	I photographed this Iris against white to emphasize the petal markings and yellow glow (toward the rear of the petals) that are intended to attract and guide bees and other pollinators.

        


        100mm macro, four exposures at shutter speeds from 1/2 of a second to 2 seconds, combined in Photoshop, each exposure at f/22 and ISO 100, tripod mounted


        [image: missing image file]


        
          	To create this photo of a Rose Cone flower, I snipped the flower off the bush and placed it on a lightbox. With a macro lens, I shot a wide range of exposures, and all at the same stopped-down f-stop (f/36). I ended up with five exposures at 1 second, 2 seconds, 4 seconds, 8 seconds and 16 seconds.


          	
            In Photoshop, I started with the lightest exposure (16 seconds) to get a pure white background. Then I layered in the different exposures, getting selectively and successively darker.

          

        


        200 mm macro, five exposures at shutter speeds from 1 to 16 seconds at f/36 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Flowers on Black

    


    
      A white background allows you to show off the delicacy and transparency of your flower subjects (see pages 102–107). A black background is also great for flower photographs and it is perhaps the most dramatic setting for floral imagery. On black, you can still photograph with the aim of displaying delicacy; yet it also provides opportunity to bring out the drama in flower coloration.


      When photographing flowers on a white background, I normally overexpose and aim for a rightward-biased histogram. The opposite is true when I photograph flowers on black: I underexpose and aim for left-biased histograms. Some underexposure deepens the black background and adds to the saturation of colors in the flowers.


      If you are planning to photograph flowers on black, consider the material of the background and how the flowers will be positioned on it. Black velvet cloth works well because it doesn’t reflect light. You can drape it as a background for larger flower arrangements or pin single blossoms to it using a pin inserted in the flower stem. Also you can suspend a flower or branch over a black background using a thin wire and light it from behind; the wire can be retouched out later in post-processing.
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          	I placed this Papver Rhoeas ‘Dawn Chorus’ on a black background to bring out the colors in the flower as much as possible using contrast.

        


        200mm macro, 36mm extension tube, three combined exposures at shutter speeds from 1/4 second to 1 second; each exposure at f/36 and ISO 100, tripod mounted
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          	Hellebores are delicate flowers that bloom close to the ground in partial shade. They are typically a spring flower and one of the first of the year. This almost-all-white blossom was hidden from view on a stalk that almost bowed to the ground. I cut the flower from its stalk and then mounted it with a pin on black velvet backed with cardboard.


          	
            I lit the flower evenly from both sides and shot straight down, taking care to underexpose with a histogram biased to the left. My choice of exposure let the background go completely black, which brought out the detail in the delicate white flower.

          

        


        100mm macro, four exposures at shutter speeds from 2 seconds to 8 seconds, combined in Photoshop; each exposure at f/22 and ISO 100, tripod mounted
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          	With bougainvilleas, the actual flowers are not very interesting. The real action is in the bract, the specialized leaf structure that hosts the somewhat-uninspiring flowers.


          	
            To photograph this bougainvillea bract, I placed it on a black background, suspending it with tiny wires that I later retouched out. I lit the bract evenly from both sides. Then I brought out the transparency of leaf portions with a small LED spotlight positioned behind the leaf.

          

        


        200mm macro, 1.6 seconds at f/36 and ISO 100, tripod mounted
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          	I photographed these roses on a black velvet background using sunlight that was focused using window shades. In this kind of situation, it is important to underexpose relative to an overall meter reading; because you want the background to go completely black, and you want the flowers to appear as saturated as possible.

        


        35mm, 1.6 seconds at f/29 and ISO 100, tripod mounted

      

    

  


  
    


    
      
        HDR Flower Photography

      


      
        My assignment: to shoot a flower for a cosmetics advertising campaign. According to the art director, I needed to capture “unimaginable folds of pink softness.” I choose Papaver rhoeas ‘Falling in Love,’ a double variety of Papaver rhoeas, for one of the subjects of this campaign.


        In my studio, I put a cut flower in a glass flute to keep it upright, and I then placed the flute on a black velvet background. The background rested on a board and a rod placed between two supports. I positioned the flower so sunlight struck it from behind and to one side. Then I used a large piece of soft gauze to soften the sunlight.


        Looking at the initial results of my shoot using this simple setup, I saw I had a problem. The exposures that were perfect for the portions of the flower in the sun made the rest of the flower too dark, and the exposures that worked for the darker areas made the sunlit areas too bright.

        (See versions A through C below.)


        To get the image of unimaginable folds that my client wanted, I needed to combine different exposures of the flower. Here’s where HDR came to my rescue.


        HDR is short for High Dynamic Range, and it is used to describe images in which the light tones are brighter and the dark tones are darker than we’ve come to expect from photographs. HDR achieves its goals by combining different exposures of the same image.


        Put a little differently, dynamic range is the difference between the lightest tonal values you can see (the bright sunshine on the flower) and the darkest tonal values in which you can still perceive a faint bit of detail (the shadows). Bright areas, also called highlights, that are so bright that you can no longer see any details are said to be “blown out”; dark areas that have gone totally black are “plugged.”


        Mastering the craft of extending digital dynamic range opens the possibility of compositions that would have been impossible in the past because of dynamic range limitations.


        While most people think of HDR as a technique that is applied to landscapes with bright skies and dark foregrounds, it also works extremely well with floral imagery. One great thing about well-handled HDR photos is that people don’t know how it was done; but if the process is done well, they realize that the results are subtle and beautiful.


        There are quite a few software programs you can use to combine the different exposure versions. Photomatix is the best-known software application known specifically for the HDR imaging process, and Photoshop also has some decent automated HDR capabilities.


        I prefer to manually process my HDR images of flowers using Hand HDR. With this technique, I place the different exposures on top of one another as layers in Photoshop, and then decide on an area-by-area basis how to combine the exposures. (See page 234 for resources related to HDR and Hand HDR processing.)


        To create the final image of the poppy with an extended dynamic range, I carefully combined the three exposures as follows.
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          	All three versions: I photographed this dramatic poppy on a black velvet background. (See text on the previous page for the details of the setup.) To compensate for the varied lights and darks in the flower, I shot three versions at different shutter speeds and the same aperture.

        


        Top: Version A, 200mm macro lens, 1/2 of a second at f/36 and ISO 100, tripod mounted


        Middle: Version B, 200mm macro lens, 1 second at f/36 and ISO 100, tripod mounted


        Bottom: Version C, 200mm macro lens, 2.5 seconds at f/36 and ISO 100, tripod mounted
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          	Step 1: With the three versions of the poppy opened in separate windows in Photoshop, start with the darkest poppy as the bottom layer in the Layers palette. This layer will be used for the black background, and it will also be used for darker portions of the flower.
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          	Step 2: Hold down the Shift key and use the Move Tool to drag the medium version from its image window on top of the darker version. Release the mouse before you release the Shift Key. This will perfectly align the layers on top of each other. There are now two layers, “Medium version” and “Darkest version,” in the Layers palette.
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            	Step 3: With the “Medium version” layer selected in the Layers palette, choose Layer ► Layer Mask ► Hide All to add a Layer Mask to that layer. The Hide All Layer Mask hides the “Medium version” layer and appears as a black thumbnail in the Layers palette.
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            	Step 4: Select the Brush Tool from the Toolbox and set Opacity set to 50% and Flow to 50%. Make sure the layer mask on the “Medium version” layer is selected. Use white to paint on the layer mask in the areas where the flower needs to be lighter.

          

        


        
          This is how the painting on the layer mask looks.
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          	Step 5: Repeat Step 2, but this time drag the lightest version from its image window onto the image window you’ve been working in. There are now three layers: “Lightest version,” “Medium version” and “Darkest version.”
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          	Step 6: Repeat Step 3 but with the “Lightest version” layer selected in the Layers palette. Choose Layer ► Layer Mask ► Hide All to add a Layer Mask to that layer.
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            	Step 7: Repeat Step 4, but this time paint on the “Lightest version” layer mask to paint in lighter areas and highlights. The results are shown on the right on page 123.

          

        


        
          This is how the painting on the layer mask looks.
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          	In Photoshop, I combined three exposures at times from 1/2 of a second to 2.5 seconds to capture the full dynamic range of the light falling on the delicate pink petals.

        


        200mm macro lens, three exposures: one at 1/2 of a second, one at 1 second, and one at 2.5 seconds; all exposures at f/36 and ISO 100, tripod mounted

      

    

  


  
    
      


      
        Focus Stacking

      


      
        Focus stacking—also called HFR (High Focal Range)—is a technique that combines two or more exposures that are focused on different spots to create an image with a greater range of focus than any single image could. Like HDR, to get good results with focus stacking you should plan to use the same aperture in each exposure that goes into the blended focus stack.


        As with HDR, you can use Photoshop to create a focus stack automatically, or do it manually in Photoshop using layers and masking. I’ll show an example of both techniques in this section.


        Generally, you do better with automated focus stacking with five or more exposures. Yet if you are manually creating an image that includes two focus points, it can work fine with just two exposures, provided that one of the images “sits” nicely on top of the other. For this to happen, there must be a clear demarcation between the two exposures (the core of a flower and the petals, for example, like the red flowering dogwood shown on pages 130–131).


        When I shoot a series of images for focus stacking in Photoshop, I make sure to focus on every plausible point that I see. The biggest mistake you can make in shooting these images is to omit a point of focus by mistake. However smart the software is, it cannot possibly include something in focus if the object is not in focus in at least one of the source images.


        Also bear in mind that being partially out-of-focus can enhance many flower images; like with glamour portraits, end-to-end sharpness can be a mixed blessing.


        The following pages show how to create an image using focus stacking in Adobe Photoshop CS4.

      


      [image: missing image file]


      
        
          	Step 1: Shoot five or more images at the same aperture, making sure that every spot in the image is in focus in at least one image. For this demonstration, I shot twelve versions of this orchid with focal points all over the flower. (Only nine are shown here in this window.)
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          	Step 2: Process the images you are going to stack in Adobe Camera RAW (ACR). Select all of the images and process them at the same time using the same settings. Save the images as PSD files (Photoshop’s native format) in one folder and then close them.
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          	Step 4: In Adobe Bridge, select all the images. From the Bridge Tools menu, choose Photoshop ► Load Files into Photoshop Layers.
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          	Step 5: In Photoshop, each image is now a layer in a single multi-layered document. Open the Layers Palette and multi-select all the layers.
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          	Step 6: Choose Edit ► Auto-Align Layers. In the Auto-Align Layers dialog, select Auto and then click OK. You may want to go out and get a cup of coffee while your system works, depending on the number of layers and your system. Photoshop aligns the layers by matching the features in each image. So if your tripod slips a bit and the center of the image shifts while you take multiple captures, Photoshop will fix it for you.
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          	Step 7: Choose Edit ► Auto-Blend Layers. In the Auto-Blend Layers dialog, select the Stacking radio button, and then click OK. Go get another coffee.
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          	Photoshop creates a mask for each layer so that only the elements in each layer that are in focus are visible.
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          	Step 8: Choose Layers Flatten to merge all the layers into one layer. You can now process your hyperfocal photo as you would a normal photo. The results are shown to the right on page 131.
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          	To create this demonstration of focus stacking, I lit this orchid from behind and intentionally chose a wide open aperture (f/4.5) for low depth-of-field.

        


        200mm macro, 36mm extension tube, twelve exposures (each at a different focus point and combined using focus stacking in Photoshop); each exposure at 1/40 of a second and f/4.5, tripod mounted

      

    


    
      
        Putting Images Together by Hand

      


      
        In many situations, you don’t need software to combine images to extend focal range—in fact, you may be able to do it better than any machine!


        The things to look for are pieces that seem to logically fit together and an object in the front focal plane that “hides” the connection to the rear plane of focus. For example, the core of the red flowering dogwood shown on this page covers the connection between the flower core and the petals behind it.

      


      [image: missing image file]


      
        
          	This photo was focused and exposed for the dogwood flower core.

        


        200mm, 0.8 of a second at f/40 and ISO 100, tripod mounted
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          	This photo was focused on the dogwood petals.

        


        200mm, 1/6 of a second at f/40 and ISO 100, tripod mounted
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          	When I shot this red flowering dogwood on a bright spring day, I realized that even fully stopped down I could get both the reproductive organs of the flower and the petals in sharp focus. Using the same aperture (f/40 for maximum depth-of-field), I shot one image of the flower core (page 132 top) and the other of the petals (page 132 bottom). This composite is an example of HDR as well as focus stacking. Since I knew I would be compositing anyhow, I exposed the version that shows the brighter petals at a shorter time (1/6 of second) than the darker core, which needed a 0.8 of a second exposure.

        


        200mm, two exposures combined in Photoshop with different focal points, combined using layers, masking and the Brush Tool: one at 1/6 of a second and one at 0.8 of a second; both exposures at f/40 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      Selective Focus

    


    
      With focus stacking, the goal is to create a floral image that is entirely in focus. But sometimes out of focus is good, particularly when it comes to colorful flowers.


      Good selective-focus images hone in on the most important element in a composition by making sure the rest of the close-up is attractively out of focus. The areas that are out of focus in the photo don’t compete with the central elements, and they make the main subject seem more important.


      To create a good selective-focus image, look for flowers that can be isolated against the background or against other clumps of flowers that contrast in some important way with the in-focus flower. Out-of-focus elements should frame the central in-focus flower, so it seems as though you are peering through a window, and only the central pane is really clean. Using focus as this kind of framing device adds to the compositional interest of a flower close-up, and it is a technique to remember when photographing in the garden.
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          	I used a 200mm telephoto lens focused on the flowers that are the subject of this photo to frame these central flowers using the out-of-focus flowers on top and bottom. I picked an intermediate f-stop (f/14) that kept the subject flowers in focus, without extending the field of focus too far.

        


        200mm, 1/250 of a second at f/14 and ISO 100, tripod mounted
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          	I used a moderate aperture (f/14) to keep this Echinacea ‘Harvest Moon’ core and petals in focus while allowing the background to blur. The contrast between the thin, white petals and the green background helps to make this image work for me.

        


        105mm macro, 1/4 of a second at f/14 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      
        Motion

      


      
        Motion is often the enemy of close-up photographers in the garden or field. One approach to stopping motion is to use flash for lighting your photos, so that your effective shutter speed becomes the duration of the flash (see pages 84–87). But if you are relying on natural lighting, stabilizing flowers in the wind is such an issue that several specialized clamps have been invented just to keep flowers still

        (see sidebar).


        There’s a saying about “making lemonade from lemons.” If you are in the garden photographing flowers and it is windy, it makes sense to see if you can take advantage of the situation. Look for moderate shutter speeds in the range of 1/15 to 1/125 of a second that enable you to retain some of the shape of the moving flower without making it utterly unrecognizable. Also look for situations in which some flowers are moving faster than others. The contrast in effect between the faster flowers—which will appear quite blurred from motion—and the slower moving flowers that mostly keep their shape makes for interesting imagery.

      


      
        
          
            	Plant Clamps

            

            Even slight amounts of wind can be frustrating to photographers looking to make close-up photos of flowers, because many flowers are engineered to be especially sensitive to motion. Moving around in the wind may help these flowers spread their pollen; it’s part of a species-survival strategy. Check out a flower in your garden or in the wild. It is likely to be at the end of a long, slender stalk that is in near constant motion.

            

            There are several specialized clamps on the market to help deal with this problem. One end of the clamp is specially designed to protect and be gentle with flowers. Flower clamps themselves are made of bendable plastic, and they attach to a stake in the ground (the McClamp Stick) or to your tripod or other solid support (McClamp and the Plamp). See page 234 for web addresses for these products.
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          	I used the McClamp Stick (that you can see reflected in the water drop) to hold the branch and drop in position so I could use a fairly long (1/3 of a second) shutter speed.

        


        200mm macro, 55mm extension tube, 1/3 of a second at f/36 and ISO 100, tripod mounted
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          	The orange California poppy was moving fiercely in the wind, but it was not as fast as the surrounding purple flowers. It took some experimentation, but I found a shutter speed (1/125 of a second) and aperture (a wide open f/5.6) combination that isolated the poppy in motion, allowing its essential shape to be captured while rendering the surrounding flowers only as motion blurs.

        


        130mm, 1/125 of a second at f/5.6 and ISO 200, tripod mounted

      

    

  


  
    
      

    


    
      
        Impressionism

      


      
        Impressionism was a movement of painters in the 19th century who reacted against strict conventions of painterly realism by emphasizing light, color and motion in their work. Just like the impressionists, close-up photographers do not need to be bound by the strictures of working to create photos that are sharp and realistic end-to-end. Impressionistic flower close-ups can be very beautiful.


        Photographers work with cameras and lenses, not paintbrushes. Often, the impressionist painters used visible brush work to create their masterpieces. The photographic tools are different.


        First, look for subject matter that emphasizes highly saturated and attractive colors. A contrast of complementary colors may add to an impressionistic photo composition, as it did to the paintings of the impressionists.


        Strong lighting sources may also help provide an impressionistic effect, particularly when the flower you are photographing is backlit.


        You can help to create impressionistic effects from your flower images by taking advantage of selective focus (pages 124–145) and by selecting a shutter speed intended to enhance motion blurs (pages 126–127).
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          	This image combines selective focus and motion blur to create an impressionistic effect.

        


        200mm macro, 1/40 of a second at f/16 and ISO 100, tripod mounted
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          	I used a wide-open aperture (f/2) to create an impressionistic, painterly overall effect in this flower close-up.

        


        100mm macro, 1/800 of a second at f/2 and ISO 200, hand held
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          	I photographed this California Poppy, Eschscholzia californica “Purple Gleam,” hand held and into the sun, with the idea of creating an impressionistic effect using the strong backlit colors.

        


        200mm, 36mm extension tube, 1/250 of a second and f/8 at ISO 200, hand held

      

    

  


  
    


    
      Colors and Abstraction

    


    
      It goes almost without saying that one of the most enticing things about flowers, and why they make such great close-up subjects, is their colors. It’s the very attractiveness of these colors that can take your flower close-ups to another level.


      Create compositions that are elegant and filled with powerhouse color combinations, and you’ll be on your way to an abstraction that has appeal even beyond its origins as a flower close-up.


      To make this kind of photo, look carefully at the colors in the flowers you are photographing. Try to emphasize colors that are especially vibrant, and find color combinations that work well together.


      When it comes to color, painters such as the impressionists (see pages 128–131) emphasized complementary colors. These are color pairs that are opposite to one another on the color wheel. Two of the basic complementary color pairs are blue-yellow and red-green.


      To create effective color abstractions when you photograph flowers, learn to recognize complementary color pairs and feature them in your close-ups.
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          	I knew that the drops of water in motion would make an interesting semi-abstract pattern in the sun. I framed the photo to include the complementary red flowers on a green background. These elements are partly obscured, which adds to the abstract effect.

        


        200mm macro, 1/350 of a second at f/10 and ISO 100, tripod mounted
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          	I got low to the ground so I could photograph the incredible brilliance of red presented by the petals of this flower in contrast to the sky.

        


        200mm macro, 1/20 of a second at f/36 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	When I framed this composition, I was struck by the intense colors and abstract shapes. My idea was to create an image that could work on its own as abstraction of shadows and light, even if the viewer didn’t know it was an Iris.

        


        105mm macro, 1.3 seconds at f/32 and ISO 200, tripod mounted
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          	Close-up, the folds of this Iris have an intimate, but abstract, look.

        


        105mm macro, 10 seconds at f/40 and ISO 200, tripod mounted
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          	In this composition, I took advantage of the resemblance between the Iris petal and a tongue trying to “taste” the pollen.

        


        105mm macro, 2 seconds at f/32 and ISO 200, tripod mounted

      

    

  


  
    
      

    


    
      
        Flowers and Digital Painting

      


      
        I believe that digital photography is one part photography and one part digital post-processing. In this sense, digital photography is a new art form.


        One shouldn’t forget the lessons of the past; it pays to learn as much about conventional photographic technique as possible. But it also doesn’t make sense to be limited by the techniques available only in the camera. This is why I sometimes use my close-ups of flowers as the basis for digital painting. It’s a way to take them to another level.


        By digital painting, I mean using Photoshop to combine portions of images with themselves, using layers, blending modes, alternative colors spaces and—perhaps most importantly—painting directly on the photos using the Photoshop Paintbrush tool. I use a wide variety of Photoshop techniques. If you want to learn more about my techniques, there is a suggestion for further reading on page 234.


        If you are interested in shooting a flower close-up as the basis for a digital painting, try to visualize what your final image will look like before you start shooting. With the final image in mind, you can make decisions about background—whether to shoot on white or black, for instance—how to light the subject, and what exposure to use.


        When I start a digital painting based on a flower photo, I realize that I will be spending more time on the computer than behind camera. Even if my digital paintings based on flower close-ups are not entirely realistic, I try to create images that are faithful to the spirit of my idea of nature. These images do not stray completely from their origins as photos of botanical objects.
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          	Starting with a photo of a white Hellebore like the one shown on page 115, I used the Photoshop Brush Tool to add blue to the petals of this flower.

        


        100mm macro, 1/2 a second at f/11 and ISO 100, tripod mounted
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          	I photographed this small anemone Japonica on a white background and used LAB color inversions in Photoshop to put the flower on a black background and add color. (See page 234 for further reading about these techniques.)

        


        200mm macro, 3 seconds at f/36 and ISO 100, tripod mounted
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          	I started with a straightforward shot of a large Clematis blossom mounted in front of a black background and lit from behind. In Photoshop, I used a blending modes, layers, masking and painting on the masks to create this effect. (See page 234 for further reading about these techniques.)

        


        105mm macro, 0.6 of a second at f/36 and ISO 100, tripod mounted
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          	Starting with the image shown above, in Photoshop I inverted the colors using the LAB color space and then placed the results on a white background. I tweaked the image by directly “painting” on the petals.

        


        105mm macro, 0.6 of a second at f/36 and ISO 100, tripod mounted

      

    

  


  
    


    
      Universe in a grain of sand
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          	Looking through the viewfinder at this water drop, I was reminded of the line from the William Blake poem about seeing the world in a grain of sand. I made sure to focus on the sand within the water drop—rather than the external wet membrane of the drop itself—so that the clarity of the internal world of sand became evident in this photo.

        


        200mm macro, 36mm extension tube, 1/2 of a second at f/32 and ISO 100, tripod mounted

      


      
        Water Drops on Parade

      


      
        Water drops are an extraordinary—but challenging—subject for extreme close-up photography. Reflecting the world around them and the light that shines on them, water drops often enclose attractive detritus in their own hermetic bubble. Adding to the challenge of photographing a subject at sizes ranging from small to absolutely tiny, most water drops—especially outdoors—are subject to constant motion.


        To make up for these difficulties, water drops can be extraordinarily fascinating and beautiful.


        As I’ve mentioned, motion is a particular problem with water drops because I like to use a stopped-down small aperture for high depth-of-field. In addition, water drops are often in dark places, and less light hits the sensor as close-up magnification gets greater. So, this is a triple whammy. You need a longer shutter speed here because of three factors:


        
          	The small aperture used to increase depth-of-field


          	Light fall-off because of the magnification factor of the macro lens


          	The dark conditions where water drops are usually found

        


        It’s normally not practical to use a flash because of the reflectivity of the drop itself, though it is possible sometimes. See pages 84–85 and page 180 for examples of successful water drop flash technique.


        There’s really no good answer to the problem of needing a long shutter speed to photograph an object that moves. You just have to wait for the right moment. In some cases you may be able to use a flower clamp to restrain the surface on which the water drop rests. (See page 126 for more information about flower clamps.)


        Another issue when photographing water drops is focus. As with any really small object, critical focus is both crucial and difficult. A magnifying eyepiece may help, as I suggest on page 70.


        Even with a focusing aid, you’ll find that the interior of a water drop with reflections may focus as far out as infinity, while the surface of the drop is extremely close. There’s no perfect solution for this dilemma: you’ll have to decide to focus on the scene inside the drop or the exterior surface of the drop. You can also sometimes focus on a third area, the reflections toward the surface of the drop where they’ve been bent by refraction and do not look like

        the normal world. (See pages 168–179 for more about reflections and refractions in water drops.)


        Water drops don’t just come solo. Often, drops are part of packs or flocks—and make a pattern of small objects. When I first started photographing water drops, it was drops en masse that I found most interesting. I looked for spider webs and leaf surfaces that catch and hold groups of drops after rain, and I tried to create interesting compositions out of the water drops on parade.
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      	After a heavy rainstorm, I found these water drops en masse on a spider web. The water drops reflect what’s around them, including—in some drops—me, my camera and my tripod; although you have to look really close to see this.

    


    105mm macro, 68mm combined extension tubes, +4 close-up filter, 0.3 of a second at f/36 and ISO 200, tripod mounted
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          	The color in these water drops on a spider web comes from the pink flower seen out-of-focus in the background.

        


        200mm macro, 36mm extension tube, +2.9 close-up filter, 0.3 of a second at f/45 and ISO 100, tripod mounted using a Kirk Mighty Low-Boy (see page 67)
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          	Drops from heavy morning dew lay on the Rosa ‘Rio Samba’. I arranged the composition so all the water drops reminded me of a city, or civilization, all huddled together on the side of a flower cliff.

        


        200mm macro, 36mm extension tube, 1/30 of a second at f/36 and ISO 200, tripod mounted
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          	Following an overnight shower, the drops of water on this blade of grass reminded me of people queuing for a bus, or lemmings about to fall off a cliff. I waited for the blade to be absolutely still in the wind and focused on its center to get as much as possible of the composition in focus.

        


        105mm macro, 68mm combined extension tubes, 4 seconds at f/36 and ISO 200, tripod mounted

      


      
        
          
            	Drops, Drops, Drops

            

            It may surprise you to know that water drops differ depending on their source. Raindrops (example page 154) look different from dew drops (example page 153). Raindrops are sharper and more defined than dew drops, and both are qualitatively different from the extremely regular water drops that result from irrigation (see page 173). Hoses produce large but irregular drops (see the example page 164), and sprayers create extra fine drops (see the examples pages 105 and 131). Of course, there are many other variables besides water source, including wind direction, temperature, humidity and force with which the drops landed.

            

            Natural water drops tend to be less regular than those generated artificially, and they are usually more spread out. (This distinction reminds me a bit of fish caught wild versus farmed fish!) Raindrops are larger than dew drops, and water drops from a properly wielded hose are likely to be larger than drops from a hand sprayer or mister.

            

            The moral here is that photographing water drops outdoors in an exercise in applied field photography. Even though water drops seem commonplace, to photograph them well, you need to use the same kinds of skills of observation and patience that you would use to photograph exotic flora or fauna.
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          	With this photo, I experimented with the Lensbaby and its close-up filter kit to add excitement and drama to a shot of drops on a leaf. I was particularly pleased to see the halo effect around the out-of-focus drops that reflected the sun.

        


        Lensbaby 2.0 +14 macro filters, 1/320 of a second using f/8.0 aperture ring at ISO 200
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          	I was surprised to find the extent of the water drops on this spider web hidden beneath an over-hanging bush. I photographed the drops on the web from a distance, trying to get as many drops as possible into the frame.

        


        200mm macro, 1 second at f/36 and ISO 100, tripod mounted


        [image: missing image file]


        
          	The sunlight glinting on these water drops makes them look suspended in space, in part because I underexposed the photo so that the background (other than the water drops) went dark. To make this exposure as vibration-free as possible, I locked up my mirror before making the exposure, a technique I often use with extreme close-ups (see sidebar above).

        


        200 macro, 36mm extension tube, +4 close-up filter, 0.2 of a second at f/36 and ISO, tripod mounted
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          	Photographing these drops caught in a spider web extremely close-up, the challenges were accurate focusing and waiting until the drops were still in the wind. Although a web inherently stabilizes the drops that rest on it, water drops are susceptible to any movement or breath of wind and are always in motion at the macro level. So a shot like this takes a great deal of patience. I had to find a period of a second (the exposure duration) without any breeze.

        


        105mm macro, 68mm combined extension tubes, +4 close-up filter, 1 second at f/36 and ISO 200, tripod mounted

      


      
        
          
            	Locking Up Your Mirror

            

            When photographing water drops, slight movements in your subject can ruin the sharpness of these high-magnification and relatively long exposure images. The water drops, it turns out, are not the only thing that can wreck your photo by moving.

            

            A good, steady tripod is an essential tool in close-up work. But even if your tripod is rock steady, DSLRs themselves can cause vibration when the mirror goes up to make an exposure.

            

            As you may know, when you look through a DSLR, you are looking through the lens via a system of mirrors. When you make an exposure, the mirror goes up before the shutter opens. This can cause vibration.

            

            It surprises many people to learn that this problem is worst at moderately long shutter speeds (between about 1/30 of a second and 2 seconds), and not at longer shutter speeds. The reason is that any vibration caused by the mirror takes up a smaller proportion of a longer exposure, and therefore doesn’t matter as much.

            

            These moderately long shutter speeds are water drop territory. For that matter, these shutter speeds are used for a great deal of close-up work. Therefore, to get the best results, you need to lock your mirror up before you expose.

            

            It works like this. First, set the mirror to lock up. Then compose the photo and make your exposure settings. When you press the shutter release—using a remote to reduce vibrations—the mirror locks up. If you look through the viewfinder at this point (with the mirror locked up), you’ll see nothing but blackness.

            

            Wait a few seconds for mirror-related vibrations to tamp down. Press the shutter release a second time to make your actual exposure.

            

            Check your camera manual to learn how to set the mirror to lock up.
          

        
      

    

  


  
    


    
      
        Natural Jewelry

      


      
        My first interest in water drops was to create photos that showed their en masse patterns (see pages 150–159). But pretty soon I looked a little closer, and saw that smaller groups of drops had an interest of their own.


        As I got closer, I felt that I was looking at nature’s jewelry: objects that were small in scale but beautiful beyond the ability of words to describe. Like gemstones, I developed a water drop scale of size, clarity and color. The best of nature’s water drops are large (for a water drop), colorful and have clear interiors. (You might be surprised at how murky the water in a water drop near mud can get!) Careful observation is the best place to start with this kind of water drop photography.


        As I started to focus on small groups of drops, and got closer to them with my camera, the issues of movement and focus became even more critical than with larger groups of water drops. No longer looking for overall patterns, I tried to find drops that singularly, or with their companions, showed an extraordinary glimpse into a new and different world.


        I realized that with one exposure, I probably couldn’t have both the interior and the exterior of a drop both fully in focus; so I chose my focus point with a great deal of care, and I experimented with different focus points.


        There was no easy solution to the problem of drops in motion. I knew that if there was a spring storm overnight and a still morning, it was time to get out and photograph drops.


        It’s hard to tell as you shoot whether an image is really razor sharp, so I overshot—taking an exposure every time the wind seemed still … and hoping that one of the exposures would actually be crisp.


        With water drops all together, the grouping and pattern made the photos compelling. On the other hand, with smaller groups of water drops, I had to pay more attention to issues of framing and image design. I looked for photos in which there was a context and effective framing, I also looked for some visual reason for the drops to appear where they did.
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        	Partly shaded by a climbing rose, water drops clung to a lovely clump of variegated gladiolas in the early morning. When I saw the flowers in each of these drops, I knew I had a winning photo … provided I could get the drops to stay still for the length of the exposure (1/4 of a second). I shot about 100 exposures, and when I examined them on the computer, the last exposure was sharp because the drops had been still enough.

      


      200mm macro lens, 36mm extension tube, +4 close-up filter, 1/4 of a second at f/36 and ISO 200, tripod mounted
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          	To create this photo, I positioned my camera so the bright red cyclamen leaves appeared to be in the sunshine against a dark, shaded background.


          	
            When the composition of a photo is about pattern, a single color often plays an important role. Cases in point: this photo of the cyclamen above is almost entirely red, with a few green accents.

          

        


        200mm macro, 36mm extension, 3 seconds at f/36 and ISO 100, tripod mounted
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          	I framed this shot of spring garden flowers using out-of-focus freesia buds on the borders of the composition.

        


        200mm macro lens, 36mm extension tube, +4 close-up filter, 0.4 of a second at f/36 and ISO 200, tripod mounted
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          	After a night of gentle rain, I went out into the garden on a bright, overcast, windless morning. The patterns in the water drops on these freesias caught my attention. I tried to frame the composition so the water drops appear situated in a vast forest made up of flower stalks and buds.

        


        200mm macro lens, 36mm extension tube, +4 close-up filter, 0.8 of a second at f/36 and ISO 100, tripod mounted
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          	To hold the branch bearing these water drops in place, I used a McClamp Stick (see page 126). I used a small aperture (f/36) to magnify the sunburst effect.

        


        200mm macro, 55mm extension tube, 0.1 of a second at f/36 and ISO 200, tripod mounted

      

    

  


  
    


    
      
        Reflections and Refractions

      


      
        A reflection is a mirror image in which left and right are reversed. Refractions are caused by the change in a light wave in relation to its speed. Refractions are seen as curvatures and distortions in reflections (because the speed of the light changes as it enters the water).


        Reflections depend upon light directed at a reflective surface and how reflective the surface is itself. Given a water drop in a decently lit position, it is quite likely to reflect some aspect of the world around it. Considering the curvature of the liquid medium that is causing the reflection, any time you see a reflection in a water drop, you are also likely to see refractions.


        Clear water as a medium is not particularly interesting. But when reflections are added, particularly when the reflections are of garden hues, along with some refraction, you get quite an interesting subject.


        The way reflections and refractions appear in your photos depends upon the subjects that are reflected in the water drop. It also depends on the light hitting the drop, the precise angle of view you choose to use, your lens and your f-stop. This means that you should carefully try a variety of positions and distances from the water drop until you see the most colorful and clear reflections and refractions in the drop.


        You may want to experiment with different lenses and a variety of f-stops. It makes sense to use a longer macro lens (see pages 48–51), so that your lens itself doesn’t become the primary subject of reflections.


        Don’t forget to check your composition with the depth-of-field preview engaged. The appearance of reflections and refractions can change greatly depending upon your choice of aperture.
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          	I spotted this water drop reflecting a nearby Lobelia but realized that the drop was too near the ground to get a tripod into place. So I shot the image on my belly hand-held … not my usual practice when the subject is a water drop.

        


        105mm macro, 1/60 of second at f/18 at ISO 100, hand held


        [image: missing image file]


        
          	In making this photo, I was trying for a stained-glass effect. I shot the image first thing in the morning, down as low as possible, with the sun reflecting and refracting on a potted lobelia. This was one of those photo sessions that got me down on my belly, covered with water and mud, to find the right position.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 0.4 of a second at f/40 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	Refraction distorts the flower reflections in this drop, making an image that is partially impressionistic.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 1.5 seconds at f/45 and ISO 100, tripod mounted


        [image: missing image file]


        
          	This water drop suspended on a spider web reflects the flower below. I think the flower reflected in the drop is by far the most attractive thing in the composition, so I selectively focused on it to emphasize its importance—as opposed to the rather odd drop on the lower left.

        


        200mm macro, 36mm extension tube, 1 second at f/36 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	This water drop, on a hybridized coneflower has been highly magnified. I used a combination of a macro lens, extension tubes and a close-up filter, with the most depth-of-field I could get. The technique here was to focus accurately and to be patient enough to wait for the subject to be still.


          	
            I like the way you can see a second reflection of the coneflower petal in this photo if you look down in the reflection to the right. The reflection is clear enough to have a great deal of depth.

          

        


        200mm macro, 36mm extension tube, +4 close-up filter, 0.8 of a second at f/36 and ISO 100, tripod mounted


        [image: missing image file]


        
          	The very clear reflections with slight refractions in this water drop show telephone wires and parts of the world that do not seem to belong in a garden; however, this contrast doesn’t detract from the overall clarity of the reflections.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 0.2 of a second at f/36 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	I stopped down for maximum depth-of-field at f/32. Using a setting of ISO 200, I exposed the top image at 1/60 of second. While I was exposing for the bright water drops and not the darker background, I still intentionally underexposed so I could get a faster shutter speed and to avoid blow out of the highlights.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 1/60 of a second at f/32 and ISO 200, tripod mounted
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          	This ice plant is heliotropic, meaning its buds only open when it is sunny. This makes water drop shooting dicey because drops evaporate quickly in the sun. So I was lucky to get a chance to capture this scene before the drops had faded at the beginning of a brief sunny interlude.


          	
            I thought the plant looked ethereal and ephemeral, not to mention pink, so I decided to exaggerate this effect by focusing primarily on the refractions on the upper part of the water drop rather than the internal reflections in the drop.

          

        


        200mm macro, 36mm extension tube, +2.9 close-up filter, 1/8 of a second at f/40 and ISO 100, tripod mounted
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          	When I saw these water drops suspended on a web above a cyclamen, I was struck by the way each reflection echoed—but reversed—the flower itself.

        


        200mm macro, 36mm extension tube, +2.9 close-up filter, 1 second at f/40, tripod mounted on a Kirk Mighty Low-Boy (see page 66)
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          	The reflections in these water drops that were resting on the upper edge of a cyclamen petal reminded me of the eyes of living creature, so I framed my photo to emphasize this effect.

        


        200mm macro, 0.4 of a second at f/40, tripod mounted
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      	As the morning sun rose, these drops on a Dahlia stem reflected Dahlia blossoms. I got very close to the drops, angled the camera to most magnify the reflections of the flowers and waited for a still moment.

    


    50mm macro, 36mm extension tube, 1/13 of a second at f/32 and ISO 200, tripod mounted

  


  
    


    
      
        The Solo Drop

      


      
        Starting with water drops en masse and moving to smaller collections of “natural jewelry,” the progression leads toward single drops. These shots are close magnifications, often far beyond 1:1.


        When I look for this kind of image, I usually try to find single large-sized drops that are in a stable situation. I want to be able to take my time and find the patterns of shapes, light and color. I’m looking for water drops that fulfill the idea of containing an entire world rather than having end-to-end clarity.


        Sometimes small details within the drop—rather than the entire drop—interest me most about the final photo.

      


      [image: missing image file]


      
        
          	This rather large drop slightly enlarged the underlying pattern of the leaf and offers a small amount of refraction. (You can easily see the refraction because the stem of the leaf does not quite align inside the drop and outside it.)

        


        200mm macro, 36mm extension tube, +4 close-up filter, 1.3 seconds at f/40 and ISO 100, tripod mounted using a Kirk Low Pod (see pages 66–67)


        [image: missing image file]


        
          	I used two macro flash units mounted at the end of my lens. They were controlled wirelessly on-camera so I could take this photo of a drop at the end of a twig in motion. For me, the smaller drop on the left with the reflection of a blossom is what makes this image worthwhile.

        


        200mm macro, 36mm extension tube, +4 close-up filter, 1/60 of a second at f/40 and ISO 200, two macro flash units mounted on a ring at the end of the lens (see pages 84–87), tripod mounted
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          	These photos show small-ish water drops on a leaf of a peony bush. You don’t really understand how great the magnification is in these images until you look at the outline of the leaves. Keep in mind the small size of a peony leaf, and compare the leaf size in your mind to the drops.


          	
            I used a macro lens with a normal lens reverse mounted on it to get really close. (See pages 54–55 for information about lens reversal rings.) I used a moderate aperture (f/16) so the water drops would be in focus … but not the leaf.

          

        


        Top: 105mm macro, reversed 50mm lens, 1/60 of a second and f/16 at ISO 200, tripod mounted


        Bottom: 105mm macro, reversed 50mm lens, 1/80 of a second and f/16 at ISO 200, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	In a break in wet weather, I went out to photograph raindrops. Looking down on this large drop, nestled in the cup of a petal, I was reminded of an entire green world with blue oceans, continents and cloud cover.

        


        200mm macro, 36mm extension tube, 0.8 of a second at f/40 and ISO 100, tripod mounted
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          	This water drop, radiating light on a dark leaf background, is certainly a natural jewel if ever there was one.

        


        200mm macro, 36mm extension tube, +2.9 close-up filter, 0.3 of a second at f/45 and ISO 100, tripod mounted
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          	I was struck by the simplicity of this single drop on a blade of grass, and I angled my camera to catch the sunburst in the drop shown here.

        


        200 mm macro, 1/15 of a second at f/32 and ISO 200, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	No way this water-laden semi-transparent flower petal was going to stay still for me. The weight of water was making the petal act like a pivoting teeter-totter. So I boosted the ISO to 640 so I could use a faster shutter speed (1/40 of a second) to minimize the impact of the motion.

        


        200 mm macro, 36mm extension tube, 1/40 of a second at f/36 and ISO 640, tripod mounted
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          	I focused on the water drop, letting the flower in the background go out of focus to become an abstraction. Not the biggest drop that I’ve shot, this one has a marvelous sense of combining clarity with a stained-glass effect.

        


        200mm macro, 36mm extension tube, 0.2 of a second at f/32 and ISO 100, tripod mounted

      

    

  


  
    


    
      Close-ups in the studio
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        	I placed a whole egg and the egg shell from a second egg on a slightly transparent white seamless paper background. The image was lit from behind the paper background by a strong late afternoon sun coming in through a window. I lit the eggs from the front by bouncing a 250-watt tungsten light off the white ceiling.


        	
          When I exposed the image, I was careful to focus carefully on the eggs and use a moderate aperture (f/8) for shallow depth-of-field, so that only the eggs would be in focus.


          In Photoshop, I added the blue background seen toward the top of the image on a layer with low opacity. I used the Gradient Tool to blend the blue with the rest of the background.

        

      


      200mm macro, 1/8 of a second at f/8 and ISO 100, tripod mounted

    


    
      
        Still Life Photography

      


      
        Still life photographs show arrangements of inanimate objects—such as food, flowers, shells, bottles, glasses, books, jewelry—captured in the studio or sometimes in the field.


        One of the traditional forms of art, still life painting was practiced by the ancient Egyptians as a way to provide a symbolic send-off for the departed. This use of symbolic and religious objects as part of still life compositions continued through the Renaissance, after which the art form became a more secular playing ground for artists who could control entire compositions. This was just not possible when creating art from larger, or more animate, subject matter. In fact, most still lifes are close-up; once a photo has a person in it, it can probably no longer be considered a still life—both on grounds of animation and of scale.


        As a photographer, when I’m in the field, I like to be prepared to make captures of still life compositions that I come across. But for me, still life really comes into its own in the studio, where I have control over every aspect of my still life compositions.


        While still life photography is in some ways extremely demanding, don’t let anyone sell you on the proposition that you need expensive equipment or specialized training to get started. As with any kind of photography, the most important tools are your brain and eyes. Use your eyes to conceptualize imagery and to see; use your brain to create setups, light images and understand how to set your camera.


        Interesting still life photos are great fun to create. Except in the environment of fancy advertising studios, creating these images takes the skills of a cunning visual guerilla warrior, not an over-the-top studio filled with all kinds of props and lighting gadgets.


        In fact, I do most of my “studio” work using improvised surfaces such as TV-tray tables or chairs with some stock backgrounds and only a couple of inexpensive lights.


        In case you hadn’t noticed, I am not Annie Leibovitz. My still lifes are not elaborately orchestrated set pieces requiring numerous support people in the studio. Nor am I Irving Penn. The kind of still lifes I like to create most are not intended for advertisements.


        In fact, I created the still life photographs in this book using simple props from the supermarket and a discount housewares store. For the most part, I used inexpensive lighting equipment that can be found at a hardware store.


        My idea is to show you that still life photography can be created using simple, everyday materials. I hope these examples inspire you to do creative close-ups of your own. Now, go raid that funny old drawer in your kitchen—yeah, the one that has weird things left by Aunt Matilda—and find some kind of light!


        On the topic of still life lighting (covered on pages 206–215), sometimes the best lighting is no lighting. Photographic still life masters such as Edward Weston often used natural lighting for their compositions.


        Despite his reputation as the master of the grand landscape, Ansel Adams also enjoyed creating still life photos. As Adams noted, “Very rewarding effects are possible with available light in the studio, whether from natural skylight or window light.”


        Of course, these photographers didn’t take just any old available or natural light. They observed carefully, were patient enough to wait until the light was right for their subject, and they weren’t above augmenting natural light with reflectors, mirrors and even studio lighting.


        So let go of the idea that studio compositions require loads of fancy equipment. You need a good eye for composition and lighting and the patience to set up the still life stage (see pages 196–199).


        You need to find and use appropriate backgrounds (pages 200–205) and you need to have the skill to set up interesting compositions and arrangements (pages 216–225).


        Great still life photography requires a truly Zen photographic approach.


        Subject, composition, lighting and background are entirely under your control in a studio still life. If you think being the Master of a Universe in this sense, albeit a small universe, sounds like fun—you are right, it is!

      


      [image: missing image file]


      
        
          	I saw this bunch of ravishing radishes in the local supermarket and couldn’t resist bringing it home to photograph. I put the radishes on a black velvet background and used a single tungsten light, positioned to the right of the camera and aimed up to bounce off the ceiling. I took great care to make sure the radishes were lit indirectly.


          	
            Needless to say, after photography was complete, we ate the radishes.

          

        


        85mm Perspective Correcting macro, four combined exposures at speeds from 2.5 seconds to 15 seconds: each exposure at f/48 and ISO 100, tripod mounted
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        	I used rear-light projection to send the shadows created by a Venetian blind against draped semi-transparent fabric. I placed the partially filled glass on a mirror in front of the fabric. No other lights were used, and the sepia glow from the light coming through the fabric gives this image its predominant color cast.

      


      50mm macro, 1/15 of a second at f/13 and ISO 100, tripod mounted
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          	I placed potatoes, rocks, and marbles—each in their own jar—on a white seamless background. I lit the setup with two lights: one bounced on the ceiling for the foreground and the other a bit more focused and covered with yellow tissue paper (except in the center) to create the spot effect seen in the background.

        


        62mm, 4 seconds at f/32 and ISO 100, tripod mounted
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          	I saw these old bottles in a window in the historic ghost town of Bodie, California. Since the bottles were behind glass, I couldn’t rearrange the composition. Getting down in the dirt of the road, I opened my tripod and positioned the camera to shoot this field still life. As I took the photo, I couldn’t help but think how much more I could do with lighting and arrangement if I had these objects in my studio!

        


        105mm macro, 1/25 of a second at f/36 and ISO 200, tripod mounted

      

    

  


  
    
      

    


    
      
        Setting the Stage

      


      
        All still life photographs are taken on a stage. Well, as Shakespeare put it in As You Like It, “All the world’s a stage.” But still life photographs are taken on a stage in a more specific sense than Shakespeare’s general metaphor about life. So the more a still life photographer understands the importance of the stage, and how it is staged, the better the results.


        To start, objects in a still life composition need to be placed on something—some kind of table or platform. Still life compositions can be found anywhere without the need to set up something, but the fun begins when you choose the stage yourself.


        You can use interesting textured backgrounds like pieces of wood, but most of the time the platform will be “dressed” using background materials (see pages 200–205). It’s pretty simple to create platforms that are dressed to create the illusion that the still life composition is floating on white or on black. And of course there are many other options.


        So already, things are starting to get a little more stagey. There’s a platform, which has been dressed to fit the aesthetics of the photo. The platform doesn’t have to be fancy. I tend to use a portable folding table for smaller work, because it can be moved easily, and because I can position myself at any side of the table. For larger still life compositions, I use a wood slab on sawhorses.


        For compositions that are extremely close-up, you don’t have to worry about extending the platform dressing so it meets the background. But for many still lifes, a background will show as part of the photo. You need to consider the visual impact of your platform dressing. Do you want it to meet the background, or should your dressing and background actually be a single draped piece of fabric or paper? If the edge of the platform, where it meets the background, is too prominent, it can spoil the illusion of the universe you so carefully built.


        To fully set the stage, you need to combine platform, dressing and background in a single construction. How do you hold these pieces together?


        One possibility: Light stands can be used to prop the dressing and background in position, and clamps will hold everything in place. (Clamps are shown to the right.) Strong tape is also useful. And none of this costs much.


        So, yes, most studio still life work is best done on a small stage. But your small studio stage needs to be dressed and propped together, just like a larger one. The good news is that this is

        easy and fun, and it doesn’t take

        much money.
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            	Since the point of this photo is the shadow, and not the glass vase, I decided to emphasize the placement of the vase and shadow on a stage. To achieve this, I had to make sure the stage was not seamless, so the viewer could see the edges. A sheet of white paper served as part of the background, and the edges of the paper were clearly visible.


            	
              I pointed a single light from behind the vase, toward the camera. (See pages 212–215 for more details about lighting setups for capturing still life shadows.)

            

          


          50mm macro, 0.3 of a second at f/32 and ISO 100, tripod mounted
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          	Clamps like these cost a few dollars each at a good hardware store, and they can be used to put together the stage for almost any still life setup.


          	
            To make this photo, I positioned these clamps on a white seamless background. I used a single 250-watt tungsten light bulb (purchased at a local hardware store, too).


            I placed this bulb in an inexpensive metallic reflector and used a “brother” of one of the clamps shown in the photo to position the reflector on a light stand. I turned the reflector up to bounce off the ceiling and used pieces of white cardboard to lighten the metal surfaces of the clamps by reflecting light into these areas.


            I shot this photo to show the inexpensive clamps I use to create the makeshift stages for my still life close-ups. But the image also shows that interesting still life compositions can be made from very humble objects.

          

        


        50mm macro, 2 seconds at f/32 and ISO 500, tripod mounted

      

    

  


  
    
      
        

      


      
        Backgrounds

      


      
        Backgrounds can make or break a still life composition. My work and life takes place against a backdrop of considerable clutter. Perhaps this has something to do with the four young kids at home.


        Unless your life is very different from mine, it’s not likely that the natural backgrounds you find in your environment will be conducive to the Zen simplicity of still life compositions. In other words, it is up to you to decorate your stage with backgrounds that hide life’s clutter.


        Fortunately, there’s no great difficulty or expense involved in coming up with a “library” of backgrounds for still life compositions. It’s great to experiment with all your options!


        I keep on hand three kinds of backgrounds:


        
          	Seamless paper


          	Fabrics


          	Mirrors

        


        Seamless paper comes in rolls that can be bought at photo or art supply stores. I have both black and white rolls on hand. Other colors can also make interesting backgrounds; and if you plan to photograph people in the studio, you should consider a gray seamless background.


        Seamless is the classic studio background. It’s extremely versatile and quite useful. The only downside is that it gets wrinkled and stained pretty easily, so you have to replace it often.


        For my still life compositions, I buy a couple of yards each of black velvet, burlap and linen at a fabric store. You cannot possibly visit a fabric store without getting all kinds of wild and interesting ideas about other fabrics to use for still life backgrounds. So plan to be there for awhile, and let your mind wander!


        If you take care of your fabric backgrounds by not spilling water on them and by storing them on a roll, you’ll be able to use them for a long time. You may need to iron fabrics when you first get them to remove lines from storage, and repeat ironing may be needed to keep that “crisp” look in your compositions.


        I often use mirrors beneath and behind the still life subjects to add depth and mystery. The best place to get mirrors for this purpose is a glass supplier, the kind that sells glass to replace broken windows. You don’t need anything too big, probably no more than two feet in any dimension; but for best results, buy the thickest glass that is offered: likely a 1/2" thick.


        Since mirrors reflect their background, it probably goes without saying that I use mirrors on my still life stages in conjunction with other background materials, such as seamless paper or fabric.


        For still life photos that make their subjects seem transparent (see pages 106–111), I like to shoot down on the subject with a fluorescent-tube lightbox as the background. You’ll find quite a few styles of lightboxes available from photo suppliers. The best ones to use have tubes that match the color temperature of daylight. Assuming you are using natural ambient light, there won’t be a conflict between light sources with a different white balance.
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          	I used a burlap background with relatively harsh and direct lighting to make the background itself an important element of this composition. The point of the photo is humorous: a pear resting on the burlap-decorated stage seems to be chatting with a pear in a glass Mason jar. Is this visiting hours in a fruit prison? The roughness of the burlap contrasts with the delicacy of the fruit, and this makes the humor of the photo more interesting.

        


        95mm, 3 seconds at f/22 and ISO 100, tripod mounted
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          	I used a black velvet background to isolate these prickly melons from everything in the composition except each other. The idea of using a black background in this way is to create a sense of mystery. At the first take, the viewer of the image doesn’t know exactly what they are looking at or what the objects in the composition are resting on.

        


        130mm, 1 second at f/36 and ISO 100, tripod mounted
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          	Mirrors can be tricky as a background because they give you a limited field of view to capture … without revealing the world beyond your stage. If you try to make a composition with a wider view, you risk dragging in extraneous subject matter. For this photo, I was able to use the mirrored background to create a sense of mystery and humor around the subject. I think this prickly melon could almost be a submarine about to navigate the silent deep, but this required careful positioning of my camera angle.

        


        85mm Perspective Correcting macro, 1 second at f/48 and ISO 100, tripod mounted
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          	I photographed these fresh, quarter-inch wide oregano leaves using a lightbox as a background. I made sure to overexpose the photo to increase “high key” feeling of the lighting effect and to make the tiny leaves seem even more transparent than they were.

        


        200mm macro, 4 seconds at f/36 and ISO 100, tripod mounted
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          	In this still life composition, the sunflower is clearly resting in a bottle. I used a black seamless background to bring out the vibrant contrasting colors in the sunflower, because colors tend to seem richer when contrasted with black.

        


        85mm Perspective Correcting macro, 2 seconds at f/45 and ISO 100, tripod mounted

      

    

  


  
    


    
      Lighting Still Life Compositions

    


    
      So all you need is one light. Well, maybe two. I’ll explain in a moment. But first let me return to a more important topic than the lighting fixtures you use. And that’s learning to see light.


      Ralph Hattersley, in his 1970s lighting technique classic, Photographic Lighting: Learning to See stated in regard to studio lighting that “learning to see is the most important step to take in the process of becoming a good photographer.” (By the way, I highly recommend the exercises in Hattersley’s book if you can find a used copy to study.)


      As with lighting in the field (see pages 80–83), photographic light can be described in terms of direction, intensity and quality.


      Direction of lighting is easy to understand because it refers simply to the direction from the light source to the subject. There are only a handful of possibilities. Backlighting comes from behind the subject and is usually facing the camera. Front lighting hits the front of the subject, usually from a light source located to the rear of the camera. Top, side and bottom lighting are clear enough as concepts, though in all cases, a given light source can hit the subject in several ways (e.g., top and side). The table on page 83 explains lighting directions in greater detail.


      I discussed light intensity and quality in the context of the field on pages 80–83, and mostly the same concepts apply indoors. Light intensity results from the strength of the light source and its distance from the subject. You can more easily quantify studio lighting than ambient light outdoors, because you know the wattage of the light bulbs you are using (if you are shooting tungsten), although fixtures and the amount of reflection also play a role.


      The quality of light includes both its color temperature—something that can be measured and stated in degrees Kelvin—and various subjective aspects, especially whether the light is soft (bounced or diffused) or harsh (direct).


      The first step in lighting a studio still life is to pre-visualize the lighting effect you’d like. Consider the composition you’d like to create and the way your setup looks on its stage. This becomes easier with experience, so don’t worry if you aren’t quite sure at first. Experiment!


      Many still life compositions will work with an overall diffused light. This can usually be achieved by bouncing an incandescent tungsten light bulb in a reflector off a white ceiling. Place the light on a light stand some distance from the still life stage; put the light stand at a medium height; turn the light on, and see what the lighting looks like. If there are “hot spots” caused by the light, back it up and try moving its position slightly. If the light seems too harsh, tone it down by putting translucent material over the light (being careful not to start a fire!).


      This kind of extremely simple setup works well for close-up details (such as the example on page 206) and when you don’t want or need drama.


      The same single lamp on a stand can be used to create backlighting as well as backlit shadow and other effects (see pages 212–215).


      A second light comes in handy for balancing the primary light source. In a backlit scenario, you can use the second light to add some illumination to the front of the still life, as in the egg photo on page 208.


      Another effective way to use two lights is to set both in front—one on the right and one on the left—facing toward the composition on the stage. Lights paired this way can be adjusted with great precision to get delicate lighting effects over all or part of a composition (see the example to the right).


      When I’m creating a still life using this kind of setup, I’m looking for subtle lighting that doesn’t call attention to itself but provides nuances with some variations across a composition. I complement the use of the lights with white cardboard (to reflect light into selected parts of the composition) and black board (to shield areas from light).


      You also need some way to send very targeted light into compositions and their backgrounds. Essentially, this is a special effect (for example, see page 207). I use a Lowel Pro equipped with either barn doors or a snoot for this purpose, but you can make a hand-made snoot (a round tunnel placed in front of a light) by rolling dark cardboard and taping it to the front of a light (once again, taking care not to start a fire).
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          	To photograph the “keypad” of this antique portable calculator manufactured by the Rapid Computer Company circa 1893, I knew I didn’t want lighting that called attention to itself. The subject matter was enough without additional drama. So I bounced a single tungsten light off the white ceiling.

        


        85mm Perspective Correcting macro, 6 seconds at f/24 and ISO 100, tripod mounted
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          	I arranged this glass of water and apple on a rough burlap background. To emphasize the textural quality of the burlap, I used a light focused using a snoot—a dark tube placed on the front of the light—to create a spotlight effect. I also bounced light off the ceiling.

        


        50mm macro, 8 seconds at f/32 and ISO 100, tripod mounted
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          	I lit this egg from behind and then realized that the complete backlighting caused the front of the egg to appear quite gray (rather than white). So I added a second light, positioned in front and above the egg. The second light wasn’t as intense as the primary backlighting, but it helped to balance the lighting.

        


        200mm macro, 10 seconds at f/36 and ISO 100, tripod mounted
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        	I placed this chambered Nautilus shell on a black velvet background. To keep the light even across the shell, I used two lights. I placed a light at an angle to the shell on both sides, and bounced both lights off the white ceiling.

      


      50mm macro, 8 seconds at f/32 and ISO 100, tripod mounted

    

  


  
    


    
      
        Shadows

      


      
        Shadows are magical. C. S. Lewis, in many of his books, explored the shadow lands. To lose your shadow means, as Peter Pan found out, losing your soul. In photos, shadows evoke fear, excitement and—most of all—a world that is not normal.


        Shadows often help make compositions interesting in field close-ups, but outdoor shadows are found objects. They are there or not there; you can alter the camera position or wait for different light, but you cannot make shadows from nothing.


        In the studio, it’s surprisingly easy to create shadows, although it can take much trial and error to get them right.


        Shadows are such an important part of studio still life photography that it is a great exercise to create close-up photos that are primarily about the shadows the compositions contain, rather than the objects creating the shadow.


        Since shadows are mostly about darks and lights, I tend to present photos that are about shadows in black and white.


        To create controlled shadows, you need a dark room (otherwise the shadows don’t show strongly) and a light source. One light will produce shadows that clearly progress in a single direction; if you use two lights, you’ll get shadows that seem to move in several directions, and the shadows may not seem as strong.


        A light behind a subject, backlighting it, will create shadows in front of the shadow-creating object (examples pages 213–215). A light behind the camera, front lighting the shadow-creating object, will produce a shadow behind the object (example page 230). Shadows in either direction can be interesting subjects.


        A light that is positioned lower in relation to a subject will produce a longer shadow. Obviously, stronger light produces a more pronounced shadow, but you need light that is focused as well as intense. I use a tungsten halogen light equipped either with barn doors or a snoot for this purpose; but as I mentioned on page 210, it is easy to hand-make a snoot.


        Generally, the further away from the object the light is, the sharper the edges of the shadow. But there’s no substitute for trying many different light positions if you are going after a striking shadow effect.
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          	To make this photo, I placed the glasses on a table in a completely darkened room. I used my Lowel tungsten spot with barn doors on a light stand. The light was positioned opposite the camera and above the glasses, so these glasses are essentially backlit. I changed the angle and height of the light many times in order to get the composition exactly right … so the shadow of the ear pieces met the “actual” ear pieces.

        


        85mm Perspective Correcting macro, 0.4 of a second at f/24 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	I positioned the light above and to the left of a parfait glass. I underexposed the photo to let the glass go dark, because I thought the shadow of the glass was far more interesting than the glass itself.

        


        50mm macro, 2 seconds at f/32 and ISO 100, tripod mounted


        [image: missing image file]


        
          	I moved the light quite close to the parfait glass so I could capture the contrast between the white background and the dark shadow areas cast by the glass; the effect in this composition reminds me of a shadow shell.

        


        85mm Perspective Correcting macro, 1/4 of a second at f/25 and ISO 100, tripod mounted

      

    

  


  
    


    
      
        Staging the Set

      


      
        Everything is ready. You have your still life objects for your close-up. A stage is in place. The stage is dressed with an attractive background that works well with your subject matter. You’ve put lights on stands, played with lighting effects, and you more or less understand how to light your subject. What’s next?


        Staging is the craft of attractively arranging objects together. This involves a visual and aesthetic component—getting the composition you want—as well as construction. The audience at a play in a theater cannot see behind the scenes to find out what holds the sets together. Likewise, when looking at a still life, you don’t really know if it is held together with toothpicks, glue sticks, tape or one of the great secrets of still life staging: Clear Museum Gel.


        Available at art supply stores, Museum Gel is removable, reusable, translucent and won’t damage most surfaces. When you put little balls of the stuff between objects and wait half an hour or so, a secure and mostly invisible bond is formed.


        In addition to the visual arrangement and physical sticking together, to make a good still life photo you’ll need to consider the composition from the viewpoint of the camera.


        This means experimenting with different lens choices and exposure settings, particularly aperture. Since aperture controls depth-of-field, changes in aperture can drive major changes in a still life composition.


        In addition, minor shifts in camera position can create great changes in close-up compositions. Sometimes, these shifts reveal some of the “scaffolding” used to set the stage, which means you may be back to work, rearranging your set and gluing things back together so they will not show.


        If you choose to try a different lens, this also can have a big impact on your composition. It, too, can make you to rearrange your staging because of the changes.

      


      [image: missing image file]

    


    
      
        	It took a great deal of careful positioning of the apple, pear and glass to get the refractions shown in this photo to look good. For more on photographing refractions, see pages 168–179.


        	
          When photographing through glass, I try to experiment with shifting the angle of the glass. I also like to see what happens when I shift the focal length of the lens and aperture. For this photo, I originally tried working with a shorter focal length lens, and I was surprised at how much better the composition looked through my macro telephoto after I had the glass in position.

        

      


      200mm macro, 10 seconds at f/32 and ISO 100, tripod mounted
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          	The still life paintings of artists from the Renaissance through the Impressionist movement often show many objects arranged to relate to each other. It’s fun to try to create this kind of assemblage for photography in the studio, but it’s harder to pull off as a cohesive composition than you might expect.


          	
            This composition takes advantage of color contrasts between green and red objects to create an underlying sense of order, even though the pattern may not be apparent at first glance.

          

        


        50mm macro, 10 seconds at f/32 and ISO 100, tripod mounted
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          	I shot this image of pears from my garden on a mirror with a fixed-lens camera, using a high ISO (1600) for the specific purpose of creating a “noisy” still life. The noise gives the composition some added visual density and interest.

        


        Canon G9 point-and-shoot, 14mm (approx. 70mm in 35mm equivalent terms), macro mode, f/8 at 1/100 of a second and ISO 1600, tripod mounted
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          	The Lensbaby allows you to set the area that is in focus (see pages 60–63); I used it here to create a more subjective image from the otherwise fairly conventional still life arrangement shown on page 218.

        


        Lensbaby Composer, 1/160 of a second using f/5.6 aperture ring, ISO 500, hand held

      

    

  


  
    
      

    


    
      
        Finding Subjects

      


      
        How do you find subjects for still life close-ups? It’s easy, often great fun and can lead to good photos if you round up the usual suspects: flowers, fruits, glassware and household items. These objects are probably listed in the order they are most frequently photographed in the studio.


        In terms of gaining experience with studio close-up work, it probably doesn’t matter much what you photograph. Lighting is lighting, and shapes are shapes.


        To practice still life photography, it doesn’t matter whether your subject is a stuffed animal, vegetable or mineral—although it makes sense to try out different colors, textures and levels of reflectivity.


        To find interesting and unusual close-up subjects, try to pre-visualize what objects will look like when they’ve been staged and lit. Try to use your imagination and keep a sense of humor.


        Pre-visualization lets me walk down the street, browse in the supermarket and generally enjoy life while keeping an eye out for objects that would be interesting to photograph—or make a good component of a still life.


        My imagination helps me to see things such as a prickly melon masquerading as a submarine (see page 202) or a pear in prison (see page 201) while other people may see, well, a weird-looking melon and a pear. The same goes for my sense of humor. So cultivate both your imagination and your funny bone!


        As you see, close-up subjects are found everywhere. Many mundane objects make great still life subjects. But, finely crafted objects such as ceramics and glassware also have their place in still life close-ups. Keep your eyes open, and start a collection of things both ordinary and special, and big and small, that you can use to create magical compositions on the small stage.
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          	I’ve already noted that you don’t need fancy gear to shoot close-ups. This photo manages to be a close-up view of jewelry and a romantic statement at the same time, created with an older generation fixed-lens camera.

        


        Canon PowerShot G3 point-and-shoot, 28.8mm (140mm in 35mm equivalent terms), macro mode, 0.8 of a second at f/8, tripod mounted
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          	Tomatillos are a relative of the tomato plant and the main ingredient in Latin American green sauces. At the supermarket, I was struck by the marvelous range of colors in these tomatillos and couldn’t resist buying a handful to photograph.

        


        85mm Perspective Correcting macro, 4 seconds at f/27 and ISO 100, tripod mounted
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          	My local supermarket is a great place for finding still life subjects—like this red pepper. The only problem is that I have to photograph this kind of subject quickly, before it becomes part of the family dinner.


          	
            I photographed this red pepper on a black velvet background using a single focused spotlight bounced against the ceiling. The low light levels that resulted from the indirect light and black background meant that this still life photo required a fairly long shutter speed. One of the exposures I used to make this image lasted a full three minutes.

          

        


        85mm Perspective Correcting macro, five exposures combined in Photoshop at shutter speeds between 30 seconds and 3 minutes; each exposure at f/51 and ISO 100, tripod mounted
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          	This photo shows an old-fashioned egg yolk separator found in the back of one of my wife’s kitchen drawers. I lit the egg yolk separator from behind using a single tungsten spotlight and carefully positioned both the light and the egg yolk separator to maximize the spiral shadow.

        


        85mm Perspective Correcting macro, three exposures combined in Photoshop at shutter speeds between 2 and 8 seconds; each exposure at f/51 and ISO 100, tripod mounted

      

    

  


  
    


    
      
        Photographing Jewelry

      


      
        Photographing jewelry is much like other studio close-up work … with some added considerations:


        
          	Often you must get extremely close to jewelry, so a macro lens is likely to be a requirement for this kind of shot.


          	The point of most jewelry photography is to make the jewelry look good, and this is not the goal of all still life close-up work.


          	Gold, silver and other reflective metals used in jewelry construction need to be treated with special care, photographically speaking.

        


        The metal used in jewelry is reflective, meaning that it acts partially like a mirror, depending upon how polished it is. You need to understand that they way this metal appears in your photos will depend upon its surroundings and how you’ve set up lighting. The combination of the lighting and what the light reflects into the metal in the jewelry determines the warmth or coolness of the metal and whether the metals appears to radiate light or suck it in.


        If you’ve set up a composition with jewelry and are happy with it generally, but not pleased with the specific color cast of the metal, it’s time to trot out the secret weapon of jewelry photographers: boards. I keep a set of black, white, red and silver-coated boards that I can move into position to reflect light into my compositions that involve metal.


        Of course, you need to position these boards precisely where you need them, and at an angle to do the most good. Once more, it is hardware store clamps to the rescue (see pages 196–199).
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          	To show this inexpensive trinket necklace in an unusual way, I placed it in a bowl of ice, and draped one of the hearts in the necklace over an ice cube formation that mimics the shape of the heart.

        


        85mm Perspective Correcting macro, 8 seconds at f/64 and ISO 100, tripod mounted
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          	This a fairly standard photo of a watch, photographed on a black velvet background, with the hands of the watch positioned at ten minutes after ten, the standard position for professional watch photos. The watch itself is attractive and a little unusual because of the extent to which the watch works are visible.


          	
            To get an attractive color in the photo for the gold of the watch, I placed small pieces of white cardboard strategically around the edges of the watch, but out of view of the camera. These boards reflected light color into the gold, rather than the dull of the black velvet background.

          

        


        85mm Perspective Correcting macro, 5 seconds at f/48 and ISO 100, tripod mounted

      

    

  


  
    
      

    


    
      
        Photographing Glass

      


      
        Like metal, glass is a polished surface that reflects lights and bright surrounding areas. These reflections can look intolerably bright, depending on how you light the glass. In addition, unless glass is photographed carefully, it can seem to disappear in your photograph. After all, glass is meant to be transparent.


        There are a number of techniques that can be used to successfully photograph still life compositions that include glass. Perhaps the simplest approach is to make sure that your lights don’t directly strike the glass. This can be done by bouncing one or two lights off a white ceiling or white board at a good distance from the glass.


        Another approach is to use colored boards or lights to create your own reflections (example page 231). If the reflections you create are attractive, then this can create successful compositions. Although the glass in photos using this technique may look nothing like the actual glassware.


        If you are creating a photo that requires strong light directed at something glass—for example, because you are interested in a shadow cast by the glass—you can partly cut down the harsh highlights caused by reflections from your light source by using black boards to selectively block light from hitting the glass (example page 230).


        Taking this approach a bit further, you can construct a “black tent” made of black pieces of cardboard around glass objects. The black tent should have openings for the camera, and (depending upon your desired lighting direction) in the back. This arrangement absorbs the light that would otherwise create highlights in the glass.


        Glass is one of the most difficult objects in a still life composition to successfully photograph close-up. This is partly because of the unattractive and harsh reflections that can result from light that is aimed directly at glass. Another issue is, as I have mentioned, the nature of glass. The best photographs of glass do not actually look like glass. Instead, successful photographs of glass create solid structures that we somehow interpret as looking like glass should look but don’t include the natural transparency of glass.


        Think of these difficulties as opportunity! Glass is a visual marvel, with its facets, reflections, refractions and fantastic shapes. The ability of a glass filled with water to refract light in never-ending variety means that to find an interesting subject for close-up work you never have to look further than your glassware cabinet and the kitchen sink.
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          	To photograph this glass vase filled with tomatillos, I placed the vase on its side between folds of linen. I used two lights bounced off the ceiling so that the glass wouldn’t show any harsh reflections. The photo creates an illusion of looking straight down into the contents of the vase.

        


        75mm, 6 seconds at f/32 and ISO 100, tripod mounted

      

    


    
      [image: missing image file]


      
        
          	If you light through ordinary glassware, sometimes you come up with an intriguing shadow. For this photo, I used a low light positioned in front of the glass and to the right of the camera. I placed a black board between the light and the glass to lessen the stark reflections on the glass. If you look at the top of the shadow toward the back, the shadow cast by the light passing through the glass may remind you of an arched bridge.

        


        85mm Perspective Correcting macro, 1/4 of a second at f/17 and ISO 100, tripod mounted
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          	To make this photo, I placed a stack of glasses on a mirror and positioned color light bulbs so they were reflected—but not visible—in the mirror. In post-processing in Photoshop, I enhanced the effect made by the reflected color lights by darkening the lines at the edges of the glasses and lightening clear portions of glass.

        


        80mm, 10 seconds at f/32 and ISO 100, tripod mounted
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      	I captured these roses on a black velvet background, using natural sunlight coming through semi-transparent shades. To make the image, I needed to get high enough above the flowers to shoot straight down. This was a bit tricky, because my tripod didn’t extend far enough. I ended up putting each tripod leg on a chair and standing on a short ladder to compose the image.

    


    50mm macro, three combined exposures at shutter speeds from 1.6 seconds to 4 seconds, all exposures at f/32 and ISO 100, tripod mounted

  


  
    


    
      
        Resources and Further Reading

      


      
        Extension tubes and close-up filters


        Kenko extension tubes: www.thkphoto.com/products/kenko/slrc-04.html


        B&W Schneider filters: www.schneideroptics.com/ecommerce/CatalogSubCategoryDisplay.aspx?CID=57


        Lensbaby


        www.lensbaby.com


        Tripods and Heads


        Gitzo: www.gitzo.com


        Kirk Enterprises: www.kirkphoto.com


        Manfrotto: www.manfrotto.com


        Really Right Stuff: www.reallyrightstuff.com


        Gorillapod: www.joby.com/products/gorillapod


        Composition and exposure


        Creative Composition: Digital Photography Tips & Techniques (Harold Davis, Wiley, 2010)


        Practical Artistry: Light & Exposure for Digital Photographers (Harold Davis, O’Reilly, 2008)


        Botany and plant identification


        Botany for Gardeners (Brian Capon, Timber Press, revised edition 2005)


        The Botany of Desire: A Plant’s-Eye View of the World (Michael Pollan, Random House, 2002)


        Plant Identification Terminology: An Illustrated Glossary (James G. Harris & Melinda Woolf Harris, Second Edition, Spring Lake Publishing, 2000)


        High Dynamic Range (HDR)


        The best software for automated High Dynamic Range processing is Photoshop, www.adobe.com, and Photomatix, www.hdrsoft.com (HDR processing is Photomatix’s specialty).


        To learn about hand HDR processing using layers and masking, see The Photoshop Darkroom: Creative Digital Post-Processing (Harold Davis, Focal Press, 2010).


        Plant clamps


        McClamp makes the McClamp stick, as well as more conventional plant clamps, www.fmphotography.us


        Wimberly makes The Plamp, an effective plant clamp, www.tripodhead.com/products/plamp-main.cfm


        Digital painting and LAB color


        For more about my digital painting techniques and LAB color, see The Photoshop Darkroom: Creative Digital Post-Processing (Harold Davis, Focal Press, 2010).


        Still Life Photography


        Masters of still life photography whose work I particularly admire include Irving Penn, Josef Sudek and Edward Weston. Of course, Penn, Sudek and Weston also created photos in other genres besides still life—and photographers known primarily for other kinds of work, such as Ansel Adams, created some fantastic still life imagery.


        You can learn more about the still life work of Penn, Sudek and Weston in these books:


        Still Life: Irving Penn Photographs, 1938–2000 (Irving Penn and John Szarkowski, Bulfinch, 2001)


        Still Lifes (Joseph Sudek, Torst, 2008)


        The Daybooks of Edward Weston (Beaumont Newhall and Edward Weston, Aperture, 2005)


        Lighting


        Lowel, www.lowel.com, makes many lights and lighting systems, including the Lowel ViP Pro-Light that I use for some of my still life work.


        Photographic Lighting (Ralph Hattersly, Prentice-Hall, 1970) is available inexpensively from many used-book sources.
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          	I got up really close to this ladybug in the garden and used my Lensbaby with close-up filters to capture the insect with a blurred background.

        


        Lensbaby, +14 close-up filters, 1/400 of a second at ISO 200, hand held

      

    

  


  
    
      

    


    
      
        Glossary

      


      
        Ambient light: The available, or existing, light that naturally surrounds a scene.


        Aperture: The size of the opening in a lens. The larger the aperture, the more light that hits the sensor.


        Barn doors: Blinder-type shutters that are placed on the front of studio lights to control intensity and direction of light.


        Bellows: A bellows is a leather or cloth “tunnel” used for close-up work that fits between the lens and camera like an extension tube. A ratcheted rail system gives the bellows flexibility in how far it is extended.


        Close-up filter: A piece of optical glass that screws into the front of a lens and provides magnification.


        Composite: Multiple images that are combined to create a new composition.


        Degrees Kelvin: see Kelvin.


        Depth-of-field: The field in front of and behind a subject that is in focus.


        Diffraction: Bending of light rays; unwanted diffraction can cause loss of optical sharpness at small apertures.


        DSLR: Digital Single Lens Reflex, a camera in which photos are composed through the lens that will be used to take the actual image.


        Dynamic range: The difference between the lightest tonal values and the darkest tonal values in a photo.


        Effective aperture: The lens aperture, adjusted for the effects of magnification.


        Exposure: The amount of light hitting the camera sensor. Also the camera settings used to capture this incoming light.


        Exposure histogram: A bar graph displayed on a camera or computer that shows the distribution of lights and darks in a photo.


        Extension tube: A hollow ring that fits between a lens and the DSLR, used to achieve closer focusing


        f-number, f-stop: The size of the aperture, written f/n, where n is the f-number. The larger the f-number, the smaller the opening in the lens.


        Focal length: The distance from the end of the lens to the sensor.


        Focus stacking: Extending the field of focus beyond that possible in any single photo by combining multiple photos.


        Focusing rail: A ratcheted rail that is attached to the camera and used for precision focusing by turning a knob to move the camera on the rail.


        Hand HDR: The process of creating a HDR (High Dynamic Range) image from multiple photos at different exposures without using automatic software to combine the photos.


        High Dynamic Range (HDR) image: Extending an image’s dynamic range by combining more than one capture either using automated software or by hand.


        Hyperfocal distance: The closest distance at which a lens at a given aperture can be focused while keeping objects at infinity in focus.


        Image stabilization: Also called vibration reduction, this is a high-tech system in a lens or camera that attempts to compensate for, and reduce, camera motion.


        Infinity: The distance from the camera that is far enough away so that any object at that distance or beyond will be in focus when the lens is set to infinity.


        ISO: The linear scale used to set sensitivity.


        JPEG: A compressed file format for photos that have been processed from an original RAW image.


        Kelvin: The scale used to notate color temperature.


        Lens reversal ring: Used to reverse a lens for close-up photography by attaching directly to a camera body or to the screw thread of a primary lens.


        Lensbaby: A special purpose lens with a flexible barrel that allows you to adjust the “sweet spot” (area in focus).


        Macro lens: A lens that is specially designed for close focusing; often a macro lens focuses close enough to enable a 1:1 magnification ratio.


        Magnification ratio: The correspondence of an object and its actual size on the sensor.


        Magnifying eyepiece: Attaches to the front of the viewfinder and magnifies what you see; useful for critical focusing.


        Multi-RAW processing: Combining two or more different versions of the same RAW file.


        Noise: Static in a digital image that appears as unexpected, and usually unwanted, pixels.


        Open up, open wide: To open up a lens, or to set the lens wide open, means to set the aperture to a large opening, denoted with a small f-number.


        Photo composite: See composite.


        RAW: A digital RAW file is a complete record of the data captured by the sensor. The details of RAW file formats vary among camera manufacturers.


        Right-angle finder: Attaches to the camera viewfinder; it can be tilted to adjust the angle at which you look through the viewfinder. It also usually provides magnification.


        Reflection: Mirror image in which left and right are reversed.


        Refraction: Curvatures and other distortions in reflections caused by the change in a light wave in relation to its speed, usually because the light has entered water.


        Sensitivity: Set using an ISO number; determines the sensitivity of the sensor to light.


        Shutter speed: The interval of time that the shutter is open.


        Snoot: In studio lighting, a dark tunnel placed in front of a light to focus the light into a round spot.


        Stop down: To stop down a lens means to set the aperture to a small opening; denoted with a large f-number.


        Sweet spot: The area that is in focus when using a Lensbaby.


        Tungsten light: Artificial incandescent light, created by sources including common household bulbs, photofloods and halogen bulbs.


        Vibration reduction: See Image stabilization.


        Wide open: See Open up.
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        	I photographed this still life of a lily in a vase on a black velvet background. I primarily lit the flower from the front using sunlight, and added a spot light covered with a diffuser to the right rear of the flower to add some highlights.

      


      50mm macro, 1/2 second at f/32 and ISO 100, tripod mounted
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  • Front piece: This photo shows the full moon rising between abandoned construction cranes at an old naval shipyard on Mare Island, California. 200mm, 4 seconds at f/5.6 and ISO 100, tripod mounted


  • Title page: I used an interval timer to create this long exposure of the setting moon. 18mm, about 90 minutes at f/22 and ISO 100, tripod mounted


  • Above: This is a detail from a shot straight up at the early morning sky from the top of Half Dome. 16mm, about 36 minutes at f/8 and ISO 100, tripod mounted
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    • I stopped the lens down to as small an aperture as possible in this night shot of the Golden Gate Bridge so that the length of the exposure would exaggerate the light trails from car head lights. 90mm, 5 minutes at f/22 and ISO 100, tripod mounted

  


  


  


  Introduction


  In 1888, the great artist Vincent van Gogh wrote in a letter to his brother Theo, “It often seems to me that the night is much more alive and richly colored than the day.” Van Gogh was right; the night is alive with vibrant colors, shapes and forms.


  Night covers the world in darkness roughly half the time. It’s a mistake to assume that because our sight is limited at night that there’s nothing to see. Hours after sunset, when the world appears dull and gray, saturation lingers. In almost complete darkness, fl owers exude electric colors. In the deep watches of the night, starlight produces subtle and glorious color variations.


  The advent of digital photography has revolutionized the practice of night photography, because a digital sensor can record the spectacular colors of the night. These colors are created by light waves in spectrums that are invisible to the human eye. For the fi rst time, we can truly “see” the world of the night around us. With digital equipment, there’s as much to photograph at night as there is during the day.


  Yet, to be fair, night photography does present some challenges that don’t exist for photography during the day. To state the obvious, it is often hard to see what you are photographing, and it can be diffi cult to see what you are doing with your camera. Auto-focus doesn’t work; forget about light meters; and exposures are all manual.


  Creative Night: Digital Photography Tips and Techniques explains what you need to know about photographic technique to participate in the exuberant, and sometimes highly caffeinated, society of night photographers. I’ll give you some ideas about how to stay safe as a night photographer. I’ll tell you how to fi nd the best subjects for night photography and how to approach night photography creatively. And I’ll show you how to take the experience of photographing at night and use it to become a better photographer during daylight hours.


  A student in one of my night photography workshops put it this way: “Now, when I’m out on the weekends, if I don’t get lucky by the time the bar scene closes, I can still get a lucky photo with my camera, timer, headlamp and tripod in the truck.”


  Expand your horizons! Welcome to the wonderful, wacky and colorful world of creative night photography.
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  • Perched on a ledge above Tennessee Beach in the Marin Headlands, California, I was struck by the way the long exposure rendered the colors of the night … and made the pounding surf appear transparent. 12mm, 3 minutes and f/5.6 and ISO 100, tripod mounted
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  • I photographed this view of a winter sea about half an hour after sunset. 34mm, 3.6 seconds at f/25 and ISO 100, tripod mounted


  


  


  Benefits of Night Photography


  As a night photographer, it’s not uncommon to hear photographers who haven’t worked at night say that they just don’t understand. More than once, I’ve heard, “You blunder around in the dark and face a completely black landscape with your camera? Why on earth would you do such a thing?”


  It so happens that this isn’t a bad description of what I like to do with my camera in the night.


  Along with the incomprehension there’s a great fascination with night photography among serious photographers. A number of camera clubs have told me that night photography is the most requested topic for speakers, and good night photography workshops tend to sell out quickly.


  So what is the point of night photography, and why does it draw both scorn and enthusiasm?


  When figuring out whether night photography is for you, consider the following benefits of night photography:


  • Night blankets the earth half the time, and there are as many nighttime hours as there are of daylight. If you are open to the possibility of photographing at night, you’ll vastly expand the opportunities available to you.


  • It’s possible to create spectacular photos at night—and nighttime imagery certainly arouses the interest and envy of other photographers.


  • Photography at night requires going back to technique basics, as photography might have been practiced 100 years ago … except with digital equipment. Exposures at night are lengthy, manual affairs that can require great patience. So once you master the technical aspects of night photography, you’ll never again have problems with photographic technique during the day.


  • With the right equipment and a bit of practice, as I explain in this book, you’ll feel comfortable working in the night. Having the freedom of the night lets you photograph late in remote locations, knowing you can get home safely in the dark.


  • When you take a camera into the night, you enter terra incognita. Night is very different from the day. To photograph the night is, in a very real sense, to become an explorer—with the added convenience that night is everywhere, and you don’t have to go someplace exotic to begin your journey.


  [image: ]



  • Driving across the Sierra Nevada Mountains of California at night, I stopped to photograph Lake Tenaya, the subject of a famous Ansel Adams image. Lake Tenaya has been photographed innumerable times, but a night image presents a new way to view this well-known scene. 18mm, 3 minutes at f/4 and ISO 640, tripod mounted
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  • Taking this photo from Arch Rock in Point Reyes National Seashore, California, meant a long walk back in the dark. It was worth it because the long exposure time implied by the low light in the early night environment made the surf soften and flatten in a way that never would have happened in the day. 13mm, 10 seconds at f/4 and ISO 100, tripod mounted


  


  Kinds of Night Photography


  There are as many different kinds of night photography as there are of photography in the day. Well, not really. But almost. The variety of subject matter that people find to photograph in the night never fails to amaze me! However, it stands to reason, because—day or night—you can point a camera at almost anything, and creative photographers are endlessly inventive.


  A major interest in night photography has always been astronomical. In fact, many of the techniques used in night photography—such as stacking star trails, explained starting on page 192—were first developed by astronomers. Photographers with astronomy as their primary interest love to photograph phenomena such as lunar eclipses, meteor showers, and conjunctions of particularly bright planets and stars.


  The vastness of the cosmos as exemplified by a star-filled sky at night stands at one end of the night photography spectrum. At the other end, you’ll find images of the works of man: cityscapes, cars in motion, buildings and more. An important sub-category of this genre involves photographing ruined structures with night as an important part of the composition, or as backdrop.


  City lights, car lights and lit-up buildings all make great nighttime subjects. In fact, the dark background of night means that almost any light you find can be used to create interesting imagery.


  But why rely on existing light when you can bring your own light to the party? A significant number of night photographers enjoy creating compositions with light itself, using flashlights or other portable light sources. Light painting with these tools can be achieved in a dark room, but this technique also works well outdoors at night.


  Portable light sources, including flashlights and strobes, can be used for fill lighting to light foreground areas of a night photo that would otherwise be too dark.


  I enjoy most kinds of night photography, and you’ll see examples of my work in a number of different nighttime genres in this book.


  By day, I am fascinated by the wilderness landscape, so it was natural for me to try capturing landscapes at night. In my work, these landscapes are usually lit naturally: by moon or stars or leftover solar radiation. My night images show the world as a blade of grass, a tree or a rock might see it after dark. Taking these photos gives me a different, more patient view of a darkened world—which is one of the benefi ts of becoming a night photographer. There’s a different rhythm and a discipline about night photography that makes you slow down and focus on what really matters.
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  • After climbing to the top of a steep ridge, I photographed this view of a lunar eclipse, as seen through light fog, using a telephoto lens. In post-processing, I cropped the image to emphasize the moon. 400mm, 1 second at f/5.6 and ISO 100, tripod mounted


  


  


  Planning for Night Photography


  The requirements of planning for night photography depend upon your goals and destination. Night photography takes a little more effort than planning a shoot during daylight hours.


  In addition to the normal preparation that goes into any successful photographic venture, you need to consider safety precautions at night (see pages 18–19).


  Scouting your locations in daylight is advisable from a safety perspective. This will also help you identify your specific locations and lead to more successful photography. If you’ve seen where you’ll be able to plant your tripod legs in daylight, you’re more likely to get it right in the dark.


  The best night photographers are literally able to operate their camera gear with their eyes closed. I suggest practicing in a dark room that has been equipped with blackout shades, or in a dark closet. At minimum, you must be able to get your camera out of the bag and on the tripod without sight before venturing out for a night shoot.


  You’ll need a camera that does RAW captures, has manual exposure controls and a Bulb shutter speed setting (see pages 20–47). You’ll also want a sturdy tripod and a remote timer. (See page 226 for information about working with a programmable interval timer.)
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  • This is a photograph of a well-known rock formation known as The Wave, located on the Arizona-New Mexico border. It was taken shortly after sunset in mid-November, as the stars began to emerge. 12mm, 8 seconds at f/11 and ISO 100, tripod mounted
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  • After taking the photo of The Wave shown on pages 18–19, I headed across the desert toward the trailhead, where my car was parked. No doubt, in daytime I would have found my way out; but at night I got lost in the desert. I stopped on a ledge, just before the chasm shown here, and I spent the night pacing in circles to keep warm. By the way, this photo shows the vista much more clearly than I was able to see it at the time because it was almost pitch dark. 12mm, about 30 minutes at f/4 and ISO 100, tripod mounted


  A great deal of night photography success depends on understanding the behavior of sun, moon and stars—because these will be the sources that light your photos and help to provide subject-matter interest. Experienced night photographers know in advance when the sun and moon set, and when they rise. If there are special astronomic conditions, these should be taken into account.


  Good night photographers use this information to help plan night compositions. You’ll find resource suggestions on page 234 that can help you pin down the information you need about moon phases, moon rises, moonsets and other celestial phenomenon.


  In the northern hemisphere, star trails are more noticeably curved the more your cameras face due north (for more about this turn to pages 156–159). Part of planning a night composition that involves star trails is to consider how to have your earth-bound foreground subject visible against the northern sky. (See pages 164–165 for information about how to find north from the night sky.)


  Generally, it’s easier to read maps and see views that you’d like to capture during the day. So try to prepare your shots as much as possible while you can still see!


  


  Safety Precautions


  Your goal should be to experiment and go shooting at night … and get home again. Great photos are icing on the cake, and safety is mostly an attitude. No photograph is worth putting yourself at risk, and there are a variety of hazards at night that you may not have considered.


  Here are some suggestions for keeping safe while photographing at night:


  • If you are uncomfortable being alone at night, go with a friend. Or maybe start by attending a night photography workshop.


  • Know where you are going and how to get back. If possible, scout the area in daylight.


  • Make sure someone knows where you are going and when you are returning. Then, don’t forget to check in with your safety buddy when you do actually return. (You don’t want them calling Search and Rescue when you are safely home in bed.)


  • If you are taking night photos in deserted or industrial neighborhoods, be alert and make sure you are comfortable with your surroundings.


  • Wear sturdy shoes, such as hiking boots.


  • Always anticipate the possibility that you will get stuck out all night. Even if this is not your plan, it will happen sooner or later if you do enough night photography. Make sure you feel (and are) safe if you have to stay put. Bring warm, layered clothing, as well as food, a Powerbar or two, and water.


  • Bring two light sources. One should be a good headlamp—so you can operate your camera with both hands. The second should be a backup. Bring spare batteries.


  • Anticipate that cell phone coverage will not be available. (See sidebar below for a possible emergency alternative.)


  Spot Personal Satellite Tracker


  If you photograph at night in areas that don’t have cell phone connectivity, you may be interested in Spot, a device that uses low-orbit satellites for communication. There’s a charge to buy the transponder and an annual subscription fee. But the device works pretty much anywhere on the planet with an open view of the sky.


  The Spot device lets you set up e-mail messages with a recipient list on the website in advance. Wherever you are, you can press a button on the transponder to send an e-mail to your list with your GPS coordinates that says either “I’m OK” or “I’m in trouble.” Another button sends your GPS coordinates to local Search and Rescue agencies.


  The transponder is a simple, lightweight, sturdy device that runs on lithium batteries virtually indefinitely. In my experience, it is reliable if you follow the directions. Keep in mind that it can take half an hour or so, facing the open sky, before it acquires a satellite to transmit your signal.
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  • After taking the desert shot shown on pages 21–22, I swung my tripod around and pointed my camera up at the sky. This was my last shot that night before my batteries gave out. (See the other photo taken earlier on pages 18–19.) The purple flaring at the edges of the image is sensor burn caused by overheating. While waiting for dawn, so I could safely hike out to my car, without photography to distract me (since my batteries were out of juice) there was nothing to do but meditate on the vastness of the desert sky at night. 12mm, about 30 minutes at f/4 and ISO 100, tripod mounted


  


  Cameras for Night Photography


  Fancy exposures modes are almost entirely useless in night photography, because you will be making manual exposures in almost every case. Some other high-end features are also irrelevant to night photography. Image stabilization, also called vibration reduction, will not help you—because night photography is done using a tripod. And auto-focus requires a bit of visible light to work, and mostly fails at night.


  Camera requirements for night photography are pretty simple. That said, the basics are absolutely necessary.


  What you want is a simple, but sturdy, manual camera. The camera should have the following features:


  • The ability to shoot in RAW format, the native camera file format that saves all the data from your captures. If you save your exposures as JPEGs, a great deal of information gets lost. Even more problematic, most JPEG conversion engines have no idea how to process night shots for good results.


  • Have a manual exposure mode that lets you set shutter speed, aperture and ISO.


  • Include a Bulb setting as a manual shutter speed option. This lets you take exposures that are longer than 30 seconds, for as long as the shutter is depressed.


  • Provide a mechanism for keeping the shutter depressed, so you don’t have to do it by hand. This is usually a connector for a remote cable release; it’s best if the cable release automatically times long exposures.


  • Have a convenient way to mount your camera on the tripod, such as a quickrelease plate.


  Although some advanced amateur compact digital cameras provide these features, most night photographers find that a DSLR best meets their needs. Handling a camera in the dark is tough enough without adding the hurdle of miniaturized controls.


  In addition, it’s a basic law of physics that the smaller the sensor, the more noise for a given size image. Since noise is an inherent problem in night photography, it is advisable to start with a camera with a larger sensor size. (See pages 34–39, 56–57, and 178–183 for more information about noise and night photography.)
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  • I dressed for winter and headed out into the night. The paths were icy but the stars were crisp and bright. I made my way to a clearing in the woods below Yosemite Falls. This would have been easy enough in the day, but it was a little trickier to find at night.


  I knew that the North Star, Polaris, was right above the Falls. In other words, Yosemite Falls was pretty much due north when standing in the valley, implying that star circles above the falls would work well. I made ten separate exposures with the plan of combining the exposures using stacking (see pages 192–223). By the last exposure, dawn was coming to Yosemite. I was happy to capture the early morning colors on the mountains and water fall. Ten combined captures with a total exposure time of about 40 minutes; each capture 10.5mm digital fisheye, 4 minutes at f/4 and ISO 200, tripod mounted


  


  Tripods


  A tripod is pretty much a requirement for night photography due to the length of exposures required. No one can hold a camera steadily enough to make sharp captures for seconds, let alone minutes.


  Since night photographers will likely have their tripods longer than a given camera body, it is worth investing in a good tripod.


  Professional-quality tripods come in two parts: the legs and the head. The best tripod legs are made of carbon fiber, the same material used in a variety of applications— from aircraft and artificial limbs to high tech windmill blades. Carbon fiber is lightweight, very strong and doesn’t conduct cold—a surprisingly important point if you ever decide to photograph in the snow. The premier manufacturer of carbon fiber tripod legs is Gitzo, a French company.


  Tripod heads come in several varieties; the one you choose is a matter of personal taste. I recommend a ball head, like the ones made by Kirk Enterprises or Really Right Stuff.


  If you look at your camera, you’ll see that it has a tripod screw hole on the bottom. But the professional-quality ball heads that I’ve mentioned do not provide the screw to fit this hole. Instead, a quick release plate (sometimes called an Arca-Swiss plate, after the first manufacturer of the item) attaches to the camera using a hex screw. The plate can quickly and easily, but very firmly, get attached to the tripod ball head. This ease of secure attachment is very important for night photography.


  It’s sometimes possible to improvise camera supports. (See the story of the photo on pages 26–27.)


  Depending on the weight of your camera, you can also look into alternative support devices like the Gorillapod. This is a lightweight tripod alternative with flexible legs that can clamp onto poles, rocks, chairs, trees—or almost anything.
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  • This photo is from the top of Mission Peak, the highest spot in the San Francisco Bay area. It can only be reached on foot. The view shows Mount Diablo, the East Bay city of Pleasanton, California, with lights coming on, traffic on Interstate 680 and a fog bank sweeping across the foothills. It’s a steep hike up Mission Peak. When I got to the trailhead, I realized I had forgotten my tripod at home. It was too long of a drive to consider getting it, but I needed a way to keep my camera steady to take long exposures at night. What was I going to do?


  Part of being a good night photographer is improvising and finding creative solutions, even when the materials at hand aren’t perfect. On top of Mission Peak there’s an old, hollow pipe that sticks about a foot out of the ground. I was able to plant my camera in the top of this pipe. Using a bunch of small rocks, I could pretty much get stable long exposures in all directions. Admittedly without the flexibility and precision of my tripod, but it worked. 40mm, 30 seconds at f/4.5 and ISO 100, rock and pole mounted
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  • Having my camera on a tripod allowed me to create this unusual night image of Yosemite Valley. Because the background star trails were created as a composite from a number of different captures, it was critical that the tripod remained stationary during the shoot. When I combined the photos, they were in exact alignment. Composite image, all captures tripod mounted 10.5mm digital fisheye; foreground 8 minutes at f/2.8 and ISO 100; background eight combined captures, each exposed for 4 minutes at f/2.8 and ISO 100


  


  Power Sources


  One of the few places that fi lm cameras clearly have digital cameras beat is how they use power. If the batteries run out in a fi lm camera, a photographer might lose the light meter and exposure automation— neither of which are needed for night photography. In this case, the basic functioning of the camera is undisturbed. But with a digital camera, if you run out of “juice,” you can’t take photos. In fact, the power supply is a severely limiting factor in night photography.


  Most DSLR cameras run on rechargeable lithium-ion (Li-ion) batteries. How much shooting time you’ll get on a single battery depends on many factors, including temperature (you get more battery life in moderate temperatures) and your camera usage (auto-focusing and extensive use of the LCD can wear a battery down faster).


  But assuming you’ve started with a fully charged battery in good condition, you should get at least 30 minutes, but no more than an hour, of camera use per battery.


  Since the exposure time for a single night image can deplete a battery, be sure to carry five or six fully charged batteries on night photography expeditions.


  You can’t change a battery in the middle of a single exposure, but if you are creating multiple night exposures for stacking (see pages 192–223), it is sometimes possible to use an extremely delicate touch to change batteries between exposures. If you try this, you need to take care not to shift the camera position even slightly.


  Depending on your camera brand and model, there may be external power supplies or grips available that let you access the power from more than one battery.


  Another alternative is to use a direct power supply rather than batteries. Direct power adapters are available for most DSLRs, but you do need an outlet. This is more problematic than it may seem, because if an electrical outlet is handy, you are likely to have unwanted “ light pollution” in the area. That noted, standard electrical power can be a great solution if there are no other lights (except those you want) around.
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  • Using an AC adaptor, I plugged my camera into an electrical outlet. Then, I set my interval timer (see pages 226–233) to delay the exposure until the moon had set and to keep the shutter open for about two hours.


  Lest you think that night photography always involves heroic deeds, let me point out that while this photo of the Pacific Ocean at Sea Ranch, California, was exposing, I was lounging in a hot tub behind the camera. 18mm, about two hours at f/5.6 and ISO 100, tripod mounted
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  • Shot from the top of Half Dome just before dawn, this photo drained an entire battery. It’s perhaps worth pointing out that if you are sitting on the top of Half Dome, when the power is gone, it is gone. When you use up the last of your batteries, you are no longer a functional photographer. 16mm, about 36 minutes at f/8 and ISO 100, tripod mounted


  


  Lenses


  Focal length is the distance from the end of the lens to the sensor. This measurement, in combination with the size of the sensor, determines whether a lens appears to bring things closer or makes them seem more distant.


  Roughly speaking, normal lenses provide the angle of view of human sight, about 43 degrees, and are roughly 40mm to 60mm in focal length in 35mm terms.


  Telephoto lenses bring things closer. Moderate telephoto lenses have a focal length from about 70mm to about 150mm, and stronger telephoto lenses go up from there.


  Wide-angle lenses, with focal lengths up to about 40mm, show a broader angle of the world than we are used to seeing.


  Much of the photography you’ll do at night use zoom lenses, which have variable focal lengths. Some zoom lenses range from wide-angle though telephoto; for night photography, it’s actually the focal length that matters, not the physical piece of glass.


  In terms of focal length, the use of lenses at night are similar to that used during the day—with a bias toward the wide angle.


  For most astronomical photography, and if you want to show the moon close-up, you’ll want to use a telephoto lens with a long focal length (or a telescope). Personally, I gravitate toward wider angle lenses at night for a number of reasons:


  • Most often, a compelling night image needs to show that it was taken at night. At the same time, to make an interesting composition, there should be foreground subject matter that compares and contrasts with the nighttime background of the photo. A wide angle of view makes it easier to combine these elements in a single shot.


  • Critical focus is often difficult, if not impossible, at night (see pages 28–29). Wide-angle focal lengths are much more forgiving in terms of focus.


  • When I am interested in capturing star trails, I know that the wider the angle of lens I use, the more curvature there will be in the star trails.


  Sensor size and focal length


  The smaller the sensor, the closer a given focal length lens brings you. For example, if a sensor has half the area of another sensor, then a given focal length will bring you twice as close on a camera with the smaller sensor. The photos in this book were shot using Nikon DSLRs with a 1.5 times 35mm focal-length equivalency. This means that to compare the focal lengths in the technical captions with focal lengths on a 35mm film camera, you’d have to multiply by 1.5.
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  • I used extension cords and a direct power adapter to take this photo from a second story window overlooking a moderately busy residential street in the middle of the night. My idea was to make as long an exposure as possible —in this case, 32 minutes; to achieve the long exposure, I had to stop the camera down to as small an aperture opening as it would go (f/22). With this long exposure and comparatively bright light sources, polygonal artifacts appear in the sky. These shapes are not dirt or rain; but are reflections and flares from the small opening of the lens. In most normal exposure situations, internal lens coatings prevent this kind of artifact from appearing.


  The smaller the opening and the brighter the light source, the more you see these flares. They begin to appear in night photograph with the lens is stopped down to f/16 or below, and there is a bright light source such as the moon or a street light. The effect itself is kind of interesting, so you’ll have to decide for yourself whether you like it, or whether it distracts from your overall image. 12mm, 32 minutes at f/22 and ISO 100, tripod mounted


  


  Focusing at Night


  Focusing at night presents considerable difficulties. Auto focus doesn’t work. And when the auto focus mechanism can’t “see” the subject to focus, most likely you can’t either. So how can you focus without being able to see?


  Many night photographs are taken with fairly wide open apertures because they are taken in low light conditions. The wide open apertures mean that there is less depth-of-fi eld, and therefore less forgiveness if the photo isn’t focused accurately.


  As I’ve suggested (pages 26–27), the bulk of night photography that is not astronomical is created using wide angle focal lengths, which require less critical focusing. Infinity, marked on your lens as ∞, is the point after which everything is in focus. The more wide-angle your focal length, the less distance there is between the camera and infinity. This means that everything beyond infinity is in focus.


  The most important point is to know your lenses and their idiosyncrasies about focusing.


  If you know that you need to focus on infinity, the thing to do at night is to turn off auto focus, use your head lamp, and manually position your focus indicator at the center of the infinity mark. There are a number of things to be cautious of in this scenario:


  • Make sure that your focus at infinity doesn’t shift between exposures because you’ve moved the camera or lens slightly. This can happen surprisingly easily without noticing it, and lenses vary greatly in how stiff the focusing ring is. (The stiffer the ring, the more the lens will stay in focus even if it is slightly jarred.)


  • Many zoom lenses over focus, meaning that they focus beyond infinity on the focus ring. So, if your lens does over focus, set your focus by the infinity mark, not by feel. Of course, if you know that the end of the dial is actually infinity, it is easy to focus at infinity in the dark.


  • Some zoom lenses do not focus consistently at the same spot for infinity across their focal range. The only way to determine this is to run tests during daylight hours and keep track of where to focus for infinity at a number of different focal lengths.


  If you need to focus on closer subjects, there are two ways to go about it. You can guesstimate the distance from the camera to the subject, and use your head lamp to enter it on the focusing ring. Or you can light the subject and use the illumination to focus before you turn the light off to make your shot in the dark.
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  • Since this moody view of a single light across a bay focuses properly at infinity, I manually set the focus ring. 65mm, 8 seconds at f/5 and ISO 100, tripod mounted
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  • This view of the Golden Gate Bridge and San Francisco clearly called for focusing on infinity, so I set my focus manually before starting the three-minute exposure. 22mm, 3 minutes at f/9 and ISO 100, tripod mounted


  


  Using Manual Exposure


  An exposure is the amount, or act, of light hitting the camera sensor. It’s also the camera settings used to capture this incoming light.


  There are only three settings that make up an exposure: shutter speed, aperture and sensitivity.


  • Shutter speed is the duration of time that the camera is open to receive incoming light. It is how long the sensor is exposed to light coming through the lens.


  • Aperture is the size of the opening in the camera’s lens. The larger the aperture, the more light that hits the sensor. The size of the aperture is called an f-stop, written f/n, and n is also called the f-number. Somewhat confusingly, the larger the f-number the smaller the hole in the lens, and the smaller the f-number the larger the opening.


  • Sensitivity determines how reactive to light a sensor is. Sensitivity is set using an ISO number; the higher the ISO, the more sensitive to light.


  When you set your camera to manual exposure, you must set the shutter speed, aperture and sensitivity based on your assessment of the incoming light that will hit the sensor (see pages 46–61 for some suggestions about determining exposures at night). For the most part, when doing night photography, you should stick to manual exposure and forget about any other exposure mode.


  Manual exposure means that you are the decider. But just because you are making the decisions, it doesn’t mean you don’t have help. Most DSLRs provide exposure readings—light meter indications of the light out there. Light meters are helpful at dusk and as the evening progresses, but they will not help you in the deep night.


  To accurately choose manual exposure settings at night, it is important to become familiar with the interrelationship of shutter speed, aperture and sensitivity, so you can adjust each setting as necessary. Shutter speed and sensitivity operate on a linear scale, so they are pretty straightforward. However, aperture corresponds to the diameter of the lens and operates on a logarithmic scale. Put as simply as possible, each full f-stop lets in half the light of the full f-stop that is next larger, as shown in the table. Note that you are not limited to using “full” f-stops; but you need to know the relative values of f-stops in order to calculate exposures in your head at night as the stars twinkle overhead.
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  • The moonlit clouds in this shot were much brighter than the White Mountains (along the California-Nevada border) in the background. Manual exposure allowed me to pick settings that captured the moonlit clouds in this shot, without blowing out the highlights. 13mm, 2 minutes at f/4.0 and ISO 200, tripod mounted
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  • I had a great deal of time to calculate the difference in exposure values between f-stops in my head during this long exposure of Yosemite Valley from Tunnel View. 16mm, about 25 minutes at f/4 and ISO 200, tripod mounted


  


  Bulb Photography


  The longest shutter-speed time you’ll find on most cameras is 30 seconds. To take a photo with a longer shutter speed than the maximum offered by your camera, select the Bulb setting, which is available on most DSLRs.


  To select the Bulb shutter-speed setting, with the camera on Manual exposure, choose Bulb as your shutter speed. This is usually designated with a B in the shutter speed window.


  With the Bulb setting selected, the shutter stays open as long as the shutter release button is depressed. But it is not practical to keep the shutter open by pressing the button directly. Apart from any other consideration, this would vibrate your camera, leading to less than sharp photos.


  Generally, when you take a photo using the Bulb setting, a remote release is used. The simplest remote releases attach to a connector on the camera, although wireless connectivity is also possible on some cameras.


  Very basic releases allow you to depress the shutter remotely, so that your act of pressing doesn’t add vibration to the camera. The simplest releases also have mechanisms that keep the shutter depressed with a lock, so you don’t have to physically hold the shutter down for the duration of the exposure; although you do have to time the mechanism. It can be a real problem to time things in the dark, because you don’t want to use a light source, which would be needed to watch a clock. It’s amazingly easy to lose track of time while waiting around in darkness.


  More sophisticated releases add precise timing, programming and interval capabilities to Bulb photography. (See pages 226–233 for more information.)
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  • I used the Bulb setting to make this five-minute exposure looking up the cliffs in Yosemite Valley. 18mm, 5 minutes at f/3.5 and ISO 100, tripod mounted


  


  Exposing at Night


  Given that the light meter in your camera won’t help you at night and that night exposures are almost all manual, it can be tricky find a starting exposure in the dark.


  The good news is that with digital, you can get instant feedback on your exposure choices using the LCD screen. A problem with this is that RAW night photos sometimes show as almost completely black on the LCD. Don’t be discouraged with this. In most cases, the image files actually contain plenty of information for “teasing out” a gorgeous night shot. Sometimes the exposure histogram (explained on pages 58–59)—instead of the actual image—is more helpful in deciding whether your exposure is good.


  Still, you don’t get many cracks at night - time shots. Unlike photography in the day, when you can bracket many exposures to get one right version, the number of exposures you can make at night is limited by the length of the exposures themselves, logistics and battery life. So finding an acceptable exposure the first time is very important.


  Experience helps. Ansel Adams supposedly was able to expose accurately for the moon in a number of situations without a light meter. He did so to create his classics such as “Moonrise, Hernandez.” But until you are able to guesstimate night exposures with good results, here are a few ideas for coming up with an exposure starting place:


  • Start taking pictures at dusk, after sunset. At this point, you will be able to use the light meter in your camera. Keep taking pictures as it gets too dark to use the incamera meter, and adjust for the changing conditions. By the way, this way of coming up with initial exposure values is another good reason for being in position before it gets dark.


  • Stars in the sky are accurately exposed at a range between three minutes at f/5.6 and ISO 100 and four minutes at f/4 and ISO 200. You can use this rule of thumb for exposures involving the moonless night sky, although the earth is darker than the sky.


  • Make a test at a high ISO, such as ISO 1000, and then use arithmetic to find an appropriate exposure at a lower ISO. For example, if your test at one minute, f/5.6 and ISO 1000 works, then you can comfortably expose an image at ten minutes, f/5.6 and ISO 100.


  Obviously, exposure issues change if you are capturing city or car lights at night; these are much brighter than the empty night, and your camera will probably offer auto-settings for starting exposures. In some situations, particularly when the moon is full (or nearly), fog can act like a giant diffuser and add a great deal of light. Try to be conscious of the kinds and vagaries of the light sources around you.


  In-Camera Long Exposure Noise Reduction


  Many cameras provide an in-camera noise reduction option (check your manual). This kicks in for exposures longer than about eight seconds, and it works by shooting a dark frame that is combined in-camera with your photo. The only downside is that your camera is occupied twice as long (to capture the original exposure and the dark frame).


  Generally, you should turn on the long exposure noise reduction option. However, if you are going to combine multiple stacked exposures (pages 192–223), turn the option off. The delay caused by creating the dark frame keeps the camera from creating a stack without gaps in the star trails.
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  • A half hour after sunset, the world had gone apparently monochrome. I shot this photo using a pure guess exposure. I looked at a dark, grey image on my LCD and didn’t think anything more of it. The next day, on my computer, it was clear that the colors of sunset lingered on these Pacific cliffs even though I hadn’t been able to see them at the time. 40mm, 8 seconds at f/4.5 and ISO 100
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  • I was giving a night photo workshop at the end of California’s Point Reyes peninsula. This is the most western point of land in the continental United States, with weather that is often formidable. Despite the wind, rain and fog, workshop participants were in good spirits, and we went out to photograph the lighthouse in the fog. The fog acted like a giant, white diffuser, adding brightness to this early-evening scene. 50mm, 1/2 of a second at f/8 and ISO 100


  


  Shutter Speed


  Shutter speed settings in night photography are selected for acceptable exposure and to render motion attractively or for technical reasons related to camera motion. Of course, you also need to select exposure settings that will capture the image in front of you. So if you are adjusting shutter speed to capture moving lights, or for some other reason, then you’ll need to adjust either aperture or ISO (or both) to compensate.


  The longer the shutter speed, the more that motion will convert discrete shapes to lines:


  • At exposure times longer than four seconds, moving car lights become lines.


  • At exposure times in the minutes, pounding surf becomes gentle, delicate and transparent.


  • When your total exposure time reaches hours, stars become curved (and possibly circular) trails of light.


  So in some sense, shutter speed acts paradoxically. On one hand, long shutter speeds turn violent motions—like that of the pounding surf—into a gentle and subtle image. On the other hand, a long shutter speed turns objects that are lit and in motion—such as stars, car lights and so on—into apparently solid lines.
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  • This is a photo looking down toward Half Dome from Olmsted Point in the Sierra Nevada Mountains of California. The shutter speed was long enough to make the motion of the stars highly visible as curved lines. 15mm, about 25 minutes at f/8 and ISO 100, tripod mounted
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  As the moon rose over the industrial cranes of Port Oakland, California, a very stiff wind was blowing. My camera, with a telephoto lens, was mounted on a tripod, but I could see it vibrating in the wind. I chose a fast shutter speed so the camera motion wouldn’t ruin the photo. I also raised the ISO (800 to 1000) to accommodate the shutter speed. Above: 190mm, 1/160 of a second at f/5.6 and ISO 1000, tripod mounted Below: 400mm, 1/200 of a second at f/5.6 and ISO 800, tripod mounted
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  Aperture


  The primary creative impact of aperture choice in daylight photography is on depthof- field. For many night shots, depth-of-field is not an issue, as these photos are entirely at infinity.


  If the range of in-focus subject matter is no concern, then the only impact of your aperture choice on the exposure of a photo is its effect on shutter speed and ISO. Note that stopping down a lens at night sometimes produces a variety of artifacts related to bright light sources, such as halos, stars and floating hexagon shapes that refract from the lens diaphragm.


  Aside from avoiding artifacts and aberrations, the primary reason to choose a small aperture for night shots is to make your exposure time longer—to take advantage of the wonderful visual changes that car headlights, waves, stars and almost anything that moves create. You can also add filters such as a Polarizer or Neutral Density to make your exposure time longer.
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  • I positioned myself on the divider of a busy highway after dark on a moonless evening. The biggest challenge was to remember where I was. I didn’t want to stick any body parts into a traffic lane by mistake. Right behind me, as I took this photo, was a traffic light. A driver stopped at the light and called out to me, “Hey man! What’s your shutter speed?”


  To get the effect of the lines from lights on moving cars, I had to have as long a shutter speed as possible. So I stopped down the aperture to the smallest opening (f/29). This led to a shutter speed of eight seconds, long enough to capture the effect I had pre-visualized. 36mm, 8 seconds at f/29 and ISO 100, tripod mounted


  


  ISO


  ISO, or sensitivity, can be raised or lowered easily on most digital cameras. The current generation of cameras handles high ISO settings much better than older cameras, and this technology is getting better all the time.


  So one approach to night photography is to boost your ISO like crazy. If you could shoot at ISO 50,000, then the darkest corner of the world would be no obstacle … and to heck with tripods and extended exposure times.


  Just keep in mind that the higher the ISO, the more noise. (See pages 176–183 for information about post-processing to reduce noise in night photos.) Underexposure, a frequent issue in night photography, also increases noise. (See the “Noise and Night Photography: A Perfect Storm” sidebar below.)


  This means that even when using cameras with improved noise-handling capabilities, ISO settings above 1000 are likely to lead to unacceptable levels of noise. So if you are thinking about leaving the tripod at home when you go out at night, consider the image to the right—shot at two minutes and ISO 640. (We’re going to hold the aperture constant at f/6.3.)


  To get it to a shutter speed where you wouldn’t need a tripod, say 1/200 of a second, you’d need to let in 2 • 60 • 200 more light than for the two-minute exposure. This works out to an ISO of 15,360,000 for the hypothetical exposure —and we’re not getting there anytime soon no matter what hardware advances there are.


  By the way, a fast shutter speed would probably also wreck the creamy effect of the moonlight on the moving water.


  Noise and Night Photography: A Perfect Storm


  Normally, noise—visual static in an image—comes from a camera’s sensor and processing software. The smaller the sensor, the more noise; some noise is inevitable because that’s the way digital signal processing works.


  Night photography involves three factors that can significantly increase noise:


  • The ISO setting: The higher the ISO, the more noise there will be. If you’re thinking about boosting the ISO to get away from long-exposure noise, forget about it. You have just substituted one cause of noise for another.


  • Exposure time: Exposures that are longer than about five seconds—most night photos—can become quite noisy.


  • Underexposure: Underexposed areas tend to have more noise. There’s a tendency, often for good reason, to underexpose night photos—but this leads to still more noise.
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  • I had lost my way in the mountains on a night photography trek, and I was wet most of the way through from having crossed and re-crossed the creek. But I was saved by the magic of the moment as I noticed the moonlight’s effect on the flowing waters of Unicorn Creek in the Sierra Nevada Mountains of California. It made the water appear almost silken. To capture this effect, I needed an exposure of about two minutes, so I raised the ISO. This gave me a shorter exposure than I could have achieved with a lower ISO. 18mm, 2 minutes at f/6.3 and ISO 640, tripod mounted


  


  Using the Exposure Histogram at Night


  A histogram is a bar graph showing a distribution of values. An exposure histogram shows the distribution of lights and darks in an exposure. (See examples of exposure histograms on pages 60–61, or check out how they look in your camera.)


  Your camera will show the exposure histogram for a capture you’ve made. Some cameras will show the histogram during composition before you’ve actually made the exposure. Check your camera manual for details on how to display exposure histograms.


  Sometimes at night it’s difficult to see on an LCD screen how an exposure came out. Some nighttime photos that are rendered as black, or near black, on the LCD turn out be full of rich and vibrant colors—provided the photos were shot as RAW images, and you take the time to tease out the information from them when you process the RAW file. In other cases, the rendering of night images on an LCD screen, even if they can be seen, is wildly inaccurate, and a histogram is a better guide.
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  • In the middle of the night, Mono Lake in Eastern California was lit by a setting moon. From a high overlook, the scene appeared almost as bright as day, so I adjusted my exposure histogram toward the middle to capture the “day in night” effect in my image. You only really know that it is night by the single car careening down U.S. 395 that bisects the scene. 12mm, 85 seconds at f/4 and ISO 100, tripod mounted
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  • Looking from the Golden Gate at the moon setting beyond Point Bonita, California, I felt that the scene was magical. I decided to concentrate on capturing the moonlight, allowing the hills and water to go dark. So I aimed for a histogram that was bunched on the left, with a few spikes toward the right, in order to capture the moon and its reflection in the water. The resulting image is a bit noisy, but I think that the noise is less important than the poetic qualities of this scene. 18mm, 30 seconds at f/3.5 and ISO 100, tripod mounted


  The exposure histogram of an underexposed photo is bunched to the left, and the exposure histogram of an overexposed photo is bunched to the right. A theoretically “correct” exposure is represented by a histogram with a bell-shaped curve smack dab in the middle.
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  The ideal position of your histogram in a night photo depends on what visual effect you are looking for.


  Theoretically, if your histogram shows a normal exposure, then—besides the color temperature of the light sources—there will not be much difference in the appearance of a night image from a day image. Your viewers won’t know your exposure time.


  As an example, moonlight is a little cooler in color temperature than sunlight, but not by much. A moonlit scene that does not directly show the moon, and is exposed according to a down-the-middle histogram, will look much like daylight. This is a pretty weird effect… and sometimes worth attempting.


  In other words, if you are trying for this “day in night” effect, then you should aim for a histogram graph in the middle of the exposure range.


  But, if you want your night images to look like the night, then you’ll want to underexpose your photos a bit. In this case, your histogram should be bunched to the left, which is only natural for night photography because the scene is pretty dark.


  A night left-biased histogram should have some values that reach toward central parts of the graph; otherwise the photo may be too dark overall. Also note that underexposure is one of the causes of excessive noise in photos; like many creative aspects of photography, use of the histogram at night is one part science and one part art.


  


  Light Painting


  A photograph of star trails uses the light emitted by the stars to “draw” lines on a photo. Moving car lights are “frozen” into lines by time exposures. Both of these effects take advantage of existing moving light sources, so the photographer is capturing a scene somewhat passively.


  However, there are ways for a photographer to take a more active role … to paint with light, particularly when a long exposure is being made.


  Light painting is a technique that’s generally used for one of three visual purposes:


  • To make darker areas of a photo, such as an important element in a dark foreground, acceptably bright. This is called fill lighting.


  • To light something in a special way to increase its visual interest.


  • To create an image in which the subject of the photo is the light itself.


  Most night photographers use light painting at some time in their career. Some photographers use light painting almost exclusively.


  There are all kinds of light sources that can be used for light painting. Keeping it simple means using the head lamp or flashlight that you use for navigating the night terrain. This can produce perfectly acceptable results. You can get more elaborate with colored lights, glow sticks, gels and transparencies. The only real limiting factors are what you can carry to your night photography locations and the availability of power for your illumination devices.


  Whichever kind of light painting you do, some general principles apply. You never, ever want to point the light source directly at the camera because this can produce unsightly bright spots. And you most likely want to keep the light source moving. When I’m light painting at night, I think of it as the “Dori wiggle”—named after an animated character in Pixar’s Finding Nemo who repeatedly chants, “Just keep swimming, just keep swimming.” In other words, keep your light source moving.


  Light painting that moves from right to left or up and down in front of the camera tends to produce stronger lines than light painting that moves toward or away from the camera.


  It can be difficult to judge the exposure you need to use when light painting. And it’s tough to know what adjustments you need to make to an exposure when you use lighting to fi ll in the foreground of a scene that you are exposing. With fi ll lighting, just don’t overdo it. Somewhere between a third and half of the exposure time should be the maximum for light painting as fi ll light.


  No matter how you use light painting, plan to experiment and to try many times with many variations, because you never know what will work and what won’t.
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  • This image was created by David Joseph-Goteiner while he was participating in one of my night photography workshops. We pointed flashlights at our faces, so that we appeared to be disembodied spirits in the night. 22mm, 20 seconds at f/5.6 and ISO 100, tripod mounted © David Joseph-Goteiner
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  • The overhead railways shown in this photo were used to provision tall warships during World War II at the Mare Island naval base. I lit the structure on the right with a powerful 15,000-watt portable light source that was powered by a car battery. The light source was in motion for the duration of the exposure. My idea was to provide fill lighting for the structure on the right and to use the light painting to grab the viewer’s attention. 28mm, 3 minutes at f/10 and ISO 100, tripod mounted
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  • I camped on Angel Island, in the middle of San Francisco Bay, right across from Golden Gate Bridge. My campsite was dominated by the stump you see in this photo.


  In the middle of the night, I got up to take photos of the Golden Gate Bridge. But the stump seemed so interesting that I had to include it. I used light painting to make sure that the foreground in the photo, including the stump, was bright enough for the photo. 18mm, 1 minute at f/5 and ISO 100, tripod mounted
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  • The south face of this old church in Bodie, a ghost town in Eastern California, was lit primarily by moonlight. I positioned the camera to face north to maximize the movement of the stars.


  The interior of the church was pitch black. So during this long exposure (about 18 minutes), I “painted” the interior of the church using a small flashlight. To do this, I walked round and round the building continuously, circling behind the camera, careful never to stop the light in one place, directing my light at the side and rear windows. The result is the interesting green effect in the interior shown in the photo. 12mm, about 18 minutes at f/16 and ISO 100, tripod mounted
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  Photographing Cityscapes at Night


  The suns sinks below the horizon and the lights of night come on. What better way to get introduced to the pleasures of night photography than to start by photographing the night lights of the city where you live?


  Long exposures of the city night may lack the subtle pleasures of nighttime in the wilderness, but the reward is capturing the effect of many different color temperatures of different lighting sources.


  Besides ambient light from the setting sun, lunar light and light from the stars, light sources you may see at night include the varying color temperatures of argon, fluorescent, halogen, mercury vapor, tungsten, xenon and more. You’ll see the tell-tale signatures of the color from all these lighting sources in any broad cityscape photo with their varying qualities of yellow, green, blue and orange. This lighting “soup” can turn mushy, but in the best case it creates an exciting story of the varieties of light on display, especially when viewed in contrast in a way most people don’t often get to see.


  Long exposures at night can also turn motion into lines and patterns. Cars, helicopters, buses, trains and airplanes are no longer apparent except in the tracks made by the lights they project.


  City views at night are made using the shortest amount of time for the shutter speed—usually between 4 and 30 seconds. This is short enough that you do not need to use the Bulb setting. You may even be able to take advantage of your camera’s light meter and exposure modes. In fact, city exposures are so short (by night photography standards) that you may need to take steps to make the exposure longer. These measures may include stopping the camera down to a small aperture or even adding a Polarizer or Neutral Density filter, which would reduce the amount of light reaching your sensor.
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  • This is a photo of the lights of Emeryville, California, San Francisco, and the Bay Bridge shortly after a crisp, winter sunset. Winter tends to have less pollution and atmospheric haze than summer, so this time of year can be better for city night photography, even if colder for the photographer. The air was particularly clear on this night, so I went out looking for a location to shoot. High up in the Oakland Hills, I got permission to climb on to a roof using a ladder, and I took this photo while the family who lived there had dinner. 170mm, 30 seconds at f/8 and ISO 100, tripod mounted
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  • This photo of the Golden Gate Bridge and the San Francisco skyline takes advantage of fog in the atmosphere to create an interesting, soft look at the hard edges of moving colored lights. 18mm, 2 minutes at f/8 and ISO 100, tripod mounted
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  • This photo takes a familiar landmark—the Transamerica Tower in San Francisco—and shows it at night, where it seems quite different from how it appears in the standard, daytime view you’d see on a postcard. The thirteen-second exposure was long enough to convert the headlights of speeding traffic into straight, semi-transparent lines. 18mm, 13 seconds at f/20 and ISO 100, tripod mounted
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  • Taking photos while looking down on cityscapes from high places, as in this image of Silicon Valley from the summit of Mission Peak, can remind us of the sprawling nature of human life. I find that when I compose this kind of image, I start wondering about the purpose of humanity and thinking about all the living moments that are happening under bright lights while I sit on the fringe in darkness making photos. Photography, as critic Susan Sontag pointed out, is essentially a voyeuristic act. To me, making this kind of night image brings home the inherent voyeurism in photography. 32mm, 30 seconds at f/5.6 and ISO 100, tripod mounted


  


  Buildings at Night


  It’s fun to photograph buildings in a city at night, and buildings by themselves can also make dramatic nighttime imagery.


  Starting in early evening, lights go on in windows around the world. There’s a sense of melancholy for those on the outside looking in, and images showing a single light in an otherwise dark building can create romantic or eerie atmospheres.


  As the night darkens, the appearance of the facades of buildings changes. You are no longer looking at straight architecture. Instead, the issue becomes how light sources interact with the building and the patterns created by light and shadow. With some notable exceptions, night light sources on buildings are more serendipitous than intentional. It’s hard to predict how the combination of lights in neighboring windows will work together; but when they combine, the question from a photographic perspective is how the resulting lights, darks and shows will work as a composition.


  A photograph of a city building at night poses the question, “What is going on inside this building?”—especially when only a single window is lit.


  A key issue when creating a dramatic night landscape is finding a foreground point of interest. The right building can solve this compositional issue.


  Now, I happen to like night landscapes that are wild and show no evidence of humanity. But it is also undoubtedly true that some of the night photos with the greatest emotional punch show buildings and structures—essentially contrasting the vastness of the night sky with the small scale of humanity.


  Using a Tripod in Public


  Tripods are pretty much a requirement for night photography, but many a night photographer is asked not to use a tripod. While private property owners have the right to keep you off their property with or without a tripod, you are allowed by law to photograph in most public places. (The few exceptions include reasonable things like military bases and nuclear facilities.) Unless your tripod is a public hazard, you should be able to use it.


  Law or no law, many public or semi-public facilities don’t like photographers using a tripod, and security guards may harass you or ask you to leave. Like other night photographers, I’ve been told to “move on” by park rangers, cops, transit police, airport security, irate private property owners and private security guards. This kind of interaction might even be regarded as a badge of honor in the fraternity of night photography.


  Because the issue can come up, it’s a good idea to contact facilities in advance, to find out if you will be allowed to photograph with a tripod on the premises and to complete any paper work that may be required. Advance contact will help to ensure that your photography trip isn’t wasted, and it will increase the chances that you (and your tripod) will be allowed to remain and photograph.
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  • This is a photograph of the general store in the old ghost town of Bodie, California, where I had special permission to photograph at night. The orange lights you can see in the store windows are from extremely low-light tungsten bulbs. I didn’t want them to “blow out,” and I wanted to give the photo the feeling of true, deep night. To do this, I set the exposure so the curve on the histogram moved far to the left. 12mm, 4 minutes at f/11 and ISO 100, tripod mounted
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  • After sunset, as dusk quickly faded to night, I looked up at this partially occupied modern apartment tower and saw a single lamp burning. 95mm, circular Polarizer, 1/4 of a second at f/29 and ISO 100, tripod mounted
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  • The hard edges of the shadows and lights made me wonder what drama was occurring within the lit window in this older building. 60mm, 3 seconds at f/10 and ISO 100, tripod mounted
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  • The historic lighthouse at the tip of Point Reyes, California, adds to an intriguing photo that features a background of oncoming night.


  If you look carefully at the photo, you’ll see a trail of light that begins at the lighthouse building and heads about halfway up the stairs. This is the flashlight of the park ranger who was helping me make the photo.


  I started my five-minute exposure from my position on the stairs above the lighthouse. As the ranger came up the stairs toward me, I called, “I’m exposing.” He turned off his flashlight about halfway through the exposure, at the spot you can see as the end of the flashlight trail. 18mm, 5 minutes at f/9 and ISO 100, tripod mounted


  


  Bridges and Water Reflections


  Bridges and water reflections each (and sometimes together) make a great subject for night photography, but they need to be treated differently at night than in daytime exposures.


  The key difference is caused by the long exposure times necessary for night images. And when you are working with long exposure times, anything that moves will change shape. Subjects in motion will not be rendered crisply; in fact, it can be hard to pre-visualize how moving objects will appear. Taking as many captures as possible, and viewing preliminary results on your LCD, is a good way to deal with this kind of unpredictability.


  Specifically, water in oceans, lakes and rivers is almost always in motion. And reflections in moving water will themselves move, too. The visual impact of this motion in a long exposure is unpredictable. But, in this situation, it is a fairly safe bet that the fields of color in the reflections will extend to a greater area than they would when the shutter speed is quick. At the same time, colors will become less saturated. These effects take place because the water is moving; you capture a broader area with somewhat less intensity at any given point.


  An effective tool for enhancing the possibly diminished reflections is to use a circular Polarizer. This is a filter that can be rotated to change the appearance of reflections.


  Since it is difficult to judge the impact of a Polarizer when it’s dark, you should take the time to let your eyes adjust. Look carefully through your viewfinder once you are used to the dark to make sure that you’ve set it to best enhance the scene.


  There are three special considerations for images that include bridges at night. First, you should try to combine night bridge compositions with reflections or shadows involving the bridge. This will almost always enhance your results.


  Next, consider the motion of cars on the bridge. As your exposures get longer, the lights from these vehicles elongate and begin to resemble solid, straight lines. It’s important to integrate this effect with your composition.


  Finally, a bridge itself is usually fairly solid and straight. At night, a lit bridge is in stark contrast with the surrounding landscape: a brilliantly lit structure alone over dark water with the night sky above. Just keep in mind that pointing your camera directly at the straight aspect of the bridge may not create an interesting composition. So try to find unusual angles for your night bridge photos, so you can present the bridge and surrounding reflections as more than straight lines put together. An interesting camera angle can greatly increase the interest of night bridge compositions.


  [image: ]



  • Port Richmond, California, is a gritty, working harbor. A narrow road follows the coast. There are fields of imported cars and cargo in shipping containers behind a chain-link fence on one side; the working harbor is on the other. While exploring this route on a dark, moonless night, I came upon these working tugs and their reflections.


  By experimenting with exposures ranging from 2 to 30 seconds, I was able to test the impact of the movement and lights. I like this relatively short, four-minute exposure best because it leaves the water dark and allows the colors of the reflections to stand out. The reflections were amplified because I used a circular Polarizing filter in front of the lens. 46mm, circular Polarizer, 4 seconds at f/6.3 and ISO 100, tripod mounted
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  • The rising moon and light fog add interesting colors to this photo showing the night lights of the Golden Gate Bridge, and the reflections in the water help to balance the composition. 95mm, 1.6 seconds at f/5.3 and ISO 100, tripod mounted
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  • At one time, the John F. McCarthy Memorial Bridge (shown below) was one of the longest bridges in the world. It is a double cantilever structure that stretches across the San Francisco Bay from Richmond to San Rafael—yet it is not as glamorous as either the Golden Gate Bridge or the Bay Bridge. I composed this night image to capture the snake-like twist in the structure by positioning myself at an angle to the bridge. The bright gleam from headlights adds visual interest under the cloudy night sky. 120mm, 13 seconds at f/6.3 and ISO 100, tripod mounted
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  • This photograph is taken from Kirby Cove, a strikingly beautiful beach in Golden Gate National Recreation Area, California, that you can reach by hiking.


  I composed the image to show the city skyline of San Francisco below the Golden Gate Bridge. As I looked carefully at the scene, the regular reflections on the water that were created by the long exposure of the bridge lights added to the compelling scene. They created a neat pattern, so I made sure that my exposure was long enough to allow these reflections to be fully visible. 46mm, 20 seconds at f/4.5 and ISO 100, tripod mounted


  


  Industrial Scenes


  Industrial scenes can make great subjects for night photography because buildings and facilities tend to have visually interesting shapes. Also, there’s often lighting with a variety of exciting color temperatures, and factories are often deserted at night.


  Night photographers’ interest in industrial scenes is long-standing, and it includes both working facilities and historic structures. Older factories may be preserved as part of a historic park, or they may be abandoned and decaying.


  With both new and old factories, there are some special safety concerns to think about. Industrial facilities can be dangerous places with unexpected hazards. Do your research! If a factory is currently operating, you should not be photographing on the premises without permission.


  Fortunately, there are plenty of historical industrial structures that you can photograph at night from public locations; it’s also true that many working facilities can be easily photographed from nearby streets.


  If you do venture into an abandoned factory, as with any night venture into the unknown, be cautious. Don’t go alone, and bring plenty of lights with you. If you don’t need lights to see safety hazards, you can always use them to light your photos in interesting ways! (See pages 62–67 for info about painting with light.)


  A Word about White Balance


  Most industrial scenes are lit by many different sources. A single scene can include moonlight, starlight, mercury vapor arc flood lamps, tungsten lights, fluorescent lights, car headlights and more. There’s no reasonable way to input an accurate white balance setting for the color temperatures of these mixed sources when you are in the field doing night photography.


  So the best bet is to leave your camera set to auto white balance. But don’t expect your camera to be able to make much sense of the color soup. The settings your camera chooses on the basis of auto white balance will likely be a weighted average of the various light sources—and accurate for none of them. This means that you shouldn’t necessarily believe the colors you see on your LCD because they are based on the white balance settings. It also means that if you want to emphasize the light from one of the sources, you’ll need to tweak the white balance settings for the photo in the digital darkroom.
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  • During World War II, Mare Island, California, was the largest naval shipyard on the West Coast of the United States. Today, many of the abandoned buildings have been preserved as part of a historic park, and it’s a fairly safe location for night photography.


  When I pre-visualized this photo, I was struck by the contrasts involved. I love the direction of lines in the composition, and I was fascinated by the combination of the color temperature of the pink cloud, the green reflections in the factory window, the red reflections in the railroad track and the bright car lights. 22mm, 30 seconds at f/5.6 and ISO 100 tripod mounted
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  • The Port of Oakland is one of the busiest ports on the West Coast of the United States. I was struck by the strong, warm orange industrial lighting on the heavy port equipment. It was easy to get close enough to photograph this strange environment safely, because Oakland Waterfront Park is conveniently located next to the heaviest cranes. 26mm, 13 seconds at f/5.6 and ISO 100, tripod mounted
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  • Looking up at this giant crane in the Port of Oakland, I realized that the predominant light source came from orange mercury vapor flood lights. I composed the image on angle to emphasize the extent to which the stairs on the crane went upward. The photo looked gray and without much color on the LCD, but I knew I could adjust the white balance in post-processing to bring back the orange glow of the flood lights. 75mm, 25 seconds at f/32 and ISO 100, tripod mounted


  


  Light and Motion at Night


  One of the great things about night photography is that a dark overall background and low-light conditions provide some interesting creative options for rendering light and motion.


  For night photography, those elements can produce cool effects. To capture light in motion, you need a subject that moves in relation to the camera. This subject must emit or reflect light.


  While there are less of these subjects than you might expect at night, quite a few exist, such as moving vehicles, the moon and stars. Each lit and moving subject adds the potential of great interest to a night photo.


  Add to this the possibility of moving the camera when shooting a stationary light, and there is a universe of creative possibilities.


  The key exposure issue in rendering motion is the length of time used for the shutter speed setting. At half a second or less, most objects appear relatively ordinary, and at ten seconds or more, moving objects begin to appear spectral and fantastic.


  The issues involved are actually a bit more complex than you might think, and I’ll get to them in a minute. Just bear in mind that your choice of shutter speed usually controls the aperture that you’ll need to use. When the aperture is large (for example, f/2), you may not have enough depth-of-field, and when it is small (for example, f/29), you may get lens fl ares at night (for example, see the photo on page 35). So you need to balance aperture selection when you choose a shutter speed for creative motion effects at night.


  When considering the shutter speed to select for an object in motion at night, think about the following factors: the speed of the lit object, its brightness, its angle to the camera (motion that is horizontal to the camera appears more pronounced), and whether there is camera motion involved. Generally, you want to time this kind of photo so that the moving light occupies at least a third of your finished photo frame; otherwise it will not seem important in your overall composition.


  In the field, determining the shutter speed that meets these conditions is often not easy. Goldilocks gets it: not too short, not too long, just right. There’s just no substitute for experience, so in a given situation, shoot at many different shutter speeds to find out what works. Of course, by definition, an object in motion is moving, so you may not always get a second chance to get your shot.


  Here are some ideas of, roughly, what you might expect from shutter speeds in relation to the most commonly photographed moving lights at night.
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  • During the day, Market Street in San Francisco is one of the busiest streets in the city. At night, it is a different, quieter story. So I was able to stand on a platform in the middle of the street to shoot this photo.


  The right side of this image shows the lights of a street tram coming into its station. The eight-second exposure has both elongated the lights and made them transparent. 36mm, 8 seconds at f/16 and ISO 100, tripod mounted
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  • I watched the moon rise over San Francisco Bay and tried to figure out how to balance the bright moon with something interesting in the foreground. Then I realized that if I extended the exposure time, I could create an interesting effect by contrasting the abstracted car headlights against the dark background of the hills that were in the moon shadow. A 25-second exposure did the trick. 50mm, 25 seconds at f/25 and ISO 100, tripod mounted
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  • I created the abstract light composition in the foreground of this image by using a telephoto focal length to focus on city lights. With my camera on a tripod, I rotated the camera up and down and side to side in a slow and deliberate way for the 1.6-second exposure.


  Obviously, with this kind of photo, you won’t know what you get until you try it. So the key is to experiment, and make a great deal of different versions. Composite of moon and lights. Lights: 200mm, 1.6 seconds at f/2.8 and ISO 200, tripod in motion; Moon: 400mm, cropped in, 1/2500 of a second at f/2.8 and ISO 200, tripod mounted
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  • I was photographing the Golden Gate Bridge at night from San Francisco’s Baker Beach when a large wave came up, threatening to drown me, my tripod and camera. I had to quickly move the camera—while the shutter was still open—to higher ground.


  There are really three components to this exposure, each about ten seconds in shutter speed duration: a fixed component before the wave hit; time when the camera and tripod were in motion; and a second fixed period on higher ground. The two fixed periods anchor this composition, which otherwise might be too abstract. 60mm, 30 seconds at f/4.8 and ISO 100, tripod mounted in motion and two fixed positions
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  During a night photography session in Las Vegas, I became interested in the movements of “gondolas” in the artificial lagoon at the Venetian casino.


  I experimented with a variety of shutter speed settings in my exposures to see which made the movement of the gondola most interesting.
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  At 2.5 seconds exposure time, the ersatz gondola appears essentially solid (above), like a gondola “should” be; while at ten seconds, the gondola becomes elegant and abstract (foreground right). Above: 18mm, 2.5 seconds at f/22 and ISO 200, tripod mounted Right: 18mm, 10 seconds at f/22 and ISO 200, tripod mounted
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  • I wanted to show the new moon setting into Mt. Tamalpais, California. I knew that a continuous exposure would render the moon as a bright, white line—and the detail of the moon’s shape would not be apparent in the photograph.


  I solved this exposure problem by combining multiple exposures, with a substantial interval between each exposure.


  The technique I used for combining the multiple exposures is explained on page 192. You can learn more about programming an interval timer in Appendix A, beginning on page 226. 70 mm, stacked composite of eleven exposures at 2-minute intervals, each exposure 13 seconds at f/8 and ISO 100, tripod mounted


  


  Photographing the Ocean


  The ocean, and particularly where it meets the shore, makes for a great photography subject after sunset. At low tide, the intertidal zone is a lovely canvas for reflections and colors of all sorts.


  At other times, waves create a motion subject for long exposures; the night tames violent surf so that it becomes transparent and delicate. The ocean itself reflects ambient light and interesting colors into the environment.


  The surprising number of lights from fishing craft and other boats is an added bonus when you point your camera out to sea.


  Before heading to the beach for an evening, or night, photography session, it is a good idea to check your local tide tables. Knowing where you are in the cycle of tides will help you plan your photography. It will also help keep you safe. In addition, it is prudent to never turn your back on the ocean—to help protect both you and your camera. It’s easy to get so involved in photography that one forgets this elementary precaution. Several times I’ve almost been swamped unawares by a rogue wave.


  Shortly after sunset, look for opportunities to capture light absorbed from sunset that is not yet discharged. Two good opportunities are the wet sand at low tide and cliffs that face a beach. At relatively “short” exposure times (thirty seconds or less), you’ll most likely want to stop your aperture down to a small opening to make your shutter speed longer. The point is to make the motion of the waves appear more interesting.


  With full night upon you, the beach becomes a mysterious place. Long night exposures, where the ocean meets the shore, add the movement of clouds and stars to the mix.


  In bad weather, the outcome of night photography will be unknown until you try. What is out there in the dark ocean on a black moonless night? You may be surprised by how much there is for your camera to “see.”
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  • The thirty-second exposure brought out lingering colors in the cliffs well after sunset, and turned the pounding action of the surf into fog-like vapor in this shot of the aptly named Sculptured Beach on the rugged California coastline. 18mm, 30 seconds at f/4.5 and ISO 100, tripod mounted
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  • I used a small aperture to force as long a shutter speed as possible in this low-tide beach shot that was taken shortly after sunset. My idea was to soften the appearance of the waves in the intertidal zone. 24mm, 7/10 of a second at f/22 and ISO 100, tripod mounted
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  • In this shot, the three-minute exposure was long enough to capture the movement of the clouds and surf and make them appear as translucent, without rendering stars and boats at sea as more than points of light. 12mm, 3 minutes at f/5.6 and ISO 100, tripod mounted
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  • On a dark, foggy night, it was pitch black, and I wondered what I would get by exposing straight out to sea. There was nothing to be seen by eye. But letting enough light into the sensor allowed me to capture a moody but subtle composition, giving a new meaning to the phrase a shot in the dark. 18mm, 4 minutes at f/3.5 and ISO 100, tripod mounted
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  • Perched on a high aerie along the rugged Marin Headlands coast of California, I made this photo pointing almost due north. At twelve minutes exposure time, the pointing surf was “flattened,” and it seems almost gentle in this image. 12mm, about 12 minutes at f/5.6 and ISO 100, tripod mounted


  


  Fog at Night


  At night, fog changes everything. You can forget about starry skies and the grandeur of the cosmos. The world closes in. Lines become blurred and painterly. Colors are more saturated. Fog operates like a giant diffuser.


  In addition to these effects, which can cover an entire scene or affect only a portion of an image, fog tends to make things brighter. To a surprising extent, I find I end up with shorter exposure times when capturing a scene that is foggy overall at night.


  Although there does tend to be a surprising amount of ambient light when conditions are foggy, it depends on the light sources involved. And even though there can be more overall light than you expect in fog at night, I often expose in the fog to maximize exposure time. This has the effect of increasing the impact of the fog, because the fog is in motion during the exposure.


  Partial fog can add a magical touch to an image, but don’t give up on night photography in total fog! While you don’t have the glorious assistance of celestial objects, fog can be wonderfully atmospheric. The challenge is to create compositions that use fog in ways you might not expect, because fog has great properties: it increases saturation, makes hard edges soft, and adds an overall feeling of mystery.
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  • Standing high in the rugged Marin Headlands along the coast of California, there was a light fog coming in off the sea. I intentionally used a small aperture to stop the camera down so I could use a longer shutter speed to maximize the impact of the fog creeping over the water. The long exposure picked up colors in the Headland cliffs along with mist and fog that were not visible to my naked eyes. 26mm, 30 seconds at f/20 and ISO 100, tripod mounted
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  • Cliff House is a famous restaurant beloved by tourists and locals. It sits opposite Seal Rocks along the San Francisco coast. In a pea soup fog, with moisture clinging to my camera and tripod, I had the scene to myself. The restaurant looked like a fun house to me as the fog diffused its lights. 18mm; five exposures combined in Photoshop; exposure times between 10 and 55 seconds; average exposure time about 25 seconds at f/5.6 and ISO 200 tripod mounted
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  • This image was created using light painting to bring out the shadows of the posts against the stairs in foggy conditions. The fog accentuated the light you see in the background, which is orange from mercury vapor street lamps. Overall, the fog adds to the slightly sinister impact of this image. 22mm, 30 seconds at f/9 and ISO 200, tripod mounted
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  In the pitch black of night in a eucalyptus grove, I purposely chose a small aperture for these shots, so I could make the exposure times longer. My idea was to create a dream-like effect. The portions of vegetation that are farthest away are more blurred than those that are nearer, because they moved more in the wind.


  Note that the overall exposure creates something of a “day in night” effect (see page 150 for more about making day look like night). You’d never know by looking at them that these photos were taken in pitch black conditions. Above: 12mm, 80 seconds at f/22 and ISO 100, tripod mounted Right: 16mm, 80 seconds at f/22 and ISO 100, tripod mounted
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  Clouds


  As with fog, photographers of both day and night can make the mistake of avoiding clouds and rainy weather. Yet, many of the best photos in both day and night are taken in rough weather. True, you have to protect your gear—and yourself—from the elements; but if you are not out in a squall, then you’ll never capture a clearing storm or the drama of a battle between clouds and wind.


  At night, you might think that clouds will make it harder to photograph the night sky, and there is some truth to this. However, the long duration of night exposures means that stars tend to peek through moving cloud cover. In addition, colors left over from sunset tend to transform clouds captured during long exposures—both shortly after sunset and in the deep night—into wonderful, magical and sometimes surreal shapes that seem to owe more to watercolor than to photography.


  There’s not much you can do with a solid, overhead mass of clouds though. Clouds at night are most interesting when they are moving.


  To take advantage of moving clouds, try to arrange your camera’s position so it is pointed at an angle to the movement. You want the clouds to move almost perpendicular to the camera. In this respect, the movement of clouds is a bit like the movement you might try to create when you paint with light. The movement of clouds in a photo appear less pronounced and less interesting when traveling directly toward or away from the camera.


  At shutter speeds that are a fraction of a second, just after sunset, cloud movement becomes slightly blurred. This can be a very attractive effect. Between two and ten seconds, clouds take on a life of their own; and at thirty seconds they are an emphatic presence—only to become wispy and ephemeral as exposures veer into the minutes.


  After a while, you’ll get the hang of how these shutter speed variations impact and render clouds in your night photos. The key thing is to use this information, and to realize that night clouds form a vital part of almost any outdoor composition.
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  • On the San Francisco waterfront, I noticed a huge bank of clouds about to envelope the entire city. I waited until the clouds partially obscured my view, and then angled my camera toward the moving clouds. This helped turn an otherwise straightforward photo of a ferry terminal into something more magical. 28mm, 5 seconds at f/6.3 and ISO 100, tripod mounted
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  • Coming out of a hike in a deep coastal valley at the tail end of sunset, I saw these clouds forming bands in the sky. With my camera mounted on a tripod, I shifted my angle so that my camera was pointed perpendicular to the clouds. I made as short an exposure as possible, so that I wouldn’t lose the shapes of these wonderful clouds. 28mm, 3/5 of a second at f/4 and ISO 200, tripod mounted
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  • High on Mission Peak, looking down at San Jose, California, I saw the somewhat sinister looking, dark cloud crossing my frame. I purposely underexposed so that the darkness of the cloud would be exaggerated against both city lights and hills. 34mm, 30 seconds at f/4.2 and ISO 100, tripod mounted


  


  Photographing the Moon


  What is life without the moon? Without it, there would be far less poetry, romance and magic in the world. The moon adds a distinctive element to night photography that is definitely not prosaic.


  Along with the wonderful properties that we associate with moonlight, however, comes a big photographic headache: the moon is a great deal brighter than the surrounding night sky. No successful night photograph that includes the moon can ignore this issue.


  In addition, the moon can be surprisingly bright on an absolute basis. In fact, it is really difficult to underexpose the moon. Even knowing this, many times I’ve ended up with photos in which the moon is too bright for contours on its surface to show clearly.


  The overall area of the moon reflects more or less light depending upon many variables, including atmospheric conditions, the phase of the moon, and its position in the sky. So there’s no onesize- fits-all solution for proper exposure settings for the moon. To expose it properly, your best bet is to take a spot meter reading of the moon, being careful to aim the spot at one of the brighter areas on the moon’s surface.


  There are a number of strategies for dealing with the moon’s brightness against the night sky.


  • Expose for the background, allowing the moon to become a white disk.


  • Allow some areas of the composition to be very dark, and expose properly for the moon.


  • Photograph at dusk, before the sky assumes its full night blackness.


  • Use city lights, or some other bright light source, in the foreground to balance the brightness of the moon.


  • In the digital darkroom, combine a “darker” version of the photo that is exposed for the moon and a “lighter” version that’s exposed for the landscape. (See page 130 for an example.)
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  • I knew that a full moon would rise at roughly 9 pm, so I positioned myself to capture the moon from beneath the Golden Gate Bridge. Residual light from sunset and the lights of the bridge and San Francisco helped to ensure that the contrast between the moon and background wasn’t too great.


  Just as the moon rose, a cruise ship passed in front of the skyline. I timed the ten-second exposure so the lights from the ship would become partially abstract, but the broad outline of the boat would be apparent. 140mm, 10 seconds at f/5.6 and ISO 100, tripod mounted
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  • This shot of the moon captures the early stages of a lunar eclipse. While overcast conditions combined with the eclipse to make the moon less bright than normal, I still had to take care to underexpose the photo (compared to an overall light meter reading) with the goal of making sure the moon didn’t look washed out in the final image. 400mm, 1/15 of a second at f/8 and ISO 100, tripod mounted
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  • I spot-metered to expose for the moon, and then underexposed to bring out the shadows of the craters and valleys on its surface. 400mm, 1/2500 of a second at f/2.8 and ISO 200, tripod mounted
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  • With about four minutes until the moon set, I decided to hold the shutter open for the duration. The effect shows the moon’s progress as it sets. 200mm, 4 minutes at f/5.6 and ISO 100, tripod mounted
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  • I exposed this photo so that some of the background would be apparent, causing the moon itself to blow out with overexposure. When I processed the image, I decided to leave the high-contrast effect intact. This abstracts the composition so the moon appears to be a cut-out white circle on a roll down the suspension cables of the bridge. 400mm, 2 seconds at f/5.6 and ISO 100, tripod mounted



  


  Night at Home


  When I first started shooting as a night photographer, I thought I had to go out on trips for the specific purpose of finding night photo subjects. But the truth is that night surrounds us. Half the world is always cloaked in darkness; if it is not your half now, it soon will be.


  As I started looking for night subjects at home, I realized that the key difference between night and day is the lighting. Since photography is notoriously about “writing with light,” this should not have been much of a surprise. But lighting at night is very different from the day in terms of its source, types of shadows, color cast and temperature. In addition, the relative darkness of night imagery means that the lighting in these photos is more high contrast and pronounced.


  So when I try night photography at home, I look for everyday objects that are transformed by the light and darkness and colors of the night.
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  • During the day, there are no shadows on the wall next to my front door. But at night, street lights cast intriguing shadows through the bushes adjacent to the house. I decided to make a photo of these shadows, intrigued by the fact that they are invisible during the day. 22mm, 30 seconds at f/11 and ISO 100, tripod mounted
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  • This macro of a water drop shows Christmas lights in its reflections—a striking night image that has nothing to do with the night sky. 200mm macro, 36mm extension tube, 30 seconds at f/25 and ISO 100, tripod mounted


  


  Everyday Objects


  Once you’ve mastered the techniques of night photography, you might be surprised at subjects that occur to you. When the length of exposure is not an issue, lowlight compositions and macros are very possible—sometimes with unexpected and striking results.


  It’s well-known that our eyes are capable of perceiving a greater range of lights and darks than a single version of a digital capture. This is sometimes called the problem of dynamic range. Images that use a variety of techniques to overcome this problem have “extended dynamic range,” also called High Dynamic Range (HDR) images. (See page 130.)


  My point is that you can use the extended dynamic range of your eyes to scope out possible everyday objects that will work for night photography.


  If you come down for a sandwich in the middle of the night and see an interesting pattern in the low night lights of your home, this may be a subject for night photography. If you are walking along the street and see an attractive color reflection or shadow in a store window, there’s another possible night subject—no matter how dark the scene.


  If you are trying to capture an object in really low-light conditions, particularly if you need a great deal of depth-of-field, it is a good idea to consider boosting your ISO. With continuing improvements in the way cameras handle high-ISO images, this may be feasible without objectionable levels of noise—and might reduce the exposure from hours to minutes … or even to less than thirty seconds.


  Now that I know about photographing at night, I have twice as much time to photograph, and I never hesitate to take a photo because there doesn’t seem to be much light!
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  • In daylight, this fire hydrant looked pretty plain and undistinguished. At night, the glow of the street light turned rust and cracked patina into a canvas of colors. In making this exposure, I closed the aperture to a relatively small opening for the purposes of increasing depth-of-field, which led to a longer exposure (three minutes). 200mm macro, 3 minutes at f/25 and ISO 200, tripod mounted
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  • The restaurant was closing for the night. I looked through the window and saw these rows of glasses prepared for the next day’s trade. To make the four-second exposure, I mounted my tripod precariously on a table that was pushed up against the window … and crossed my fingers that it would stay balanced. 20mm, 4 seconds at f/22 and ISO 100, tripod mounted


  


  Extending Dynamic Range


  As in the day, sometimes the night photographer is presented with an impossible exposure situation in terms of dynamic range. In this situation, the range between the lightest and darkest values in an image is so great that either dark tones or light tones (or both) lose detail when the image is rendered.


  Common examples of this situation at night include a bright moon above a relatively dark landscape and a star-filled sky over a foreground landscape that is relatively dark.


  Here, if you do a middle-of-the-road exposure, the bright areas will be overexposed, and the dark areas underexposed. No matter what you do, there’s no way the photo will come out rendering lights and darks as you might like—unless you extend the dynamic range.


  If you set your camera to shoot RAW format, which I always suggest for night photography, you can Multi-RAW process the file and then combine versions processed at different exposure values to extend the dynamic range. This means using software such as Adobe Camera RAW (ACR) and Photoshop to blend different versions of the same RAW file that have been processed with different exposure values.


  Another technique for extending dynamic range, shown here, is to start by shooting two or more images at different exposures. Take care to shoot the bracketed exposures at the same apertures by varying the shutter speeds. Otherwise the depth-offield may be different in the two versions, and you won’t be able to combine them seamlessly. In addition, you may have problems with this technique if the subject is moving, because it won’t be in the same place in the different frames.


  There are quite a few software programs you can use to combine the different exposure versions automatically, including Photomatix and Photoshop. But most of the time, I prefer to blend my images by hand because I know the effect I want to achieve better than any ole automated software program.


  This process is called Hand HDR. The example here shows you how to use Hand HDR in Photoshop to extend the dynamic range by blending two images—each shot at a different exposure and combined into one final photo. (See page 234 for resources related to Multi-RAW processing, HDR and Hand HDR processing.)
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  • Both: As I waited for the full moon to rise over the historic ghost town of Bodie, California, I realized I had a true exposure dilemma. I couldn’t expose an image to properly render both the bright moon and the comparatively dark town in the foreground. So I shot two versions: a darker version for the moon and a lighter version for the foreground. I made sure not to move my camera on the tripod between exposures, and I used the same aperture (f/5.6) for both shots. Light version (top): 34mm, 2 seconds at f/5.6 and ISO 100, tripod mounted Dark version (bottom): 34mm, 1/4 seconds at f/5.6 and ISO 100, tripod mounted


  Hand HDR in Photoshop


  With the light and dark versions opened in their own image windows in Photoshop, the idea is to combine the two images by positioning the light version on top of the dark version as a layer. Add a Hide All (black) layer mask to the top layer and partially reveal that layer using the Gradient Tool. Once you get the hang of it, this is a process that takes about thirty seconds from start to finish.
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  • Step 2: With the “Lighter” layer selected in the Layers palette, choose Layer • Layer Mask • Hide All to add a Layer Mask to that layer. The Hide All Layer Mask hides the layer it is associated with (in this case the “Lighter” layer) and appears as a black thumbnail in the Layers palette associated with the “Lighter” layer.


  [image: ]



  • Step 3: Make sure the layer mask on the “Lighter” layer is selected in the Layers palette. Choose the Gradient Tool from the Toolbox and drag a black-to-white gradient from the middle of the image window, starting roughly at the horizon line and extending down to the bottom of the image window. This will leave the sky dark and lighten the foreground in a natural way.
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  • The completed image, Moonrise over Bodie, looks appropriately exposed both in the foreground and the sky. 34mm, two composited captures, at 1/4 of a second and 2 seconds, both captures at f/5.6 and ISO 100, tripod mounted



  


  Night in Black and White


  Since the colors of the night were what first interested me in night photography, it took me awhile to become comfortable with black and white images of the night.


  The truth is that not all night subjects are suitable for black and white. If color is important to a composition then, obviously, it will not work as a monochrome image. Black and white requires high contrast and inherently strong compositions that do not rely on color.


  Once I realized this, I came to love black and white at night for the way it can represent the vast open spaces of the night and also for the way that the absence of color can visually imply color.


  Many digital cameras have a black and white capture mode, but it is not a good plan to use this mode except as a tool for aiding in pre-visualization. Speaking of pre-visualization, more and more DSLRs are starting to have Live View capabilities, which enable you to see the photo you are about to take in the LCD. If you have Live View, and it can be set to display in monochrome, you’ll find that this is an excellent pre-visualization tool to help determine if a photo will work in black and white.


  The best approach for creating high-quality black and white images in digital is to shoot in color as you normally would. Once you have the image in your digital darkroom, there are a number of techniques for converting it to black and white that don’t just drop the color information. The color information in the digital file is used to make a richer black and white image. You’ll find more information about this process in the resources listed on page 234.


  When you look at good black and white photos of the night, you should viscerally feel the color, the black-blueness of the night—even though there is no color in the image. This is the feeling to aim for when you make your own black and white photos of the night.
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  • I shot this image of the Golden Gate Bridge in color, pre-visualized it after processing as a color image. I found it an attractive night photo in color.
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  • But I realized that the composition didn’t depend upon the color in any way, so I converted the color version into a relatively rare category of image: a black and white night photo involving moving lights that were originally captured in color. 380mm, 10 seconds at f/11 and ISO 100, tripod mounted
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  • In black and white images that include the night sky, I look for high contrast between the light sources in the night sky and interesting compositional elements that do not depend upon colors in the foreground. 44mm, about 3 minutes at f/4.5 and ISO 100, tripod mounted
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  • From a parking lot, I looked at this row of trees through a dense fog. The trees were backlit with emphatic orange light from street lamps, but I pre-visualized the image ignoring the color, because I thought it was irrelevant to the composition. 56mm, 52 seconds at f/4.8 and ISO 100, tripod mounted
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    • Against the backdrop of pounding surf and a light mist on the ocean, I photographed star trails between Point Reyes Lighthouse. I think of this image as a portrait of “the edge of night.”


    The star trails are shorter and less curved than you might expect for an exposure of this duration because I was facing south (rather than north). You can see the separation in the star trails between the ten-minute exposure and the stacked composite (the longer segments of each star trail). This kind of “gap” in the path of the individual stars is not approved of by star trail “purists,” but I like the effect in this image.


    There’s an explanation of stacking, one of the techniques I used to make this image, starting on page 194. 10.5mm digital fisheye, composite of foreground (10 minutes at f/2.8 and ISO 100) and sky (13 stacked exposures, each exposure at 4 minutes, f/4, and ISO 100), tripod mounted, total exposure time 62 minutes

  


  Freedom of the Night


  Becoming comfortable with photographing the night has many advantages. When darkness is familiar, you can photograph at the “golden hour” and beyond in remote locations without worries about getting back safely. Most people never see the world of darkness, and this world is revealed to you as a night photographer. You get the chance to explore a world that appears dark but is actually full of color—in places that seem familiar and in more exotic locations.


  Night photography reduces exposure considerations to the basics. You’ll want full manual control, often using the Bulb setting (see pages 40–51). Once you get night exposures right, you are far less likely to have problems in any daytime situation—however extreme.


  All these benefits of night photography sum up to a creative form of “freedom of the night.” And with freedom comes responsibility.


  Responsibility in the context of night photography has two major implications. You need to take common sense precautions to stay safe (see page 22 for some suggestions). And to come back with compelling photos of the night landscape, you need to plan your shots.


  Planning a night photography shoot means pre-visualizing the image you want to achieve. Your plan should consider how you will arrive at the right location, at the right time. You should also plan to bring the right gear to take your photo, and to keep you safe and warm.


  Becoming comfortable in darkness and experiencing the freedom of the night is great. Add to this a bit of pre-visualization and planning, and you have the recipe to make great images of the empty spaces of the night.
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  • My idea with this photo was to present a different view of this iconic bridge along US 1 in Big Sur, California. I spent several days in the area, photographing mostly under heavy coastal cloud cover as I planned this shot. I established a base for night photography along the Big Sur coast, and then drove 25 miles in the gathering dusk toward the bridge, which I had previously scouted. I waited for more than an hour for the light to dim enough for a thirty-second exposure and for the right combination of cars to cross the bridge. 16mm, 30 seconds at f/7.1 and ISO 100, tripod mounted


  


  Nightscapes by Moonlight


  Once the sun goes down, the moon may take its place. Assuming that the moon is in the sky in one of its fuller phases, it is a surrogate for the sun. What I mean is that the moon is so much brighter than any other celestial object, and no night photo can be made without taking into account the moon’s position and comparative brightness. This is exactly like considering the sun when photographing during the day.


  If you are photographing during the day, you need to assess the direction, quality and intensity of the light. Is the light strong and direct, or is it filtered and diffused? Does the light look warm or cool?


  Nightscapes by moonlight present the same set of questions to the photographer. Where is the moon in relationship to the subject matter, and what is the direction of light cast by the moon? How strong is the moonlight? What is the impact on the subject in terms of the shadows it creates?


  A strong, overhead moon may not create much in the way of shadows, but it is also not great lighting for a landscape—unless your primary interest is the moon itself. (See pages 120–125 for more about photographing the moon.)


  Generally, if I am interested in creating a nightscape that’s lit by the moon, I prefer to use the moon as a source of backlighting. It’s also very effective to create compositions that combine bright, moonlit areas with relatively dark areas of the night landscape. I find that this kind of photo seems to come together when my tripod is positioned in a shadowed area.
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  • I took this photograph during the course of a night I spent on the top of Half Dome in Yosemite National Park, California, at about 11:20 pm. The view is facing nearly due east with the bright setting moon behind the camera. You can see the recognizable profile of Half Dome in the moon shadow in the foreground of the photo. 12mm, about 9 1/2 minutes at f/4 and ISO 100, tripod mounted
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  • This photo shows the road down from Tioga Pass in the Sierra Nevada Mountains of California. Closed much of the year because of snow, Tioga Pass is the highest auto road through these mountains. I photographed the road from the top of a vast gulch with my camera and tripod in deep shadow. The light of the full moon behind me illuminated the cliff side and clouds, and a single car light traversed the Tioga Pass road, bisecting the photo and creating an unusual night composition. 14mm, 2 minutes at f/5.6 and ISO 100


  


  Making Night Look Like Day


  You look at a photo of a landscape. At first glance, it seems normal enough. But there’s something about this landscape that is unusual and maybe not quite right. After a few moments you realize that the landscape photo was taken at night.


  Night landscapes that look almost like day can be excellent for creating an “Aha!” moment. Setting up the viewer with this kind of “double take” is a great way to get attention for your images. Of course, there must be more than this visual sense of dislocation to make a photo worthwhile—but it is a good starting place.


  I find that the day-for-night effect requires moonlight. Starlight just isn’t bright enough, and it has a different look and feel—perhaps because of the relative motion of the stars or the variable color temperature of starlight.


  The trick to making a moonlit landscape look like it might have been taken during daylight hours is to aim for a histogram smack dab in the middle of the exposure range. Or you might want to overexpose and see the histogram over to the right. (See pages 58–61 for an explanation of using exposure histograms.) This is the opposite of what I usually do at night. My typical night photos, when I want them to look like they were taken at night, feature a left-biased, underexposed histogram.


  Creating an exposure means matching the settings that control your camera’s reaction to incoming light with the amount of light in your subject. Obviously, there is less light by moonlight than by sun. But if you ratchet the exposure settings on your camera to reflect this fact, then it’s quite easy to create night landscape photos that appear to be taken during the day.


  It’s worth noting that the strength of illumination coming from the moon is extraordinarily variable. As with the sun, it depends on weather and atmospheric conditions as well as the moon phase, its distance from the earth and other astronomical variables. So be prepared for a wide range of exposure settings when creating night landscapes that use moonlight to partially create a daytime effect.
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  • At first glance, this photograph of the historic Standard Mill in the ghost town of Bodie, California, looks like a daytime shot. It’s only when you look closely and see the star trails in the sky that you realize it must have been taken at night.


  When I made this photo, I calculated that an exposure time of three or four minutes would adequately capture the buildings and foreground. I intentionally used a longer exposure to produce star trails with some noticeable heft to create the day-for-night effect. 26mm, about 6 minutes at f/8 and ISO 100, tripod mounted
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  • In this thirty-minute exposure, the climbing walls of El Capitan and Yosemite Valley are partially illuminated by moonlight. If you look closely, you can see the lights of climbers who are bivouacked for the night on the “big wall.”


  I used light painting (see pages 62–67) to lighten the tree in the foreground, so that the contrast between the dark tree and the moonlit scene wouldn’t be too great. 12mm, about 30 minutes at f/8 and ISO 100, tripod mounted
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  • Bright moonlight and a right-leaning exposure histogram make this beach scene seem almost like it could have been taken during the daytime … until you notice the stars. 18mm, 3 minutes at f/5.6 and ISO 400, tripod mounted
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  • The light of this powerful, full moon was so bright that the scenery seemed to be in daylight, even though my exposure was a relatively short 30 seconds. I composed this photo to line up a star directly through the hole in the rock wall. This would have been more difficult to achieve with a longer exposure, because the star would have moved relative to the cliff and would have appeared more like a line, or blur, than a point. 24mm, 30 seconds at f/3.8 and ISO 100, tripod mounted


  


  Understanding the Night Sky


  If you are photographing night in a city, the state of the heavens doesn’t matter much because ambient light tends to drown out whatever is in the sky. At most, astronomical objects provide an accent to this type of photo because they are not the central subject matter.


  However, once you take on the challenge of creating images that show landscapes in the context of the lonely spaces of the night, the more you know about astronomical matters, the better you’ll be able to plan your night shots. You’ll find some of the websites I use to get astronomical information listed in the Resources Section on page 234.


  No knowledge is wasted, and the more you know about the night skies, the better. But you don’t need to have a PhD in astronomy to take great photos that include the night sky. It’s fun to learn about stars and constellations; but there are only a few astronomical things you need to know about the night sky to take good night photos. This is true unless your interests run to astronomical photography that requires telescopes, which is a whole different world. In any case, the web is a terrific resource for finding what you need to know about the night sky. (See page 234 for some suggestions.)


  We know that the earth is spinning on its axis in space. But from the viewpoint of the night photographer with a tripod fixed on a spot on the earth, the earth’s rotation creates a visual effect that makes it seem as though the stars are moving across the sky over time—even though it is the earth that is, in fact, moving. Stars do also move own their own, but much more slowly.


  Astronomers know that the spinning earth creates the motion effect; as a night photographer I use the apparent motion of the stars to paint with light in the skies of my compositions.


  To plan and pre-visualize night photos, it helps to have the following information:


  • Sun: At what time does the sun set, and when does it rise? Where on the western horizon will the sun set? (This all varies based on the time of year.)


  • Moon: You’ll want to know the time of moonrise, moonset and the phase of the moon. Depending on your plans, the position of moonrise and moonset may be significant.


  • Polaris: In the northern hemisphere, it is important to be able to locate Polaris, also called the North Star. (See photo caption on page 156 for information on how to do so.) Knowing how to locate Polaris is vital for navigation for those who don’t have access to a GPS. It’s also useful for night photographers, because stars appear to curve around Polaris, which seems stationary in the night sky. All other things being equal, the closer to north your camera is pointing—meaning, the more Polaris is centered in your frame—the more curved the star trails in your photo will be in a timed exposure.


  • Astronomical Phenomenon: You’ll want to know about any pertinent astronomical event, such as meteor showers, planetary conjunctions, particularly bright planets or stars, and so on.


  • Milky Way: The Milky Way is the galaxy on which our solar system is located. As city dwellers, we don’t often get to see the Milky Way; but before the days of ambient light pollution, seeing the Milky Way at night was a common part of the human experience. Our solar system is out on one arm of the Milky Way; and when we look at the Milky Way in the night sky, it appears as a kind of dense, sometimes sideways, gateway. It can be an extraordinarily interesting element in compositions that include the night sky.


  • Weather: Don’t underestimate the importance of basic weather. Clouds and fog can be great for some kinds of night landscapes. Other night shots call for an open sky with stars. Knowing what to expect will help you better plan your photographic journey under the night skies.
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  • In this photo, the “cup and handle” of the Big Dipper can be seen clearly. The constellation is upside down on the top right of the photo. If you can see the stars in the northern sky, it is usually pretty easy to find the seven stars that form the cup and handle pattern of the Big Dipper in the northern sky in the early parts of the night.


  To find Polaris, the North Star, you start by locating the Big Dipper. With the Big Dipper in your sites, draw a mental line through the two bright stars on the “outside” of the cup (shown in this photo on the left side of the Big Dipper). Continue drawing this mental line straight until it hits another, moderately bright star. This distance to this other star, Polaris, is about five times the distance between the two stars on the handle, and Polaris is by no means the brightest star in the sky.


  If you draw another mental line from where you are standing to Polaris, this second line is pointing north.


  This old fishing trawler in Inverness, California, is lined up facing north in a number of my photos. (For other examples, see pages 192 and 223.) 12mm, 3 minutes at f/5.6 and ISO 100, tripod mounted
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  • When I framed this photo, my idea was to illustrate the concept that the earth is just one component in a system that includes stars and space. So part of the appeal of this night photo of the coastline of Big Sur, California, is that the Milky Way is an important part of the composition. 12mm, about 8 minutes at f/4 and ISO 200, tripod mounted


  


  The Night Landscape


  What is the night landscape? The answer is that it is anywhere and everywhere during the night. However, as I already noted, it can be difficult to see the night in the presence of artificial lights. And it’s often a challenge to truly get away from the lights and light pollution that are a side effect of our civilization.


  “Night” itself is not a constant state. Rather, night is a process. As the earth spins on its axis, late afternoon changes into evening as the sun sets. Evening fades to true night, which is darkest before dawn—proving that some clichés are accurate.


  How long night last depends on time of year and location. The state of weather has a huge impact on the quality of atmosphere and light at night, too. And if the moon is up, its light tends to monopolize the illumination of the scenery. Night landscape by moonlight has a unique look and feel (see page 146).


  There are many variables that go into the perception of the night landscape. It’s your job as a photographer to observe these variables carefully and use them in your photos.


  Consider two progressions:


  • Darkness of the country to the core of the city


  • Evening just after sunset to the deep night


  Think about what it’s like to start out in the wilderness at night. Perhaps you’ve been hiking and emerge at the trailhead after dark. There are no lights around; and absent the moon, you’ll be amazed by what you can see by starlight. (Your camera, of course, can “see” even more than you can.)


  As you speed along the highway toward your home in the city, you pass isolated farmsteads and houses. Light from these structures, and from passing cars, contrasts with the darkness of the landscape. Maybe being within the circle of light while all outside is black gives you a sense of comfort, but you still have a sense of being within the night landscape.


  This is lost as you reach the suburbs. Ambient light pollution keeps the night at bay, and it seems like a wall of light in the city meets a wall of blackness in the night—even though as photographers of the night, we recognize the fact that night isn’t truly black.


  The second progression is from dusk to night and back again.


  As you plan shoots of the night landscape, try to position the photos you’d like to make in context of these progressions. Photographs showing car lights, highways and bridges can be redolent of lonely spaces and nostalgia, but they are likely better made during early night or just before dawn, when the contrast between these lights and the night landscape isn’t too great. The subject matter of these photos is not the night sky.


  On the other hand, if you photograph the night landscape in locations where there isn’t much trace of humanity, deeper night often works better. With these photos, try to compose your image to balance the celestial and earthly content, and to convey the feeling that the earth is a rotating ball connected to movement in the sky.
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  • On a remote overpass in a dense fog as evening turned to night, I intentionally underexposed to exaggerate the bleakness of the surroundings and to make the tree seem alone in contrast to the car lights passing by on the highway. 65mm, 6 seconds at f/16 and ISO 100, tripod mounted
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  • Until full night was upon me, this shot of the iconic Bixby Bridge along the Big Sur coast didn’t work because the contrast between the car lights and surroundings wasn’t intense enough. As true night came on, I was able to maximize the contrast of the car lights with the background landscape while keeping the surf visible, for an unusual view of an often-photographed subject. 12mm, 30 seconds at f/5 and ISO 100, tripod mounted
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  • Wet fog enveloped most of Yosemite Valley as I wandered with my camera through the winter night. From time to time, I observed odd pockets of open sky.


  I took advantage of one of these breaks in the clouds to take this twelve-minute shot from Swinging Bridge on the Merced River.


  From this bridge, I had a pretty straight shot at the stars over Yosemite Falls. From my vantage point, the falls aligned fairly closely with Polaris.


  The falls themselves were partially hidden by the darkness and fog, but the entire cliff face was illuminated by the light pollution from Yosemite Lodge. So in this case, light pollution has a positive effect on the photo, and the reflection of Yosemite Falls in the river would probably not be recognizable without this intense ambient light source. 10.5mm digital fisheye, about 12 minutes at f/4.5 and ISO 200
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  • Photographing in the middle of the night in Zion Canyon, Utah, I was midway between the canyon floor and the high towers of Angel’s Landing. I knew it was dark, but I had no real idea how dark. So I ran a test exposure at ISO 2000, three minutes and f/4. This seemed okay when I checked the exposure histogram, so I burnt my battery to the ground with this 30-minute exposure at ISO 200. (Incamera noise reduction was turned on, which added to the processing time.)


  A single car moved along the road at the bottom of the canyon, creating a surprising amount of light. You can tell how dark this night landscape was by noting the impact of a single set of car headlights. 12mm, about 30 minutes at f/4 and ISO 200, tripod mounted


  Flowers of the Night


  Landscapes are not the only subject matter that comes alive in the spaces of the night. It turns out that flowers emit light waves at night that are beyond our ability to see.


  It’s fairly well-known that digital sensors are more sensitive to infrared (IR) light waves than either fi lm or the human eye. In fact, this is so much the case that digital cameras are equipped with a filter that screens out IR from the sensor. You can capture IR photographs either by removing this factory-supplied CCD filter or by adding your own filter to the camera.


  Less appreciated is that digital sensors can also pick up more ultraviolet (UV) light waves than fi lm or the human eye. As with IR, this effect can be amplified using filters; but long exposures at night will pick up UV that you can’t see even without special equipment.


  Of course, since you can’t see UV waves, you don’t really know what you are going to get until you try. Light waves emitted by flowers vary tremendously, and they seem to depend upon their propagation strategies, atmospheric conditions and other variables.


  The most important thing to a flower is to attract propagators, mostly bees and other insects. The markings on flowers are not cosmetic eye candy intended to make flowers pretty to us humans. These markings are intended to attract insect propagators and, in some cases, to help guide the flight paths of these insects. This is the point of the markings on an Iris, for example, which looks much like a landing strip close up.


  So if a flower emits light waves beyond the spectrum that we can see, the point is to help insect propagators find the sexual organs of the flower. I haven’t found any way to recognize this phenomenon or to know whether these light waves will be picked up by a given digital sensor. You just have to experiment. The problem is compounded by the technical challenges facing macro photography at night.


  While UV emissions can appear as very vibrant colors in digital captures, they are fainter than the light waves emitted from more common sources, such as sunlight. If you try to light a flower yourself or to capture one lit by a distant street lamp, you are unlikely to capture these emanations.


  Because of the magnification involved, any movement of a subject in macro photography is exaggerated. Also, the closer you get to a subject, the less depth-of-field you have. This means you need to stop the camera lens down to a small aperture. The combination of factors leads to a situation in which any movement, however slight, on the part of the flower, will spoil the sharpness of your photo. Night photography of flowers should probably not even be attempted if there is the slightest bit of wind.


  Another problem is the critical focus that’s required of macro work. This is hard to achieve at night, but it can be accomplished by using a flashlight or headlamp to light the flower while you focus.
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  • Hiking on the Chimney Rock Trail in Point Reyes National Seashore after dark, I came across this Indian Paintbrush.


  It was a bright night, with a low but intense coastal fog and almost no wind. This flower was sitting by the edge of a headland cliff. Even in the dark, I could see that the reds and greens of the flower glowed with an incredible intensity. They almost seemed to smolder, or vibrate, but the blue tendrils in the photo were not visible to me.


  I used a headlamp to focus precisely on the flower, and I stopped the lens down to a small aperture (f/32) for depth of field, as I would have done during the day. I was lucky that unusually still wind conditions prevailed during my long (eight minute) exposure. 105mm macro, 36mm extension tube, about 8 minutes at f/32 and ISO 200, tripod mounted
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    • Pages 170–171: This photo shows the planet Venus setting into the Pacific Ocean in the dark watches of the night. 135mm, 8 minutes at f/16 and ISO 100, tripod mounted

  


  Long Exposures in the Night


  Whenever I give a night photography workshop, participants ask how I determine exposure settings when it is truly dark. It’s a good question.


  You’ll find information about exposure settings at night on pages 40–61. It’s important to remember that when you’re working in the middle of the night, you need to think about exposure settings a bit differently. For one thing, the idea of setting up before darkness and gradually adjusting your exposures just doesn’t get you to midnight or 2 am in any feasible way.


  The photos in this book, and the related exposure data that I’ve provided with each one, should provide a starting place for deep-night exposures.


  Observation is probably the most important part of deciding on exposure settings. At night, this takes a bit more work than during the day because you have to let your eyes gradually adjust to the low light levels. Once your vision has adapted, consider the light sources. Are you exposing just by starlight? Or is moonlight acting as a “fi ll” light to brighten some areas of your composition?


  Given that stars themselves can be properly exposed between three minutes at f/5.6 and ISO 100 (the darker end of an acceptable exposure range) and four minutes at f/4 and ISO 200 (the lighter end of the range), you can use starlight as the basis for finding a long nighttime exposure. Obviously, your exposure will depend upon the lightness or darkness of the elements in your composition other than stars. If you want to render a dark forest lit only by starlight as anything other than a black mass, you’ll need a much longer exposure time than if you are choosing settings for starlight.


  Since movement of the stars (and moon) is crucial to many nighttime compositions, it often makes sense to start with the shutter speed you want. You can then calculate aperture and ISO roughly based on the known settings for starlight. Note that if the moon is in an exposure calculated this way, it will appear as blown-out highlights. (See pages 120–125 for more about photographing the moon.) When I’m contemplating a really long night exposure, I know that I’m likely to only get (at most) a couple of shots per night.


  So I like to run a high ISO test in advance to make sure I am getting the exposure right.


  The first step in this process is to set the camera at a fairly “short” (for deep night) shutter speed—somewhere between thirty seconds and three minutes. Next, try a range of high ISO settings, perhaps between ISO 500 and 2000. Determine which ISO is right. Be sure to use the exposure histogram as well as the view in the LCD; although the LCD can be particularly deceptive at night.


  For example, the image shown to the right was shot as a test at thirty seconds and f/4. I then tried various ISO values and decided that ISO 640 was about right.


  This was the data point that I needed for my longer exposures. I wanted to shoot the longer versions at ninety minutes to maximize the motion of stars and moon, and I needed to use an ISO setting of 100 to minimize noise. The missing variable was aperture (f-stop).


  To go from thirty seconds to roughly ninety minutes meant I would let in 180 times as much light (without other adjustments). To go down in sensitivity from ISO 640 to ISO 100 meant reducing the amount of light by 6.4. (Okay, call it 6 to make calculations in the dark easier!) Divide 180 by 6 and you can see that the aperture I selected should let in roughly 1/30 of the light as f/4.


  The aperture in a lens is approximately circular, and the designation of aperture openings (f-stops) is on a logarithmic scale. Starting with f/4, each of these apertures lets in roughly half the light of the preceding aperture:


  f/4, f/5.6, f/8, f/11, f/16, f/22


  This means that:


  1/2 * 1/2 * 1/2 * 1/2 * 1/2 = 1/32


  This is why I chose f/22 for my exposure (at roughly 5393 seconds and ISO 100).


  Since I thought the test exposure was a little too bright (the reflection of the moonlight below shows some highlight blowout), I cut the exposure by a little more (by dividing by 6 rather than 6.4 and by cutting the aperture by 1/32 rather than my estimated 1/30). I threw in an extra ten minutes exposure time on pure instinct—after all, what’s the difference between one hour and thirty minutes and one hour and forty minutes in the dark watches of the night?


  The photo created on the basis of this test and calculation can be seen on pages 190–191; an even longer version I made the next night is shown on the title page (pages 2–3).
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  • During this roughly twenty-minute exposure, Half Dome was lit by the moon. I reduced the aperture to f/8 to compensate for more brightness than would normally be found in a deep night landscape. 17mm, about 20 minutes at f/8 and ISO 100, tripod mounted
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  • This photo was a high-ISO test capture for the image shown on pages 188–189 (see accompanying text). By confirming with this photo that I had the exposure roughly right at ISO 640, I could calculate back for my subsequent, much longer exposure. 18mm, 30 seconds at f/4 and ISO 640, tripod mounted


  


  Minimizing Noise


  Noise is a kind of static in a digital image. All digital signals, including digital photographs, create some noise—a side effect that is often (but not always) undesirable when too pronounced. Noise is the closest thing in the digital era to grain in a fi lm photograph.


  There are many causes of noise, and some noise is theoretically inevitable. But noise is a particular problem with night photography. Using a high ISO, underexposure and a long exposure time all increase noise levels, and all three commonly occur in night photography.


  Depending upon your equipment and the situation, when you use an ISO above 500 or 600 to take relatively short exposures at night, you should expect to see an increased level of noise. Make sure that high-ISO noise reduction is turned on in your camera, if this option is available. The good news is that digital cameras are getting much, much better at high-ISO processing. It’s likely that by the time you read this, the threshold ISO that you can use without having to worry about unacceptable noise levels will be higher.


  Underexposed areas in a photo—or a photo that is underexposed overall, as shown by a left-biased histogram—will have more noise than a “properly” exposed photo. (See pages 58–61 for more about using exposure histograms.) I find some underexposure inevitable in many of my night images—both because I prefer the color saturation of underexposed captures and because it is so darn dark.


  There’s not much you can do about noise from underexposure at the time of exposure except be aware that it is an issue. (You can plan to underexpose if you think your image might benefit from increased noise.) Consider post-processing this kind of noise in the digital darkroom, as I explain starting on page 178.


  Noise caused by long exposure times is the true bugaboo of night photography. Some of the noise that is added during long exposures occurs because the camera sensor gets hot. You can combat this issue by keeping your camera as cool as possible during long exposures. For example, I’ve found it practical on occasion to cool my camera with snow packed in a plastic bag while the camera chugs away.


  Many DSLRs have an in-camera long exposure noise-reduction option available. Unless you are shooting for a stacked composite (see pages 194–223), this option should be turned on.


  In-camera long exposure noise reduction works by shooting a second exposure following the long exposure. The second, a so-called “ dark frame,” is shot with the shutter closed. The dark frame is then subtracted in-camera from the original exposure, which reduces much of the noise through a noise-cancellation process.


  A downside to in-camera long exposure noise reduction using dark-frame subtraction is that your camera will be “locked out” and unavailable for the length of the second exposure—no small matter when you are dealing with hourlong exposures and considering that the length of the dark-frame exposure itself may add to sensor noise (not to mention battery drain).


  An advanced option for resolving this problem is to turn long exposure noise reduction off and to shoot your own dark frame with your lens cap on, either before or after a sequence of exposures. You can then combine your dark frame in the digital darkroom with your actual captures. In Photoshop, place the the dark frame as a layer above the image and select the Difference blending mode at about 20% Opacity to blend the dark frame pixels with the image pixels.
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  • In near total darkness, I stood up to my knees in the mud of the salt water flats across from San Quentin State Prison. Also known as the “Big House,” this prison is the state of California’s only death row for male inmates and is the largest death row in the United States. I wanted to make this photo as ominous and creepy as possible, so I intentionally underexposed to increase the noise in the dark, cloudy areas. 200mm, 3 seconds at f/5.6 and ISO 100, tripod mounted


  


  Post- Processing Noise


  Let’s face it: A long exposure taken at night will have some noise. That’s the bad news. The good news is that you can reduce noise by post-processing in the digital darkroom.


  Before I start showing you how to reduce noise in post-processing, you should understand that reducing noise inherently also reduces sharpness in an image. You can’t have it both ways. Part of what makes an image appear sharp is the noise in the image. So successful post-processing for noise involves a balancing act.


  The trick is to selectively noise reduce areas that are particular visual problems, without reducing the sharpness of an entire image by using overall noise reduction. Taking this concept one step further, you can reduce noise selectively at different intensities, so that really heavy duty noise suppression is only applied to a few spots.


  In order to selectively process an image, I use duplicate layers and layer masks in Photoshop.


  There are some choices to make about what noise reduction tool to use within Photoshop. In addition to Photoshop’s own noise reduction filter, there are third-party noise reduction plug-ins available from PictureCode, Nik Software and others. My mild preference, because I think it does the job best, is the Noise Ninja plug-in from Picture Code (which is what I’ll show you here). You can download a trial version at www.picturecode.com/download.htm.


  But it doesn’t matter so much what tool you use. The important thing is that you process selectively, rather than the whole image at a single setting.
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  • Step 2: Choose Layer • Duplicate Layer to duplicate the “Background” layer. Name the new layer “Noise Reduction Standard.” There are now two layers: “Background” and “Noise Reduction Standard” in the Layers palette.
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  • Step 3: Choose Filter - Noise Ninja to open Noise Ninja.
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  • Step 5: Click OK to apply the noise reduction to the “Noise Reduction Standard” layer. The Noise Ninja window closes. In Photoshop, take a look at the results to see where the noise processing looks good and where it does not.


  [image: ]



  • Step 6: With the “Noise Reduction Standard” layer selected in the Layers palette, choose Layer • Layer Mask • Hide All to add a layer mask to that layer. The Hide All layer mask hides the layer it is associated with (in this case the “Noise Reduction Standard” layer). It appears as a black thumbnail in the Layers palette associated with the “Noise Reduction Standard” layer.
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  • Step 7: Follow Step 2 on page 179 to duplicate the “Background” layer again. Name this layer “Noise Reduction Heavy” and move it to the top of the layer stack in the Layers palette.
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  • Step 8: Make sure the “Noise Reduction Heavy” layer is selected in the Layers palette. Choose Filter - Noise Ninja to open Noise Ninja again. Click the Filter tab. To perform heavier noise processing, set Strength to 20, Smoothness to 20, Contrast to 3 and check Course noise. Click OK to apply the noise reduction and close the Noise Ninja window.
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  • Step 9: With the “Noise Reduction Heavy” layer selected in the Layers palette, choose Layer - Layer Mask - Hide All to add a layer mask to the layer (as you did in Step 6).
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  • This nighttime view of the Pacific coast shows the movement of the clouds in front of the stars and the distant ambient light of San Francisco. Even after noise post-processing, you can still see plenty of noise in the photo, but the overall effect is quite pleasing. 12mm, 5 minutes at f/4 and ISO 100, tripod mounted


  


  Capturing Star Trails


  In certain circles, so to speak, capturing star trails that are as long and curved as possible has become a trophy element of night photography. It’s therefore worth considering the elements that create longer and more curvilinear star trails.


  To capture star trails and render them as long and curved as possible, use these techniques:


  • Camera Direction: Point your lens as close as possible to due north. (See pages 156–159 for information about locating north at night without a compass or GPS.)


  • Angle of View: The wider the angle of your lens, the more curved the star trails will be. To get really curved star trails, use as wide an angle lens as you have—a digital fisheye is great!


  • Total Exposure Time: From our perspective on the earth, the stars appear to be in motion, so it stands to reason that the longer your total exposure time, the longer your star trails will be. Keep in mind that for really long total exposures, a stacked composite (explained starting on page 194) may work better than a single exposure—that is, in terms of producing a final image with acceptable levels of noise.


  Using any one of these techniques will increase the length of the star trails … as they are rendered, their curvature, or both. Using all three techniques will help you create a photo with the maximum star trail curvature and length.


  Keep in mind that a photo of star trails by itself is likely to be a bit boring. You need to create compositions that have interest in the foreground as well as the sky.


  An implication of including the earth as well as the sky in photos is that your foreground will be in silhouette, or you’ll probably have to composite images for appropriate exposure control. The foreground is likely to be much darker than the sky, and the only way to handle this (if you don’t want your foreground to go very dark) is to shoot it separately with the plan of combining it and the sky. (See pages 220–223 for more information about this technique.)


  Bigger, well longer, is not always better in my opinion. Long star trails are great! But it’s also nice to capture star trails when they have a modest and poetic quality about them, and when there are only one or two in the sky.
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  • Hiking down in the dark from Angels Landing in Zion National Park, I paused after the set of switchbacks known as Willy’s Wiggles.


  In a narrow chasm between towering cliffs, in profound darkness, I pointed my camera due north to maximize the curvature and length of the star trails that I could capture in this twenty-minute exposure. 12mm, about 20 minutes at f/4 and ISO 200, tripod mounted
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  • To me, this photo depicts that time when evening turns to night—when stars wake up. My idea was to create a star trail image with minimalist qualities. 22mm, 5 minutes at f/16 and ISO 100, tripod mounted


  To maximize trails made by the stars, I used an extreme wideangle lens (my digital fisheye) pointed due north. To capture star trails of substantial length, I needed a long total exposure time, so I planned to combine exposures for a total time of 46 minutes. This was a long enough to wait to make me appreciate my warm clothing on the narrow ledge above the waves. 10.5mm digital fisheye, composite of foreground (6 minutes at f/4) and sky (ten captures each at 4 minutes and f/5.6), all captures at ISO 100, tripod mounted
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  • The combination of a relatively short exposure time, a high ISO, and extensive noise post-processing creates a dreamy view of Half Dome by starlight. The red “accent” line is an airplane light. 12mm, 150 seconds at f/4 and ISO 640, tripod mounted
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  • On a narrow platform high above the rock-bound Marin Headland coast in California, I steadied my tripod. The climb to get to this location, and the platform itself, were not for the faint of heart, particularly at night. There was a straight drop down to the pounding surf hundreds of feet below.



  


  Night Music


  This is a 5,393-second exposure, or about an hour and forty minutes, that started at about 12:30 am and ended a bit after 2:00 am. The bright, comet-like light is the setting moon going down into the ocean while stars wheel around above. You can see lens artifacts in the image; they were caused by the comparative brightness of the setting moon during this long-time exposure.


  When I post-processed this image, I intentionally left noise in the sky. It seems to me a better effect than making the star trails appear too smooth.


  I derived the exposure settings for this photo (and the one shown on pages 2–3, which has an even longer exposure) from a high-ISO test shot, shown with an explanation of the process on page 175.


  With both exposures, I tried to time the delay before the exposure started—and the length of the exposure itself—so that the process of the moon setting into the Pacific Ocean would be captured along with the music of the stars.


  The long exposure time would not have been possible on a single battery. The photographs shown on this page and on pages 2–3 were made using a direct AC power connection with an adapter and a long extension cord.


  Lest you think that all night photography is about macho photographers suffering in foul weather, I’d like to point out that these images were taken at the Sea Ranch community in northern California. While the programmable timer took care of my exposures, I lounged in the hot tub that was directly behind the camera.
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  • 18mm, 5,393 seconds (about 1 hour 40 minutes) at f/22 and ISO 100, tripod mounted
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    • The wreck of the Point Reyes, a fishing trawler, lies beached outside the town of Inverness, California, and is a favorite subject of mine.


    To start, with the camera pointing north, I lined up the boat in front of the North Star. I used a digital fisheye lens to maximize the celestial rotation of the star trails. I tested the light with a one-minute exposure at ISO 800 at f/3.5. Then I made an eight-minute ISO 100 exposure (with in-camera long exposure noise reduction enabled) for the foreground.


    Next, I turned off noise reduction and programmed my interval timer for twenty exposures, each capture at four minutes, ISO 100, and f/5.6.


    When I looked at the photos I’d captured on my computer monitor, I saw that an airplane had made it into one of them. I decided to keep this visual anomaly in the final image; it appears as the straight line in the sky behind the ship. 10.5mm digital fisheye, composite of foreground (8 minutes at f/3.5 and ISO 100) and sky (stacked composite of twenty exposures, each capture 4 minutes at f/5.6 and ISO 100), tripod mounted, total exposure time 88 minutes

  


  


  Understanding Stacking


  Stacking was developed as a technique to use in digital astrophotography—photography through a powerful telescope—to reduce noise. The technique works just as well for terrestrial night photography that includes the earth as well as the sky.


  By segmenting a single very long exposure into many shorter exposures and then recombining the shorter exposures in post-processing, most of the noise in each individual image gets canceled out. While this technique is conceptually simple, it takes planning and practice to execute successfully. And it requires work at the shooting stage as well as when postprocessing the image stack.


  Once you know the routines, the work that I refer to is not actually your work! An old advertisement suggested, “Let your fingers do the walking” to look up businesses in the Yellow Page phone directories. Similarly, I like to let my programmable interval timer do the heavy lifting when it comes to creating stacks.


  A programmable interval timer takes care of making the multiple segment exposures; your job is waiting, being patient and enjoying the night sky. You’ll find information on interval timers and how to program them starting on page 226. It is, practically speaking, impossible to create a set of images that can be stacked without a programmable interval timer, because you just can’t time things accurately enough over a long period manually.


  Stacking works best when the background is dark, which is just fine for the night sky. You can often get acceptable results when the sky isn’t completely dark, but the contrast between the star trails and the sky won’t be as great.


  It’s important to turn off in-camera long exposure noise reduction when you are shooting a stack. For one thing, the inherent noise-cancelation feature of stacking means that you don’t need in-camera noise reduction as much as you would on a single long exposure. More importantly, the time the camera takes to generate the black frame for in-camera noise reduction would produce huge gaps in the star trails of your stack.


  To make up for the lack of in-camera long exposure noise reduction—you can’t use incamera noise reduction when stacking—an option is to shoot your own dark frame with the lens cap on before or after you shoot your stack. Combining this dark frame with the stacked composite (as explained on pages 176–177) may reduce the noise in the image. However, it’s possible that your stack will already be noiseless enough and the dark frame subtraction won’t make much visible difference.


  Each of the segment exposures destined for a stack should be exposed for starlight. As I noted on pages 174–175, this implies an exposure within the range of three minutes at f/5.6 and ISO 100 and four minutes at f/4 and ISO 200—or the equivalent exposure value. For example, exposure settings of eight minutes at f/5.6 and ISO 200 would also work for starlight, although I prefer to keep segments that are destined for a stack to three or four minutes in length.


  Long star trails require time. Noise cancelation requires multiple exposures. These two facts imply that for most stacked star trail images, you should plan many exposures, especially since some exposures may need to be discarded. For example, if an airplane wanders into the sky in your photo, and you don’t want to show the lights from the plane, you’ll have to throw away the exposure that shows them. If a car headlight or your flashlight fl ares into an exposure, you also may need to discard the image from the stack.


  Usually, a minimum of eight captures is a good idea. Theoretically, there’s no limit to the number of captures you make. You are only constrained by the duration of night, your patience, the life of your battery, and whether you have the computing power for processing all your images in the digital darkroom. As a practical matter, I find that I rarely go beyond twenty different captures, if each one is in the three to four minute range.


  As I’ve mentioned, photos that show the night sky without foreground interest rarely work. And exposing for starlight creates problems with the foreground: the foreground is usually way too dark to show details. There are a number of approaches for dealing with this exposure problem.


  • Use the foreground from the lightest version on the stack, perhaps lightened further in the digital darkroom.


  • Shoot a special exposure for the foreground, allowing more light into the camera. Composite it with the stack in the digital darkroom.


  • Create a composition with bright elements in the foreground, either naturally or via light painting, as explained on pages 62–67.


  • Choose a composition where the foreground elements work well in dark silhouette.


  Obviously, you should be sure that your tripod and camera do not move while exposing a stack. If you do move the camera during your exposures, you can try the auto-alignment features available in some stacking software, although it is better not to move the camera in the first place. In addition, be sure your camera is in an absolutely unchanged position if you shoot a special exposure for the foreground.
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  • On a relatively balmy November evening shortly after sunset, I drove out to the end of the North Fork of the Point Reyes, California, peninsula.


  I pointed my camera due north for maximum star circles and lined up the historic Pierce Farm with Polaris. My plan was to stack at least twelve exposures as a composite and to use the lightest version for the foreground. My first exposure was, in fact, the lightest version, since a bit of light from the sunset lingered. So once I had created my stack, I separately composited the foreground from this version onto my stack.


  As the camera did all the work, it was pleasant lying back on the grass, talking stars and philosophy with my oldest son, who had come along. 10.5mm digital fisheye, stacked composite of fifteen exposures, each capture 4 minutes at f/4 and ISO 200, tripod mounted, total exposure time 1 hour
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  • It’s unusual to create a viable image of star trails above a city, because the bright city lights tend to overpower the stars. This stacked composite works because of the relative isolation of the setting—a deserted beach along the Golden Gate strait, west of the Golden Gate Bridge—although you can see that the star trails are less bright than in a typical star trail image.


  Since I wanted the bridge and its reflections in the composition, I couldn’t point the camera north (the camera is pointing roughly southeast). You can see that the star trails show less rotation than they would have if the camera had faced north.


  Originally, I planned more than twelve exposures for the image stack, but I had to discard some of the captures because they included distracting horizontal airplane trails. 10.5mm digital fisheye, stacked composite of twelve exposures, each capture 4 minutes at f/5.6 and ISO 100, tripod mounted, total exposure time 48 minutes


  [image: ]



  • In this stacked composite taken from Glacier Point in Yosemite National Park, a bright moon lit the mid-ground and the sky. To get a bit of detail in the foreground, I composited in a separate exposure that was intended to pick up detail in the shadow areas. 10.5mm digital fisheye, composite of foreground (8 minutes at f/2.8 and ISO 100) and sky (stacked composite of fifteen exposures, each capture 4 minutes at f/4 and ISO 100), tripod mounted, total exposure time 68 minutes
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  • This stacked composite image is one of a series of stacked composites I made from Glacier Point without the benefit of moonlight. With this one, I experimented with adding a high-ISO version as one of the elements of the stack. I intentionally left the foreground dark (the way it looks in the individual exposures) rather than trying to blend in a brighter foreground, as I did in some of the other versions.


  If you are wondering, the bright purple that can be seen in the star circles comes from sensor flaring due to overheating. I tend to believe that this dramatic color addition helps my composition rather than diminishing it. 10.5mm digital fisheye, stacked composite of thirteen exposures (twelve captures at 4 minutes, f/3.2, and ISO 100; one capture at 4 minutes, f/4 and ISO 800), tripod mounted, total exposure time 56 minutes
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  • This roughly twenty-minute exposure of the Inverness fishing trawler approaches the limits of possible exposure time without excessive noise in a single shot. (Compare a stacked version of this boat, shown on pages 192–193.) The lone, long star trail is quite nice, but the effect is not nearly as spectacular as you can get with stacking. 13mm, about 20 minutes at f/22 and ISO 100, tripod mounted
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  • Most of the time, I stack many images together. With this image, I decided to experiment with a stack of two images to capture stars by themselves. I allowed a substantial interval between the two exposures, and I’m pleased with the result: the star pattern resembles the short-long letter A in Morse code. 18mm, two stacked captures, one exposed at 5 minutes and one at 8 minutes, approximately 6 minutes between the two exposures, both exposures at f/5.6 and ISO 100, tripod mounted
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  • Photography for a stack takes such a long time that sometimes I try to do two images at once, using two camera bodies and two programmable interval timers. With one camera in one direction, I photographed the images that I later combined into a stack shown in its finished version on pages 142–143. With my other camera, I photographed this stack, pointing straight north up Bodega Bay on the coast of California.


  In this image, stacking created an interesting effect in the fog on the water as well as in the circular star trails. 12mm, stacked composite of twelve exposures, each capture 4 minutes at f/4 and ISO 100, total exposure time about 48 minutes


  


  Stacking Software


  I use the Statistics Script that ships with the Adobe Photoshop Extended (first introduced in the extended version of CS3) to create my star trail stacks. I’ll show a detailed example of how I use Statistics to create my stacks starting on page 210. I believe that this is the most powerful tool available for creating stacks, and it yields the best high-resolution results. Since I’m already working in Photoshop, I can do all my post-processing work in one swoop.


  But you don’t need expensive software to create star stacks. There are quite a few options available at little or no cost, shown in the table below.
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  • In this stacked image of San Francisco Bay, the star trails don’t appear as bright compared to the sky because of all the ambient light from nearby cities. Moving boats were captured in several of the images in the stack, and I decided to leave them in the final composite. (The light trail along the water is a ferry.)


  For me, this image illustrates the activity that goes on above and around us that we are not aware of, even in big cities. In today’s world, we are almost never alone. 10.5mm digital fisheye, stacked composite of fifteen exposures, each capture 4 minutes at f/5.6 and ISO 100, tripod mounted, total exposure time 1 hour


  


  Combining a Stack in Photoshop


  As I’ve noted (see pages 208–209), I use the Statistics Script, available in the Extended Edition of Photoshop, to process my interval-timed shots into a stacked composite. My choice to use Photoshop (compared to the other star stacking software that I’ve listed) is based on the ability to produce a high resolution stack. Photoshop also includes the functionality to handle all my digital darkroom needs.


  When stacking, the first thing I do is inspect the images that I shot for the stack using Adobe Bridge. A few may be need to be eliminated from the stack, usually due to unwanted lighting effects or airplane motion in the sky; it is likely, however, that this will leave a gap in the star trails.


  I open the acceptable images in Adobe Camera RAW (ACR), select all the images, and process them into PSD files using a single ACR setting.


  As an example, I’ll use a stack I shot at the historic Pigeon Point Lighthouse on the San Mateo coast of California. The giant light on this historic structure is lit once a year, and it always gathers crowds. I didn’t want to be penned in by other photographers, so I found an isolated position across an inlet of water to photograph this event.


  [image: ]



  • This is the Adobe Camera RAW (ACR) window showing all 13 photos that will go into the stack, being processed at the same time. After converting the RAW images in ACR, they will be opened in Photoshop. Next, I’ll save the images in Photoshop’s native PSD format. After that, I’ll use the Photoshop Statistics script to stack the images.
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  Using the Statistics Script Once all thirteen images were processed in Adobe Camera RAW, I saved them in Photoshop in the PSD file format. My next step was to open these processed images in the Photoshop Statistics Script window.


  Note that I could have “saved” a step in this process by loading my RAW files directly into the Statistics Script without first converting them. I choose not to do this, and I make the extra step, because I want my interpretation of the data in the RAW file to be in place before the images are stacked together. I find that Photoshop’s default rendering of RAW files taken at night can be way, way off.


  Here’s how to use the Statistics Script in Photoshop to stack a set of images.


  Note: Setting the Stack Mode to Maximum in Step 2 gives you the brightest star trails. This setting is what I usually use. However, it is worth taking the time to play with some of the other stacking modes.
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  • Step 1: Chose File - Scripts - Statistics to launch the Statistics script.
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  • Step 2: In the Statistics window, select Maximum from the Choose Stack Mode drop-down list. Next, click Browse to select the folder in which the image set is saved. Click OK to run the Statistics script. Depending upon the number of images being stacked and the processing power of your computer, this could take awhile. (Some image sets that I’ve stacked have taken 45 minutes to process!)
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  Finding the foreground and saving the image


  I had invested many hours into shooting this stacked image of Pigeon Point Lighthouse, but it wasn’t coming out as I had pre-visualized it. The foreground was too dark.


  I thought back to the afternoon and evening I had spent shooting this one scene. I literally had not moved from that spot for hours. In fact, I hadn’t even moved my tripod or shifted the camera.


  Inspiration struck: What if I use layers in Photoshop to combine an image that I took earlier in the afternoon showing the foreground with the darker, stacked image?


  I went back to the captures from that shoot and found a photo with the afternoon sun lighting the foreground rocks and beach. Opening the image in Photoshop, I realized that I was back in business. My time hadn’t been wasted; I would be able to finish the image.
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  • The sky in the stacked image looked great, but the foreground was way too dark. I wanted to see the details on the beach: rocks, sand and water.
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  • I had taken this image in the late afternoon before shooting the image set that would later be stacked in Photoshop. Thankfully, I hadn’t moved my tripod or camera, so it was possible to layer in this image showing the detail in the foreground with the darker stacked image. 10.5mm digital fisheye, 1/125 of a second at f/8 and ISO 100


  Layering the stacked image with the foreground image


  With the stacked image and foreground image opened in their own windows in Photoshop, I combined them by positioning the foreground image on top of the stacked image as a layer.


  Then, by drawing a gradient on a Hide All (black) layer mask on the foreground layer, I was able to reveal the foreground at the lower portion of the composite image while leaving the darker sky with star trails visible. This technique of using a gradient on a layer mask is also described on pages 132–133.


  Once you get the hang of it, it is a simple operation that can be used to blend a lighter and darker version of the same scene. And it takes all of thirty seconds.
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  • Step 2: With the “Foreground” layer selected in the Layers palette, choose Layer - Layer Mask - Hide All to add a Layer Mask to that layer. The Hide All Layer Mask hides the “Foreground” layer and appears as a black thumbnail in the Layers palette.
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  • The finished image shows the star trails in the sky and detail in the foreground. To see the image full-size, turn to page 222.


  Finding a surprise


  When I added up the hours of work that went into this image, I found that shooting alone totaled about seven hours. That’s seven hours in one windy and treacherous spot, not moving the tripod by even a millimeter.


  What I always worry about when I do a night photography trip that requires me to embed myself in a location long before dark … and then wait out the onset of night is: How hard will it be to get back out when this is done? Will the tide have come up? Will I remember how to get out? Will there be cliffs, potholes, poison oak or other obstacles to fall into or off of? It’s this kind of suspense that keeps me on the tough but rewarding path of the night photographer!


  Post-processing a stack does get easier as you get used to the concepts. But there are many captures involved. For each capture in a complex image involving multiple night exposures, it is still an experimental journey at the computer, with false starts and intermittent progress.


  On top of all the time spent on location, I spent about ten hours post-processing before I noticed the airplane trail shown to the right. I’m not always pleased with airplane trails in my stacked photos—and sometimes remove the exposure with the trails from the stack, although this can leave a gap in the star trails.


  But this red airplane tail light reminded me of a whimsical insect, flitting from point to point, and I think the oddball doodle that its flight path makes is the kind of serendipity that can make long exposures at night truly interesting.
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  • After finishing the Pigeon Point Lighthouse image, I was surprised to find some red airplane trails in the sky. Looking back at the thirteen images I had stacked, I discovered that airplane trails only appear in the thirteenth image (shown above). This image was my original failed attempt at creating a foreground image for the set. (See this image with the entire set of photos on page 213.) So, this image wasn’t a wash after all! If I hadn’t extended the exposure time to eight minutes while taking the photo, I would have never captured the airplane trails. 10.5mm digital fisheye, 8 minutes at f/4 and ISO 200, tripod mounted
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  • This is a blow-up of the sky area in the finished image. You can clearly see the red airplane trails.
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  • This was an unexpected image for me in several ways: My hope had been to get closer to the lighthouse. Airplane trails in star photos are often a nuisance that need to be removed, but in this case I thought they added a touch of whimsy to the final stacked composite. (See blow-up of the detail above.) I had thought that by shooting a longer (eight minute) exposure and adding it to the stack that I’d be able to add foreground detail. But it didn’t work. So I “rescued” the image by heroically compositing in a shot taken of the exact scene earlier, just around sunset. 10.5mm digital fisheye, composite of foreground (1/125 of a second at f/8 and ISO 100, photographed just after sunset) and sky (stacked composite of thirteen exposures taken at 4 minutes and f/4 and ISO 100, and one capture taken at 8 minutes at f/4 and ISO 200), tripod mounted, total exposure time about 62 minutes
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    • I stood at the edge of the Rio Grande Gorge near Taos, New Mexico, and waited for a car to come along the empty highway to cross the Rio Grande Gorge Bridge. I knew that a twenty second exposure would create a nice abstract effect from the movement of the car headlight. 38mm, 20 seconds at f/16 and ISO 200, tripod mounted Programming an Interval Timer

  


  


  Programming an Interval Timer


  A lack of sharpness in photographic images can be attributed to several issues. One of the most important to control is movement of the camera itself, because even the slightest movement of a camera can ruin a long exposure. No one likes to see hard work wasted. So start armed with the knowledge that you need to keep your camera shake-free.


  Keeping a camera motion-free is the point of using a remote control, as well as its more sophisticated “big brother,” the programmable interval timer. Before I explain how this piece of equipment works though, let me point out the basic things you need to know to reduce camera motion.


  Reducing Camera Motion


  When you press a shutter by hand at shutter speeds longer than 1/30 of a second—which is standard for all night photography—the very act of touching the camera will vibrate it and thereby decrease the sharpness of your photo. So you don’t want to fi re your shutter by hand at night. As I explain in a bit, a remote control is used to trigger the shutter of a camera at night to avoid movement.


  A camera’s self-timer can also be used in a pinch to fi re an exposure, but it’s not as effective as a remote control. A self-timer is not vibration free and a self-timer can usually initiate exposures only up to about thirty seconds (for reasons that will become clear in a moment).


  For the most part, when you are making a long exposure, your camera will be mounted on a tripod. The photographs shown in this book were all taken using a tripod (or, in a couple of cases, improvised camera support).


  When your camera is on a tripod, generally you should turn off image stabilization (also called vibration reduction), if your camera or lens has this feature. Since there are a very few exceptions to this rule, take the time to check your product manual to verify the setting you should use when the camera is on a tripod. Image stabilization is designed to compensate for vibration when you hold a camera, but it can actually add camera movement when the camera is on a tripod.


  In night photography, wind can be a problem because it can cause a camera on a tripod to move. Some wind conditions are simply too intense to allow long exposures. In moderate wind, it helps to add weight to a tripod. You can place rocks around the tripod’s legs or hang something heavy— such as a camera bag—from the hook that many tripods provide at the bottom of their center pole.


  In a DSLR, when you look through the viewfinder and lens, a mirror is used so you see what the sensor would see. To take the actual photo, the mirror must be raised at the beginning of an exposure. Raising the mirror can vibrate the camera. A good way to mitigate this problem is to raise the mirror as a separate operation at least five seconds before you make your exposure.


  (Check your camera manual to see if it allows you to raise the mirror in advance of your exposure.)


  You might expect that the longer the exposure, the more important it is to raise the mirror in advance. But, this is not the case. As exposures get really long, the amount of vibration that the action of the mirror adds at the beginning of the exposure becomes proportionally minimal. Raising the mirror in advance has the most significant benefit at moderate shutter speeds—between roughly 1/125 of a second and two seconds.


  Using a Remote Control


  A remote control lets you trigger the shutter from a distance. The remote control is connected to the camera on the tripod with a cable or via wireless. Both are fine. With a wireless remote, you can usually get further from your camera, and you don’t have to worry about the remote cable falling off the camera. On the other hand, a remote control connected with a cable is simpler and less prone to failures.


  Back in the days of fi lm, there was a standard size “cable release” for the connector to a remote control. With the onset of digital, electronic communication with a camera has become more complicated. There is no one-size-fits-all connector. Only remote controls designed for use with your camera will work with your camera.


  Simple remote controls provide a button; when you press the button, the shutter on the camera is triggered.


  The longest shutter speed provided by most cameras is thirty seconds (although this does vary, so check your manual). To make exposures with a shutter speed longer than thirty seconds, you need to use manual exposure mode, with the shutter speed set to Bulb. On Bulb, the shutter stays open as long as it is depressed. (See page 45 for more about using the Bulb setting. Not all cameras have a Bulb setting, so once again, check your manual.)


  The need to keep the shutter button depressed in order to keep the shutter open for exposures longer than thirty seconds explains why a self-timer is not a substitute for a remote control. You don’t want to keep the button on the remote control pressed during a long exposure. Fingers get cold. Fingers get tired. It’s easy to lose track of time in the dark.


  Fortunately, even the simplest remote control usually has a lock, so you can press the shutter button and leave it locked in the “on” position.


  However, this still leaves the problem of timing long exposures in the dark, which is more difficult than it sounds. It is surprisingly easy to get disoriented about time in the dark of the night. Often, you can’t use a light because of your exposure and staring at an illuminated dial will ruin your night vision.


  You can’t arrange for a photo to be taken after an interval of time with a simple remote control. It just can’t be done. In addition, if you want to take a timed sequence of shots, perhaps for use in a star trail stack like the ones I show on pages 192–223, it’s very difficult to achieve this with a simple remote control.


  This leads to the need for a piece of equipment that you’ll find in the gear bag of almost every serious night photographer: ta-da … the programmable interval timer.


  Benefits of a Programmable Interval Timer


  A programmable interval timer runs on batteries and starts with the functionality of a simple remote control. It has a button that triggers the camera’s shutter release, which can be locked in an “on” position.


  Besides the simple remote control functionality, a programmable remote control provides a timed function that’s used to set an interval before the exposure. It also lets you make timed exposures (used with Bulb shutter speeds) and set intervals between exposures for creating a stack or other timelapse effects. There’s a separate button that triggers the timed functionality as opposed to the remote control (see the figure below).


  A programmable interval timer also provides illumination, so you can see what is going on at night. Yet it is dim enough to not interfere with your photography or night vision.
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  • Mount Tamalpais is near metropolitan San Francisco and displays quite a bit of light even in the middle of the night. 18mm, 5 minutes at f/3.5 and ISO 100, tripod mounted
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  • This is a three-minute timed exposure from Arch Rock in Point Reyes National Seashore looking northwest up the coast toward Limantour Beach, Drakes Bay and the Point Reyes Lighthouse.


  As I exposed the image, Venus was shining brightly in the sky and an airplane wandered across the night moonscape.


  The waves were crashing below where I was standing with my camera and tripod, and there was quite a bit of wind blowing the clouds seen in this image. If you look carefully, you can even see reflected stars on the surface of the ocean. 15mm, 3 minutes at f/4 and ISO 100, tripod mounted


  Timers and Cameras


  A good programmable interval timer costs between $100 and $200. Not all DSLRs can be equipped with one, so check your product documentation. If you have a choice between a programmable remote made by your camera manufacturer and a third-party remote, I suggest getting the camera manufacturer’s product on the grounds of reliability, even if it is a little more expensive.


  Generally, the least expensive DSLRs cannot be fitted with a remote programmable interval timer. The table below shows the two programmable interval timers that Canon and Nikon make, along with a list of some compatible camera models.
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  Using a Programmable Interval Timer


  The first step is to connect the cord of the programmable interval timer to the connector on your camera, making sure the attachment is snug. It’s often easiest to do this before you put your camera on the tripod.


  Just like a simple remote control, a programmable interval timer has a button that presses the shutter release (and a lock). If your exposure isn’t set to Bulb, this may be all you need to use, and you don’t need to get into the complexity of the programmable timer.


  If you do need to program the timer, set the following items in order.


  Delay: If you want to start exposing right away, this should be set to “0.” Otherwise, enter the delay in hours, minutes and seconds before you want the timed exposure (or exposures) to start.


  Long: Set the duration of the exposure (or exposures) in hours, minutes and seconds.


  Interval: If you are shooting a single exposure, this setting does not matter.


  If you are shooting a sequence of exposures, and you want as little as possible time between the exposures, you have two options:


  1. Set the interval to the least possible interval (one second), and set the Number of exposures to unlimited; or


  2. Set the interval to one second longer than your Long setting, and set the Number of exposures to the number of captures you’d like as part of the sequence.


  If you want a time delay between the exposures in your sequence, set the interval accordingly. (Note: If you’ve specified a Number of exposures, the interval starts from the beginning of the exposure, not the end of the exposure.)


  Number: If you are taking one exposure, this setting should be “1.” Otherwise, choose a number of exposures or use the unlimited setting. Just remember that with a specified number of exposures, the Interval starts at the beginning of the exposure, not the end of the exposure, and must be at least one second longer than the exposure time. With your timer set, press the timed start button to begin your exposure or timed sequence of exposures.


  A programmable interval timer gives you the ability to take really long Bulb exposures at night along with the flexibility to segment your exposures for noise reduction. Once you’ve begun exposing using this kind of remote cable, I’m sure it will become a permanent fixture in your camera bag.
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  • I waited quite a while for a car to come along this deserted stretch of country road. I pressed the shutter release before the car came into view so I could capture its taillights as it passed. 18mm, 15 seconds at f/22 and ISO 100, tripod mounted


  


  Glossary


  Aperture: The size of the opening in a lens. The larger the aperture, the more light that hits the sensor.


  Black frame: An image shot with the shutter closed or the lens cap on for the purpose of noise cancellation.


  Black frame reduction: Combines a black frame with a photo in order to cancel noise in the photo.


  Bulb: A Bulb exposure is one in which the shutter stays open as long as the shutter release is engaged.


  CCD: Charge-coupled device, or filter, used to shift image signals from one spectrum to another.


  Composite: Combined images that are used to create a new composition.


  Depth-of-field: The area in front of and behind a subject that is in focus.


  DSLR: Digital Single Lens Reflex, a camera in which photos are composed through the lens that will be used to take the actual image.


  Dynamic range: The difference between the lightest tonal values one can see and the darkest tonal values in a photo.


  Exposure: The amount, or act, of light hitting the camera sensor; also the camera settings used to capture this incoming light.


  Exposure histogram: A bar graph displayed on a camera or computer showing the distribution of lights and darks in a photo. f-number, f-stop: The size of the aperture, written f/n, where n is the f-number. The larger the f-number, the smaller the opening in the lens.


  Focal length: The distance from the end of the lens to the sensor.


  GPS: Global Positioning System, a radio-navigation system that provides location, navigation and timing services.


  Hand HDR: The process of creating a HDR (High Dynamic Range) image from multiple photos at different exposures without using automatic software to combine the photos.


  Histogram: A bar graph showing a distribution of values; see also Exposure histogram.


  Image stabilization: Also called vibration reduction, this is a high tech system in a lens or camera that attempts to compensate for, and reduce, camera motion. infinity: The farthest distance a lens can focus.


  ISO: The linear scale used to set sensitivity.


  JPEG: A compressed fi le format for photos that have been processed from the original RAW image.


  LCD: Liquid crystal display, a viewing device that’s part of most digital cameras.


  Long exposure noise reduction: When this setting is turned on, a camera shoots a black frame and uses noise cancellation to reduce long exposure noise.


  Multi-RAW processing: Combining two or more different versions of the same RAW file.


  Noise: Static in a digital image that appears as unexpected, and usually unwanted, pixels.


  Noise cancellation: Uses black frame reduction to “cancel” the noise in an image.


  Open up: To open up a lens means to set the aperture to a large opening, denoted with a small f-number.


  Photo composite: See Composite.


  RAW: A digital RAW fi le is a complete record of the data captured by the sensor. The details of RAW file formats vary between camera manufacturers.


  Sensitivity: Set using an ISO number; determines the sensitivity of the sensor to light.


  Shutter speed: The interval of time that the shutter is open.


  Stack, stacking: Combining photos shot over time to create a single image with an effective exposure time of all the shots combined.


  Star trails: Paths of light created by the apparent motion of the stars.


  Stop down: To stop down a lens means to set the aperture to a small opening, denoted with a large f-number.


  Vibration reduction: See Image stabilization.
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  • Standing on a sandy beach near the Golden Gate Bridge, I shot this photo as the moon rose and the ambient light illuminated the clouds with an attractive, colorful pattern. 18mm, 6 seconds at f/3.5 and ISO 100, tripod mounted
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  • I was struck by the patterns of light and dark and the mixed lighting sources shown in this composition. I stopped the camera down to a small aperture for depth-of-field so the foreground and background would both be in focus. 50mm, 20 seconds at f/20 and ISO 200, tripod mounted
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  Resources and Websites


  General night photography sites


  Digital Night is my site with information about night photography: www.digitalnight.us


  The Nocturnes is probably the classic source for information about night photography on the web: www.thenocturnes.com


  Books about photographic technique


  Harold Davis, Creative Composition: Digital Photography Tips and Techniques (Wiley, 2010), provides information about tools and techniques for visualizing and framing photos.


  Harold Davis, Practical Artistry: Light and Exposure for Digital Photographers (O’Reilly, 2008), explains exposing digital photos.


  Harold Davis, The Digital Darkroom: Creative Digital Post-Processing (Focal Press, 2010), explains Multi-RAW processing, Hand HDR processing, and digital black and white conversions


  Sites about astronomy and the stars


  Astronomy.com is a good site for general information as well as to learn about specific astronomical phenomenon: www.astronomy.com


  Naval Astronomical Applications provides a portal with access to a great many astronomy resources: www.usno.navy.mil/USNO/ astronomical-applications


  The astronomy picture of the day is a great way to learn about the cosmos, and often beautiful, too: http://apod.nasa.gov/apod/


  Spot Personal Satellite Tracker (page 22) www.findmespot.com


  Tripods and Heads (pages 26–29)


  Gitzo: www.gitzo.com


  Kirk Enterprises: www.kirkphoto.com


  Really Right Stuff: www.reallyrightstuff.com


  Gorillapod: www.joby.com/products/gorillapod


  Understanding the night sky (page 156)


  Find sunrise, sunset, moonrise, moonset, and rise and set times of all planets: www.almanac.com/rise/


  Enter zipcode to get a star chart of where you are gazing from. On the star chart, click the star or planet for more info (including rise and set times): www.wunderground.com/sky/index.asp


  Complete sun and moon data for one day at specified location: http://aa.usno.navy. mil/data/docs/RS_OneDay.php


  Generate custom sunrise and sunset calendars listing local times: www.sunrisesunset.com


  [image: ]



  • Behind the picturesque fishing harbor on Monterey Bay, California, looms a gigantic natural-gas-fired power plant. I often wonder what compels some people to wreck the beauty that nature provides. Why site that power plant in such a special spot?


  Perhaps it is to benefit night photographers. The power plant is always illuminated, and the lighting is interesting in both clear and cloudy weather. 55mm, 20 seconds at f/32 and ISO 200, tripod mounted
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